The information in this manual is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this manual.

Except as may be expressly stated anywhere in this manual, nothing herein shall be construed as any kind of guarantee or warranty by ABB for losses, damages to persons or property, fitness for a specific purpose or the like.

In no event shall ABB be liable for incidental or consequential damages arising from use of this manual and products described herein.

This manual and parts thereof must not be reproduced or copied without ABB’s written permission.

Additional copies of this manual may be obtained from ABB.

The original language for this publication is English. Any other languages that are supplied have been translated from English.

© Copyright 2008-2013 ABB. All rights reserved.

ABB AB
Robotics Products
SE-721 68 Västerås
Sweden
# Table of contents

Overview .................................................................................................................. 11  
Product documentation, M2004 ................................................................................ 17  
Safety ..................................................................................................................... 19  

1 Introduction to RobotStudio .................................................................................. 21  
  1.1 What is RobotStudio .......................................................................................... 21  
  1.2 Terms and concepts .......................................................................................... 22  
    1.2.1 Hardware concepts .................................................................................... 22  
    1.2.2 RobotWare concepts .................................................................................. 23  
    1.2.3 RAPID concepts ....................................................................................... 25  
    1.2.4 Concepts of programming .......................................................................... 26  
    1.2.5 Targets and paths ...................................................................................... 27  
    1.2.6 Coordinate systems ................................................................................... 28  
    1.2.7 Robot axis configurations ......................................................................... 34  
    1.2.8 Libraries, geometries and CAD files ......................................................... 36  
    1.2.9 VSTA as the IDE ....................................................................................... 39  
  1.3 Installing and licensing RobotStudio ................................................................ 40  
  1.4 User interface ................................................................................................... 48  
    1.4.1 Ribbon, tabs and groups ............................................................................. 48  
    1.4.2 Layout browser ........................................................................................... 49  
    1.4.3 The Paths & Targets browser ..................................................................... 50  
    1.4.4 The Modeling browser ............................................................................... 52  
    1.4.5 The Controller browser ............................................................................. 53  
    1.4.6 Files browser ............................................................................................. 55  
    1.4.7 Add-Ins browser ....................................................................................... 56  
    1.4.8 The Output window ................................................................................... 57  
    1.4.9 The Controller Status window ................................................................... 58  
    1.4.10 The Operator Window .............................................................................. 60  
    1.4.11 The Document Manager window ............................................................ 62  
    1.4.12 Using a mouse ......................................................................................... 69  
    1.4.13 Selecting an item ...................................................................................... 70  
    1.4.14 Attaching and detaching objects ............................................................... 71  
    1.4.15 Keyboard shortcuts .................................................................................... 72  

2 Building stations .................................................................................................. 75  
  2.1 Workflow of building a station .......................................................................... 75  
  2.2 Conveyor tracking station with two robots ....................................................... 77  
    2.2.1 Two robot systems in same task frame position ......................................... 77  
    2.2.2 Two robot systems in different task frame positions ................................. 79  
  2.3 Creating a system with external axes automatically ......................................... 81  
  2.4 Manually setting up system with track motion ............................................... 83  
    2.4.1 Track motion of type RTT or IRBTx003 ...................................................... 83  
    2.4.2 Track motion of type IRBTx004 ................................................................. 84  
  2.5 Virtual Controller ............................................................................................ 85  
    2.5.1 Starting a VC ............................................................................................. 85  
    2.5.2 Restarting a VC ......................................................................................... 86  
  2.6 Station components .......................................................................................... 87  
    2.6.1 Importing a station component .................................................................. 87  
    2.6.2 Converting CAD formats .......................................................................... 89  
    2.6.3 Troubleshooting and optimizing geometries .............................................. 90  
  2.7 Modeling .......................................................................................................... 92  
    2.7.1 Objects ...................................................................................................... 92  
    2.7.2 Mechanisms ............................................................................................... 94  
    2.7.3 Tools and tooldata ..................................................................................... 95  
    2.7.4 Setting the local origin of an object .......................................................... 96
## Table of contents

### 2 Programming robots

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.8 Placement</td>
<td>97</td>
</tr>
<tr>
<td>2.8.1 Placing objects</td>
<td>97</td>
</tr>
<tr>
<td>2.8.2 Placing external axes</td>
<td>98</td>
</tr>
<tr>
<td>2.8.3 Placing robots</td>
<td>100</td>
</tr>
</tbody>
</table>

### 3 Programming robots

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Workflow for programming a robot</td>
<td>103</td>
</tr>
<tr>
<td>3.2 Workobjects</td>
<td>104</td>
</tr>
<tr>
<td>3.3 Jogging mechanisms</td>
<td>105</td>
</tr>
<tr>
<td>3.4 Targets</td>
<td>106</td>
</tr>
<tr>
<td>3.5 Paths</td>
<td>108</td>
</tr>
<tr>
<td>3.6 Orientations</td>
<td>111</td>
</tr>
<tr>
<td>3.7 RAPID Instructions</td>
<td>115</td>
</tr>
<tr>
<td>3.8 Testing positions and motions</td>
<td>122</td>
</tr>
<tr>
<td>3.9 Programming MultiMove systems</td>
<td>124</td>
</tr>
<tr>
<td>3.9.1 About programming MultiMove</td>
<td>124</td>
</tr>
<tr>
<td>3.9.2 Setting up the MultiMove</td>
<td>126</td>
</tr>
<tr>
<td>3.9.3 Testing the MultiMove</td>
<td>127</td>
</tr>
<tr>
<td>3.9.4 Tuning the motion behavior</td>
<td>128</td>
</tr>
<tr>
<td>3.9.5 Creating paths</td>
<td>130</td>
</tr>
<tr>
<td>3.10 Programming external axes</td>
<td>131</td>
</tr>
<tr>
<td>3.11 Loading and saving programs and modules</td>
<td>133</td>
</tr>
<tr>
<td>3.12 Synchronization</td>
<td>134</td>
</tr>
</tbody>
</table>

### 4 Simulating programs

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1 Simulation Overview</td>
<td>135</td>
</tr>
<tr>
<td>4.2 Detecting collisions</td>
<td>137</td>
</tr>
<tr>
<td>4.3 Creating an event</td>
<td>140</td>
</tr>
<tr>
<td>4.4 Simulating I/O signals</td>
<td>141</td>
</tr>
<tr>
<td>4.5 Enabling simulation monitoring</td>
<td>142</td>
</tr>
<tr>
<td>4.6 Measuring simulation time</td>
<td>143</td>
</tr>
</tbody>
</table>

### 5 Deploying and distributing

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Copying programs</td>
<td>145</td>
</tr>
<tr>
<td>5.2 Pack &amp; Go / Unpack &amp; Work</td>
<td>146</td>
</tr>
<tr>
<td>5.3 Screen Capture</td>
<td>147</td>
</tr>
</tbody>
</table>

### 6 Working online

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1 Connecting a PC to the service port</td>
<td>149</td>
</tr>
<tr>
<td>6.2 Network settings</td>
<td>151</td>
</tr>
<tr>
<td>6.3 User Authorization</td>
<td>154</td>
</tr>
<tr>
<td>6.4 The System Builder</td>
<td>156</td>
</tr>
<tr>
<td>6.4.1 System Builder Overview</td>
<td>156</td>
</tr>
<tr>
<td>6.4.2 Viewing system properties</td>
<td>158</td>
</tr>
<tr>
<td>6.4.3 Building a new system</td>
<td>159</td>
</tr>
<tr>
<td>6.4.4 Modifying a system</td>
<td>163</td>
</tr>
<tr>
<td>6.4.5 Copying a system</td>
<td>167</td>
</tr>
<tr>
<td>6.4.6 Creating a system from backup</td>
<td>168</td>
</tr>
<tr>
<td>6.4.7 Downloading a system to a controller</td>
<td>169</td>
</tr>
<tr>
<td>6.4.8 Creating boot media</td>
<td>170</td>
</tr>
<tr>
<td>6.4.9 Examples using the System Builder when offline</td>
<td>171</td>
</tr>
<tr>
<td>6.4.9.1 A MultiMove system with two coordinated robots</td>
<td>171</td>
</tr>
<tr>
<td>6.4.9.2 A system with support for one robot and one positioner external axis</td>
<td>173</td>
</tr>
<tr>
<td>6.4.9.3 Options settings for systems with positioners</td>
<td>175</td>
</tr>
<tr>
<td>6.5 Handle I/O</td>
<td>176</td>
</tr>
<tr>
<td>6.6 Configure systems</td>
<td>177</td>
</tr>
<tr>
<td>6.7 Handle events</td>
<td>183</td>
</tr>
</tbody>
</table>
# Table of contents

## 7 File tab

7.1 Overview ......................................................................................................................... 187
7.2 New .................................................................................................................................. 188
7.3 Share ................................................................................................................................. 189
  7.3.1 Pack and Go .............................................................................................................. 189
  7.3.2 Unpack and Work ................................................................................................. 190
  7.3.3 Station Viewer ......................................................................................................... 191
7.4 Options ............................................................................................................................. 193

## 8 Home tab

8.1 Overview .......................................................................................................................... 201
8.2 ABB Library ..................................................................................................................... 202
8.3 Import Library .................................................................................................................. 203
8.4 Robot System ................................................................................................................... 204
  8.4.1 Robot System ........................................................................................................... 204
  8.4.2 External Axis Wizard ............................................................................................. 207
8.5 Import Geometry .............................................................................................................. 210
8.6 Frame .............................................................................................................................. 211
  8.6.1 Frame ....................................................................................................................... 211
  8.6.2 Frame from Three Points ....................................................................................... 212
8.7 Workobject ...................................................................................................................... 214
8.8 Tooldata .......................................................................................................................... 215
8.9 Target .............................................................................................................................. 216
  8.9.1 Teach Target ............................................................................................................ 216
  8.9.2 Create Target ......................................................................................................... 217
  8.9.3 Create Jointtarget .................................................................................................. 219
  8.9.4 Create Targets on Edge ........................................................................................ 220
8.10 Empty Path .................................................................................................................... 222
8.11 AutoPath ......................................................................................................................... 223
8.12 MultiMove ..................................................................................................................... 225
8.13 Teach Instruction .......................................................................................................... 233
8.14 Move Instruction .......................................................................................................... 234
8.15 Action Instruction ......................................................................................................... 235
8.16 Instruction Template Manager ....................................................................................... 236
8.17 Settings ......................................................................................................................... 239
  8.17.1 Task ......................................................................................................................... 239
  8.17.2 Workobject .......................................................................................................... 240
  8.17.3 Tool ......................................................................................................................... 241
8.18 The Freehand Group ...................................................................................................... 242
  8.18.1 Move ....................................................................................................................... 242
  8.18.2 Rotate ...................................................................................................................... 243
  8.18.3 Jog Joint .................................................................................................................. 244
  8.18.4 Jog Linear .............................................................................................................. 245
  8.18.5 Jog Reorient ......................................................................................................... 246
  8.18.6 MultiRobot Jog .................................................................................................. 247
8.19 The 3D View group ....................................................................................................... 248
8.20 Viewpoint ....................................................................................................................... 250
8.21 Markup .......................................................................................................................... 252

## 9 Modeling tab

9.1 Overview .......................................................................................................................... 253
9.2 Component Group .......................................................................................................... 254
9.3 Empty Part ....................................................................................................................... 255
9.4 Smart Component .......................................................................................................... 256
  9.4.1 Smart Component .................................................................................................. 256
  9.4.2 Smart Component Editor ....................................................................................... 257
  9.4.3 The Compose tab .................................................................................................. 258
  9.4.4 The Properties and Bindings tab ............................................................................ 261
# Table of contents

11.3.3 Authenticate ................................................................. 373
11.3.4 File transfer ................................................................. 374
11.3.5 FlexPendant Viewer ....................................................... 376
11.3.6 Import Options ............................................................. 377
11.3.7 Properties ................................................................. 378
11.3.8 Go Offline ................................................................. 381
11.3.9 Online Monitor ........................................................... 382
11.3.10 User Accounts .......................................................... 383
11.3.11 UAS Grant Viewer ...................................................... 388
11.4 Features for virtual controllers ........................................ 392
  11.4.1 Virtual FlexPendant .................................................... 392
  11.4.2 Control Panel .......................................................... 393
  11.4.3 Shutdown ............................................................... 394
  11.4.4 Set Task Frames ....................................................... 395
  11.4.5 Edit System ............................................................ 396
  11.4.6 Encoder Unit .......................................................... 398

12 RAPID tab ........................................................................ 399
  12.1 Overview of the RAPID tab ........................................... 399
  12.2 Synchronize to Station .................................................... 400
  12.3 Synchronize to VC ......................................................... 401
  12.4 Edit RAPID code .......................................................... 402
  12.5 Find and replace RAPID code ....................................... 407
  12.6 Manage RAPID modules ............................................... 409
  12.7 Edit RAPID data .......................................................... 411
  12.8 Manage RAPID files and backups ................................. 412
  12.9 Manage RAPID code on the controller .......................... 413
    12.9.1 Manage RAPID programs ....................................... 413
    12.9.2 RAPID Tasks ........................................................ 414
    12.9.3 Run Mode ............................................................ 416
    12.9.4 Adjust Robtargets ................................................ 417
  12.10 Test and debug ............................................................ 420
    12.10.1 Commands for testing and debugging ..................... 420
    12.10.2 Using the Program Pointer .................................... 421
    12.10.3 Using the RAPID Profiler ...................................... 423
  12.11 RAPID Watch window ................................................. 425
  12.12 Examples of using the RAPID editor ............................. 426

13 Add-Ins tab ........................................................................ 429
  13.1 Overview of the Add-Ins tab .......................................... 429
  13.2 Building a VSTA add-in .................................................. 430
  13.3 Gearbox Heat Prediction ............................................... 431
  13.4 Integrated Vision ........................................................ 434

14 Context menus .................................................................. 435
  14.1 Add to Path ................................................................. 435
  14.2 Align Frame Orientation ............................................... 436
  14.3 Align Target Orientation ................................................ 437
  14.4 Attach to ................................................................. 438
  14.5 Configurations ............................................................ 439
  14.6 Check Reachability ....................................................... 441
  14.7 Configurations ............................................................ 442
  14.8 Convert Frame to WorkObject ....................................... 443
  14.9 Convert to Move Circular .............................................. 444
  14.10 Copy / Apply Orientation .............................................. 445
  14.11 Detach ................................................................. 446
  14.12 Execute Move Instruction .............................................. 447
  14.13 External Axis Interpolation ........................................... 448
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.14 Graphic Appearance</td>
<td>449</td>
</tr>
<tr>
<td>14.15 Go to Visualization and Go to Declaration</td>
<td>451</td>
</tr>
<tr>
<td>14.16 Interpolate Path</td>
<td>452</td>
</tr>
<tr>
<td>14.17 Invert</td>
<td>453</td>
</tr>
<tr>
<td>14.18 Jump to Target</td>
<td>454</td>
</tr>
<tr>
<td>14.19 Linked Geometry</td>
<td>455</td>
</tr>
<tr>
<td>14.20 Modify Library Component</td>
<td>456</td>
</tr>
<tr>
<td>14.21 Mechanism Joint Jog</td>
<td>457</td>
</tr>
<tr>
<td>14.22 Mechanism Linear Jog</td>
<td>459</td>
</tr>
<tr>
<td>14.23 Mirror Path</td>
<td>460</td>
</tr>
<tr>
<td>14.24 Mirror</td>
<td>461</td>
</tr>
<tr>
<td>14.25 Modify Curve</td>
<td>462</td>
</tr>
<tr>
<td>14.26 Modify External Axis</td>
<td>467</td>
</tr>
<tr>
<td>14.27 Modify Instruction</td>
<td>468</td>
</tr>
<tr>
<td>14.28 Modify Mechanism</td>
<td>469</td>
</tr>
<tr>
<td>14.29 Modify Tooldata</td>
<td>470</td>
</tr>
<tr>
<td>14.30 Modify Workobject</td>
<td>471</td>
</tr>
<tr>
<td>14.31 Move Along Path</td>
<td>472</td>
</tr>
<tr>
<td>14.32 Move to Pose</td>
<td>473</td>
</tr>
<tr>
<td>14.33 Offset Position</td>
<td>474</td>
</tr>
<tr>
<td>14.34 Place</td>
<td>475</td>
</tr>
<tr>
<td>14.35 Protected Smart Component</td>
<td>477</td>
</tr>
<tr>
<td>14.36 Remove Unused Targets</td>
<td>478</td>
</tr>
<tr>
<td>14.37 Rename Targets</td>
<td>479</td>
</tr>
<tr>
<td>14.38 Reverse Path</td>
<td>480</td>
</tr>
<tr>
<td>14.39 Rotate</td>
<td>481</td>
</tr>
<tr>
<td>14.40 Rotate Path</td>
<td>482</td>
</tr>
<tr>
<td>14.41 Set Local Origin</td>
<td>483</td>
</tr>
<tr>
<td>14.42 Set Normal to Surface</td>
<td>484</td>
</tr>
<tr>
<td>14.43 Set Position</td>
<td>485</td>
</tr>
<tr>
<td>14.44 Tool Compensation</td>
<td>486</td>
</tr>
<tr>
<td>14.45 Translate Path</td>
<td>487</td>
</tr>
<tr>
<td>14.46 View Robot at Target</td>
<td>488</td>
</tr>
<tr>
<td>14.47 View Tool at Target</td>
<td>489</td>
</tr>
</tbody>
</table>

## 15 ScreenMaker tab

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.1 Introduction to ScreenMaker</td>
<td>491</td>
</tr>
<tr>
<td>15.1.1 Overview</td>
<td>491</td>
</tr>
<tr>
<td>15.1.2 Development environment</td>
<td>494</td>
</tr>
<tr>
<td>15.2 ScreenMaker projects</td>
<td>504</td>
</tr>
<tr>
<td>15.2.1 Managing ScreenMaker projects</td>
<td>504</td>
</tr>
<tr>
<td>15.2.2 Application variables</td>
<td>510</td>
</tr>
<tr>
<td>15.2.3 RAPID array</td>
<td>511</td>
</tr>
<tr>
<td>15.2.4 Form designer</td>
<td>512</td>
</tr>
<tr>
<td>15.2.5 Data binding</td>
<td>515</td>
</tr>
<tr>
<td>15.2.6 ScreenMaker Doctor</td>
<td>518</td>
</tr>
<tr>
<td>15.2.7 Screen navigation</td>
<td>521</td>
</tr>
<tr>
<td>15.3 Tutorial</td>
<td>522</td>
</tr>
<tr>
<td>15.3.1 Overview</td>
<td>522</td>
</tr>
<tr>
<td>15.3.2 Designing the FlexArc operator panel</td>
<td>523</td>
</tr>
<tr>
<td>15.3.3 Designing the screen</td>
<td>526</td>
</tr>
<tr>
<td>15.3.4 Building and deploying the project</td>
<td>532</td>
</tr>
<tr>
<td>15.4 Frequently asked questions</td>
<td>533</td>
</tr>
</tbody>
</table>

Index | 535
Overview

About this manual

RobotStudio is a PC application for modeling, offline programming, and simulation of robot cells. This manual describes how to create, program and simulate robot cells and stations using RobotStudio. This manual also explains the terms and concepts related to both offline and online programming.

Usage

This manual should be used when working with the offline or online functions of RobotStudio.

Who should read this manual?

This manual is intended for RobotStudio users, proposal engineers, mechanical designers, offline programmers, robot technicians, service technicians, PLC programmers, Robot programmers, and Robot System integrators.

Prerequisites

The reader should have basic knowledge of:

• Robot programming
• Generic Windows handling
• 3D CAD programs

Organization of chapters

The operating manual is structured in the following chapters:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction to RobotStudio on page 21 Contains installation instructions, basic explanations of the terms and concepts related to robotics and programming, and a description of the GUI.</td>
</tr>
<tr>
<td>2</td>
<td>Building stations on page 75 Describes how to build stations in RobotStudio. This includes importing and configuring the equipment to be simulated, as well as testing the reachability for finding the optimal station layout.</td>
</tr>
<tr>
<td>3</td>
<td>Programming robots on page 103 Describes how to create robot movements, I/O signals, process instructions and logics in a RAPID program for the robots. It also describes how to run and test the program.</td>
</tr>
<tr>
<td>4</td>
<td>Simulating programs on page 135 Describes how to simulate and validate robot programs.</td>
</tr>
<tr>
<td>5</td>
<td>Deploying and distributing on page 145 Describes how to transfer systems between RobotStudio’s virtual controllers and real IRC5 controllers, how to copy programs, how to package an active station for moving between RobotStudio PCs, and how to capture a screen.</td>
</tr>
<tr>
<td>6</td>
<td>Working online on page 149 Covers the functionality of the Minimal Installation, describing such online functions as building systems (with offline examples), handling I/O and events, and configuring systems.</td>
</tr>
</tbody>
</table>

Continues on next page
### Chapter Descriptions

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td><strong>File tab on page 187</strong> Describes the options to create new station, create new robot system, connect to a controller, save station as viewer, and RobotStudio options.</td>
</tr>
<tr>
<td>8</td>
<td><strong>Home tab on page 201</strong> Describes the controls required for building stations, creating systems, programming paths and placing items.</td>
</tr>
<tr>
<td>9</td>
<td><strong>Modeling tab on page 253</strong> Describes the controls for creating and grouping components, creating bodies, measurements and CAD operations.</td>
</tr>
<tr>
<td>10</td>
<td><strong>Simulation tab on page 317</strong> Describes the controls for setting up, configuring, controlling, monitoring, and recording simulations.</td>
</tr>
<tr>
<td>11</td>
<td><strong>Controller tab on page 347</strong> Describes the controls for managing a real controller and also the controls for synchronization, configuration and tasks assigned to the virtual controller (VC).</td>
</tr>
<tr>
<td>12</td>
<td><strong>RAPID tab on page 399</strong> Describes the features of the RAPID editor, management of RAPID files and other controls for RAPID programming.</td>
</tr>
<tr>
<td>13</td>
<td><strong>Add-Ins tab on page 429</strong> Describes the control for PowerPacs and the Visual Studio Tools for Applications (VSTA).</td>
</tr>
<tr>
<td>14</td>
<td><strong>Context menus on page 435</strong> Describes the options available from the context menus.</td>
</tr>
<tr>
<td>15</td>
<td><strong>ScreenMaker tab on page 491</strong> Describes the ScreenMaker development tool, how to manage projects in ScreenMaker and the various menus and commands used in the application.</td>
</tr>
</tbody>
</table>

### References

<table>
<thead>
<tr>
<th>Reference</th>
<th>Document Id</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product manual - IRC5</td>
<td>3HAC021313-001</td>
</tr>
<tr>
<td>Operating manual - IRC5 with FlexPendant</td>
<td>3HAC16590-1</td>
</tr>
<tr>
<td>Technical reference manual - RAPID overview</td>
<td>3HAC16580-1</td>
</tr>
<tr>
<td>Technical reference manual - System parameters</td>
<td>3HAC17076-1</td>
</tr>
<tr>
<td>Application manual - MultiMove</td>
<td>3HAC021272-001</td>
</tr>
<tr>
<td>Application manual - Conveyor tracking</td>
<td>3HAC16587-1</td>
</tr>
<tr>
<td>Application manual - SafeMove</td>
<td>3HAC030053-001</td>
</tr>
<tr>
<td>Application manual - Electronic Position Switches</td>
<td>3HAC027709-001</td>
</tr>
<tr>
<td>Application manual - Integrated Vision</td>
<td>3HAC044251-001</td>
</tr>
</tbody>
</table>

### Revisions

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>First revision, called RobotStudio 2008, released for Partner Days. The entire manual has been adapted to the new GUI, in which RobotStudio Online has been integrated.</td>
</tr>
</tbody>
</table>

Continues on next page

© Copyright 2008-2013 ABB. All rights reserved.
<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
</table>
| B        | Released with RobotStudio 5.12. The following updates were made in the manual:  
  - Conveyor Tracking on page 344  
  - Create Conveyor mechanism on page 308  
  - Conveyor Simulation on page 345  
  - Two robot systems in same task frame position on page 77  
  - Two robot systems in different task frame positions on page 79  
  - Creating a system with external axes automatically on page 81  
  - Track motion of type RTT or IRBTx003 on page 83  
  - Track motion of type IRBTx004 on page 84  
  - The Operator Window on page 60  
  - Station Viewer on page 191  
  - Recording the simulation on page 343  
  - Viewpoint on page 250  
  - Linked Geometry on page 455 |
| C        | Released with RobotStudio 5.13.  
  - Merged chapters The Offline tab and The Online tab  
  - Added the missing information from RobotStudio Online manual.  
  - Integrated ScreenMaker. See ScreenMaker on page 353.  
  Added the following new contents:  
  - Smart Component on page 256  
  - The Simulation Watch window on page 286  
  - The Document Manager window on page 62  
  - Station Logic on page 328  
  - Simulation Setup on page 319  
  Updated the changes related to handling Task Frames.  
  - Updated Modifying Task frame on page 395.  
  - Added Placing robots on page 100.  
  - Updated Creating a system from layout on page 204. |
| D        | Released with RobotStudio 5.13.02  
  The ScreenMaker tutorial was updated. See Tutorial on page 522. |
## Revision

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
</table>
| E        | Released with RobotStudio 5.14  
• Added The Controller Status window on page 58.  
• Updated the sections Simulation Setup on page 319 and Simulation Control on page 330.  
• Moved RAPID Watch window on page 425 to the chapter Common features in Online and Offline tabs.  
• Updated The Document Manager window on page 62 (added Station mode).  
• Updated Creating and loading a Station Viewer on page 191 (Record to Viewer)  
• Added Jog Reorient on page 246.  
• Added The 3D View group on page 248.  
• Updated The Compose tab on page 258 (added Export to XML and updated Base Component menu).  
• Updated Coordinate systems on page 28 (improved task frame description).  
• Updated Supported 3D formats on page 37 (information on CAD Converters)  
Added the following new contents:  
• AutoPath on page 223  
• Online Monitor on page 382  
• Adjust Robotargets on page 417  
• Using the RAPID Profiler on page 423  
• Markup on page 252  
• Signal Analyzer on page 335  
• External Axis Interpolation on page 448  
• Auto Configuration on page 439  
• The Design tab on page 267  
The following are the ScreenMaker updates:  
• Added ScreenMaker Doctor on page 518.  
• Added new controls VariantButton on page 503 and Conditional-Trigger on page 503.  
• Updated Creating a new project on page 504 (added pre-defined templates).  
• Updated Controller object data binding on page 516 (added information on shared data). |

Continues on next page
<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
</table>
| F        | Released with RobotStudio 5.14.02  
Added the following new contents:  
• Gearbox Heat Prediction on page 431  
• External Axis Wizard on page 207  
Added the following new contents in Settings tab:  
• Selecting a Task on page 239  
• Selecting a Workobject on page 240  
• Selecting a Tool on page 241  
Updated Creating boot media on page 170 (added information on creating a new system)  
Added information on Logic Expression in Signals and Properties on page 268  
Added a Note for Call.Net Method in Form designer on page 512 of the ScreenMaker tab  
Added information on l-start in Result on page 166 for the Modifying a system section  
Added information on Offs in the Note for Prerequisites on page 417 in Using Adjust Robtargets  
Added a Note for the Execute button in Using Adjust Robtargets on page 417  
Added information on Always on top in Create Markup of the Markup on page 252 section  
Updated Note for Using ScreenMaker Doctor in ScreenMaker Doctor on page 518 |
| G        | Released with RobotStudio 5.14.02.01  
Added How to activate RobotStudio - Network License on page 43 |
| H        | Released with RobotStudio 5.14.03  
Added a note regarding the usage of .NET DLLs under Advanced options on page 513  
Added scenarios in Errors fixed by ScreenMaker Doctor on page 518  
Updated the procedure in Creating Markup on page 252  
Updated the note in Prerequisites on page 417 for Adjust Robtargets  
Updated the procedure for Using Adjust Robtargets on page 417  
Updated the table under LogicExpression for Signals and Properties on page 268  
Added a procedure for adding events to a menu item under CommandBar on page 502  
Updated the details for Creating autopath under AutoPath on page 223  
Updated the table showing the Supported 3D formats on page 37 |
## Overview

### Continued

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
</table>
| J        | Released with RobotStudio 5.15  
In addition to the following important updates, numerous minor improvements and corrections have been made throughout the document.  
Introduced the following new chapters containing both new features and also updated features;  
- Controller tab on page 347, which contain features related to real and virtual controllers.  
- RAPID tab on page 399, which contains features related to RAPID programming.  
Added the following new content:  
- Edit RAPID data on page 411  
- Transfer on page 365  
- Stopwatch on page 334  
- Go to Visualization and Go to Declaration on page 451  
- Offset Position on page 474  
- Protected Smart Component on page 477  
Updated, reworked the following sections:  
- Edit RAPID code on page 402  
- RAPID Watch window on page 425  
- Installing and licensing RobotStudio on page 40, and in particular How to activate RobotStudio - Network License on page 43  
- Virtual Controller on page 85  
- Screen Capture on page 147  
- Pack and Go on page 189 and Unpack and Work on page 190 |
| K        | Released with RobotStudio 5.15.01  
- Added section RAPID array on page 511.  
- Added a note in the section Controller object data binding on page 516.  
- Renamed the section ScreenMaker Doctor scenarios as Errors fixed by ScreenMaker Doctor and made some updates. See Errors fixed by ScreenMaker Doctor on page 518. |
Categories for manipulator documentation

The manipulator documentation is divided into a number of categories. This listing is based on the type of information in the documents, regardless of whether the products are standard or optional.

All documents listed can be ordered from ABB on a DVD. The documents listed are valid for M2004 manipulator systems.

Product manuals

Manipulators, controllers, DressPack/SpotPack, and most other hardware will be delivered with a **Product manual** that generally contains:

- Safety information.
- Installation and commissioning (descriptions of mechanical installation or electrical connections).
- Maintenance (descriptions of all required preventive maintenance procedures including intervals and expected life time of parts).
- Repair (descriptions of all recommended repair procedures including spare parts).
- Calibration.
- Decommissioning.
- Reference information (safety standards, unit conversions, screw joints, lists of tools).
- Spare parts list with exploded views (or references to separate spare parts lists).
- Circuit diagrams (or references to circuit diagrams).

Technical reference manuals

The technical reference manuals describe reference information for robotics products.

- **Technical reference manual - Lubrication in gearboxes**: Description of types and volumes of lubrication for the manipulator gearboxes.
- **Technical reference manual - RAPID overview**: An overview of the RAPID programming language.
- **Technical reference manual - RAPID Instructions, Functions and Data types**: Description and syntax for all RAPID instructions, functions, and data types.
- **Technical reference manual - RAPID kernel**: A formal description of the RAPID programming language.
- **Technical reference manual - System parameters**: Description of system parameters and configuration workflows.

Application manuals

Specific applications (for example software or hardware options) are described in **Application manuals**. An application manual can describe one or several applications.
An application manual generally contains information about:

- The purpose of the application (what it does and when it is useful).
- What is included (for example cables, I/O boards, RAPID instructions, system parameters, DVD with PC software).
- How to install included or required hardware.
- How to use the application.
- Examples of how to use the application.

Operating manuals

The operating manuals describe hands-on handling of the products. The manuals are aimed at those having first-hand operational contact with the product, that is production cell operators, programmers, and trouble shooters.

The group of manuals includes (among others):

- Operating manual - Emergency safety information
- Operating manual - General safety information
- Operating manual - Getting started, IRC5 and RobotStudio
- Operating manual - Introduction to RAPID
- Operating manual - IRC5 with FlexPendant
- Operating manual - RobotStudio
- Operating manual - Trouble shooting IRC5, for the controller and manipulator.
Safety

Safety of personnel

A robot is heavy and extremely powerful regardless of its speed. A pause or long stop in movement can be followed by a fast hazardous movement. Even if a pattern of movement is predicted, a change in operation can be triggered by an external signal resulting in an unexpected movement. Therefore, it is important that all safety regulations are followed when entering safeguarded space.

Safety regulations

Before beginning work with the robot, make sure you are familiar with the safety regulations described in the manual Operating manual - General safety information.
This page is intentionally left blank
1 Introduction to RobotStudio

1.1 What is RobotStudio

RobotStudio is a PC application for modeling, offline programming, and simulation of robot cells.

RobotStudio allows you to work with an off-line controller, which is a virtual IRC5 controller running locally on your PC. This offline controller is also referred to as the virtual controller (VC). RobotStudio also allows you to work with the real physical IRC5 controller, which is simply referred to as the real controller.

When RobotStudio is used with real controllers, it is referred to as the online mode. When working without being connected to a real controller, or while being connected to a virtual controller, RobotStudio is said to be in offline mode.

RobotStudio offers the following installation options:

- Complete
- Custom, allowing user-customized contents and paths
- Minimal, allowing you to run RobotStudio in online mode only.
1 Introduction to RobotStudio

1.2 Terms and concepts

1.2.1 Hardware concepts

Overview

This section introduces the hardware in a typical IRC5 robot cell. For detailed explanations, see the manuals related to IRC5 robots specified on page 12.

Standard hardware

The table below describes the standard hardware in an IRC5 robot cell.

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robot manipulator</td>
<td>An ABB industrial robot.</td>
</tr>
<tr>
<td>Control module</td>
<td>Contains the main computer that controls the motion of the manipulator. This includes RAPID execution and signal handling. One control module can be connected to 1 – 4 drive modules.</td>
</tr>
<tr>
<td>Drive module</td>
<td>A module containing the electronics that power the motors of a manipulator. The drive module can contain up to nine drive units, each controlling one manipulator joint. Since the standard robot manipulators have six joints, you usually use one drive module per robot manipulator.</td>
</tr>
<tr>
<td>FlexController</td>
<td>The controller cabinet for the IRC5 robots. It consists of one control module and one drive module for each robot manipulator in the system.</td>
</tr>
<tr>
<td>FlexPendant</td>
<td>The programming pendant, connected to the control module. Programming on the FlexPendant is referred to as “online programming”.</td>
</tr>
<tr>
<td>Tool</td>
<td>A device usually mounted on the robot manipulator to allow it to perform specific tasks, such as gripping, cutting or welding. The tool can also be stationary, see below for more information.</td>
</tr>
</tbody>
</table>

Optional hardware

The table below describes the optional hardware for an IRC5 robot cell.

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track manipulator</td>
<td>A moving stand holding the robot manipulator to give it a larger work space. When the control module controls the motion of a track manipulator, it is referred to as a “Track External Axis”.</td>
</tr>
<tr>
<td>Positioner manipulator</td>
<td>A moving stand normally holding a work piece or a fixture. When the control module controls the motion of a positioner manipulator, it is referred to as an “External Axis”.</td>
</tr>
<tr>
<td>FlexPositioner</td>
<td>A second robot manipulator acting as a positioner manipulator. It is controlled by the same control module as the positioner manipulator.</td>
</tr>
<tr>
<td>Stationary tool</td>
<td>A device that stands in a fixed location. The robot manipulator picks up the work piece and brings it to the device to perform specific tasks, such as gluing, grinding or welding.</td>
</tr>
<tr>
<td>Work piece</td>
<td>The product being worked on.</td>
</tr>
<tr>
<td>Fixture</td>
<td>A construction holding the work piece in a specific position so that the repeatability of the production can be maintained.</td>
</tr>
</tbody>
</table>
1.2.2 RobotWare concepts

Overview

This section introduces terminology regarding RobotWare. For detailed explanations, see the manuals related to IRC5 robots specified on page 12.

RobotWare

The table below describes the RobotWare terminology and concepts that can be useful when working with RobotStudio.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>RobotWare</td>
<td>As a concept, refers to both the software used to create a RobotWare System and the RobotWare systems themselves.</td>
</tr>
<tr>
<td>RobotWare DVD</td>
<td>Delivered with each control module. On the DVD you will find the RobotWare installation and some other useful software. Check the Release Notes on your DVD for specifications.</td>
</tr>
<tr>
<td>RobotWare installation</td>
<td>When installing RobotWare on a PC, you install into the mediapool the specific versions of the files from which RobotStudio uses to create the RobotWare system. When installing RobotStudio, only one version of RobotWare will be installed. To simulate a specific RobotWare system, the RobotWare version used for this particular RobotWare system must be installed on your PC.</td>
</tr>
</tbody>
</table>
| RobotWare Key      | Used when you create a new RobotWare system or upgrade an existing system. The RobotWare keys unlock the RobotWare options included in the system, and determine the RobotWare version from which the RobotWare system will be built. For IRC5 systems there are three types of RobotWare keys:  
• The controller key, which specifies the controller and software options.  
• The drive keys, which specify the robots in the system. The system has one drive key for each robot it uses.  
• Additional option keys, which specify additional options, like positioner external axes. A virtual key allows you to select any RobotWare options you wish, but a RobotWare system created from a virtual key can only be used in a virtual environment such as RobotStudio. |
| RobotWare system   | A set of software files that, when loaded into a controller, enables all functions, configurations, data and programs controlling the robot system. RobotWare systems are created in the RobotStudio software. The systems can be stored and saved on a PC, as well as on the control module. RobotWare systems can be edited by RobotStudio or the FlexPendant. |
| RobotWare version  | Each RobotWare is released with a major and a minor version number, separated by a dot. The RobotWare version for IRC5 is 5.xx, where xx identifies the minor version. When ABB releases a new robot model, a new RobotWare version will be released with support for the new robot. |
### Explanation

The mediapool is a folder on the PC in which each RobotWare version is stored in a folder of its own. The files of the mediapool are used to create and implement all the different RobotWare options. Therefore, the correct RobotWare version must be installed in the mediapool when creating RobotWare systems or running them on virtual controllers.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mediapool</td>
<td>The mediapool is a folder on the PC in which each RobotWare version is stored in a folder of its own. The files of the mediapool are used to create and implement all the different RobotWare options. Therefore, the correct RobotWare version must be installed in the mediapool when creating RobotWare systems or running them on virtual controllers.</td>
</tr>
</tbody>
</table>
1.2.3 RAPID concepts

Overview

This section introduces the basic terminology of RAPID. The manuals related to RAPID and programming are listed on page 12.

Terminology of the RAPID structure

The table below describes the RAPID terminology that you may come across when working with RobotStudio. The concepts are listed by size, from most basic to increasingly large.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data declaration</td>
<td>Used to create instances of variables or data types, like num or tooldata.</td>
</tr>
<tr>
<td>Instruction</td>
<td>The actual code commands that make something happen, for example, setting data to a specific value or a robot motion. Instructions can only be created inside a routine.</td>
</tr>
<tr>
<td>Move instructions</td>
<td>Create the robot motions. They consist of a reference to a target specified in a data declaration along with parameters that set motion and process behavior. If inline targets are used, the position is declared in the move instructions.</td>
</tr>
<tr>
<td>Action instruction</td>
<td>Instructions that perform other actions than moving the robot, such as setting data or sync properties.</td>
</tr>
<tr>
<td>Routine</td>
<td>Usually a set of data declarations followed by a set of instructions implementing a task. Routines can be divided into three categories: procedures, functions and trap routines.</td>
</tr>
<tr>
<td>Procedure</td>
<td>A set of instructions that does not return a value.</td>
</tr>
<tr>
<td>Function</td>
<td>A set of instructions that returns a value.</td>
</tr>
<tr>
<td>Trap</td>
<td>A set of instructions that is triggered by an interrupt.</td>
</tr>
<tr>
<td>Module</td>
<td>A set of data declarations followed by a set of routines. Modules can be saved, loaded and copied as files. Modules are divided into program modules and system modules.</td>
</tr>
<tr>
<td>Program module (.mod)</td>
<td>Can be loaded and unloaded during execution.</td>
</tr>
<tr>
<td>System module (.sys)</td>
<td>Used mainly for common system-specific data and routines, for example, an arcware system module that is common for all arc robots.</td>
</tr>
<tr>
<td>Program files (.pgf)</td>
<td>In IRC5 a RAPID program is a collection of module files (.mod) and the program file (.pgf) that references all the module files. When loading a program file, all old program modules are replaced by those referenced in the .pgf file. System modules are unaffected by program load.</td>
</tr>
</tbody>
</table>
1.2.4 Concepts of programming

Overview
This section introduces the terminology regarding programming. The manuals related to programming and IRC5 Robots are listed on page 12.

Programming concepts
The table below describes the terminology and concepts that are used in robot programming.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online programming</td>
<td>Programming when connected to a real controller. This expression also implies using the robot to create positions and motion.</td>
</tr>
<tr>
<td>Offline programming</td>
<td>Programming without being connected to the robot or the real controller.</td>
</tr>
<tr>
<td>True offline programming</td>
<td>Refers to the ABB Robotics concept of connecting a simulation environment to a virtual controller. This enables not only program creation, but also program testing and optimizing offline.</td>
</tr>
<tr>
<td>Virtual controller</td>
<td>A software that emulates a FlexController to allow the same software (the RobotWare system) that is controlling the robots to run on a PC. This gives the same behavior of the robots offline as you get online.</td>
</tr>
<tr>
<td>MultiMove</td>
<td>Running multiple robot manipulators with the same control module.</td>
</tr>
<tr>
<td>Coordinate systems</td>
<td>Used to define positions and orientations. When programming a robot, you can take advantage of using different coordinate systems to more easily position objects relative to each other.</td>
</tr>
<tr>
<td>Frame</td>
<td>A synonym for coordinate system.</td>
</tr>
<tr>
<td>Workobject calibration</td>
<td>If all your targets refer to workobjects, you only need to calibrate the workobjects when deploying offline programs.</td>
</tr>
</tbody>
</table>
1.2.5 Targets and paths

Overview

Targets (positions) and paths (sequences of move instructions to targets) are used when programming robot motions in RobotStudio.

When you synchronize the RobotStudio station to the virtual controller, RAPID programs are created from the paths.

Targets

A target is a coordinate that the robot shall reach. It contains the following information:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>The position of the target, defined in a workobject coordinate system, see Coordinate systems on page 28.</td>
</tr>
<tr>
<td>Orientation</td>
<td>The orientation of the target, relative to the orientation of the workobject. When the robot reaches the target, it will align the TCP’s orientation with the target’s orientation, see Coordinate systems on page 28.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Configuration values that specify how the robot shall reach the target. For more information, see Robot axis configurations on page 34.</td>
</tr>
</tbody>
</table>

Targets are converted to instances of the data type `robtarget` when synchronized to the virtual controller.

Paths

A sequence of move instructions, paths are used to make the robot move along a sequence of targets.

Paths are converted to procedures when synchronized to the virtual controller.

Move instructions

A move instruction consists of:

- a reference to a target
- motion data, such as motion type, speed and zone
- a reference to a tooldata
- a workobject reference

Action instructions

An action instruction is a RAPID string that can be used for setting and changing parameters. Action instructions can be inserted before, after or between instruction targets in paths.
1.2.6 Coordinate systems

Overview

This section provides an introduction to the coordinate systems used mostly for offline programming. In RobotStudio, you can either use the coordinate systems (that are explained below) or the user-defined coordinated systems for co-relating elements and objects.

Hierarchy

The coordinate systems are co-related hierarchically. The origin of each coordinate system is defined as a position in one of its ancestries. The following are the descriptions of the commonly used coordinate systems.

Tool Center Point Coordinate system

The tool center point coordinate system, also called TCP, is the center point of the tool. You can define different TCPs for one robot. All robots have one predefined TCP at the robot’s tool mounting point, called tool0. When a program runs, the robot moves the TCP to the programmed position.

RobotStudio World Coordinate system

The RobotStudio world coordinate system represents the entire station or robot cell. This is the top of the hierarchy to which all other coordinate systems are related (when using RobotStudio).

Base Frame (BF)

The base coordinate system is called the Base Frame (BF). Each robot in the station, both in RobotStudio and the real world has a base coordinate system which is always located at the base of the robot.

Task Frame (TF)

The Task Frame represents the origin of the robot controller world coordinate system in RobotStudio. The following picture illustrates the difference between the base frame and the task frame.
In the picture to the left, the task frame is located at the same position as the robot base frame. In the picture to the right, the task frame has been moved to another position.

The following picture illustrates how a task frame in RobotStudio is mapped to the robot controller coordinate system in the real world. For example, on the shop floor.

<table>
<thead>
<tr>
<th>RS-WCS</th>
<th>World coordinate system in RobotStudio</th>
</tr>
</thead>
<tbody>
<tr>
<td>RC-WCS</td>
<td>World coordinate system as defined in the robot controller. It corresponds to the task frame of RobotStudio.</td>
</tr>
<tr>
<td>BF</td>
<td>Robot Base Frame</td>
</tr>
<tr>
<td>TCP</td>
<td>Tool Center Point</td>
</tr>
<tr>
<td>P</td>
<td>Robot target</td>
</tr>
<tr>
<td>TF</td>
<td>Task Frame</td>
</tr>
<tr>
<td>Wobj</td>
<td>Workobject</td>
</tr>
</tbody>
</table>

Continues on next page
Stations with multiple robot systems

For a single robot system, RobotStudio’s task frame corresponds to the robot controller world coordinate system. When several controllers are present in the station, the task frame allows the connected robots to work in different coordinate systems. That is, the robots can be located independent of each other by defining different task frames for each robot.

<table>
<thead>
<tr>
<th>RS-WCS</th>
<th>World coordinate system in RobotStudio</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP(R1)</td>
<td>Tool Center Point of robot 1</td>
</tr>
<tr>
<td>TCP(R2)</td>
<td>Tool Center Point of robot 2</td>
</tr>
<tr>
<td>BF(R1)</td>
<td>Base Frame of robot system 1</td>
</tr>
<tr>
<td>BF(R2)</td>
<td>Base Frame of robot system 2</td>
</tr>
<tr>
<td>P1</td>
<td>Robot target 1</td>
</tr>
<tr>
<td>P2</td>
<td>Robot target 2</td>
</tr>
<tr>
<td>TF1</td>
<td>Task Frame of robot system 1</td>
</tr>
<tr>
<td>TF2</td>
<td>Task Frame of robot system 2</td>
</tr>
<tr>
<td>Wobj</td>
<td>Workobject</td>
</tr>
</tbody>
</table>
MultiMove Coordinated systems

The MultiMove functions help you create and optimize programs for MultiMove systems where one robot or positioner holds the work piece and other robots operate on it.

When using a robot system with the RobotWare option MultiMove Coordinated, it is important that the robots are working in the same coordinate system. As such, RobotStudio does not allow task frames of the controller to be separated.

<table>
<thead>
<tr>
<th>RS-WCS</th>
<th>World coordinate system in RobotStudio</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP(R1)</td>
<td>Tool Center Point of robot 1</td>
</tr>
<tr>
<td>TCP(R2)</td>
<td>Tool Center Point of robot 2</td>
</tr>
</tbody>
</table>

Continues on next page
**MultiMove Independent systems**

For a robot system with the RobotWare option *MultiMove Independent*, robots operate simultaneously and independently while being controlled by one controller. Even though there is only one robot controller world coordinate system, robots often work in separate coordinate systems. To allow this setup in RobotStudio, the task frames for the robots can be separated and positioned independent of each other.

<table>
<thead>
<tr>
<th>RS-WCS</th>
<th>World coordinate system in RobotStudio</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP(R1)</td>
<td>Tool Center Point of robot 1</td>
</tr>
<tr>
<td>TCP(R2)</td>
<td>Tool Center Point of robot 2</td>
</tr>
<tr>
<td>BF(R1)</td>
<td>Base Frame of robot 1</td>
</tr>
<tr>
<td>BF(R2)</td>
<td>Base Frame of robot 2</td>
</tr>
<tr>
<td>P1</td>
<td>Robot target 1</td>
</tr>
<tr>
<td>P2</td>
<td>Robot target 2</td>
</tr>
<tr>
<td>TF1</td>
<td>Task Frame 1</td>
</tr>
<tr>
<td>TF2</td>
<td>Task Frame 2</td>
</tr>
<tr>
<td>Wobj</td>
<td>Workobject</td>
</tr>
</tbody>
</table>
Workobject coordinate system

The workobject normally represents the physical work piece. It is composed of two coordinate systems: the User frame and the Object frame, where the latter is a child to the former. When programming a robot, all targets (positions) are related to the object frame of a workobject. If no other workobject is specified, the targets will be related to the default Wobj0, which always coincides with the base frame of the robot.

Using workobjects provides the chance to easily adjust robot programs with an offset, if the location of the work piece has been changed. Thus, workobjects can be used for calibrating offline programs. If the placement of the fixture or work piece relative to the robot in the real station does not completely match the placement in the offline station, you simply adjust the position of the workobject.

Workobjects are also used for coordinated motion. If a workobject is attached to a mechanical unit (and the system uses the option for coordinated motion), the robot will find the targets in the workobject even when the mechanical unit moves the workobject.

In the picture below the grey coordinate system is the world coordinate system, and the black ones are the object frame and the user frame of the workobject. Here the user frame is positioned at the table or fixture and the object frame at the workpiece.

User coordinate systems

User coordinate systems are used for creating reference points of your choice. For example, you can create user coordinate systems at strategic points in the work piece to simplify programming.
1.2.7 Robot axis configurations

Axis configurations

Targets are defined and stored as coordinates in a WorkObject coordinate system. When the controller calculates the position of the robot axes for reaching the target, it will often find more than one possible solution to configuring the robot axes.

To distinguish between the different configurations, all targets have a configuration value that specifies the quadrant in which each axis shall be located.

Storing axis configurations in targets

For targets that are taught after jogging the robot to the position, the used configuration will be stored in the target.

Targets created by specifying or calculating positions and orientations get a default configuration value (0,0,0,0), which might not be valid for reaching the target.

Common problems related to robot axis configurations

It is most likely that targets created by other ways than jogging cannot be reached at their default configuration.

Even if all targets in a path have validated configurations, you might encounter problems when running the path if the robot cannot move from one configuration to the other. This is likely to occur where an axis shifts greater than 90 degrees during linear movements.

Repositioned targets keep their configuration, but the configurations are no longer validated. As a result, the problems described above might occur when moving targets.

Common solutions for configuration problems

To resolve the problems described above, you can assign a valid configuration to each target and verify that the robot can move along each path. You can also turn configuration monitoring off, which means that you ignore the stored configurations and let the robot find working configurations at runtime. If this is not done the proper way, you might get unexpected results.

In some cases there might not be any working configurations. Possible solutions might then be to reposition the work piece, reorient targets (if acceptable for the process) or add an external axis that either moves the work piece or the robot for increasing reachability.
How configurations are denoted

The robot’s axis configurations are denoted by a series of four integers, specifying in which quadrant of a full revolution significant axes are located. The quadrants are numbered from zero for positive (counterclockwise) rotation and from -1 for negative (clockwise) rotation.

For a linear axis, the integer specifies the range (in meters) from the neutral position in which the axis is located.

A configuration for a six-axis industrial robot (like IRB 140) may look like:

\[0-121\]

- The first integer (0) specifies the position of axis 1: somewhere in the first positive quadrant (between 0 and 90 degrees rotation).
- The second integer (-1) specifies the position of axis 4: somewhere in the first negative quadrant (between 0 and -90 degrees rotation).
- The third integer (2) specifies the position of axis 6: somewhere in the third positive quadrant (between 180 and 270 degrees rotation).
- The fourth integer (1) specifies the position of axis x, a virtual axis used for specifying the wrist center in relation to other axes.

Configuration monitoring

When executing a robot program, you can choose whether to monitor configuration values. If configuration monitoring is turned off, configuration values stored with the targets are ignored, and the robot will use the configuration closest its current configuration for reaching the target. If turned on, it will only use the specified configuration for reaching the targets.

Configuration monitoring can be turned off and on for joint and linear movements independently and is controlled by the ConfJ and ConfL action instructions.

Turning configuration monitoring off

Running a program without configuration monitoring may result in different configurations each time a cycle is executed: When the robot returns to the start position after completing a cycle, it may choose a different configuration then the original.

For programs with linear move instructions this might cause a situation where the robot gets closer and closer its joint limits and eventually will not be able to reach the target.

For programs with joint move instructions this might cause sweeping, unpredictable movements.

Turning configuration monitoring on

Running a program with configuration monitoring forces the robot to use the configurations stored with the targets. This results in predictable cycles and predictable motions. In some situations, however, like when the robot moves to a target from an unknown position, using configuration monitoring may limit the robot’s reachability.

When programming offline, you must assign a configuration to each target if the program shall be executed with configuration monitoring.
1 Introduction to RobotStudio

1.2.8 Libraries, geometries and CAD files

Overview
For programming or simulating in RobotStudio, you need models of your work pieces and equipment. Models for some standard equipment are installed as libraries or geometries with RobotStudio. If you have CAD models of your work pieces and custom equipment, these can be imported as geometries to RobotStudio. If you do not have CAD models, you can create them in RobotStudio.

Difference between geometries and libraries
The objects you import to a station can be either geometries or libraries. Geometries are basically CAD files, which, when imported, are copied to the RobotStudio station.

Libraries are objects that have been saved in RobotStudio as external files. When you import a library, a link from the station to the library file is created. Accordingly, the station file does not grow in the same way as when importing geometries. Furthermore, besides the geometrical data, library files can contain RobotStudio-specific data. For example, if a tool is saved as a library, the tool data is saved together with the CAD data.

How geometries are constructed
An imported geometry is displayed as one part in the Objects browser. From RobotStudio’s Modeling tab, you can see the components of the geometry.

The top node of the geometry is called a Part. The part contains Bodies, which can be of the types solid, surface or curve.

Solid bodies are 3D objects, made up of Faces. You recognize a true 3D solid by this one body containing multiple faces.

Surface bodies are 2D objects of just one face. A part that contains several bodies with one face each that together constitute a 3D object is created from 2D surfaces, and is therefore not a true 3D solid. If these parts are not created correctly, they might cause problems both in their display and graphical programming. see Troubleshooting and optimizing geometries on page 90.

Curved bodies, represented by the body node alone in the Modeling browser, do not contain any child nodes.

From the Modeling tab, you can edit the parts by adding, moving, rearranging or deleting bodies. Thus, you can optimize existing parts by removing unnecessary bodies, as well as create new parts by grouping bodies.

Importing and converting CAD files
For importing geometries from single CAD files, you use RobotStudio’s import function, see Importing a station component on page 87.

If you need to convert CAD files to other formats or want to change the default settings for the conversion before making the import, you can use the CAD converter installed with RobotStudio before making the import, see Converting CAD formats on page 89.

Continues on next page
Supported 3D formats

The native 3D format of RobotStudio is ACIS. RobotStudio contains ACIS R23 SP1 which supports later versions of its supported CAD formats.

RobotStudio also supports other formats for which you need an option. The following table shows the supported formats and the corresponding options:

<table>
<thead>
<tr>
<th>Format</th>
<th>File extensions</th>
<th>Option required</th>
<th>Default target formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>IGES, reads up to version 5.3, writes version 5.3</td>
<td>igs, iges</td>
<td>IGES</td>
<td>ACIS, STEP, VDA-FS</td>
</tr>
<tr>
<td>STEP, reads versions AP203 and AP214 (geometry only), writes version AP214</td>
<td>stp, step, p21</td>
<td>STEP</td>
<td>ACIS, IGES, VDA-FS</td>
</tr>
<tr>
<td>VDA-FS, reads 1.0 and 2.0, writes 2.0</td>
<td>vda, vdafs</td>
<td>VDA-FS</td>
<td>ACIS, IGES, STEP</td>
</tr>
<tr>
<td>CATIA V5, reads versions R6 – R22 (V5-6 R2012)</td>
<td>model, exp</td>
<td>CATIA V5</td>
<td>ACIS, IGES, STEP, VDA-FS</td>
</tr>
<tr>
<td>Pro/ENGINEER, reads versions 16 – Creo 2.0</td>
<td>prt, asm</td>
<td>Pro/ENGINEER</td>
<td>ACIS, IGES, STEP, VDA-FS</td>
</tr>
<tr>
<td>Inventor, reads V6 – V2013</td>
<td>ipt</td>
<td>Inventor</td>
<td>ACIS, IGES, STEP, VDA-FS</td>
</tr>
<tr>
<td>VRML</td>
<td>wrl, vrml, vrml1, vrml2</td>
<td>-</td>
<td>RsGfx, obj, dae</td>
</tr>
<tr>
<td>Jupiter, up to 6.4</td>
<td>jt</td>
<td>-</td>
<td>RsGfx, obj, dae</td>
</tr>
<tr>
<td>STL</td>
<td>stl</td>
<td>-</td>
<td>RsGfx, obj, dae</td>
</tr>
<tr>
<td>PLY</td>
<td>ply</td>
<td>-</td>
<td>RsGfx, obj, dae</td>
</tr>
<tr>
<td>3DStudio</td>
<td>3ds</td>
<td>-</td>
<td>RsGfx, obj, dae</td>
</tr>
<tr>
<td>COLLADA 1.4.1</td>
<td>dae</td>
<td>-</td>
<td>RsGfx, obj, dae</td>
</tr>
</tbody>
</table>

To import these files into RobotStudio, use the Import Geometry function.
To convert files to VDA-FS, STEP and IGES, use the standalone CAD Converter tool. For converting to other formats, use the Export Geometry function in RobotStudio. You need the option for both the target and the source formats when converting files.

Mathematical versus graphical geometries

A geometry in a CAD file always has an underlying mathematical representation. Its graphical representation, displayed in the graphics window, is generated from the mathematical representation when the geometry is imported to RobotStudio, after which the geometry is referred to as a part.
For this kind of geometry, you can set the detail level of the graphical representation, thus reducing the file size and rendering time for large models and improving the visual display for small models you might want to zoom in on. The detail level only affects the visual display; paths and curves created from the model will be accurate both with coarse and fine settings.

A part can also be imported from a file that simply defines its graphical representation; in this case, there is no underlying mathematical representation. Some of the functions in RobotStudio, such as snap mode and creation of curves from the geometry, will not work with this kind of part.

To customize the detail level settings, see Options on page 193.
1.2.9 VSTA as the IDE

Overview

RobotStudio uses Microsoft Visual Studio Tools for Applications (VSTA) as its Integrated Development Environment (IDE), enabling advanced users to extend and customize its functionality. You can, for example, write an add-in in C# or VB.Net to create a toolbar or macro, debug code or inspect variable values during execution.

In addition, the Add-In browser acts as a single window for both VSTA add-ins and non-VSTA, RobotStudio-specific add-ins known as PowerPacs.

For a procedure, see Building a VSTA add-in on page 430.

Types of add-ins

The following add-ins may be available in the Add-In browser:

<table>
<thead>
<tr>
<th>Add-in</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>A custom add-in based on the RobotStudio SDK, and optionally PC-SDK, created using Visual Studio. A General add-in is unrelated to VSTA.</td>
</tr>
<tr>
<td>PowerPac</td>
<td>An add-in that accords with RobotStudio specifications, but is not part of the VSTA system itself.</td>
</tr>
<tr>
<td>VSTA Station Add-In</td>
<td>A VSTA add-in that has been attached to a station, and saved to the station file.</td>
</tr>
<tr>
<td>VSTA User Add-In</td>
<td>A VSTA add-in that has not been attached to a station and is active only on the current user’s computer.</td>
</tr>
</tbody>
</table>

Using the shortcut menus of the Add-In browser, PowerPacs may be loaded or autoloaded, while VSTA add-ins may be added, loaded, unloaded, reloaded, autoloaded, edited, deleted, or removed from the station.

Note

For the RobotStudio 5.15 64-bit edition PowerPacs, Visual Studio Tools for Applications, and any customized add-ins that use PC-SDK are not supported...
1.3 Installing and licensing RobotStudio

Installation options and prerequisites

Note
You should have administrator privileges on the PC before installing RobotStudio.

RobotStudio is categorized into the following two feature levels:

• **Basic** - Offers selected RobotStudio functionality to configure, program, and run a virtual controller. It also includes online features for programming, configuring, and monitoring a real controller connected over Ethernet.

• **Premium** - Offers full RobotStudio functionality for offline programming and simulation of multiple robots. The Premium level includes the features of the Basic level and requires activation.

In addition to the Premium functionality, there are add-ins like PowerPacs and options for CAD converters available.

• PowerPacs provides enhanced features for selected applications.

• Options for CAD converters allows import of different CAD formats.

RobotStudio offers the following installation options:

• **Minimal** - Installs only the features required to program, configure, and monitor a real controller connected over Ethernet.

• **Complete** - Installs all the features required to run the complete RobotStudio. If installed with this option, additional features of Basic and Premium functionality are available.

• **Custom** - Installs user-customized features. This option allows excluding unwanted robot libraries and CAD converters.

Note

RobotStudio 5.15 64-bit edition is installed for the Complete installation option on computers that have a 64-bit operating system. The 64-bit edition allows large CAD-models to be imported as it can address more memory than the 32-bit version. However, the 64-bit edition has the following limitations:

• PowerPacs, Visual Studio Tools for Applications, and any customized add-ins that use PC-SDK are not supported

• ScreenMaker, SafeMove Configurator, and EPS Wizard are not supported.

• Jupiter import is not supported

• Import of stations and libraries from RobotStudio 4.0 (for S4) is not supported

• Add-ins will be loaded from the following folder

  C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.15\Bin64\Addins

Continues on next page
How to install RobotStudio on a PC

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1      | Insert the robot software DVD in the PC.  
• If a menu for the DVD is opened automatically, continue with step 5.  
• If no menu for the DVD is opened, continue with step 2. |
| 2      | On the Start menu, click Run. |
| 3      | In the Open box, type the drive letter for your DVD drive followed by:  
\l\aun\ch.exe  
If your DVD drive has the letter D, then type: D:\l\aun\ch.exe |
| 4      | Click OK. |
| 5      | Select the language for the DVD menu. |
| 6      | On the DVD menu, click Install. |
| 7      | On the installation menu, click RobotStudio. This opens the installation wizard, which guides you through the rest of the software installation. |
| 8      | After installing RobotStudio, you can proceed with installing RobotWare.  
Go to the installation menu, and click RobotWare. This opens this installation wizard, which guides you through the rest of the RobotWare installation. |
| 9      | This step is optional, and is for installing the Track mediapool.  
On the Install products menu, click Additional Options. This opens a file browser that displays the Track mediapool installation and other available options.  
Double-click the TrackMotion folder and then the file setup.exe to start the installation wizard and proceed. |

After installing RobotStudio, proceed with activating your RobotStudio installation.

**Knowing which RobotStudio version is installed**

The version number of your RobotStudio installation is displayed on the RobotStudio title bar.

**Activation of RobotStudio license**

When you start RobotStudio for the first time after installation, you are prompted to enter your 25-digit Activation Key (xxxxx-xxxxx-xxxxx-xxxxx-xxxxx). The software performs in the Basic Functionality mode if you do not use a valid Activation Key. After the installation is activated, you will have valid licenses for the features covered by your subscription.

**Note**

Activation is not required for Minimal installation, or for Basic Functionality mode of the Complete or Custom installation.

**What is Basic Functionality mode**

In Basic Functionality mode, which is a reduced functionality mode, RobotStudio allows only the use of the basic features for the real and the virtual controller. No existing files or stations are harmed in this mode. After activating your software, you will have full functionality for the features you have purchased.

A real controller can be programmed, configured and monitored over Ethernet without activating your installation of RobotStudio. Activation, however, will provide

Continues on next page
access to the Premium productivity features that will make your engineering work more efficient.

How to activate RobotStudio - Standalone license

Use the Activation Wizard to activate your RobotStudio installation. When you start RobotStudio for the first time after installation, the wizard starts automatically and prompts you for the Activation Key. If you do not want to activate your copy of RobotStudio at installation, you can do so later using the Activation Wizard.

Note

If you have a problem with your activation, contact your local ABB customer support representative at the e-mail address or telephone number provided at www.abb.com/contacts.
Alternatively, with your activation key attached, send an e-mail to softwarefactory_support@se.abb.com.

For using the Activation Wizard, follow this procedure.

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 On the File tab, click Options and go to General:Licensing.</td>
</tr>
<tr>
<td>2 On the Licensing page to the right, click Activation wizard to launch the Activation Wizard.</td>
</tr>
<tr>
<td>3 In the Activation Wizard, on the Activate RobotStudio page, indicate whether you have a Standalone License or a Network License, and then click Next. If you have chosen Standalone License, you will proceed to the Activate a Standalone License page. See Activate automatically over the Internet or manually on page 42 for further steps. If you have chosen Network License, you will proceed to the Network License page. See How to activate RobotStudio - Network License on page 43 for further steps.</td>
</tr>
</tbody>
</table>

Activate automatically over the Internet or manually

The Activation Wizard gives you two choices on how to proceed. You can choose either automatic activation over the Internet or manual activation. These are explained in the following section.

Automatic Activation (recommended)

In automatic activation, the Activation Wizard automatically contacts and sends your activation request to the ABB licensing servers over your Internet connection. Your license will then be automatically installed and your product will be ready for use.

For automatic activation you need an Internet connection and also a valid activation key that has not exceeded the number of installations allowed.

RobotStudio must be restarted after the activation has been successfully completed.

Note

If you choose to activate over the Internet but are not currently connected to the Internet, then the wizard alerts you that there is no connection.
Manual Activation

If the computer does not have an Internet connection, you must proceed with manual activation.

1. Create a license request file by selecting the option Step1:Create a license request file.
   Proceed through the wizard, enter your activation key and save the license request file to your computer.

2. Use removable storage, such as a USB stick, to transfer the file to a computer with an Internet connection. On that computer, open a web browser, go to http://www101.abb.com/manualactivation/ and follow the instructions given. The result will be a license key file that should be saved and transferred back to the computer having the installation awaiting activation.

3. Relaunch the activation wizard and go through the steps until you reach the Activate a Standalone License page.

   Proceed through the wizard, selecting the license key file when requested. Upon completion, RobotStudio is activated and ready for use.

RobotStudio must be restarted after the activation has been successfully completed.

How to activate RobotStudio - Network License

Network licensing allows you to centralize license management by installing licenses on a single server rather than on each individual client machine. The server administers the licenses to the clients as required. A single network license allows several clients to use the software.

Network Licensing is set up in the following stages:

1. Install the server for network licensing (See Installing the Network Licensing Server on page 43)

2. Activate the licenses for network licensing (See Using the SLP Server Web Interface on page 44)

3. Set up the client for network licensing (See Setting up Network Licensing in the client on page 46)

Tip

Network licenses are displayed as Network in the View Installed Licenses link of the Licensing page.

Installing the Network Licensing Server

Network licensing in RobotStudio uses the SLP Distributor server as the network licensing server. It manages the allocation of network licenses to the clients.
You can install the SLP Distributor server from the Utilities\SLP Distributor directory of the RobotStudio distribution.

Note

You require administrative privileges for installing and configuring the SLP Distribution server.

The installer requires the following:

- Windows Server 2008, Windows 8, Windows 7, or Windows Vista
- 32-bit or 64-bit version of Windows
- .NET Framework 3.5 SP1

The SLP Distributor server is installed as a service that starts automatically with Windows. It requires two open TCP ports, by default 2468 (for the web interface) and 8731 (for licensing). The installer opens these ports in the standard Windows Firewall, but any third-party firewall must be configured manually by the system administrator.

Using the SLP Server Web Interface

Once the SLP server is online, you can access its web interface on the address http://<server>:2468/web.

The following table shows how to use the server's web interface.

<table>
<thead>
<tr>
<th>To...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate a network license automatically (for PCs with Internet connection)</td>
<td>The Activation tab. Type in the Activation Key provided by ABB, and then click Submit. The number of network licenses activated depends on the activation key provided.</td>
</tr>
</tbody>
</table>
## 1.3 Installing and licensing RobotStudio

### Activate a network license manually (for PCs without Internet connection)

<table>
<thead>
<tr>
<th>To...</th>
<th>Use...</th>
</tr>
</thead>
</table>
| The Activation tab.  
1. Click Manual Activation.  
2. Type in your activation key, provided by ABB, and then click Submit.  
3. Copy and send the Request Data which appears, by mail to softwarefactory_support@se.abb.com. The license file will be mailed to you.  
4. Once you receive the license file, click Browse to upload and install the license file. | Your network license is now activated. |

### View the installed licenses

<table>
<thead>
<tr>
<th>To...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Home tab. Under Dashboard, click Details. Alternatively, click the Products tab. Both these open the Product details for RobotStudio page, where details about the installed licenses are displayed.</td>
<td></td>
</tr>
</tbody>
</table>

### View the usage of licenses

<table>
<thead>
<tr>
<th>To...</th>
<th>Use...</th>
</tr>
</thead>
</table>
| The Home tab. Under Dashboard, click Usage. Alternatively, click the Usage tab. Both these open the Current usage of RobotStudio page, which lists the following in a table:  
• Licenses which are currently allocated  
• Client to which each license is allocated to  
• Number of remaining licenses available for use | Each table row corresponds to one client system. |

Continued on next page
Note

Certain proxy issues upon activation in the SLP server's web interface may produce a messages which only states *Activation failed*. Such a case may happen when the system account that the SLP-Distributor-service is executed in, does not have the rights to read the user profile. As a workaround, follow this procedure:

1. Open the Services control panel (services.msc)
2. Open properties for **Software Potential Distributor**
3. Change **Log on as** to an actual named user, preferably the currently logged on user
4. Restart the service and re-attempt an activation.
5. After your re-attempt, change **Log on as** back to Local System account and restart the service.

Setting up Network Licensing in the client

Note

You require Administrative privileges to store this configuration.

You need to use the RobotStudio Activation Wizard in the client system for setting up Network Licensing.

Use this procedure to set up Network Licensing for a client system.

**Action**

1. On the File tab, click Options and go to **General**: Licensing.
2. On the Licensing page to the right, click **Activation wizard** to launch the Activation Wizard.
3. In the Activation Wizard, on the **Activate RobotStudio** page, choose the option **I want to specify a network license server and manage server license**, and then click **Next**. You will proceed to the **License Server** page.
4. Specify the name or IP address of the License Server, and then click **Finish**. If Windows UAC is enabled, a confirmation dialog appears. This prompts you to restart RobotStudio in order to start using the specified server.

To go to the SLP Distributor server web interface, click the **Open the server dashboard** link. For information about using the server dashboard, see *Using the SLP Server Web Interface on page 44*.

Note that the changes made are not applied until RobotStudio is restarted.

Note

For Network Licensing to work, the client system should be online with the server. For information about enabling licensing while working offline, see *Using Commuter Licenses on page 47*. 
Using Commuter Licenses

Commuter licenses allow a client system to work offline from the license server. You can check out a license from the server for a specified number of days. During this period the checked out license is unavailable to other users. The commuter license is made available for other clients only when it is manually checked in back to the server.

The commuter license in the client system expires when the check out time expires. In this case, on starting RobotStudio in the client system, the Network License dialog opens automatically and prompts you to check in the license back to the server.

**Note**

It is not possible to check out specific features in the license. All features in a license are included when it is checked out.

To check in/check out a commuter license, you need to use the Activation Wizard. Use this procedure to check in/check out a commuter license.

**Action**

1. On the **File** menu, click **Options** and select **General: Licensing**
2. On the Licensing page to the right, click **Activation wizard** to launch the Activation Wizard.
3. In the Activation Wizard, on the **Activate RobotStudio** page, choose **I want to check out or check in a commuter license** and click Next.
   
   You will proceed to the **Commuter License** page.
4. Under **Commuter License**, you will be presented one of the following options as per your requirement:
   - **Check out a commuter license** - In the **Check out days** box specify the number of days for which you wish to keep the license. This option is disabled if you already have a commuter license checked out.
   - **Check in a commuter license** - Choose this option to return the currently checked out license to the server. This option is enabled only if a commuter license is already checked out. If so, the expiration date and time of the license is also displayed.
5. Click **Finish** to complete the check in/check out.

**Tip**

Network licenses checked-out as commuter licenses are displayed as Floating (checked out) in the **View Installed Licenses** link of the Licensing page.

**Knowing whether your RobotStudio installation is activated**

**Action**

1. On the **File tab**, click **Options** and then go to **General: Licensing**.
2. On the Licensing page to the right, select **View Installed Licenses** to see the status of your current license.
   
   The **Licenses** opens, where you can view all the valid licenses for the features covered by your subscription.
1.4 User interface

1.4.1 Ribbon, tabs and groups

The following figure shows the ribbon, tabs and groups of the Graphical User Interface.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>File</td>
</tr>
<tr>
<td>2</td>
<td>Home</td>
</tr>
<tr>
<td>3</td>
<td>Modeling</td>
</tr>
<tr>
<td>4</td>
<td>Simulation</td>
</tr>
<tr>
<td>5</td>
<td>Controller</td>
</tr>
<tr>
<td>6</td>
<td>RAPID</td>
</tr>
<tr>
<td>7</td>
<td>Add-Ins</td>
</tr>
</tbody>
</table>
1.4.2 Layout browser

Overview

The layout browser is a hierarchical display of physical items, such as robots and tools.

Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Node</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="xx050000" alt="Robot" /></td>
<td>Robot</td>
<td>The robot in the station.</td>
</tr>
<tr>
<td><img src="xx050001" alt="Tool" /></td>
<td>Tool</td>
<td>A tool.</td>
</tr>
<tr>
<td><img src="xx050002" alt="Link collection" /></td>
<td>Link collection</td>
<td>Contains all the links of the objects.</td>
</tr>
<tr>
<td><img src="xx050003" alt="Link" /></td>
<td>Link</td>
<td>A physical object in a joint connection. Each link is made up of one or several parts.</td>
</tr>
<tr>
<td><img src="xx050004" alt="Frames" /></td>
<td>Frames</td>
<td>Contains all the frames for an object.</td>
</tr>
<tr>
<td><img src="xx050005" alt="Component group" /></td>
<td>Component group</td>
<td>A grouping of parts or other assemblies, carrying its own coordinate systems. It is used to structure a station.</td>
</tr>
<tr>
<td><img src="xx050006" alt="Part" /></td>
<td>Part</td>
<td>A physical object in RobotStudio. Parts with geometric information are made up of one or more 2D or 3D entities. Parts without geometric information (such as imported .jt files) are empty.</td>
</tr>
<tr>
<td><img src="xx050007" alt="Collision set" /></td>
<td>Collision set</td>
<td>Contains all collision sets. Each collision set includes two groups of objects.</td>
</tr>
<tr>
<td><img src="xx050008" alt="Objects group" /></td>
<td>Objects group</td>
<td>Contains references to the objects that are subject to collision detection.</td>
</tr>
<tr>
<td><img src="xx050009" alt="Collision set mechanisms" /></td>
<td>Collision set mechanisms</td>
<td>The objects in the collision set.</td>
</tr>
<tr>
<td><img src="xx050010" alt="Frame" /></td>
<td>Frame</td>
<td>The frames in the station.</td>
</tr>
</tbody>
</table>
1.4.3 The Paths & Targets browser

Overview

The paths & targets browser is a hierarchical display of non-physical items.

Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Node</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="xx050011" alt="Station Icon" /></td>
<td>Station</td>
<td>Your station in RobotStudio.</td>
</tr>
<tr>
<td><img src="xx050012" alt="Virtual Controller Icon" /></td>
<td>Virtual Controller</td>
<td>The system for controlling the robots, just like a real IRC5 controller.</td>
</tr>
<tr>
<td><img src="xx050013" alt="Task Icon" /></td>
<td>Task</td>
<td>Contains all logical elements in the station, such as targets, paths, workobjects, tooldata and instructions.</td>
</tr>
<tr>
<td><img src="xx050001376" alt="Tooldata Collection Icon" /></td>
<td>Tooldata Collection</td>
<td>Contains all tooldata.</td>
</tr>
<tr>
<td><img src="xx050014" alt="Tooldata Icon" /></td>
<td>Tooldata</td>
<td>A tooldata for a robot or a task.</td>
</tr>
<tr>
<td><img src="xx050015" alt="Workobjects &amp; Targets Icon" /></td>
<td>Workobjects &amp; Targets</td>
<td>Contains all workobjects and targets for the task or robot.</td>
</tr>
<tr>
<td><img src="xx050016" alt="Jointtarget Collection and Jointtarget Icon" /></td>
<td>Jointtarget Collection and Jointtarget</td>
<td>A specified position of the robot axes.</td>
</tr>
<tr>
<td><img src="xx050017" alt="Workobject Collection and Workobject Icon" /></td>
<td>Workobject Collection and Workobject</td>
<td>The workobject collection node and the workobjects it contains.</td>
</tr>
<tr>
<td><img src="xx050018" alt="Target Icon" /></td>
<td>Target</td>
<td>A defined position and rotation for a robot. A target equals a RobTarget in a RAPID program.</td>
</tr>
<tr>
<td><img src="xx050019" alt="Target without assigned configuration Icon" /></td>
<td>Target without assigned configuration</td>
<td>A target for which no axis configuration has been assigned, for example, a repositioned target or a new target created by means other than teaching.</td>
</tr>
<tr>
<td><img src="xx050020" alt="Target without found configuration Icon" /></td>
<td>Target without found configuration</td>
<td>An unreachable target, that is, for which no axis configuration has been found.</td>
</tr>
<tr>
<td><img src="xx050021" alt="Path Collection Icon" /></td>
<td>Path Collection</td>
<td>Contains all paths in the station.</td>
</tr>
<tr>
<td><img src="xx050022" alt="Path Icon" /></td>
<td>Path</td>
<td>Contains the instructions for the robot movements.</td>
</tr>
<tr>
<td><img src="xx050023" alt="Linear Move Instruction Icon" /></td>
<td>Linear Move Instruction</td>
<td>A linear TCP motion to a target. If the target has no valid configuration assigned, the move instruction gets the same warning symbols as the target.</td>
</tr>
</tbody>
</table>

Continues on next page
<table>
<thead>
<tr>
<th>Icon</th>
<th>Node</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>xx050024</td>
<td>Joint Move Instruction</td>
<td>A joint motion to a target. If the target has no valid configuration assigned, the move instruction gets the same warning symbols as the target.</td>
</tr>
<tr>
<td>xx050025</td>
<td>Action Instruction</td>
<td>Defines an action for the robot to perform at a specified location in a path.</td>
</tr>
</tbody>
</table>
1.4.4 The Modeling browser

Overview

The modeling browser is a display of editable objects and their building blocks.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Node</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="modeling" alt="Part" /></td>
<td>Part</td>
<td>Geometric items corresponding to the objects in the Layout browser.</td>
</tr>
<tr>
<td><img src="modelin0" alt="Body" /></td>
<td>Body</td>
<td>Geometric building blocks that comprise the parts. 3D bodies contain several faces, 2D bodies one face, and curves no faces.</td>
</tr>
<tr>
<td><img src="modelin1" alt="Face" /></td>
<td>Face</td>
<td>The faces of the bodies.</td>
</tr>
</tbody>
</table>
1.4.5 The Controller browser

Overview

The Controller browser is a hierarchical display of controller and configuration elements found in the Controller tab view.

Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Node</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚛</td>
<td>Controllers</td>
<td>Contains the controllers that are connected to the Robot View.</td>
</tr>
<tr>
<td>⚛</td>
<td>Connected Controller</td>
<td>Represents a controller with a working connection.</td>
</tr>
<tr>
<td>⚛</td>
<td>Connecting Controller</td>
<td>Represents a controller which is currently being connected.</td>
</tr>
<tr>
<td>⚛</td>
<td>Disconnected Controller</td>
<td>Represents a controller that has lost its connection. It might have</td>
</tr>
<tr>
<td></td>
<td>Denied login</td>
<td>been turned off or disconnected from the network.</td>
</tr>
<tr>
<td>🛠️</td>
<td>Configuration</td>
<td>Contains the configuration topics.</td>
</tr>
<tr>
<td>📝</td>
<td>Topic</td>
<td>Each parameter topic is represented by a node:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Communication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Controller</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• I/O</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Man-machine communication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Motion</td>
</tr>
<tr>
<td>📡</td>
<td>Event Log</td>
<td>With the Event Log you can view and save controller events.</td>
</tr>
<tr>
<td>🌐</td>
<td>I/O System</td>
<td>Represents the controller I/O system. The I/O system consists of I/O buses and units.</td>
</tr>
<tr>
<td>🌐</td>
<td>I/O Bus</td>
<td>An I/O bus is a connector for one or several I/O units.</td>
</tr>
</tbody>
</table>
### 1 Introduction to RobotStudio

#### 1.4.5 The Controller browser

Continued

<table>
<thead>
<tr>
<th>Icon</th>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="io-unit" /></td>
<td>I/O Unit</td>
<td>An I/O Unit is a board, panel or any other device with ports through which the I/O signals are sent.</td>
</tr>
<tr>
<td><img src="image" alt="rapid-task" /></td>
<td>RAPID Tasks</td>
<td>Contains the active tasks (programs) of the controller.</td>
</tr>
<tr>
<td><img src="image" alt="task" /></td>
<td>Task</td>
<td>A task is a robot program, which executes alone or together with other programs. A program is composed of a set of modules.</td>
</tr>
<tr>
<td><img src="image" alt="program-module" /></td>
<td>Program Modules</td>
<td>Program modules contain a set of data declarations and routines for a specific task. Program modules contain data specific for this program.</td>
</tr>
<tr>
<td><img src="image" alt="system-module" /></td>
<td>System Modules</td>
<td>System modules contain a set of type definitions, data declarations and routines. System modules contain data that applies to the robot system, regardless which program modules that are loaded.</td>
</tr>
<tr>
<td><img src="image" alt="nostep-in-module" /></td>
<td>Nostepin Module</td>
<td>A module that cannot be entered during step-by-step execution. That is all instructions in the module are treated as one if the program is executed step-by-step.</td>
</tr>
<tr>
<td><img src="image" alt="view-only-and-read-only-module" /></td>
<td>View-only and Read-only Program Modules</td>
<td>A icon for program modules that are either view-only or read-only.</td>
</tr>
<tr>
<td><img src="image" alt="view-only-and-read-only-system-module" /></td>
<td>View-only and Read-only System Modules</td>
<td>A icon for system modules that are either view-only or read-only.</td>
</tr>
<tr>
<td><img src="image" alt="procedure" /></td>
<td>Procedure</td>
<td>A routine that does not return any value. Procedures are used as subprograms.</td>
</tr>
<tr>
<td><img src="image" alt="function" /></td>
<td>Function</td>
<td>A routine that returns a value of a specific type.</td>
</tr>
<tr>
<td><img src="image" alt="trap" /></td>
<td>Trap</td>
<td>A routine that provides a means of responding to interrupts.</td>
</tr>
</tbody>
</table>
1.4.6 Files browser

Overview

The Files browser in the RAPID tab allows you to manage RAPID files and system backups. Using the Files browser you can access and then edit standalone RAPID modules and system parameter files that are not residing in the controller memory.

Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Node</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="xx1200000824" alt="Files icon" /></td>
<td>Files</td>
<td>See <em>Managing RAPID files on page 412.</em></td>
</tr>
<tr>
<td><img src="xx1200000825" alt="Backups icon" /></td>
<td>Backups</td>
<td>See <em>Managing system backups on page 412.</em></td>
</tr>
</tbody>
</table>
1.4.7 Add-Ins browser

Overview

The Add-Ins browser shows the installed PowerPacs, General add-ins and VSTA add-ins, if available, under their respective nodes.

Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Node</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="xx1200000826" /></td>
<td>Add-In</td>
<td>Indicates an available add-in loaded into the system</td>
</tr>
<tr>
<td><img src="image" alt="xx1200000827" /></td>
<td>Disabled Add-In</td>
<td>Indicates a disabled add-in</td>
</tr>
<tr>
<td><img src="image" alt="xx1200000828" /></td>
<td>Unloaded Add-In</td>
<td>Indicates an add-in un-loaded from the system</td>
</tr>
</tbody>
</table>
1.4.8 The Output window

Overview
The output window displays information about events that occur in the station, such as when simulations are started or stopped. This information is useful when troubleshooting stations.

Layout of the Output tab
The Output tab contains two columns: the first states the event, the second the time the message was generated. Each row is a message.

Event types
The three event types indicate the severity of the event:

<table>
<thead>
<tr>
<th>Event type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td>An information message is a normal system event, for example, starting and stopping programs, changing the operational mode, and turning motors on and off. Information messages never require an action from you. They can be useful for tracking errors, collecting statistics or monitoring user-triggered event routines.</td>
</tr>
<tr>
<td>Warning</td>
<td>A warning is an event of which you should be aware, but it is not so severe that the process or RAPID program needs to be stopped. Warnings must occasionally be acknowledged. Warnings often indicate underlying problems that at some point will need to be resolved.</td>
</tr>
<tr>
<td>Error</td>
<td>An error is an event that prevents the robot system from proceeding. The running process or RAPID program cannot continue and will be stopped. An error must occasionally be acknowledged. Some errors require some immediate action from you in order to be resolved. Double-click an error to display a detailed information box.</td>
</tr>
</tbody>
</table>

Some of the events are active. These are linked to an action for resolving the problem that generated the event. To activate the linked action, double-click the message.

Handling messages in the Output window

<table>
<thead>
<tr>
<th>Goal</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>To filter messages...</td>
<td>Right-click in the Output window and then click Show messages. From the options All Errors, Information, Warnings and Warnings and Errors, select the type of messages you want to display.</td>
</tr>
<tr>
<td>To save a message to file...</td>
<td>Select it, right-click and then click Save to file. Choose a name and location in the dialog box. Multiple messages can be selected by pressing SHIFT while clicking each.</td>
</tr>
<tr>
<td>To clear the Output window...</td>
<td>Right-click in the Output window and then click Clear.</td>
</tr>
</tbody>
</table>
### 1.4.9 The Controller Status window

#### Overview

The Controller Status window shows the operational status of the controllers in your robot view.

#### Layout of the Controller Status window

The Controller Status window has the following columns:

1. **System Name**: Displays the name of the system running on the controller.
2. **Controller Name**: Displays the name of the controller.
3. **Controller State**: Displays the state of the controller.

<table>
<thead>
<tr>
<th>When the controller is in state...</th>
<th>the robot is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initializing</td>
<td>starting up. It will shift to state motors off when it has started.</td>
</tr>
<tr>
<td>Motors off</td>
<td>in a standby state where there is no power to the robot’s motors. The state has to be shifted to motors on before the robot can move.</td>
</tr>
<tr>
<td>Motors on</td>
<td>ready to move, either by jogging or by running programs.</td>
</tr>
<tr>
<td>Guard Stop</td>
<td>stopped because the safety runchain is opened. For instance, a door to the robot's cell might be open.</td>
</tr>
<tr>
<td>Emergency Stop</td>
<td>stopped because emergency stop was activated.</td>
</tr>
<tr>
<td>Waiting for motors on after e-stop</td>
<td>ready to leave emergency stop state. The emergency stop is no longer activated, but the state transition isn't yet confirmed.</td>
</tr>
<tr>
<td>System Failure</td>
<td>in a system failure state. A warm start is required.</td>
</tr>
</tbody>
</table>

4. **Program Execution State**: Displays if the robot is running any program or not.

<table>
<thead>
<tr>
<th>When the controller is in state...</th>
<th>the robot...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running</td>
<td>is running a program.</td>
</tr>
<tr>
<td>Ready</td>
<td>has a program loaded and is ready to run it when a PP (starting point in the program) has been set.</td>
</tr>
<tr>
<td>Stopped</td>
<td>has a program loaded, with a PP, and is ready to run it.</td>
</tr>
<tr>
<td>Uninitialized</td>
<td>has not initialized the program memory. This indicates an error condition.</td>
</tr>
</tbody>
</table>

5. **Operating Mode**: Displays the operating mode of the controller.

<table>
<thead>
<tr>
<th>When the controller is in mode...</th>
<th>the robot is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initializing</td>
<td>starting up. It will shift to the mode selected on the controllers cabinet when it has started.</td>
</tr>
<tr>
<td>Auto</td>
<td>ready to run programs in production. In Auto mode it is possible to get remote Write access to the controller, which is necessary for editing programs, configurations and other things when connected to a real controller.</td>
</tr>
</tbody>
</table>
When the controller is in mode...

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual</td>
<td>only able to move if the enabling device on the FlexPendant is activated. Furthermore, the robot can only moved with reduced speed in manual mode. In manual mode it is not possible to get remote Write access to the controller, unless it is configured for this and the remote Write access granted on the FlexPendant.</td>
</tr>
<tr>
<td>Manual full speed</td>
<td>only able to move if the enabling device on the FlexPendant is activated. In manual mode it is not possible to get remote Write access to the controller, unless it is configured for this and the remote Write access granted on the FlexPendant.</td>
</tr>
<tr>
<td>Waiting for acknowledge</td>
<td>about to enter Auto mode, but the mode transition has not yet been acknowledged.</td>
</tr>
</tbody>
</table>

6 **Logged on as**: Displays the user name the PC is logged on to the controller with.

7 **Access**: Displays the users having write access to the controller, or if it is available.
1.4.10 The Operator Window

Overview

Operator Window is an alternative to the corresponding feature in the Virtual FlexPendant for communicating with the user during RAPID program execution. It displays the same output as displayed on the Virtual FlexPendant Operator Window.

When running in a Virtual Controller, the RAPID program communicates with the operator via messages on the FlexPendant screen. The Operator Window integrates this functionality and allows the user to run interactive RAPID programs without starting the Virtual FlexPendant.

Enabling Operator Window

To enable an operator window:

1. On the File menu, click Options.
2. On the Navigation pane to the left, select Robotics:Virtual Controller.
3. On the Virtual Controller page to the right, select Automatically open virtual Operator Window.
4. Click Apply.

Note

When the Show virtual Operator Window feature is enabled, an Operator Window is automatically created for each controller in the station. By default, the window is located in the tab area below the graphics window.

RAPID Instructions

The following are the RAPID instructions supported by the Operator Window. When these instructions are executed, the behavior is similar to that of Virtual FlexPendant:

- TPRead
- TPReadFK
- TPReadNum
- TPWrite
- UIAlphaEntry
- UIMsgBox
- UINumEntry

The following are the RAPID instructions not supported by the Operator Window. When these instructions are executed, an error message is displayed in the Operator Window prompting you to use the Virtual FlexPendant instead:

- TPShow
- UIShow
- UINumTune
- UIListView

Continues on next page
1 Introduction to RobotStudio

1.4.10 The Operator Window

Continued

Note

You should not run both the Virtual Flexpendant and Operator Window simultaneously.
1.4.11 The Document Manager window

Overview

The Document Manager window allows you to search and browse the RobotStudio documents like libraries, geometry and so on in large numbers and from different locations. You can also add associate documents with a station, either as a link or by embedding a file in the station.

Opening a Document Manager window

1. On the Home tab, click Import Library and select Documents from the dropdown menu.

   The Documents window appears.

Layout of the Document Manager window

The Documents window is a docked area that by default takes the right-hand corner. The upper part of the window contains controls for searching and browsing the document locations. The lower part consists of a list view that displays the documents and folders and a status area.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station</td>
<td>Allows to add documents associated with the station, either by adding the file/folder as a reference (link) or by embedding the file in the station. See Using the Station mode on page 62.</td>
</tr>
<tr>
<td>Search</td>
<td>Allows to search for keywords or query. See Using the Search mode on page 63.</td>
</tr>
<tr>
<td>Browse</td>
<td>Displays a folder structure of the document locations. See Using the Browse mode on page 65.</td>
</tr>
<tr>
<td>Location</td>
<td>Allows to configure the document location. See Document Locations window on page 67.</td>
</tr>
</tbody>
</table>

Using the Station mode

Use this procedure to add documents associated with the current station:

1. Click Station from the Document Manager.

2. Click Add button and select what to add to the current station:
   - File Reference
   - Folder Reference
   - Embedded File
   - New Text Document

   **Note**
   - The referenced file/folder is displayed with an arrow icon
   - The embedded file and new text document are displayed with a diskette icon

3. In the Documents window, right-click the document.

Continues on next page
The following context menu items appears depending on the document type selected:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open</strong></td>
<td>Opens the document in the program associated with its file type. For example, a <code>.docx</code> file is opened in Microsoft Word. An embedded file is saved to a temporary location before opening. If RobotStudio detects that the temporary file has changed, you will be asked to update the embedded file.</td>
</tr>
<tr>
<td><strong>Open containing folder</strong></td>
<td>Opens the folder containing the file in Windows Explorer. This option is not available in embedded files.</td>
</tr>
<tr>
<td><strong>Copy to Station</strong></td>
<td>Converts a referenced file to an embedded file.</td>
</tr>
<tr>
<td><strong>Save as</strong></td>
<td>Saves an embedded file to disk.</td>
</tr>
<tr>
<td><strong>Include in Pack and Go</strong></td>
<td>Specifies if a referenced file/folder should be included when a Pack and Go file is created. For a referenced folder, all files in the folder will be included. To use this option, the file must be located in the parent folder of the station file. For example, if the station file is <code>D:\Documents\Stations\My.rsstn</code>, the reference must be located in <code>D:\Documents</code> to be included in Pack and Go. Embedded files are always included when a Pack and Go file is created, since they are part of the station file.</td>
</tr>
<tr>
<td><strong>Include Subfolders</strong></td>
<td>Specifies that subfolders of a referenced folder should be included in Pack and Go.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Removes the selected document.</td>
</tr>
</tbody>
</table>

**Note**

Some context menu items can be disabled and the document marked as `Locked` in the API.

### Using the Search mode

1. Click the option **Search** and enter a query or syntax in the text box. For more information about the available syntaxes, see *Search syntax on page 64*.

**Note**

The drop-down list contains the search history of the previous ten queries between sessions.

2. Click the Expand button to access additional controls. This allows you to specify if the search should cover all the enabled locations or one specific location.
3 Select **Search in results** check box to search for the resulting documents of the previous search.

**Note**

The search is performed automatically, after you stop typing in the text box or manually, by clicking the glass icon. During the search, this icon is changed to a cross and clicking this cancels the search operation.

### Search syntax

The search field supports certain keywords and operators which allows you to specify an advanced search query.

**Note**

Keywords are not localised.

The following table displays the keywords that specifies an advanced search query:

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>filename</td>
<td>matches the filename of the documents.</td>
</tr>
<tr>
<td>title</td>
<td>matches the title field of the document metadata.</td>
</tr>
</tbody>
</table>
| type     | matches the type field of the document metadata.  
For library (.rslib) files, this is a user-defined string. For example, Robot.  
For other files, this is the Windows description of the file type. For example, Text Document. |
| author   | matches the author field of the document metadata. |
| comments | matches the comment field of the document metadata. |
| revision | matches the revision field of the document metadata. |
| date     | matches the last time the file was modified.  
For the colon operator, the match is done against a string representation of the modified date.  
For other operators, the search string should interpret as a date according to .NET standards. |
| size     | matches the file size (in KB). |
| and, or, parentheses (,) | not used to group or invert queries. |

The following table displays the operators that specifies an advanced search query:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>:</td>
<td>matches if the field contains the search string.</td>
</tr>
<tr>
<td>=</td>
<td>matches if the field equals the search string.</td>
</tr>
<tr>
<td>&lt;</td>
<td>matches if the field is smaller than the search string.</td>
</tr>
<tr>
<td>&gt;</td>
<td>matches if the field is greater than the search string.</td>
</tr>
</tbody>
</table>
Note

• Quotation marks can be used to specify a string with whitespace. An empty string is specified by "".
• All search strings are case insensitive.
• Text without a preceding keyword is matched against the filename and all metadata.
• If queries are specified without a grouping keyword, "and" is implied.
• Some metadata (title, author, comments and revision) is not available for all file types.

Examples

• 1400 - Matches documents with the string 1400 in the filename or any metadata.
• not author:ABB - Matches documents where the author field does not contain the string ABB.
• size>1000 and date<1/2009 - Matches documents larger than 1000KB and modified before 1/1/2009.
• IRBP comments="ABB Internal" - Matches documents with the string IRBP in the filename or any metadata, and where the comment field equals ABB Internal.

Using the Browse mode

1 Click the option Browse from the Document Manager.
A folder structure of the document location is displayed.

Note
The top level of the folder structure lists the configured locations. If a location is unavailable (for example, an offline network path) it is marked as Unavailable and cannot be opened. The text box displays the path of the current folder relative to the location root.

2 You can open a folder in either of the two ways:
• Double-click the document location.
• Right-click the document location and select Open from the context menu.

3 You can navigate through the folders in either of the two ways:
• Click the folder icon at the top-right corner.
• Select the parent folder from the dropdown list.

Note
You can browse and add component xml files (*.rsxml) to your station.
4 Click **Refresh** icon in the text box to manually refresh the contents of the folder.

**Note**

The refresh operation can be time consuming, if a folder resides in a network location or contains many documents. During this time, the refresh icon changes to a cross icon allowing you to cancel the operation.

### Results view

In the Browse mode, items are grouped into folders and documents. The resulting folders and documents are displayed in a list view.

The search result appears in the status bar at the bottom, displaying the number of items found, and progress made during the search. The Search results are grouped beneath headers according to their location.

Each document is represented by an image, the document title or filename in black text, and the metadata and file information in grey text. For library files, the image can be a screenshot or other custom image. For other document types, the image is the icon associated with the file type.

### Using the Context menu

In the results view, right-click a document or folder. The following context menu items appears:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Open                  | This command opens the selected folder, library or geometry files, station files, and document.  
  - For folders, browses into the selected folder.  
  - For library or geometry files, imports the file into the station. (If no station is open, a new empty station is first created.)  
  - For station files, opens the station.  
  - For other documents, attempts to open the selected document according to its file association. For example, Microsoft Word starts when a .doc file is opened. |
| Open containing folder| This command opens the folder containing the document or the folder in the Windows Explorer. |
| Properties            | This command is disabled for folders. This command opens a dialog that displays complete metadata and file information about the selected document. |

**Tip**

Double-click an item to import the library and geometry files and open the other documents.
In the results view, right-click an empty area. The following context menu appears that controls how the documents are grouped and sorted:

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by:</td>
<td>Controls how the documents are arranged in groups.</td>
</tr>
<tr>
<td></td>
<td>The following options are available:</td>
</tr>
<tr>
<td></td>
<td>• Location</td>
</tr>
<tr>
<td></td>
<td>• Folder</td>
</tr>
<tr>
<td></td>
<td>• Type</td>
</tr>
<tr>
<td>Sort by:</td>
<td>Controls how the documents are sorted within the group.</td>
</tr>
<tr>
<td></td>
<td>The following options are available:</td>
</tr>
<tr>
<td></td>
<td>• Name</td>
</tr>
<tr>
<td></td>
<td>• Date</td>
</tr>
<tr>
<td></td>
<td>• Size</td>
</tr>
</tbody>
</table>

Ascending and Descending: Items are sorted in the ascending and descending order.

Using the drag and drop feature

You can import a library or a geometry file into the station by dragging it from the results view into either the graphics window, or onto a object node in the Layout browser.

• When dragging into the Layout browser, the component will be placed as a child object under the station, component group or smart component.

• When dragging into the graphics window, the component will be positioned at the point on the station floor where you drop it. You can snap the point to the UCS grid by enabling the Snap Grid or by holding down the ALT key while dragging.

Document Locations window

You can launch the Document Locations window in any one of the following ways:

1 Select Locations from the Documents window.

2 On the File menu, click Options and select Files & Folders in the navigation pane. Click Document Locations on the right side.

3 On the Home tab, click Import Library and select Locations from the dropdown menu.

Layout of the Document Locations window

It consists of a menu bar and a list displaying the configured locations. The list displays general information about the locations. The menu bar contains the following controls:

<table>
<thead>
<tr>
<th>Controls</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locations</td>
<td>The following options are available from the dropdown menu:</td>
</tr>
<tr>
<td></td>
<td>• Import : Opens a dialog box to import document locations from an xml file.</td>
</tr>
<tr>
<td></td>
<td>If a location with the same URL already exists, you have the option to retain or delete the existing location.</td>
</tr>
<tr>
<td></td>
<td>• Export : Opens a dialog box to export all the configured locations to an xml file.</td>
</tr>
<tr>
<td></td>
<td>• Reset to Default : Loads the default locations (ABB Library, User Library, and User Geometry).</td>
</tr>
</tbody>
</table>
1 Introduction to RobotStudio

1.4.11 The Document Manager window

Continued

<table>
<thead>
<tr>
<th>Controls</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Location</td>
<td>Opens a dialog box to add a document location. By default, there is one location type available. For more information, see FileSystem location on page 68.</td>
</tr>
<tr>
<td>Remove</td>
<td>Deletes the selected location.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens a dialog box to modify the selected location. For more information, see FileSystem location on page 68.</td>
</tr>
</tbody>
</table>

**File System location**

1. Click **Add Locations** and select **File System** from the dropdown menu. The File System dialog box appears.

The File System dialog box contains the following controls:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Name</td>
<td>Specifies a name associated with the location.</td>
</tr>
<tr>
<td>Path</td>
<td>Specifies the file system directory that corresponds to the root folder of the location. This can be on a local or network disk.</td>
</tr>
<tr>
<td>Filter</td>
<td>Specifies a filename filter to include only certain files when searching and browsing. Multiple filters are separated by a semicolon. If the filter is empty all files are included.</td>
</tr>
<tr>
<td>Cache files from network</td>
<td>Specifies that the library and geometry files from a network location should be copied to a local directory and imported from there, rather than directly from the network path. This will ensure that a station containing such files can be opened even if the network location is unavailable. This option is only available for network locations.</td>
</tr>
<tr>
<td>Directory</td>
<td>Specifies the directory where to store the local copies. This must be on a local disk.</td>
</tr>
<tr>
<td>Show as gallery</td>
<td>Specifies that the contents of the location should be displayed as a gallery in the specified ribbon menu.</td>
</tr>
<tr>
<td>Style</td>
<td>• Flat - Specifies that all documents are displayed in a single gallery with subfolder names as headers. • Recursive - Specifies that the documents are displayed in submenus corresponding to the folder structure.</td>
</tr>
<tr>
<td>Include when searching all locations</td>
<td>Specifies if the search should cover all the enabled locations.</td>
</tr>
</tbody>
</table>
1.4.12 Using a mouse

Navigating the graphics window using the mouse

The table below shows how to navigate the graphics window using the mouse:

<table>
<thead>
<tr>
<th>To</th>
<th>Use the keyboard/mouse combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select items</td>
<td>left-cli</td>
<td>Just click the item to select. To select multiple items, press CTRL key while clicking new items.</td>
</tr>
<tr>
<td>Rotate the station</td>
<td>CTRL + SHIFT + left-cli</td>
<td>Press CTRL + SHIFT + the left mouse button while dragging the mouse to rotate the station. With a 3-button mouse you can use the middle and right buttons, instead of the keyboard combination.</td>
</tr>
<tr>
<td>Pan the station</td>
<td>CTRL + left-cli</td>
<td>Press CTRL + the left mouse button while dragging the mouse to pan the station.</td>
</tr>
<tr>
<td>Zoom the station</td>
<td>CTRL + right-cli</td>
<td>Press CTRL + the right mouse button while dragging the mouse to the left to zoom out. Dragging to the right zooms in. With a 3-button mouse you can also use the middle button, instead of the keyboard combination.</td>
</tr>
<tr>
<td>Zoom using window</td>
<td>SHIFT + right-cli</td>
<td>Press SHIFT + the right mouse button while dragging the mouse across the area to zoom into.</td>
</tr>
<tr>
<td>Select using window</td>
<td>SHIFT + left-cli</td>
<td>Press SHIFT + the left mouse button while dragging the mouse across the area to select all items that match the current selection level.</td>
</tr>
</tbody>
</table>
1 Introduction to RobotStudio

1.4.13 Selecting an item

Overview

Each item in a station can be moved to achieve the required layout, so you first have to determine its selection level. The selection level makes it possible to select only specific types of items, or specified parts of objects.

The selection levels are curve, surface, entity, part, mechanism, group, target/frame and path. The target/frame and path selection can be combined with any of the other selection levels.

Objects may also be grouped together as component groups, see Component Group on page 254.

Selecting an item in the graphics window

To select items in the graphics window, follow these steps:

1. At the top of the graphics window, click the desired selection level icon.
2. Optionally, click the desired snap mode icon for the part of the item you wish to select.
3. In the graphics window, click the item. The selected item will be highlighted.

Multiple selection of items in the graphics window

To select multiple items in the graphics window, do the following:

1. Press the SHIFT key, and in the graphics window drag the mouse diagonally over the objects to select.

Selecting an item in the browsers

To select items in a browser, do the following:

1. Click the item. The selected item will be highlighted in the browser.

Multiple selection of items in the browsers

To select multiple items in a browser, follow these steps:

1. Make sure that all the items to be selected are of the same type and located in the same branch of the hierarchical structure; otherwise, the items will not be operable.
2. Do one of the following:
   • To select adjacent items: In the browser, hold down the SHIFT key and click the first and then the last item. The list of items will be highlighted.
   • To select separate items: In the browser, hold down the CTRL key and click the items you want to select. The items will be highlighted.
1.4.14 Attaching and detaching objects

Overview

You can attach an object (child) to another object (parent). Attachments can be created on part level and on mechanism level. When an object has been attached to a parent, moving the parent also moves the child.

One of the most common attachments is to attach a tool to a robot. For procedures, see Attach to on page 438 and Detach on page 446.
### General keyboard shortcuts

The following table lists general keyboard shortcuts in RobotStudio.

<table>
<thead>
<tr>
<th>Command</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Shortcuts</strong></td>
<td></td>
</tr>
<tr>
<td>Activate menu bar</td>
<td>F10</td>
</tr>
<tr>
<td>Open API Help</td>
<td>ALT + F1</td>
</tr>
<tr>
<td>Open Help</td>
<td>F1</td>
</tr>
<tr>
<td>Open Virtual FlexPendant</td>
<td>CTRL + F5</td>
</tr>
<tr>
<td>Switch between windows</td>
<td>CTRL + TAB</td>
</tr>
<tr>
<td><strong>General Commands</strong></td>
<td></td>
</tr>
<tr>
<td>Add Controller System</td>
<td>F4</td>
</tr>
<tr>
<td>Open Station</td>
<td>CTRL + O</td>
</tr>
<tr>
<td>Take Screenshot</td>
<td>CTRL + B</td>
</tr>
<tr>
<td>Teach Move Instruction</td>
<td>CTRL + SHIFT + R</td>
</tr>
<tr>
<td>Teach Target</td>
<td>CTRL + R</td>
</tr>
<tr>
<td>Import Geometry</td>
<td>CTRL + G</td>
</tr>
<tr>
<td>Import Library</td>
<td>CTRL + J</td>
</tr>
<tr>
<td>New Empty Station</td>
<td>CTRL + N</td>
</tr>
<tr>
<td>Save Station</td>
<td>CTRL + S</td>
</tr>
<tr>
<td><strong>General Editing Commands</strong></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL + C</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL + X</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL + V</td>
</tr>
<tr>
<td>Delete</td>
<td>DELETE</td>
</tr>
<tr>
<td>Redo</td>
<td>CTRL + Y</td>
</tr>
<tr>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL + A</td>
</tr>
<tr>
<td>Undo</td>
<td>CTRL + Z</td>
</tr>
</tbody>
</table>

### RAPID Editor shortcuts

The following table lists the keyboard shortcuts specific to the RAPID Editor.

<table>
<thead>
<tr>
<th>Command</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RAPID Editor Intellisense</strong></td>
<td></td>
</tr>
<tr>
<td>Complete Word</td>
<td>CTRL + SPACEBAR</td>
</tr>
<tr>
<td>Parameter Info</td>
<td>CTRL + SHIFT + SPACEBAR</td>
</tr>
<tr>
<td>Auto Complete</td>
<td>TAB (when the cursor located at the end of an identifier)</td>
</tr>
<tr>
<td>Command</td>
<td>Key Combination</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td><strong>General RAPID Editor Commands</strong></td>
<td></td>
</tr>
<tr>
<td>Start Program Execution</td>
<td>F8</td>
</tr>
<tr>
<td>Step In</td>
<td>F11</td>
</tr>
<tr>
<td>Step Out</td>
<td>SHIFT + F11</td>
</tr>
<tr>
<td>Step Over</td>
<td>F12</td>
</tr>
<tr>
<td>Stop</td>
<td>SHIFT + F8</td>
</tr>
<tr>
<td>Toggle Breakpoint</td>
<td>F9</td>
</tr>
<tr>
<td>Apply Changes</td>
<td>CTRL + SHIFT + S</td>
</tr>
<tr>
<td>Print</td>
<td>CTRL + P</td>
</tr>
<tr>
<td><strong>RAPID Editor Text Commands</strong></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL + Insert or, CTRL + C</td>
</tr>
<tr>
<td>Cut</td>
<td>SHIFT + Delete or, CTRL + X</td>
</tr>
<tr>
<td>Cut line</td>
<td>CTRL + L</td>
</tr>
<tr>
<td>Delete line</td>
<td>CTRL + SHIFT + L</td>
</tr>
<tr>
<td>Delete to beginning of word</td>
<td>CTRL + BACKSPACE</td>
</tr>
<tr>
<td>Delete to end of word</td>
<td>CTRL + Delete</td>
</tr>
<tr>
<td>Find next occurrence</td>
<td>F3</td>
</tr>
<tr>
<td>Indent</td>
<td>Tab</td>
</tr>
<tr>
<td>Make the selected text lowercase</td>
<td>CTRL + U</td>
</tr>
<tr>
<td>Make the selected text uppercase</td>
<td>CTRL + SHIFT + U</td>
</tr>
<tr>
<td>Move to beginning of document</td>
<td>CTRL + Home</td>
</tr>
<tr>
<td>Move to beginning of line</td>
<td>Home</td>
</tr>
<tr>
<td>Move to end of document</td>
<td>CTRL + End</td>
</tr>
<tr>
<td>Move to end of line</td>
<td>End</td>
</tr>
<tr>
<td>Move to next word</td>
<td>CTRL + Right</td>
</tr>
<tr>
<td>Move to previous word</td>
<td>CTRL + Left</td>
</tr>
<tr>
<td>Move to visible bottom</td>
<td>CTRL + Page Down</td>
</tr>
<tr>
<td>Move to visible top</td>
<td>CTRL + Page Up</td>
</tr>
<tr>
<td>Open line above</td>
<td>CTRL + Enter</td>
</tr>
<tr>
<td>Open line below</td>
<td>CTRL + SHIFT + Enter</td>
</tr>
<tr>
<td>Outdent</td>
<td>SHIFT + TAB</td>
</tr>
<tr>
<td>Paste</td>
<td>SHIFT + Insert or, CTRL + V</td>
</tr>
<tr>
<td>Redo</td>
<td>CTRL + SHIFT + Z or, CTRL + Y</td>
</tr>
<tr>
<td>Scroll down</td>
<td>CTRL + Down</td>
</tr>
<tr>
<td>Scroll up</td>
<td>CTRL + Up</td>
</tr>
</tbody>
</table>

*Continued on next page*
### 1.4.15 Keyboard shortcuts

<table>
<thead>
<tr>
<th>Command</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select block down</td>
<td>ALT + SHIFT + Down</td>
</tr>
<tr>
<td>Select block left</td>
<td>ALT + SHIFT + Left</td>
</tr>
<tr>
<td>Select block right</td>
<td>ALT + SHIFT + Right</td>
</tr>
<tr>
<td>Select block up</td>
<td>ALT + SHIFT + Up</td>
</tr>
<tr>
<td>Select down</td>
<td>SHIFT + Down</td>
</tr>
<tr>
<td>Select left</td>
<td>SHIFT + Left</td>
</tr>
<tr>
<td>Select page down</td>
<td>SHIFT + Page Down</td>
</tr>
<tr>
<td>Select page up</td>
<td>SHIFT + Page Up</td>
</tr>
<tr>
<td>Select right</td>
<td>SHIFT + Right</td>
</tr>
<tr>
<td>Select to beginning of document</td>
<td>CTRL + SHIFT + Home</td>
</tr>
<tr>
<td>Select to beginning of line</td>
<td>SHIFT + Home</td>
</tr>
<tr>
<td>Select to end of document</td>
<td>CTRL + SHIFT + End</td>
</tr>
<tr>
<td>Select to end of line</td>
<td>SHIFT + End</td>
</tr>
<tr>
<td>Select to next word</td>
<td>CTRL + SHIFT + Right</td>
</tr>
<tr>
<td>Select to previous word</td>
<td>CTRL + SHIFT + Left</td>
</tr>
<tr>
<td>Select to visible bottom</td>
<td>CTRL + SHIFT + Page Down</td>
</tr>
<tr>
<td>Select to visible top</td>
<td>CTRL + SHIFT + Page Up</td>
</tr>
<tr>
<td>Select up</td>
<td>SHIFT + Up</td>
</tr>
<tr>
<td>Select word</td>
<td>CTRL + SHIFT + W</td>
</tr>
<tr>
<td>Toggle overwrite mode</td>
<td>Insert</td>
</tr>
<tr>
<td>Transpose characters</td>
<td>CTRL + T</td>
</tr>
<tr>
<td>Transpose lines</td>
<td>CTRL + ALT + SHIFT + T</td>
</tr>
<tr>
<td>Transpose words</td>
<td>CTRL + SHIFT + T</td>
</tr>
</tbody>
</table>
2 Building stations

2.1 Workflow of building a station

Overview

The following sections outline the workflow for building a new station. It also includes the prerequisites for creating and simulating robot programs. The workflow includes:

- Options for creating a station with a system.
- Importing or creating the objects to work with.
- Optimizing the station layout by finding the best placement of robots and other equipment.

Note

For most scenarios, you are recommended to follow the workflows from start to finish, even though other sequences may be possible.

Creating a station with a system

The table below shows the options for creating a station with a system.

For the exact procedures, see New on page 188.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a station with a template system</td>
<td>This is the simplest way to create a new station containing a robot and a link to a rudimentary system template.</td>
</tr>
<tr>
<td>Create a station with an existing system</td>
<td>This creates a new station containing one or more robots in accordance with an existing, built system.</td>
</tr>
<tr>
<td>Create a station with no system</td>
<td>An advanced user can build a station from scratch and then add a new or existing system to it.</td>
</tr>
</tbody>
</table>

Manually starting the VC

The table below shows the alternatives for manually starting with a system. Perform only those steps applicable to your station.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually connecting a library to the VC</td>
<td>See Starting a VC on page 85.</td>
</tr>
<tr>
<td>Restarting the VC</td>
<td>See Restarting a VC on page 86.</td>
</tr>
</tbody>
</table>

Importing station components

The table below shows the workflow for importing station components. Perform only those steps applicable to your station.

For procedures, see Importing a station component on page 87.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import a robot model</td>
<td>See Robot System on page 204.</td>
</tr>
<tr>
<td>Import a tool</td>
<td>See Import Library on page 203.</td>
</tr>
<tr>
<td>Import a positioner</td>
<td>See ABB Library on page 202.</td>
</tr>
</tbody>
</table>

Continues on next page
2 Building stations

2.1 Workflow of building a station

Continued

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import a track</td>
<td>See <em>Import Library on page 203</em>.</td>
</tr>
<tr>
<td>Import other equipment</td>
<td>If you have CAD models of the equipment, you can import them, see <em>Import Library on page 203</em>. Otherwise, you can create models in RobotStudio, see <em>Mechanisms on page 94</em>.</td>
</tr>
<tr>
<td>Add work piece</td>
<td>If you have CAD models of the work piece, you can import them, see <em>Workobject on page 214</em>. Otherwise, you can create models in RobotStudio, see <em>Objects on page 92</em>.</td>
</tr>
</tbody>
</table>

### Placing objects and mechanisms

The table below shows the workflow for placing the objects in the station.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place objects</td>
<td>If you are building a model of a real station, start by placing all objects with known positions. For objects without known positions, find a suitable placement, see <em>Placing objects on page 97</em> and <em>Placing external axes on page 98</em>.</td>
</tr>
<tr>
<td>Attach tools</td>
<td>Attach the tools to the robot, see <em>Attach to on page 438</em>.</td>
</tr>
<tr>
<td>Attach robots to tracks</td>
<td>If track external axes are used, attach the robots to the tracks, see <em>Attach to on page 438</em>.</td>
</tr>
<tr>
<td>Attach work pieces to positioners</td>
<td>If positioner external axes are used, attach the work pieces to the positioners, see <em>Attach to on page 438</em>.</td>
</tr>
<tr>
<td>Test reachability</td>
<td>Test if the robot can reach critical positions on the work piece. If you are satisfied with how the robot reaches the positions, your station is ready for programming. Otherwise, continue adjusting the placement or trying other equipment as described below, see <em>Testing positions and motions on page 122</em>.</td>
</tr>
</tbody>
</table>
2.2 Conveyor tracking station with two robots

2.2.1 Two robot systems in same task frame position

Overview
This section describes what happens when both the robot systems share the same task frame position. The baseframes of the mechanical units in both the robot systems have the same task frame position.

Prerequisites
- Two robot systems with conveyor tracking option (system 1 and system 2)
- A conveyor mechanism saved as library
See Create Conveyor mechanism on page 308 to create conveyor tracking systems.

Setting up the conveyor tracking station

1. Add the existing system (system 1) to the station. See Robot System on page 204.

   Note
   After starting the system, when asked to select the library, browse and select the already saved conveyor mechanism library.

2. Modify the baseframe positions of conveyor and robot.
   a. Move the mechanical unit (conveyor/robot) to its new location.
   b. See Updating the baseframe position on page 396 to update the baseframe position of the conveyor/robot.
   c. Repeat steps 1 and 2 to modify the baseframe position of the robot.
   d. In the System Configuration window, click OK. When asked if you want to restart the system, answer Yes. Close the System Configuration window.

3. Add the existing system (system 2) to the station. See Robot System on page 204.

   Note
   After starting the system, when asked to select the library, browse and select the same library as the one selected for system 1 or any other library. Later, this conveyor library will be removed from the station since system 2 shall use the same conveyor library as system 1.

4. Refer both systems (system 1 and system 2) to the same conveyor library.
   a. On the Controller tab, in the Virtual Controller group, click Edit System.
      This opens the System Configuration dialog for system 2.
   b. Select the library node in the hierarchical tree.

Continues on next page
c Select the option Select from Station. Click Change. The Select Library dialog box appears.

d Select the same conveyor library as the one selected for system 1. Click OK.

**Note**

Now both systems (system 1 and system 2) use the same conveyor library and the library previously referenced by system 2 is removed from the station.

5 Modify the baseframe positions of robot (system 2).

a Move the mechanical unit (robot) to its new location.

b See Updating the baseframe position on page 396 to update the baseframe position of the robot.

c Repeat steps 1 and 2 to modify the baseframe position of the robot.

d In the System Configuration window, click OK. When asked if you want to restart the system, answer Yes. Close the System Configuration window.
2.2.2 Two robot systems in different task frame positions

Overview

This section describes what happens when two robot systems have different task frame positions but uses the same sync switch. This means the Baseframes of the conveyor mechanical units in both the robot systems have different values.

Prerequisites

Two robot systems with conveyor tracking option (system 1 and system 2)

See Create Conveyor mechanism on page 308 to create conveyor tracking systems.

Setting up the conveyor tracking station

1. Add the existing system (system 1) to the station. See Robot System on page 204.

   Note

   After starting the system, when asked to select the library, browse and select the already saved conveyor mechanism library.

2. Modify the baseframe positions of conveyor and robot.
   a. Move the mechanical unit (conveyor/robot) to its new location.
   b. See Updating the baseframe position on page 396 to update the baseframe position of the conveyor/robot.
   c. Repeat steps 1 and 2 to modify the baseframe position of the robot.
   d. In the System Configuration window, click OK. When asked if you want to restart the system, answer Yes. Close the System Configuration window.

3. Add the existing system (system 2) to the station. See Robot System on page 204.

   Note

   After starting the system, when asked to select the library, browse and select the same library as the one selected for system 1 or any other library. Later, this conveyor library will be removed from the station since system 2 shall use the same conveyor library as system 1.

4. Update both systems (system 1 and system 2) to use the same conveyor library.
   a. On the Controller tab, in the Virtual Controller group, click Edit System.
      This opens the System Configuration dialog for system 2.
   b. Select the library node in the hierarchical tree.
   c. Select the option Select from Station. Click Change. The Select Library dialog box appears.
   d. Select the same conveyor library as the one selected for system 1. Click OK.

Continues on next page
2 Building stations

2.2.2 Two robot systems in different task frame positions

Continued

**Note**

Now both systems (system 1 and system 2) use the same conveyor library and the library previously referenced by system 2 is removed from the station.

5 Modify the task frame position of the conveyor mechanism. See *Set Task Frames on page 395*.

**Note**

Before modifying the task frame, make a note of the current conveyor position in world coordinates. After modifying the task frame, move the conveyor back to the position it was before modifying the task frame.

6 Modify the baseframe positions of robot (system 2).

Repeat step 2 to modify the baseframe position of the robot (system 2)

a Move the mechanical unit (robot) to its new location.

b See *Updating the baseframe position on page 396* to update the baseframe position of the robot.

c Repeat steps 1 and 2 to modify the baseframe position of the robot.

d In the System Configuration window, click OK. When asked if you want to restart the system, answer Yes. Close the System Configuration window.

7 Modify the baseframe position of the conveyor (system 2).

a On the Controller tab, in the Virtual Controller group, click Edit System. This opens the System Configuration dialog for system 2.

b Select the conveyor in the hierarchical tree. The BaseFrame property list for the conveyor is now displayed.

c Select the option *Use Current Station Values* to update the baseframe value of the robot in the controller.

d Deselect the option *Check BaseFrame on Startup*.

e In the System Configuration window, click OK. When asked if you want to restart the system, answer Yes.

**Note**

By deselecting the option *Check BaseFrame on Startup*, RobotStudio will not compare the BaseFrame values in the station and the controller every time the controller is started. This avoids repositioning the conveyor library. If the two robot systems use the same part on the conveyor, the relation between the part and the two conveyor workobjects should be the same.
2.3 Creating a system with external axes automatically

Automatically create a system with external axes

1. Import the desired robots, positioners, and track libraries into the RobotStudio station. See Import Library on page 203.

   If a robot and track are selected, attach the robot to the track. See Attach to on page 438.

   Note

   Robot system supports the following tracks with lengths 1.7 m to 19.7 m in a separate task or same robot task. Depending on the manipulator type, the system allows one to three tracks per task. However with IRBTx004, only one track of this type can be used per system.
   - IRBT4003
   - IRBT4004
   - IRBT6003
   - IRBT6004
   - IRBT7003
   - IRBT7004
   - RTT_Bobin
   - RTT_Marathon
   - Paint Rail

2. Create a robot system from layout. See Robot System on page 204.

   Note

   To create a robot system with IRBT4004, IRBT6004, or IRBT7004, the TrackMotion mediapool must be installed. For more information, see Installing and licensing RobotStudio on page 40.

Supported external axes configuration

The following table shows a combination of different external axes configurations:

<table>
<thead>
<tr>
<th>Combination</th>
<th>Positioner type</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>K</th>
<th>L</th>
<th>2xL</th>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td>One IRB (Positioner in same task)</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>One IRB (Positioner in separate task)</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Two IRB (Positioner in separate task)</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>One IRB on Track Motion (Positioner in same task)</td>
<td></td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>YX</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>One IRB on Track Motion (Positioner in separate task)</td>
<td></td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>YX</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
</tbody>
</table>

Continues on next page
2 Building stations

2.3 Creating a system with external axes automatically

Continued

<table>
<thead>
<tr>
<th>Combination</th>
<th>Positioner type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A</td>
</tr>
<tr>
<td>Two IRB on Track Motion (Positioner in separate task)</td>
<td>Y</td>
</tr>
</tbody>
</table>

- **Y** - Combination is supported
- **N** - Combination is not supported
- **YX** - Combination is supported and manual mapping of mechanical units and joints required

**Note**

Creating a system from layout only supports tracks of type RTT and IRBTx003 in combination with positioners. i.e. IRBTx004 is not supported in combination with the positioners.

**Manual mapping of mechanical units and joints**

If the system contains more than one mechanical unit, the number of tasks and base frame positions of the mechanism should be verified in the System Configuration.

1. On the Controller tab, in the Virtual Controller group, click Edit System. This opens the System Configuration dialog.
2. Select the robot from the node in the hierarchical tree. The property page of this node contains controls for mapping and setting axes and joints.
3. Click Change to open a dialog box.
4. Manually map the mechanical unit and mechanism joints. Click Apply.
5. Modify the baseframe positions of the mechanical unit. See *Updating the baseframe position on page 396.*
2.4 Manually setting up system with track motion

2.4.1 Track motion of type RTT or IRBTx003

Manually setting up a system with track motion of type RTT or IRBTx003

Use this procedure to manually set up a system with track motion type RTT Bobin, RTT Marathon or IRBT4003, IRBT6003, or IRBT7003.

1 Build and start a new system. See Building a new system on page 159.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the desired robot variant (IRB6600). In the New Controller System wizard of the System Builder, navigate to Modify Options page and scroll down to Drive Module 1 &gt; Drive module application group and expand ABB Standard manipulator option and select Manipulator type (IRB6600).</td>
</tr>
<tr>
<td>2</td>
<td>Select the Additional axes configuration. In the New Controller System wizard of the System Builder, navigate to Modify Options page of the System Builder, scroll down to Drive Module 1 &gt; Additional axes configuration group and expand the Add axes IRB/drive module 6600 option and select the 770-4 Drive W in pos Y2 option. The option 770-4 Drive W in pos Y2, the Drive module, and the Position varies depending on the Additional axes configuration selected. Make sure to select at least one drive in any position.</td>
</tr>
<tr>
<td>3</td>
<td>Click Finish. Close the Modify Options page.</td>
</tr>
</tbody>
</table>

2 Add the system to the station. See Adding a system on page 85

3 Add the corresponding track configuration file of the desired robot variant (IRB 6600) and the desired track model to the station. See Adding the track to the system on page 87.

Note

In the Select Library group, select either the existing track or import a different track.

The system may fail unless the correct additional axes configuration is selected.

4 Specify whether the baseframe is moved by another mechanism.
   a On the Controller tab, in the Virtual Controller group, click Edit System. This opens the System Configuration dialog.
   b Select ROB_1 node from the hierarchical tree.
   c Select the option Track from the BaseFrame moved by list.
   d Click OK. When asked if you want to restart the system, answer Yes. Close the System Configuration window.
2 Building stations

2.4.2 Track motion of type IRBTx004

2.4.2 Track motion of type IRB Tx004

Overview

For configuration of tracks of type IRB4004, IRB6004, or IRB7004, the TrackMotion mediapool must be installed. For more information, see Installing and licensing RobotStudio on page 40.

Manually setting up a system with track motion of type IRB Tx004

1 Build and start a new system. See Building a new system on page 159.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add additional options for IRB-Tx004. See Adding additional options on page 160. Browse and select the key file (.kxt) located in the mediapool Track 5.XX.YYYY where 5.XX indicates the latest RobotWare version being used.</td>
</tr>
<tr>
<td>2</td>
<td>Select the desired robot variant (IRB6600). On the Modify Options page of the System Builder, scroll down to Drive Module 1 &gt; Drive module application group and expand ABB Standard manipulator option and select Manipulator type (IRB6600).</td>
</tr>
<tr>
<td>3</td>
<td>Select Additional axes configuration. On the Modify Options page of the System Builder, scroll down to Drive Module 1 &gt; Additional axes configuration group and expand the Add axes IRB/drive module 6600 option and select the 770-4 Drive W in pos Y2 option. The option 770-4 Drive W in pos Y2, the Drive module, and the Position varies depending on the Additional axes configuration selected. Make sure to select at least one drive in any position.</td>
</tr>
<tr>
<td>4</td>
<td>Select the desired track motion (IRBT 6004). On the Modify Options page of the System Builder, scroll down to the TRACK and expand the Drive module for Track motion group. Select Drive Module 1 &gt;Track Motion type &gt;IRBT 6004 &gt; Irb Orientation on Track &gt; Standard carriage In Line &gt; Select Track Motion Length &gt; 1.7m (or any other variant).</td>
</tr>
<tr>
<td>5</td>
<td>Click Finish. Close the Modify Options page.</td>
</tr>
</tbody>
</table>

2 Add the system to the station. See Adding a system on page 85.

3 Add the desired track model to the station using the following procedure. See Adding the track to the system on page 87.

   a In the Select Library group, click Other to import a different track motion library.

   b Click OK. When asked if you want to restart the system, answer Yes. Close the System Configuration window.
2.5 Virtual Controller

2.5.1 Starting a VC

Overview

RobotStudio uses virtual controllers for running the robots. Virtual controllers can run both systems for real robots and specific virtual systems for testing and evaluation purposes. A virtual controller uses the same software as the controller to execute the RAPID program, to calculate robot motions and to handle I/O signals.

When starting a virtual controller, point out which system to run on it. Since the system contains information about the robots to use and important data such as robot programs and configurations, it is important to select the right system for the station.

Note

You can start and stop a virtual controller, using a given system path and without needing a station. For more information, see Start Virtual Controller on page 349.

Starting a VC

The table below describes the different ways a virtual controller may start:

<table>
<thead>
<tr>
<th>Startup</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic, when creating a station</td>
<td>In most cases, a VC is automatically started when you create a new station. Library files for the robots used by the system are then imported to the station.</td>
</tr>
<tr>
<td>Automatic, when adding a system to an existing station</td>
<td>If your station uses several systems or if you started with an empty station, you can add systems to an open station. Library files for the robots used by the the systems are then imported to the station.</td>
</tr>
</tbody>
</table>
| Manually, when connecting to an imported library | If you have manually imported a robot library you want to use with a system, instead of importing a new library at startup, you can connect this library to a controller.  
If you have manually imported a robot library you want to use with a system, instead of importing a new library at startup, you can connect this library to a controller.  
A library may only be connected to a single-robot system and may not be already connected to another VC. |
| Manually, when starting a controller from the Controller tab. | The Start Virtual Controller commands allows you start and stop a virtual controller, using a given system path and without needing a station. |

Adding a system

To add a system to a new station, see New on page 188.

To add a system to an existing station, see Robot System on page 204.

For information how to create a system with specific options, see The System Builder on page 156.

To start or add a virtual controller which is not part of a station, see Add Controller on page 348.
2.5.2 Restarting a VC

For information on when and how to restart a VC in RobotStudio, see Restart a controller on page 355.
2.6 Station components

2.6.1 Importing a station component

Importing a robot model
This is how to import a robot model without a controller to your station.
A robot which is not connected to a controller cannot be programmed. To import a robot connected to a virtual controller, configure a system for the robot and start it in a virtual controller, see Building a new system on page 159 and Starting a VC on page 85, respectively.
To import a robot model, in the Home tab, click Robot System and then select a robot model from the gallery.

Importing a tool
A tool is a special object, for example, an arc weld gun or a gripper, that operates on the work piece. For achieving correct motions in robot programs, the parameters of the tool have to be specified in the tool data. The most essential part of the tool data is the TCP, which is the position of the tool center point relative to the wrist of the robot (which is the same as the default tool, tool0).
When imported, the tool will not be related to the robot. So in order for the tool to move with the robot, you must attach it to the robot.
To import a tool, in the Home tab, click Tool and then select a tool from the gallery.

Importing a positioner
To import a tool, in the Home tab, click Positioner and then select a positioner from the gallery.

Adding the track to the system
To select the model of the external axis to use, follow these steps:

Note
This procedure is not applicable for a robot system with track motions IRBT4004, IRBT6004, or IRBT7004. They are configured by the TrackMotion mediapool and not by adding separate configuration files. For information on installation instructions, see Installing and licensing RobotStudio on page 40.

1. Start the system in a virtual controller, either in a new empty station or in an existing station, see Robot System on page 204.
2. In the Layout browser, select the system to add the track to.
3. On the Controller tab, click System Configuration.
4. Click Add to add parameters for the track to the system. Browse to the parameter file (.cfg) for the track to add and click Open.
If you have a specific parameter file for you track, use that one. Otherwise, parameter files for some standard tracks are delivered with the RobotStudio installation. These can be found in the folder ABB Library/Tracks in

Continues on next page
RobotStudio’s installation folder. The ABB Library folder can also be opened from the Quick access pane at the left of the Open dialog box used for adding parameter files.

The file name of each parameter file tells which tracks it supports. The first part tells the length of the track and the second the number of tasks.

For example, the file TRACK_1.7.cfg supports all tracks with the length 1.7 meters in systems with one single task. For Multimove systems or other systems with several tasks, use the configuration file with the matching number of tasks.

For example, if the track length is 19.9 m and the robot attached to the track is connected to task 4 of the MultiMove system, then select TRACK_19.9_Task4.cfg file.

5 In the System Configuration window, click OK. When asked if you want to restart the system, answer Yes.

6 During the restart a list of all tracks compatible with the configuration file is displayed. Select the one to use and click OK.

After the restart the track appears in the station. Continue with attaching the robot to the track.

---

Importing a library, geometry or piece of equipment

A library component is a RobotStudio object that has been saved separately. Normally, components in a library are locked for editing.

A geometry is CAD data which you can import to use in RobotStudio. For a list of importable CAD formats, see Libraries, geometries and CAD files on page 36.

To import a library, geometry or piece of equipment, see Import Library on page 203.
2.6.2 Converting CAD formats

Overview
A CAD converter is installed together with RobotStudio by default. In most cases you do not have to convert CAD files before importing them to RobotStudio, but the CAD converter might be useful for converting several files at once, or for converting with custom settings.

Prerequisites
Most of the file formats require separate licenses, see Libraries, geometries and CAD files on page 36 for more information.

Starting the CAD converter
Click Start menu, point to Programs, ABB Industrial IT, Robotics IT, RobotStudio 5.xx and click CAD Converter.

Converting CAD files
To convert CAD files, follow these steps:
1. Click Add files and select the files to convert. Optionally, click Add files, again to add more files from another location. Each file is now added to a row in the grid.
2. Optionally, change the suggested file name or target format by clicking that column for the file to change.
3. In the Target directory box, specify the folder in which to save the new files.
4. Optionally, click Settings and change the settings for the conversion. For details about the conversion settings, see Conversion settings on page 89.
5. Click Convert Files.

Conversion settings
The table below describes the settings for the conversion:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acis save file format</td>
<td>Select which version of ACIS to save to when using ACIS as target format.</td>
</tr>
<tr>
<td>Enable Healing</td>
<td>Controls whether the conversion engine attempts to heal geometric entities. Only supported for specified formats.</td>
</tr>
<tr>
<td>Translate hidden/no-show entities</td>
<td>Controls whether the hidden entities are translated or discarded. Only supported for specified formats.</td>
</tr>
<tr>
<td>VRML/STL Scale factors</td>
<td>VRML and STL are often created in units that RobotStudio does not expect; they thus need to be resized.</td>
</tr>
<tr>
<td>Delete all generated log files on exit</td>
<td>Makes the CAD converter delete log files when exiting.</td>
</tr>
</tbody>
</table>
Overview

The characteristics of the geometries and CAD models in the station may have great effect on your work in RobotStudio, both in aspects of making the objects easier to program as well as enhancing simulation performance.

Below are some guidelines for troubleshooting geometries.

<table>
<thead>
<tr>
<th>Trouble</th>
<th>Information</th>
</tr>
</thead>
</table>
| The pointer snaps to the wrong parts of the objects when selecting in the graphics window | This problem might be caused by wrong snap mode settings, imprecise selecting, hidden or lack of geometrical information. To resolve these problems, do the following:  
• Check the selection level and snap mode settings. For more information, see Selecting an item on page 70.  
• When making the selection, zoom and rotate the object so that you are sure to click inside the object.  
• Check if the object has hidden details that might affect the snapping. Remove details that are not necessary for your programming or simulation. For more information, see Modifying a part on page 93.  
• Some file formats only contain a graphical representation and no geometrical data. Import the geometry from a file format that also contains geometrical data. For more information, see Libraries, geometries and CAD files on page 36. |
| The graphics window redraws or updates slowly | This might be due to the performance of your computer not being high enough for the size of the geometry files in your station. To reduce the size of the geometry files, do any of the following:  
• Use a lower detail level for rendering the geometry. For more information, see Graphic Appearance on page 449.  
• Blends, chamfers and holes can be automatically simplified by using the Defeature function. This can greatly reduce graphic complexity, speed up simulations and reduce memory usage.  
• Check if the object has unnecessary details. Remove details that are not necessary for your programming or simulation. For more information, see Modifying a part on page 93. |
2 Building stations

2.6.3 Troubleshooting and optimizing geometries

Continued

<table>
<thead>
<tr>
<th>Trouble</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parts of the geometry are not visible</td>
<td>If parts of the geometry are not visible from some views, a probable cause is that the object is made up of 2D surfaces and the option Backface culling is on. Backface culling means that the faces of the object are only visible from the front, and if the object (or any of its faces) is oriented differently, they will not be visible. To correct the problem, do one of the following: • Switch to modeling mode and invert the direction of the face that is not displayed correctly. This not only corrects the display, it also decreases the chance of faulty orientations during graphical programming. For more information, see Invert on page 453 or To invert the direction of all faces of a part on page 91. • Turn backface culling off for the specific object. This makes the object display correctly, but does not affect the direction of the face, which might cause problems if the face will be used for graphical programming. For more information, see To deactivate backface culling for a single object on page 91. • Turn backface culling off for all objects in the station. This makes the objects display correctly, but does not affect the direction of the face, which might cause problems if the face will be used for graphical programming. It also decreases the performance of the graphic handling. For more information, see To change the generic setting for backface culling on page 91.</td>
</tr>
</tbody>
</table>

To invert the direction of all faces of a part

To invert the direction of all faces of a part, follow these steps:

1 Select the part on which faces you want to invert the directions.
2 On the Modify menu, click Graphic Appearance.
3 On the Rendering tab, click Flip normals and then click OK.

To deactivate backface culling for a single object

To change the backface culling setting for a single object, follow these steps:

1 Select the part for which you want to change the backface culling setting.
2 On the Modify menu, click Graphic Appearance.
3 On the Rendering tab, clear the Backface culling check box and then click OK. The faces of the object will now be displayed even if the generic setting for backface culling is on.

To change the generic setting for backface culling

The generic setting for backface culling affects all new objects and existing objects that do not have backface culling specifically deactivated.

1 On the File menu, click Options.
3 On the Performance page to the right, select or clear the Cull back-facing triangles check box and then click OK.
2 Building stations

2.7 Modeling

2.7.1 Objects

Overview
This section describes how to create or modify geometrical objects.

Creating a frame
A frame is a generic coordinate system that you can use as reference when positioning objects. Generic frames can also be converted to special kinds of coordinate systems, like work objects or tool center points.
For procedures, see Frame on page 211 and Frame from Three Points on page 212.

Creating a solid
With the create solids commands you can create and build models of objects you do not have CAD files or libraries for. With the create solids commands you create primitive solid bodies; these can later be combined to more complex bodies.
For procedures, see Solid on page 288.

Creating a surface
For procedures, see Surface on page 292.

Creating a curve
When creating paths with targets based on the object geometries, curves are the geometrical objects that RobotStudio uses. For example, if you want the robot to run along the edge of an object, you can first create a curve along the border and then generate a complete path along that curve, instead of manually finding and creating the necessary targets.
If the CAD model/geometry of the work piece does not already contain curves, you can create the curves in RobotStudio.
For procedures, see Curve on page 294.

Modifying a curve
When creating paths with targets based on the objects geometries, curves are the geometrical objects that RobotStudio uses. By optimizing the curves before starting programming, you reduce the touch-up of the generated paths.
For procedures, see Modify Curve on page 462.

Creating a border
For procedures, see Border on page 299.

Creating a line from normal
A line can be created as a new part and body perpendicular to a surface.
For a procedure, see Line from Normal on page 306.

Continues on next page
Extruding a surface or curve

Curves and surfaces and curves can also be extruded to 3D objects, which may then be converted to solids. You can extrude along either a vector or a curve. For procedures, see *Extrude Surface or Curve on page 304*.

Modifying a part

When you import a geometry or create an object, it will be one part. A part can, however, contain several bodies. In RobotStudio’s modeling mode you can modify the parts by adding, moving and deleting the bodies.

To modify a part, follow this step:

1. In the **Modeling** browser, expand the node for the part to modify. Then modify the part by doing any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete a body</td>
<td>Select the body and press the DEL key.</td>
</tr>
<tr>
<td>Move a body from one part to another</td>
<td>Drag the body or use the Copy and Paste commands on the Edit menu.</td>
</tr>
<tr>
<td>Move one body relative to the others</td>
<td>Select the body and then move it using any of the ordinary commands for moving objects, see <em>Placing objects on page 97</em>.</td>
</tr>
</tbody>
</table>

Modifying a library component

As external files, libraries are merely linked from a station. Therefore, to modify an imported library component, the link must first be broken and later reestablished. For procedures, see *Modify Library Component on page 456*. 
2.7.2 Mechanisms

Workflow

This information topic describes how to create a new mechanism, that is, a graphical representation of a robot, tool, external axis or device. The various parts of a mechanism move along or around axes.

Creating a mechanism is dependent upon skillful construction of the main nodes of the tree structure. Four of these—links, joints, frames/tools and calibration—are initially marked red. As each node is configured with enough subnodes to make it valid, the marking turns to green. As soon as all nodes have become valid, the mechanism will be considered compilable and can be created. For additional validity criteria, see the table below.

<table>
<thead>
<tr>
<th>Node</th>
<th>Validity criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Links</td>
<td>• It contains more than one subnode.</td>
</tr>
<tr>
<td></td>
<td>• The BaseLink is set.</td>
</tr>
<tr>
<td></td>
<td>• All link parts are still in the station.</td>
</tr>
<tr>
<td>Joints</td>
<td>• At least one joint must be active and valid.</td>
</tr>
<tr>
<td>Frame/tool Data</td>
<td>• At least one frame/tool data exists.</td>
</tr>
<tr>
<td></td>
<td>• For a device, no frames are needed.</td>
</tr>
<tr>
<td>Calibration</td>
<td>• For a robot, exactly one calibration is required.</td>
</tr>
<tr>
<td></td>
<td>• For an external axis, one calibration is required for each joint.</td>
</tr>
<tr>
<td></td>
<td>• For a tool or device, calibrations are accepted, but not required.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>• None.</td>
</tr>
</tbody>
</table>

The modify mode of the Mechanism Modeler has two purposes: to enable modification of an editable mechanism in its tree structure, and to complete the modeling of a new or modified mechanism.

It is recommended to configure each main node in the tree structure from the top down. Depending on its current status, right-click or double-click a node or subnode to add, edit or remove it.

For procedures, see Create Mechanism on page 308.
2.7.3 Tools and tooldata

Overview

To simulate the robot tool, you need tooldata for the tool. If you import a predefined tool or if you create a tool using the Create Tool Wizard, the tooldata is automatically created; otherwise, you have to create the tooldata yourself.

The tooldata simplifies the programming work with respect to the different tools that may come in use. Defining separate sets of tooldata for different tools makes it possible to run the same robot program with different tools: only the new tooldata has to be defined. The tooldata contains the information required for moving and simulating the tool.

Two methods for manipulating tooldata in RobotStudio are as follows:

• Create or modify tooldata, see Tooldata on page 215 and Modify Tooldata on page 470, respectively. This will create all data necessary for programming, but there will be no visual tool during the simulation.

• Create tooldata for an existing geometry, Create Tool on page 315.

Creating and setting up a stationary tool

This information topic describes how to create a stationary tool. For information about creating a robot hold tool, see Create Tool on page 315.

Using a stationary tool, the robot holds and moves the work piece in relation to the tool. Thus, both the tooldata and the workobject must be set up correctly.

To create the tooldata for a stationary tool, follow these steps:

1 Import the geometry or library that represents the tool, see Import Geometry on page 210.

   If you do not have the geometry or library at hand but know the position, you can skip this step. The tool will be programable, but not visible in the station.

2 Create the tooldata for the tool, see Tooldata on page 215.

   Make sure to set the Robot holds tool option to false.

3 Create a workobject that is moved by the robot. see Workobject on page 214.

   Make sure to set the Robot holds workobject option to true.

4 If you have a geometry or library component for the work piece, attach it to the robot, see Attach to on page 438.
2.7.4 Setting the local origin of an object

Overview

Each object has a coordinate system of its own called local coordinate system in which the object dimensions are defined. When the object's position is referred from other coordinate system, it is the origin of this coordinate system that is used. With the Set Local Origin command you reposition the object's local coordinate system, not the object itself.

For a procedure, see Set Local Origin on page 483.
2.8 Placement

2.8.1 Placing objects

Overview

To achieve the required layout of your station, you need to import or create objects, place them accordingly and, if applicable, attach them to other objects.

Placing objects means setting their position and rotation. If the objects are to be attached to robots or other mechanisms, they will be placed at their attachment point automatically.

The following table describes the actions relating to placement:

<table>
<thead>
<tr>
<th>Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placing an object</td>
<td>To place an object is to put the object in the required position in the station, see Place on page 475 and Set Position on page 485.</td>
</tr>
<tr>
<td>Rotating an object</td>
<td>The objects in the station can be rotated to achieve the required layout, see Rotate on page 481.</td>
</tr>
<tr>
<td>Measuring distance or angles</td>
<td>The measurement functions calculates distances, angles and diameters between points you select from the graphics window. When using measurements, results and instructions on how to proceed are displayed in the Output window, see The Measure Group on page 307.</td>
</tr>
<tr>
<td>Creating a component group</td>
<td>A component group groups related object in the browser, see Component Group on page 254.</td>
</tr>
<tr>
<td>Attaching or detaching an object</td>
<td>Objects that are to be used by the robots in any way, such as tools, need to be attached to the robot, see Attach to on page 438 and Detach on page 446.</td>
</tr>
<tr>
<td>Jogging a robot</td>
<td>Robots can be placed by jogging. The robot axes can also be positioned by jogging, see Jogging mechanisms on page 105.</td>
</tr>
<tr>
<td>Modifying the task frame</td>
<td>Modifying the task frame repositions a controller and all its robots and equipment in the station. By default the controller world and the station world coordinate system coincide. This is convenient when building a station with one single controller. For a procedure, see Set Task Frames on page 395. However, when you have several controllers in one station, or need to reposition a controller in an existing station, you need to modify the Edit System on page 396.</td>
</tr>
<tr>
<td>Modifying the baseframe position</td>
<td>Modifying the baseframe position sets an offset between the controller’s world coordinate system and the baseframe of the mechanical unit. This is necessary when having several mechanical units belonging to one controller, for example, several robots in MultiMove systems or when using positioner external axes. For a procedure, see Edit System on page 396.</td>
</tr>
</tbody>
</table>
2 Building stations

2.8.2 Placing external axes

2.8.2 Placing external axes

Overview

When starting a system with a track or positioner external axis in a RobotStudio station, you have to set up the system to load a model for the track or positioner and get the motions to work properly.

Prerequisites

The system shall be created with support for track or positioner external axes, see A system with support for one robot and one positioner external axis on page 173.

Attaching the robot to the track

To attach the robot to the track, follow these steps:

1. In the Layout browser, drag the robot icon and drop it on the track icon.
2. To the question Should the robot be coordinated with the track?, answer Yes to be able to coordinate the track’s position with that of the robot in robot programs. To program the track and the robot independently, answer No.
3. When asked if you want to restart the system, answer Yes.

The track is now added to the system and ready to be programmed, see Programming external axes on page 131 for more information on how to program the track.

CAUTION

If the system is I-started, the setup is deleted and the procedures described here must be performed again.

Placing the positioner in the station

To place the positioner in the station, follow these steps:

1. Move the positioner to the desired position using any of the ordinary functions for placing and moving objects, see Placing objects on page 97.
2. Modify the baseframe position of each mechanical unit of the positioner except the INTERCH unit, if it exists. When asked if you want to restart the system, answer Yes.

After the restart the system is updated with the positioner’s new location.

Continue attaching fixtures and workobjects to the positioner.

Attaching objects to the positioner

To program robot motions on an object that is held by the positioner, the targets must be created in a workobject that is attached to the positioner. For a complete visual simulation, CAD models that are moved by the positioner should also be attached. To attach the objects, follow these steps:

1. Import the models of the fixture and the work piece if you do not have them in the station already, see Importing a station component on page 87.
2 Attach the fixture to the positioner, see *Attaching and detaching objects on page 71*. When asked whether to keep the current position, answer *No*.

If the positioner has several stations, you will be asked which one to attach the object to.

3 Attach the work piece to the fixture. When asked whether to keep the current position, answer *No*.

4 Attach the work object in which you will program the work piece to either the fixture, the work piece or the positioner. If you have defined calibration positions on either the work piece or the fixture, it is a good practice to use that object. When asked whether to keep the current position, answer *No*.

The positioner is now set up and ready to be programmed, see *Programming external axes on page 131* for more information.

---

**Tip**

If the positioner is of an interchangeable type with several stations, you can either attach individual fixtures, work pieces and work objects to each station flange, or you can use one set of objects that you attach and detach to the different flanges by events.

---

**CAUTION**

If the system is I-started, the setup is deleted and the procedures described here must be performed again.
2 Building stations

2.8.3 Placing robots

Overview

When modifying the position of a robot connected to a VC there is a possibility to modify the related task frame or any stationary RAPID objects (tooldata, workobjects) connected to the robot.

Prerequisites

A robot library must be present in the station and connected to a VC, see Creating a station with a system on page 75.

Modifying the robot position using a positioning tool

1. Modify the baseframe position of a robot connected to a VC using any of the following options:
   - Set Position. See Positioning an item on page 485.
   - Place object by One Point, Two Points, Three Points, Frame, and Two Frames. See Placing an item on page 475.
   - Rotate. See Rotating an item on page 481.

2. Click Apply.

   To the question, Do you also want to move the Task Frame?. Click Yes or No.

   - Click Yes to move the task frame, but the base frame keeps its relative placement to the task frame.
   - Click No to move the base frame and the placement relative to the task frame will change.

Note

If there are any stationary RAPID objects (tooldata, workobjects) in the corresponding task, the following question appears Do you want to keep the positioning of all stationary RAPID objects?

   - Click Yes to keep all the stationary RAPID objects in their global coordinates.
   - Click No to move all the stationary RAPID objects along with the base frame (same coordinates relative to base frame). Workobjects attached to any other object in the station will not be affected. Workobjects attached to any other object in the station will not be affected.

If the base frame configuration of the VC is updated, the VC has to be restarted for the changes to take effect. i.e. if the base frame changes its placement relative to task frame, the following question appears Do you want to update the controller configuration and restart?

   - Click Yes to restart the controller and update the base frame configuration of the connected VC.
   - Click No if the base frame is not in accordance with the controller.
Modifying the robot position using Freehand move or rotate

1. Modify the baseframe position of a robot connected to a VC using the following Freehand options:
   - Move. See *Moving an item on page 242*.
   - Rotate. See *Rotating an item on page 243*.

For information on updating the robot baseframe, see *Updating the baseframe position on page 396*.

2. A warning message is displayed in the Output window.
This page is intentionally left blank
3 Programming robots

3.1 Workflow for programming a robot

Overview

In most cases, going through the workflow from start to finish is recommended, even if it possible to work in other sequences as well.

Synchronizing will save and load text files containing RAPID modules, and create RAPID programs from your station.

Prerequisites

Before creating a program for your robot, you should set up the station, including robots, work pieces and fixtures, in which your robot will work.

Programming a robot

The table below describes the workflow for programming a robot to perform the task you require.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create targets and paths</td>
<td>Create the targets and paths the robot requires to perform the work tasks. To create targets and paths, do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Create a curve to match your required shape. Then use the Create path from curve command to generate a path, complete with targets, along the shape you have created. See Curve on page 294 and AutoPath on page 223.</td>
</tr>
<tr>
<td></td>
<td>• Create targets at the requested positions, then create a path and insert the created targets into it. See Create Target on page 217, Teach Target on page 216 and Empty Path on page 222.</td>
</tr>
<tr>
<td>Check the target orientations</td>
<td>Make sure that the targets are oriented in the most efficient way for the tasks to be performed. If not, reorient the targets until you are satisfied. See Orientations on page 111.</td>
</tr>
<tr>
<td>Check reachability</td>
<td>Check that the robot and tool reach all targets in the path. See Testing positions and motions on page 122.</td>
</tr>
<tr>
<td>Synchronize the program to the virtual controller</td>
<td>Generates RAPID code from the RobotStudio items and enables the program to be simulated.</td>
</tr>
<tr>
<td>Perform text-based editing</td>
<td>If you need to edit the instructions or data created by RobotStudio, you can start the RAPID Editor. See Examples of using the RAPID editor on page 426.</td>
</tr>
<tr>
<td>Collision detection</td>
<td>Check that the robot or tool does not collide with the surrounding equipment or the fixtures. If it does, adjust the placements or orientations until no collisions occur. See Detecting collisions on page 137.</td>
</tr>
<tr>
<td>Test the program</td>
<td>Test the program by moving along the paths. See Testing positions and motions on page 122.</td>
</tr>
</tbody>
</table>
3 Programming robots

3.2 Workobjects

Creating a workobject

A workobject is a coordinate system used to describe the position of a work piece. The workobject consists of two frames: a user frame and an object frame. All programmed positions will be related to the object frame, which is related to the user frame, which is related to the world coordinate system.

For creating a workobject, see Workobject on page 214.

Modifying a workobject

For a procedure, see Modify Workobject on page 471.

Converting a frame to a workobject

You can create a new workobject from an existing frame. The converted workobject gets the same name and position as the selected frame.

For a procedure, see Convert Frame to Workobject on page 443.

Creating a frame by points

You can create a frame by specifying points on the axes of the coordinate system and letting RobotStudio calculate the placement and orientation of the frame’s origin.

For a procedure, see Frame from Three Points on page 212.
3.3 Jogging mechanisms

Jogging a robot

To check if the robot can reach all positions on the work piece, you can jog the TCP or the joints of the robot, either with the freehand commands of through dialog boxes. Jogging the robot close to its boundaries is best done with the latter method.

<table>
<thead>
<tr>
<th>To</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jog the joints of a robot</td>
<td>For freehand, see Jog Joint on page 244. For a dialog box, see Mechanism Joint Jog on page 457.</td>
</tr>
<tr>
<td>Jog the TCP of a robot</td>
<td>For freehand, see Jog Linear on page 245. For a dialog box, see Mechanism Linear Jog on page 459.</td>
</tr>
</tbody>
</table>

Prerequisites

To jog the TCP of a robot, the robot’s VC must be running.

Jogging several mechanisms

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mutlirobot jog</td>
<td>When using multirobot jog, all selected mechanisms will follow the TCP of the one being jogged. Multirobot jog is available for all kinds of jogging. See MultiRobot Jog on page 247.</td>
</tr>
</tbody>
</table>
| Jogging with locked TCP   | When jogging a mechanism that moves a robot (like a track external axis) with locked TCP, the robot will reposition so that the position of the TCP does not change, even though its baseframe is moved.  
When jogging an external axis that moves the work object with locked TCP, the robot will reposition so that its TCP follows the work object in the same way as when using multirobot jog.  
Locked TCP is available when jogging a mechanism that belongs to the same task as a robot.  
See Mechanism Joint Jog on page 457. |
3.4 Targets

Creating a target
You can create a new target manually either by entering the position for the target in the Create Target dialog box or by clicking in the graphics window. The target will be created in the active workobject.
For a procedure, see Create Target on page 217.

Creating a joint target
A joint target is a specification of the position for the robot axes.
For a procedure, see Create Jointtarget on page 219.

Teaching targets
You can create a new target by jogging the robot and teaching a target at the active TCP. Taught targets will be created with the axis configuration used when jogged to the target.
The target will be created in the active workobject.
For a procedure, see Teach Target on page 216.

Modifying a target position
By using the modify position command you can modify the position and rotation of a target.
For procedures, see Set Position on page 485 and Rotate on page 481, respectively.

Modifying a target with ModPos
The position of an existing target can be modified by jogging the robot to a new, preferred position. By selecting a move instruction for the target in a path, the ModPos command can be used to move the target to the TCP of the active tool.
When ModPos is executed, the target, referenced to by the move instruction, will be updated with the following information:
• position and orientation corresponding to the TCP of the active tool
• the current configuration of the active robot
• the current position and orientation values of all active external axes for the active robot

Note
To jog a robot linearly, a virtual controller must be running for that robot. For detailed information, see Starting a VC on page 85.

Renaming targets
With this command you can change the name of several targets at once. You can either rename targets individually, or you can rename all targets in one or several paths at once.
The new target names will consist of an optional prefix, an incremental number and an optional suffix.

For a procedure, see *Rename Targets on page 479*.

When renaming targets, make sure that the new targets conform to the naming rules. The target names must:

- start with an alphabetical character in the ISO 8859-1 encoding (that is, an ordinary letter from the English alphabet)
- be shorter than 16 characters
- not be empty strings
- not contain any characters illegal in RAPID. See *RAPID reference manual* for details.

### Removing unused targets

If deleting or changing paths or move instructions during programming, you might end up with large numbers of targets that are no longer used in any instructions. To make the workobjects and their targets easier to grasp, you can delete all unused targets.

For a procedure, see *Remove Unused Targets on page 478*. 

---

*3 Programming robots*

*3.4 Targets*

*Continued*
3 Programming robots

3.5 Paths

Creating an empty path

A path is a sequence of targets with move instructions that the robot follows. An empty path will be created in the active task.

For a procedure, see Empty Path on page 222.

Creating a path from curve

If the work piece has curves or contours that correspond to the path to be created, you can create the paths automatically. The create path from curve command generates paths, complete with targets and instructions along existing curves.

The path will be created in the active task.

The orientation of the targets that will be created will be according to the settings of the approach/travel vectors in the Options dialog box.

To create a path from a curve, the curve must have first been created in the station. See AutoPath on page 223.

Setting robot axis configuration for paths

The robot axis configuration specifies the position of the axes as the robot moves from target to target, when multiple solutions are possible. This is necessary for executing move instructions using configuration monitoring.

Taught targets have validated configurations, but targets created in any other way do not. Also, targets that are repositioned lose their configuration. In RobotStudio, targets without a valid configuration are marked with a yellow warning symbol. See Robot axis configurations on page 34 for more information about configurations.

To set a configuration for all targets in a path, see Configurations on page 439.

To set a configuration for a single target, see Configurations on page 442.

Reversing paths

The reverse path commands change the sequence of targets in the path so that the robot moves from the last target to the first. When reversing paths, you can reverse either the target sequence alone or the entire motion process.

For procedures, see Reverse Path on page 480.

Note

When reversing paths, the original paths are deleted. If you want to keep them, make copies before reversal.

Note

When reversing paths, only move instructions are handled. Action instructions, if any exist, have to be inserted manually after the reversal.
3 Programming robots

3.5 Paths

Continued

Rotating paths

With the rotate path command you can rotate complete paths and move the targets used by the paths accordingly. When rotating paths, the included targets will lose their axis configurations, if any have been assigned.

A frame or target must exist at the position to rotate around before starting the rotate path command.

For a procedure, see Rotate Path on page 482.

Translating a path

The translate path function moves a path and all included targets.

For a procedure, see Translate Path on page 487.

Compensating paths for tool radius

You can offset a path so that it compensates for the radius of a rotating tool. Since the targets in the path are moved, they will lose their axis configurations, if any have been assigned.

For a procedure, see Tool Compensation on page 486.

Interpolating a path

The interpolate functions reorient the targets in a path so that the difference in orientation between the start and end targets is distributed evenly among the targets in between. The interpolation can be either linear or absolute.

Linear interpolation distributes the difference in orientation evenly, based on the targets’ positions along the length of the path.

Absolute interpolation distributes the difference in orientation evenly, based on the targets’ sequence in the path.

Below are examples of the difference between linear and absolute interpolation. The interpolate functions reorient the targets in a path so that the difference in orientation between the start and end targets is distributed evenly among the targets in between. The interpolation can be either linear or absolute.

For a procedure, see Interpolate Path on page 452.

No interpolation

This is the path before any interpolation. Note that the last target is oriented differently than the others.
Linear interpolation

This is the same path after linear interpolation.

Note that the targets are oriented based on their placement relative to the start and end targets.

If a target were moved and you reran the linear interpolation, it would be reoriented according to its new position.

If new targets were inserted between the existing ones and you reran the linear interpolation, it would not affect the orientation of the existing targets.

Absolute interpolation

This is the same path after absolute interpolation.

Note that the targets are orientated based on their sequence in the path: each target has been reoriented equally, regardless of its place.

If a target were moved and you reran the absolute interpolation, it would not affect the orientation.

If new targets were inserted between the existing ones and you reran the absolute interpolation, it would change the orientation of all targets.

Mirroring a path

The mirror path function mirrors all motions instructions and their targets to a new path.

For a procedure, see Mirror Path on page 460.
3.6 Orientations

Overview

This is an overview of the tools for automating the modification of target orientations. When creating paths from curves in RobotStudio, the orientation of the targets depends on the characteristics of the curves and the surrounding surfaces. Below is an example of a path with unordered target orientations and examples of how the different tools have affected the targets.

Unordered orientations

In the path below, the target orientations are unordered. The function View tool at target has been used for illustrating how the targets point in different directions.
Effect of target normal to surface

In the picture below, the targets, which previously were orientated randomly, have been set normal to the flat round surface at the right side of the path. Note how the targets’ Z axis has been orientated normal to the surface; the targets have not been rotated in the other directions.

Setting a target normal to surface

To set a target orientation normal to a surface is to make it perpendicular to the surface. The target can be oriented normal to the surface in two different ways:

- The entire surface can be used as a reference for the normal. The target will be oriented as the normal to the closest point at the surface. The entire surface is the default surface reference.
- A specific point on the surface can be used as the reference for the normal. The target will be orientated as the normal to this point, regardless of whether the normal to the closest point at the surface has another orientation.

Objects imported without geometry (for example, .jt files) can only refer to specific points on the surface.

For a procedure, see Set Normal to Surface on page 484.
Effect of align target orientation

In the picture below, the targets, which were previously orientated with the Z axis normal to the surface but with the X and Y axes orientated randomly, have been organized by aligning the targets’ orientation around the X axis with the Z axis locked. One of the targets in the path has been used as reference.

Aligning a target orientation

With the align target orientation command you align the rotation of selected targets around one axis without changing the rotation around the others.

For a procedure, see Align Target Orientation on page 437.

Tip

You can also align ordinary frames in the same way.
Effects of copy and apply orientation

In the picture below, the targets, which were previously oriented randomly, have been organized by copying the exact orientation of one target to all the others. This is a quick way to fix workable orientations for processes where variations in approach, travel, or spin directions either do not matter or are not affected, due to the shape of the work piece.

Copying and applying an orientation for objects

To transfer an orientation from one object to another is an easy way to align different frames for simplifying the programming of the robot. Target orientations may also be copied.

For procedures, see Copy / Apply Orientation on page 445.
3.7 RAPID Instructions

Note
For information on the RAPID Editor, which is used for creating and modifying RAPID program code, see RAPID tab on page 399.

Move and action instructions

For RAPID programming, RobotStudio’s main advantage is in the area of motion programming.

A move instruction is an instruction for the robot to move to a specified target in a specified manner. With RobotStudio, you can create move instructions in three ways:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a move instruction based on an existing target</td>
<td>Creates move instructions based on one or several targets selected in the Paths&amp;Targets browser. For a procedure, see Add to Path on page 435.</td>
</tr>
<tr>
<td>Create a move instruction and a corresponding target</td>
<td>Creates a move instruction and a corresponding target at once. The position of the target can either be selected from the graphics window or typed numerically. For a procedure, see Move Instruction on page 234.</td>
</tr>
<tr>
<td>Teach a move instruction</td>
<td>Teaching a move instruction creates a move instruction and a corresponding target at the robot's current position. Teaching a move instruction also stores the current configuration with the target. For a procedure, see Teach Instruction on page 233.</td>
</tr>
</tbody>
</table>

In addition to move instructions, you can also create and insert action instructions from RobotStudio. An action instruction is an instruction other than a move instruction that can, for example, set parameters, or activate or deactivate equipment and functions. The action instructions available in RobotStudio are limited to those commonly used for affecting the robot’s motions. For inserting other action instructions or another kind of RAPID code in the program, use the RAPID Editor. For a procedure, see Action Instruction on page 235.

The table below lists the action instructions that can be created. For details, see the RAPID Reference Manual.

<table>
<thead>
<tr>
<th>Action instruction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConfL On/Off</td>
<td>ConfL specifies whether to monitor the robot’s configurations during linear movements. When ConfL is set to Off, the robot may use another configuration than the programed one for reaching the target during program execution.</td>
</tr>
<tr>
<td>ConfJ On/Off</td>
<td>ConfJ specifies whether to monitor the robot’s configurations during joint movements. When ConfJ is set to Off, the robot may use another configuration than the programed one for reaching the target during program execution.</td>
</tr>
<tr>
<td>Actunit UnitName</td>
<td>Actunit activates the mechanical unit specified by UnitName.</td>
</tr>
<tr>
<td>DeactUnit UnitName</td>
<td>Deactunit deactivates the mechanical unit specified by UnitName.</td>
</tr>
</tbody>
</table>

Continues on next page
3 Programming robots

3.7 RAPID Instructions

Continued

<table>
<thead>
<tr>
<th>Action instruction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConfJ On/Off</td>
<td>ConfJ specifies whether to monitor the robot's configurations during joint movements. When ConfJ is set to Off, the robot may use another configuration than the programed one for reaching the target during program execution.</td>
</tr>
<tr>
<td>Actunit UnitName</td>
<td>Actunit activates the mechanical unit specified by UnitName.</td>
</tr>
<tr>
<td>DeactUnit UnitName</td>
<td>Deactunit deactivates the mechanical unit specified by UnitName.</td>
</tr>
</tbody>
</table>

Modifying an instruction

Most instructions have arguments that specify how the instruction shall be carried out. For example, the MoveL instruction has arguments that specify the speed and accuracy with which the robot moves to the target.

For a procedure, see Modify Instruction on page 468.

Note

Some arguments are read from the virtual controller. If the virtual controller has not been started, only the arguments stored in the station can be modified.

Converting to move circular

To create a circular motion to an instruction target, you must convert the motion type to circular motion (that is, MoveC in RAPID).

A circular motion is defined by two motion instructions, where the first is the via-point and the second contains the end point of the circular motion.

The circular motion can only be used for open circular arcs, not for closed circles. To create a path for a closed circle, use two circular motions.

For a procedure, see Convert to Move Circular on page 444.

Creating RAPID instructions for setting I/O signals

For controlling I/O signals in the robot program, you use RAPID commands that set the signals. These require that you first create instruction templates for the instructions that set the signals. See RAPID reference manual for details about the instructions that control I/O signals.

To add RAPID instructions that set I/O signals, follow these steps:

1. Synchronize the system in which you want to add the instructions to the virtual controller, see Synchronization on page 134.

2. In programming mode, select the module for editing, right-click it and then click Edit program.

3. In the RAPID editor, add the instructions for setting the signals.

4. When you are done adding instructions, synchronize the task and paths from the Virtual Controller back to the station.

Continues on next page
Using cross-connections and groups for setting I/O signals

You can also create cross-connections and signal groups, which make one signal set the value of several other signals. See System parameters reference manual for details about cross-connections and groups.

To make one signal set several others, follow these steps:

1. Request write access, and then open the configuration topic I/O in the configuration editor. Add configure instances for the cross-connections and groups to create.

Instruction templates

Instruction templates contain predefined sets of argument values that are applied to the instructions you create using the template. You can create templates for all instructions in the system running on the virtual controller. To see which instructions are available and what their arguments do, see the RAPID reference manual for your RobotWare version and the reference sections in manuals for software options, if you have any installed on the system.

*Move instruction templates* are always part of *process templates*. The process templates contain one instruction template for each type of move instruction that might be used by the process.

The *process templates* are instances of *process definitions*, which define the types of move instructions (*move instruction definitions*) that might be used by the process.

To create new move instruction templates, start by creating a new process template for a process that uses the type move instructions you want to create templates for. If such a process does not exist, you first have to create a new process definition.

If no *move instruction definition* for the type of instruction you want to create a template for exists, you must create it first.

When creating instruction descriptions, the virtual controller must be running, since the available instruction types are read from the system.

Templates can be imported and exported on four levels: tasks, move instruction descriptions, action instruction descriptions and process definitions. The default directory for imported and exported template files is *My Documents/RobotStudio*. Simply choosing another directory will then make that directory default. As a default .xml is the file format.

The validation procedure checks for duplicate names, incomplete process definitions and virtual controller equality. It is performed automatically, after a template file has been imported or a node renamed or deleted.

For procedures, see Instruction Template Manager on page 236.

Instruction Template Manager

The Instruction Template Manager is used to add support for instructions other than the default set that comes with the RobotStudio.

For example, a robot controller system with the RobotWare Dispense option has specialized move instructions related to gluing like DispL and DispC. You can

Continues on next page
manually define the instruction templates for these using the Instruction Template Manager. The instruction templates are exported to XML format and reused later. The instruction template supports the following Robotware options:

- Cap (Continuous Application Process)
- Disp (Dispense)
- Trigg (Fixed Position Events)
- Spot Pneumatic
- Spot Servo
- Spot Servo Equalizing
- Paint

RobotStudio has pre-defined XML files that are imported and used for robot controller systems with the appropriate RobotWare options. These XML files have both the Move and Action instructions.

**Note**

Use RobotStudio ArcWelding PowerPac while using RobotWare Arc.

### Creating a process template with move instruction templates

**Note**

Move instructions are always related to processes.

1. On the Home tab, from the active Task list, select the task for the robot for which you want to create the instruction template.

2. On the Create menu, click Instruction Template Manager. This opens the Instruction templates page in the work space.

3. In the Instruction Templates tree to the left, make sure there are move instruction definitions for the types of move instructions you want to create templates for. If not, follow the procedure in Creating a move instruction description on page 119 for creating them.

4. Make sure there is a process definition that uses the types of move instructions you want to create templates for. If not, follow the procedure in Creating a process definition on page 119 for creating it.

5. Right-click the process definition for which you want to create a new templates and click Create Process Definition.

6. In the Create Process Definition dialog box, enter a name, with characters from ASCII set, for the new template and click Create. A new process template node with a set of move instruction templates is now created.

7. Select each new template one at a time, and in the arguments grid to the right of the tree view, set the argument values that shall be applied when you create new instructions based on the template. Finish for each template by clicking Apply changes at the bottom of the grid.

Continues on next page
Creating a move instruction description

To create templates for other instructions than the one that already exists in the tree view, you first have to create an instruction description that defines the arguments that belong to the instruction. To create the instruction description, follow these steps:

1. Right-click the Move Instructions node and click Create Move Instruction Description. This opens the Create Move Instruction Description dialog box.
2. In the Controller Description list, select the instruction you want to make a description for. All action instructions installed on the controller, both through RobotWare and software options, are available.
3. In the Motion type list, select the motion type for the instruction.
4. Optionally, in the Information text box, enter a comment to the instruction.
5. Click Create. The instruction description appears in the tree view and its settings are displayed in the grid.
6. In the instruction grid, set the point type values. If necessary, also change the other settings.
7. After changing the settings, click Apply Changes in the bottom of the grid view.

Editing an instruction template

To edit an instruction template, follow these steps:

1. In the active task list, select the task for the robot for which you want to edit the instruction template.
2. On the Create menu, click Instruction Template Manager. This opens the Instruction templates page in the work space.
3. In the Instruction Templates tree to the left, browse to and select the template to edit.
4. In the arguments grid to the right of the tree view, set the argument values that shall be applied when you create new instructions based on the template. Finish by clicking Apply changes at the bottom of the grid.

For details about available arguments and what they do, see the RAPID reference manual for ordinary RAPID instructions and the option manual for software option instructions.

Creating a process definition

To create a process definition, follow these steps:

1. Make sure there are move instruction definitions for the types of move instructions you want to create templates for. If not, follow the procedure above for creating them.
2 Right-click the Process definitions node and click Create Process Definition. This opens the Create Process Description dialog box.

3 In the Create Process Definitions dialog box, enter a name for the process definition, a name for its first process template and then select the move instruction types to use. Finish by clicking Create.

Creating an action instruction template

To create a template for an action instruction, follow these steps:

1 In the active task list, select the task for the robot for which you want to create the instruction template.

2 On the Home menu, click Instruction Template Manager.

3 In the Instruction Templates tree to the left, right-click the instruction description (corresponding to the instructions as described in the RAPID reference manual) for which you want to create a new template and click Create Action instruction Template.

   If the instruction description does not exist in the tree, create it by following the procedure described in Creating an action instruction description on page 120.

4 In the Create Action Instruction Template dialog box, enter a name for the new template and click Create. The new template is now created under the instruction description node it belongs to.

5 Select the new template and in the arguments grid to the right of the tree view, set the argument values that shall be applied when you create new instructions based on the template. Finish by clicking Apply changes at the bottom of the grid.

   For details about available arguments and what they do, see the RAPID reference manual for ordinary RAPID instructions and the option manual for software option instructions.

Creating an action instruction description

To create templates for other instructions than the one that already exists in the tree view, you first have to create an instruction description that defines the arguments that belong to the instruction.

To create the instruction description, follow these steps:

1 Right-click the Action Instructions node and click Create Action Instruction Description. This opens the Create Instruction Description dialog box.

2 In the Controller Description list, select the instruction you want to make a description for. All action instructions installed on the controller, both through RobotWare and software options, are available.

3 Optionally, in the Information text box, enter a comment to the instruction.

4 Click Create. The instruction description appears in the tree view, and its settings are displayed in the grid.

   After changing the settings (if necessary), click Apply Changes in the bottom of the grid view.
5 Continue with creating templates for the instruction description, as described in *Creating an action instruction template on page 120.*
3 Programming robots

3.8 Testing positions and motions

Overview

RobotStudio has several functions for testing how robots reach and move to targets. They are useful both for finding the optimal layout when building a station and during programming.

Below are brief descriptions of the functions for testing reachability and motions.

Checking reachability

The check reachability function displays whether the robot can reach selected targets and motion instructions by changing the frames' colors in the graphic view. Reachable frames are colored green, unreachable red, and frames with reachable positions but not with current orientation are colored yellow.

The reachability check is useful when building the station, since the reachability of several targets are displayed at once. For a procedure, see Check Reachability on page 441.

Jumping to target

Jump to target tests whether the robot can reach a specific position. This is useful when building the station: by creating targets at critical positions on the work piece and jumping the robot to them, you get an early indication of whether the items are positioned correctly or not. For a procedure, see Jump to Target on page 454.

Viewing a robot at target

When View robot at target is activated, the robot is automatically positioned with the tool at the target when one is selected. If several robot axis configurations are possible for reaching the target, the robot will use the one nearest the configuration it had before jumping to the target. For a procedure, see View Robot at Target on page 488.

Viewing tool at target

View tool at target displays the tool at target, without checking that the robot can reach it. This test is useful both when building the station and when programming the robot, since the orientation of targets both affects the reachability and the process performance. For a procedure, see View Tool at Target on page 489.

Executing move instructions

Execute move instruction tests if the robot can reach a specific position with the programed motion properties. This is useful for testing motions during programming. For detailed information, see Execute Move Instruction on page 447.

Moving along path

Move along path executes all move instructions in a path. It is thereby a more complete test than Execute move instructions, but not as complete as a full simulation, since it ignores RAPID code that is not move instructions. For a procedure, see Move Along Path on page 472.

Continues on next page
Moving to a pose

Moving to a pose moves a mechanism to a predefined joint value at a predefined time without using the Virtual Controller. This is useful when movement of the external equipment (such as a clamp or conveyer) must be simulated. For a procedure, see Move to Pose on page 473.

Simulating programs

Simulating programs involves running a program on the virtual controller as it is run on a real controller. It is the most complete test whereby you can see how the robot interacts with external equipment through events and I/O signals. For a procedure, see Simulation Setup on page 319.

Improving the reachability

If the robot cannot reach the target, or if you are not satisfied with the motions, try the following for improving the reachability:

1. Set ConfL or ConfJ to Off for enabling the robot to use new configurations for reaching the target.
2. Change the orientation of the target.
3. Change the position of either the robot or the work piece.
4. Use a system with a track external axis for increasing the robot’s range.
5. Use a system with a positioner external axis for enabling different work piece positions for different targets.
Programming MultiMove systems

3.9.1 About programming MultiMove

About MultiMove

The MultiMove functions help you create and optimize programs for MultiMove systems where one robot or positioner holds the work piece and other robots operate on it. Below is an outline of the main workflow for programming MultiMove systems with RobotStudio, with references to detailed instructions further down in the section.

Prerequisites

For using the MultiMove functions you must first have the following:

- A virtual controller running a MultiMove system started in RobotStudio, see A MultiMove system with two coordinated robots on page 171 for an example.
- All coordinate systems and tools used by the system.
- The paths along which the tool shall move. The paths must be created in a work object that belongs to a tool robot and is attached to the work piece robot. A wizard will guide you through attaching the work objects if this has not been done before starting the MultiMove functions.

For detailed information about MultiMove in RobotWare systems and RAPID programs, see MultiMove application manual.

Normal workflow

This is the typical workflow for creating MultiMove programs using the MultiMove function:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up the MultiMove</td>
<td>Select the robots and paths to use in the program, see Setting up the MultiMove on page 126.</td>
</tr>
<tr>
<td>Testing the MultiMove</td>
<td>Execute the motion instructions along the paths, see Testing the MultiMove on page 127.</td>
</tr>
<tr>
<td>Tuning the motion behavior</td>
<td>Tune motion behavior, such as tolerances and constraints for TCP motions, see Tuning the motion behavior on page 128.</td>
</tr>
<tr>
<td>Creating the program</td>
<td>Generate the tasks for the robots, see Creating paths on page 130.</td>
</tr>
</tbody>
</table>

Continues on next page
Additional actions

In addition to using the functions that calculate and create optimized MultiMove paths, you can program MultiMove manually using a combination of the ordinary programming tools in RobotStudio and a set of tools specific for MultiMove programming.

The main actions for programming MultiMove manually are outlined below. Not all actions might be necessary, but the order in which they shall be carried out depends on the contents of the station and your goals.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Tasklists and Syncidents</td>
<td>This data specifies the tasks and paths that shall be synchronized with each other. See The Create Tasklist tool on page 232 and The Create Syncident tool on page 232, respectively.</td>
</tr>
<tr>
<td>Adding and updating ID arguments to the instructions to synchronize</td>
<td>To add IDs to the instructions, you can use one of the following methods: Using The Recalculate ID tool on page 231 to add and update IDs for instructions in paths that already are synchronized. Using The Convert path to MultiMove path tool on page 232 to add IDs to instructions in paths that have not yet been synchronized.</td>
</tr>
<tr>
<td>Adding and adjusting Sync instructions to the paths.</td>
<td>Add SyncMoveon/Off or WaitSyncTask instructions to the paths to synchronize and set their tasklist and Syncident parameters. See Creating an action instruction on page 235.</td>
</tr>
<tr>
<td>Teaching MultiMove instructions</td>
<td>It is also possible to jog all robots to the desired positions and then teach instructions to new synchronized paths. See MultiTeach tab on page 228.</td>
</tr>
</tbody>
</table>
3 Programming robots

3.9.2 Setting up the MultiMove

3.9.2 Setting up the MultiMove

Selecting robots and paths

This procedure is for selecting the robots and paths in the station that shall be used for the MultiMove program. All robots for the MultiMove program must belong to the same system.

1. On the Home tab, click MultiMove. Click the Setup tab below the MultiMove work area.
2. In the work area, click the System config bar for expanding the system config section.
3. In the Select System box, select the system that contains the robots to program.
   The robots of the selected system are now displayed in the System grid below the Select system box.
4. For each robot that shall be used in the program, select the check box in the Enable column.
5. For each robot that shall be used in the program, specify whether it carries the tool or the work piece using the options in the Carrier column.
6. In the work area, click the Path config bar for expanding the path config section.
7. Select the Enable check box for the tool robot and click the expand button. This displays the paths of the robot.
8. Select the order of the paths to execute by specifying them in right order using Path name column.
9. For each path that shall be included in the program, select the check box in the Enable column.
10. When you have set up the robots and paths, continue testing the Multimove and then tune the motion properties, if necessary.
3.9.3 Testing the MultiMove

Overview

Testing the MultiMove executes the motion instructions along the paths according to the current settings on the setup and motions properties pages.

Testing Paths

This procedure is for setting the robots start position and testing the resulting movements along the path sequence.

1. Jog the robots to what seems to be a good start position.
2. On the Home tab, click MultiMove. Click the Test tab at the bottom of the MultiMove work area for displaying the test area.
3. Optionally, select the Stop at end check box to make the simulation stop after moving along the paths. Clearing this check box makes the simulation continue in a loop until you click Pause.
4. Click Play to simulate the motions along the paths based on the current start position.

If you are satisfied with the motions, continue generating multimove paths.

If the simulation cannot complete or if you are not satisfied with the motions, pause the simulation and perform any of the actions below to adjust the motions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examine the robots’ positions for critical targets.</td>
<td>Click Pause and then use the arrow buttons to move to one target a time.</td>
</tr>
<tr>
<td>Jog the robots to new start positions.</td>
<td>New start positions might result in changed motions, since the robots will use different configurations. In most cases, positions near the robots’ joint limits shall be avoided.</td>
</tr>
<tr>
<td>Go to the Motion Behavior tab and remove constraints.</td>
<td>The default setting for the motion properties is no constraints. If this has been changed, constraints might exist that limit motions more than necessary.</td>
</tr>
</tbody>
</table>
Tuning the motion behavior means to set up rules for the robot’s motions, for example, constraints on the position or orientation of the tool. Generally, the MultiMove program will obtain the smoothest motions with the fastest cycle and process times with as few constraints as possible.

For procedures, see Motion Behavior tab on page 225.

Modifying the joint influences
The joint influence controls the balance of how much the robots will use their joints. Decreasing the weight value for one axis will restrict the motion for this axis, while increasing it will promote motion on this axis relative to alternative axes.

1. On the Home tab, click the Motion Behavior tab.
2. Expand the Joint Influence group by clicking its title bar.
3. In the Select Robot box, select the robot whose joint influence you want to modify.
   - The weight values for the robot axes are now displayed in the grid.
4. For each axis whose motion you want to restrict or promote, adjust the Weight value. A lower value restricts, and a higher value promotes, motions on that axis.

Modifying the TCP constraints
The joint influence controls the balance of how much the robots will use their joints. Decreasing the weight value for one axis will restrict the motion for this axis, while increasing it will promote motion on this axis relative to alternative axes.

1. On the Simulation tab, click the Motion Behavior tab.
2. Expand the TCP Constraints group by clicking its title bar.
   - The directions and rotations in which you can constrain the TCP’s motion are now displayed in the grid.
3. For each pose you want to constrain, select the Enable check box and specify the constraint values (location in the TCP coordinate system). To use the values from the current TCP position, click Pick from TCP.
4. Optionally, adjust the Weight value for the constraint. A low value results in a harder constraint, while a high value allows a larger deviation.

Modifying the tool tolerance
The joint influence controls the balance of how much the robots will use their joints. Decreasing the weight value for one axis will restrict the motion for this axis, while increasing it will promote motion on this axis relative to alternative axes.

1. On the Simulation tab, click the Motion Behavior tab.
2. Expand the Tool Tolerance group by clicking its title bar.
   - The directions and rotations in which you can enable tolerances are now displayed in the grid.

Continues on next page
For each offset you want to set, select the Enable check box.

In the Value column, specify the allowed deviation.

Optionally, adjust the Weight value for the tolerance. A low value increases the use of the tolerance, while a high value promotes motions that do not use the tolerance.

Modifying the tool offset

The tool offset sets a fixed distance between the tool and the paths.

1. On the Simulation tab, click the Motion Behavior tab.
2. Expand the Tool Offset group by clicking its title bar.
   The directions and rotations in which you can set offsets are now displayed in the grid.
3. For each offset you want to set, select the Enable check box.
4. In the Offset column, specify the offset distance.
3 Programming robots

3.9.5 Creating paths

3.9.5 Creating paths

Overview

When you are satisfied with the motions displayed when testing the Multimove program, the next step is to convert the temporary move instructions used by the MultiMove function to ordinary paths in RobotStudio.

Creating the paths

To create paths for the MultiMove program in RobotStudio, follow these steps:

1. On the Home tab, click Create Paths tab.
2. Expand the Settings group by clicking on its title bar.
3. Optionally, change the naming settings in the following boxes:

<table>
<thead>
<tr>
<th>Box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start ID</td>
<td>Specify the first ID number for the synchronization of the instructions for the robots.</td>
</tr>
<tr>
<td>ID step index</td>
<td>Specify the increment between ID numbers.</td>
</tr>
<tr>
<td>Sync ident prefix</td>
<td>Specify a prefix for the syncident variable, which connects the sync instructions in the tasks for the tool robot and the work piece robot with each other.</td>
</tr>
<tr>
<td>Task list prefix</td>
<td>Specify a prefix for the tasklist variable, which identifies the tasks for the tool robot and the work piece robot to synchronize.</td>
</tr>
</tbody>
</table>

4. Expand the WP Robot Settings group by clicking on its title bar and then check the settings in the following boxes:

<table>
<thead>
<tr>
<th>Box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WP Workobject</td>
<td>Specify the workobject to which the targets generated for the workpiece robot shall belong.</td>
</tr>
<tr>
<td>WP TCP</td>
<td>Specify which tooldata the workpiece shall use when reaching its targets.</td>
</tr>
<tr>
<td>Path prefix</td>
<td>Specify a prefix for the generated paths.</td>
</tr>
<tr>
<td>Target prefix</td>
<td>Specify a prefix for the generated targets.</td>
</tr>
</tbody>
</table>

5. Expand the Generate path group by clicking on its title bar and then click Create Paths.
3.10 Programming external axes

Overview

This is a brief overview of the functions and commands for programming external axes in RobotStudio. For a more detailed description of external axes and how to program them, see the product manual for the external axis to use and the RAPID reference manual.

Coordinated motions

Normally, external axes are used to move the workpiece, the robot or any other mechanism. The motions of an external axis can be coordinated with those of a robot in two ways, depending on the task in which the external axis is defined.

<table>
<thead>
<tr>
<th>Task for external axis</th>
<th>Coordination method</th>
</tr>
</thead>
</table>
| Same task as the robot’s | If the external axis is in the same task as the robot, the current position of active external axes is stored with each target that is created. When the robot then moves to the target, the external axis will move to the stored position as well.  
Modifying and optimizing the position of positioner external axes can be automated using the MultiMove function, or be performed manually for selected targets. Positions of track external axes can only be modified manually.  
For information about using the MultiMove function, see About programming MultiMove on page 124. For information about how to modify the position of external axes manually, see below. |
| Other task than the robot’s | If the external axis is in another task than that of the robot it shall be coordinated with, the motions of the external axis are created by MoveExt instructions, and the coordination is made by sync instructions.  
For positioner external axes creating or optimizing MoveExt and sync instructions can be automated way using the MultiMove function, or be performed manually by creating a path with MoveExt instructions for the positioner and then adding sync instructions to the path for the robot and the external axis.  
Track external axes can only be programed manually.  
For information about using the MultiMove function see About programming MultiMove on page 124. For information about how to use the sync instructions, see RAPID reference manual and MultiMove application manual. |

Modifying positions of external axes

When programming external axes, you often need to adjust the position of the external axis for some targets. For example, if you create a path from curves on a work piece that is attached to a positioner, the positioner will initially have the same position for all targets. By repositioning the work piece for some of the targets you might improve process time and reachability.

When targets are created in stations with a coordinated external axis, the position values of the external axis are stored in the target. With the Modify External Axis function you can reposition the external axis, thus making it possible for the robot to reach the target in new ways. For a procedure, see Modify External Axis on page 467.
To modify the external axis values for a target, the following conditions must be met:

- The external axis must be added to the system and set up correctly. For examples of how to add support for an external axis to a system, see A system with support for one robot and one positioner external axis on page 173. For information about how to set up an external axis in a RobotStudio station, see Placing external axes on page 98.
- The external axis must be defined in the same task as the robot.
- The external axis must be activated.

**Activation and deactivation**

Activating a mechanical unit makes it controlled and monitored by the controller. Consequently, the mechanical unit must be activated before programming or running programs. If a system uses several external axes or interchangeable models with several work stations, several mechanical units might share common drive units. If this is the case, you must make sure to set the mechanical unit as active.

For more information about activating and deactivating mechanical units, see RAPID reference manual on the instructions ActUnit and DeactUnit.

Activating and deactivating mechanical units can be done either manually, see Activate Mechanical Units on page 329, or programmatically by RAPID instructions, see below.

**To activate or deactivate mechanical units programmatically**

To set the mechanical units to be active programmatically by RAPID instructions, follow these steps:

1. In the Paths&Targets browser, browse down to the path in which you want to insert the activation or deactivation instruction. To insert it as the first instruction in the path, select the path node and to insert it between existing instructions, select the instruction before the intended insertion point.
2. On the Home tab, click Action Instruction to bring up a dialog box.
3. In the Instruction Templates list, select one of the ActUnit or DeactUnit instructions.
4. In the Instruction Arguments grid and the MechUnit list, select the unit to activate or deactivate.
5. Click Create. When the path is executed either through the Move along path command, or running the RAPID program, the instruction will be carried out.
3.11 Loading and saving programs and modules

Overview
RAPID programs and modules are normally stored in the RobotWare systems, as they are created. You can also save the programs to files on the PC, which makes it possible to load them to other controllers, either other virtual controllers or real IRC5 controllers.

Programs are saved from the VC
When saving a program to files on the PC from RobotStudio, it is the RAPID program stored in the system of the VC that is saved. This program is created and updated by synchronizing the station to the VC, see Synchronize to VC on page 401.

Procedures
To create or load a module or load a program, see:
- Creating a new RAPID module on page 409
- Loading a RAPID module on page 409
- Loading a RAPID program on page 413

To save a module or program, see:
- Saving a RAPID module as another on page 409
- Saving a program on page 413
3.12 Synchronization

Overview

To synchronize is to make sure that the RAPID program in the system running on the virtual controller corresponds to the programs in RobotStudio. You can synchronize both from RobotStudio to the virtual controller and from the virtual controller to RobotStudio.

In a RobotStudio station, robot positions and movements are defined by targets and move instructions in paths. These correspond to data declarations and RAPID instructions in the modules of the RAPID program. By synchronizing the station to the virtual controller, you create RAPID code out of the data in the station. By synchronizing the virtual controller to the station, you create paths and targets out of the RAPID program in the system running on the virtual controller.

When to synchronize the station to the VC

Synchronizing the station to the VC updates the RAPID program of the virtual controller with the latest changes in the station. This is useful to do before:

- Performing a simulation.
- Saving a program to files on the PC.
- Copying or loading RobotWare systems.

To synchronize a station to the VC, see *Synchronize to VC on page 401*.

When to synchronize the VC to the station

Synchronizing the VC to the station creates paths, targets and instructions that correspond to the RAPID program in the system running on the virtual controller. This is useful to do when you have:

- Started a new virtual controller which system contains existing programs.
- Loaded a program from a file.
- Text-edited the program.

To synchronize the VC to a station, see *Synchronize to Station on page 400*.
4 Simulating programs

4.1 Simulation Overview

About this chapter

This chapter describes how to simulate and validate robot programs. Below are short introductions to the simulation functions in RobotStudio.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play simulations</td>
<td>Simulations run entire robot programs on a virtual controller. Before you run a simulation you need to decide which paths are to be simulated. To set up a simulation, see Simulation Setup on page 319. To run a simulation, see Simulation Control on page 330.</td>
</tr>
<tr>
<td>Collision detection</td>
<td>Collision detection displays and logs collisions and near-misses for specified objects in the station. Normally used during simulation of robot programs, it can also be used when building the station. For more information, see Detecting collisions on page 137.</td>
</tr>
<tr>
<td>Event handling</td>
<td>Events can be used to connect an action to a trigger. For example, you can attach one object to another when they collide or a signal is set. For more information, see Creating an event on page 140.</td>
</tr>
<tr>
<td>I/O Simulation</td>
<td>In simulations I/O signals are normally set either by the robot program or by events. With the I/O simulator you can set signals manually, which provides a quick test of specific conditions. For more information, see Simulating I/O signals on page 141.</td>
</tr>
<tr>
<td>Simulation Monitoring</td>
<td>With the simulation monitoring functions you enhance the simulation by adding traces along the TCP movements or alerts triggered by defined speeds or motions. For more information, see Enabling simulation monitoring on page 142.</td>
</tr>
<tr>
<td>Process time measurement</td>
<td>With the process timer you measure the time for a process to complete. For more information, see Measuring simulation time on page 143.</td>
</tr>
</tbody>
</table>

Time handling during simulation

When simulating stations with events or several controllers, or other time managing equipment, time can be managed in two modes: either as free runtime or as time slices. RobotStudio uses time slice mode by default, but you can switch to free runtime, if required.

Free runtime

Since all controllers use the same computer resources, their synchronization might not be exactly as in the real world if they run independently of each other (called free run mode). The cycle time will be correct, but the timing for setting signals and triggering events might be inaccurate.

Continues on next page
4 Simulating programs

4.1 Simulation Overview

Continued

Time Slice

Time slices can be used to ensure that the timing for signals and other interaction between controllers is accurate. In this mode, RobotStudio synchronizes the controllers by dividing a time segment into small slices and waiting for all controllers to complete a current time slice before any controller can start anew. Thus, the controllers are synchronized, and the cycle time will be calculated correctly. The drawbacks are that the virtual FlexPendant cannot be open, and that the simulation might be somewhat slow and jerky, depending on the complexity of the simulation and the performance of the computer.

Note

If the simulation uses events or involves several different controllers, the virtual time mode Time Slice shall be used to make sure that the timing between the controllers is correctly simulated.
4.2 Detecting collisions

Overview

With RobotStudio you can detect and log collisions between objects in the station. The basic concepts of collision detection are explained below.

Collision sets

A collision set contains two groups, Objects A and Objects B, in which you place the objects to detect any collisions between them. When any object in Objects A collides with any object in Objects B, the collision is displayed in the graphical view and logged in the output window. You can have several collision sets in the station, but each collision set can only contain two groups.

A common use of collision sets is to create one collision set for each robot in the station. For each collision set you then put the robot and its tool in one group and all objects you do not want it to collide with in the other. If a robot has several tools, or holds other objects, you can either add these to the robot’s group as well or create specific collision sets for these setups.

Each collision set can be activated and deactivated separately.

Collisions and near-misses

In addition to collisions, the collision detection can also watch for near-misses, which is when an object in Objects A comes within a specified distance from an object in Objects B.

Recommendations for collision detection

In general, the following principles are recommended to facilitate collision detection:

- Simplify and defeature your models by removing everything that is not necessary for simulation purposes.
- Use as small collision sets as possible, splitting large parts and collecting in the collision sets only relevant parts.
- Enable coarse detail level when importing geometry.
- Limit the use of near-miss.
- Enable last collision detection, if the results are acceptable.

Results of creating a collision set

After you have created a collision set, see Create Collision Set on page 318, RobotStudio will check the positions of all objects and detect when any object in ObjectsA collides with any object in ObjectsB.

Activation of detection and displayal of collisions depend on how the collision detection is set up.

If the collision set is active, RobotStudio will check the positions of the objects in the groups, and indicate any collision between them according to the current color settings.

Continues on next page
Collision detection checks whether robots or other moving parts collide with equipment in the station. In complex stations, you can use several collision sets for detecting collisions between several groups of objects. After collision detection has been set up, it does not need to be started, but automatically detects collisions according to the setup.

Setting when to check for collisions
To set whether to detect collisions always or only during simulation, follow these steps:

1. On the File menu, click Options.
2. On the Navigation pane to the left, select Simulation: Collision.
3. On the Collision page to the right, select one of the following options from the Perform collision detection:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>During simulation</td>
<td>Collision detection is active only during simulation (when running RAPID programs in the virtual controller).</td>
</tr>
<tr>
<td>Always</td>
<td>Collision detection is always active, even when moving objects manually or testing reachability.</td>
</tr>
</tbody>
</table>

Setting the objects for collision detection
To set the objects for collision detection, follow these steps:

1. Make sure that the objects for collision detection are placed correctly in collision sets.
2. Make sure that the collision set for the objects is activated, which is indicated by an icon in the Layout browser:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Active. Collisions between objects in this set will be detected.</td>
</tr>
<tr>
<td>xx050033</td>
<td>Active. Collisions between objects in this set will be detected.</td>
</tr>
<tr>
<td>Not active</td>
<td>Not active. Collisions between objects in this set will not be detected.</td>
</tr>
<tr>
<td>xx050007</td>
<td>Not active. Collisions between objects in this set will not be detected.</td>
</tr>
</tbody>
</table>

To activate or deactivate collision sets, continue with the following steps:

3. Right-click the collision set to change and then click Modify Collision set to bring up a dialog box.
4. Select or clear the Active check box and then click Apply.

Setting near-miss detection
Near-misses occur when objects in collision sets are close to colliding. Each collision set has its own near-miss settings. For setting near-miss detection, follow these steps:

1. In the Layout browser, right-click the collision set to change and then click Modify Collision set to bring up a dialog box.
2 In the Near miss box, specify the maximum distance between the objects to be considered a near-miss and then click Apply.

Setting logging options

In addition to the graphical display of collisions, you can also log the collisions to the output window or a separate log file:

1 On the File menu, click Options and under Simulation, click Collision.
2 On the Navigation pane to the left, select Simulation: Collision.
3 On the Collision page to the right, select Log collisions to Output window check box.
   The collision log is displayed in the output window.
4 On the Collision page to the right, select Log collisions to file check box and enter the name and path to the log file in the box.
   A separate file for logging collisions is created below the check box.
4 Simulating programs

4.3 Creating an event

4.3 Creating an event

Overview

Events enhance your simulations by defining actions that are carried out when specific trigger conditions are fulfilled. You can use events to:

- Attach one object to another, for example, a work piece to a gripper when simulating material handling, see *Attaching and detaching objects on page 71*.
- Set signals, for example, when simulating signals set by equipment other than the controller, see *Simulating I/O signals on page 141*.
- Start or stop the process timer, see *Measuring simulation time on page 143*.

Used for creating new events, the Create New Event Wizard is launched from the Event manager, see *Event Manager on page 322*.

Prerequisites

Before creating the event, make sure that the station contains all signals and objects that are planned to be used as triggers or affected by the action.
4.4 Simulating I/O signals

Procedures

When simulating I/O signals you can either create events that set signal values when specified trigger conditions are fulfilled, or you can set signal values manually.

For procedures using the event manager, see Event Manager on page 322.

For procedures using the I/O simulator, see I/O Simulator on page 331.

Related information

For information about controlling I/O signals from the RAPID program, see Creating RAPID instructions for setting I/O signals on page 116.
4 Simulating programs

4.5 Enabling simulation monitoring

Overview

The simulation monitor commands are used to visually detect critical robot movements during simulation by drawing a colored line that follows the TCP.

To enable TCP tracing

To enable TCP tracing, follow these steps:

1. On the Simulation tab, click Monitor to bring up a dialog box.
2. In the left pane, select the appropriate robot.
3. On the TCP Trace tab, select the Enable TCP Trace check box. This activates TCP tracing for the selected robot.
4. Optionally, change the length and color of the trace. For detailed information, see Monitor on page 333.

To enable simulation alerts

To enable simulation alerts, follow these steps:

1. On the Simulation menu, click Monitor to bring up a dialog box.
2. In the left pane, select the appropriate robot.
3. On the Alerts tab, select the Enable Simulation Alerts check box. This activates simulation alerts for the selected robot.
4. In the threshold value boxes, specify the threshold for the alerts. Setting the threshold to 0 is equivalent to disabling the alert. For detailed information, see Monitor on page 333.
4.6 Measuring simulation time

Stopwatch feature for measuring simulation time
The Simulation tab's Stopwatch feature is used for measuring the time taken between two trigger points in a simulation, and also for the simulation as a whole. The two trigger points are called the Start Trigger and the End Trigger.

When a stopwatch is setup, the timer starts when the Start Trigger occurs, and stops when the End Trigger occurs. The kinds of triggers you can specify are:

- Simulation Start
- Simulation Stop
- Target Changed
  Additionally, specify the mechanical Unit and the target.
- I/O Value
  Additionally, specify the source mechanical unit from where the signal comes, the type of I/O signal and the value of the signal.

You can several stopwatches setup for a simulation. You can also specify a different name for each stopwatch.

For information on how to use the Stopwatch feature, see Stopwatch on page 334

Tip
While you are on the Simulation tab, you can check the RobotStudio status bar for the Simulation Time, that is, from simulation start to simulation stop.
5 Deploying and distributing

5.1 Copying programs

Overview

RAPID programs are normally stored in the systems that run on the virtual controllers of your station. To copy programs to systems on other controllers, save the programs to file on the PC and then load these files to the destination controllers. You can save either entire programs or specific modules.

Copying a program

To copy a program from one controller to another, follow these steps:

1. In the Controller browser, select the controller that contains the program to copy.
2. Save the program to file on the disc. For details, see Saving a program on page 413.
3. If necessary, copy the files to a location that is accessible to the other controller.
4. For instructions on loading the program to a system on a virtual controller, a FlexController or a non-running system, see the table below.

<table>
<thead>
<tr>
<th>System location</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual controller, running in RobotStudio</td>
<td>See Loading a RAPID program on page 413.</td>
</tr>
<tr>
<td>FlexController</td>
<td>Connect to the FlexController and load the program.</td>
</tr>
<tr>
<td>A non-running system stored on the PC</td>
<td>Start the system in a virtual controller, then load the program, see Adding a system on page 85 and Loading a RAPID program on page 413, respectively.</td>
</tr>
</tbody>
</table>
The Pack & Go / Unpack & Work feature makes it possible to create a package (zip file) of an active station that can be unpacked on another computer. The package contains all necessary files, except media pools, but additional, option-based media pools are included.

For procedures, see Pack and Go on page 189 and Unpack and Work on page 190.
5.3 Screen Capture

Overview

Screen capture entails two functions useful for demonstrations and training purposes:

- The Screenshot function which allows you to capture an image of the application.
- The Record Movie function which allows you to make a recording of your work in RobotStudio, either of the entire GUI or just the graphics window.

Taking screenshots

The Screenshot function allows you to capture an image of the entire application or an active document window such as the graphics window.

Note

The Screenshot feature is available only for RobotStudio Premium users.

Configure the options for the screenshot function as per your requirement under Options: General: Screenshot in the File tab. For more information, see Options: General: Screenshot on page 194.

You can take screenshots using the keyboard shortcut CTRL + B. Alternatively, you can use the Screenshot button on the Quick Access Toolbar, but you must enable it first.

To enable the screenshot command button:

1. Click the Quick Access Toolbar's down arrow. The Customize Quick Access Toolbar menu is displayed.
2. Click Screenshot to add the check mark to the command. This adds the screenshot button to the Quick Access Toolbar.

Recording movies

You can record your activities in the RobotStudio application as a video. You can also record videos of simulations. For information on how to record videos in RobotStudio, see Record Movie on page 343.
6 Working online

6.1 Connecting a PC to the service port

Note

The service port shall only be used for direct connection to a PC as described in this procedure. It must not be connected to a LAN (Local Area Network), since it has a DHCP server that automatically distributes IP addresses to all units connected to the LAN.

Contact your network administrator for more information.

Note

The maximum number of connected network clients using Robot Communication Runtime is:

- LAN: 3
- Service: 1
- FlexPendant: 1

The maximum number of applications using Robot Communication Runtime running on the same PC connected to one controller has no built-in maximum. However, UAS limits the number of logged-on users to 50.

The maximum number of concurrently connected FTP clients is 4.

Ports DSQC639

The illustration below shows the two main ports on the computer unit: the Service Port and the LAN port. Make sure the LAN (factory network) is not connected to any of the service ports!

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Service port on the computer unit</td>
</tr>
<tr>
<td>B</td>
<td>LAN port on computer unit (connects to factory LAN)</td>
</tr>
</tbody>
</table>

Continues on next page
Connecting a PC to the service port

<table>
<thead>
<tr>
<th>Action</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Make sure the network setting on the PC to be connected is correct. Refer to the system documentation for your PC, depending on the operative system you are running. The PC must be set to “Obtain an IP address automatically” or set as described in Service PC Information in the Boot Application.</td>
</tr>
<tr>
<td>2</td>
<td>Use the delivered category 5 Ethernet crossover boot cable with RJ45 connectors. The cable is delivered in the RobotWare product box.</td>
</tr>
<tr>
<td>3</td>
<td>Connect the boot cable to the network port of your PC.</td>
</tr>
<tr>
<td>4</td>
<td>Connect the boot cable to the service port on the computer unit. The placement of the network port may vary depending on the PC model.</td>
</tr>
</tbody>
</table>
6.2 Network settings

Overview

This topic describes the network settings for a PC connected to a controller, which is a prerequisite for working online.

You can connect the PC to the controller through an Ethernet network in the following ways:

- Local network connection
- Service port connection
- Remote network connection

Local network connection

You can connect your PC to the same Ethernet network that the controller is connected to. When the PC and the controller are connected correctly and to the same subnet, the controller will be automatically detected by RobotStudio.

The network settings for the PC depend on the network configuration. For setting up the PC, contact the network administrator.

Service port connection

When connecting to the controller’s service port, you can either obtain an IP address for the PC automatically, or you can specify a fixed IP address.

If you are not sure how to set up the service port connection, contact the network administrator.

Automatic IP address

The controller’s service port has a DHCP server that will automatically give your PC an IP address if it is configured for this. For detailed information see Windows help on configuring TCP/IP.

Fixed IP address

Instead of obtaining an IP address automatically, you can also specify a fixed IP address on the PC you connect to the controller.

Use the following settings for a fixed IP address:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address</td>
<td>192.168.125.2</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0</td>
</tr>
</tbody>
</table>

For detailed information about how to set up the PC network connection, see Windows help on configuring TCP/IP.
Note

Obtaining an IP address automatically might fail if the PC already has an IP address from another controller or Ethernet device.

To ensure that you get a correct IP address if the PC was previously connected to an Ethernet device, do one of the following:

- Restart the PC before connecting to the controller.
- Run the command `ipconfig /renew` from the command prompt after connecting the PC to the controller.

Remote network connection

To enable a connection to a controller on a remote subnet or over the local network, the relevant network traffic must be allowed through any firewalls between the PC and the controller.

The firewalls must be configured to accept the following TCP/IP traffic from the PC to the controller:

- UDP port 5514 (unicast)
- TCP port 5515
- Passive FTP

All TCP and UDP connections to remote controllers are initiated by the PC, that is the controller only responds on the given source port and address.

Firewall settings

The firewall settings are applicable irrespective of whether you are connected to a real controller or a virtual controller.

The following table describes the necessary firewall configurations:

<table>
<thead>
<tr>
<th>Status</th>
<th>Name</th>
<th>Action</th>
<th>Direction</th>
<th>Protocol</th>
<th>Remote Address</th>
<th>Local Service</th>
<th>Remote Service</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RobNetScanHost</td>
<td>Allow</td>
<td>Out</td>
<td>UDP/IP</td>
<td>Any</td>
<td>Any</td>
<td>5512,5514</td>
<td>robnetscanhost.exe</td>
</tr>
<tr>
<td>IRC5Controller</td>
<td>Allow</td>
<td>In</td>
<td>UDP/IP</td>
<td>Any</td>
<td>5513</td>
<td>Any</td>
<td>robnetscanhost.exe</td>
<td></td>
</tr>
<tr>
<td>robComCtrlServer</td>
<td>Allow</td>
<td>Out</td>
<td>TCP/IP</td>
<td>Any</td>
<td>5515</td>
<td>Any</td>
<td>robcomctrlserver.exe</td>
<td></td>
</tr>
<tr>
<td>RobotFTP</td>
<td>Allow</td>
<td>Out</td>
<td>TCP/IP</td>
<td>Any</td>
<td>Any</td>
<td>FTP(21)</td>
<td>Any</td>
<td></td>
</tr>
</tbody>
</table>

Note

RobotStudio uses the current Internet Options, HTTP, and proxy settings to get the latest RobotStudio news. To view the latest RobotStudio news, go to the File tab and then the Help sub-tab.

Connecting to the controller

1. Make sure the PC is connected to the controller's service port and that the controller is running.
2. On the File menu, click Online and then select One Click Connect. This takes you to the Controller tab.
3. Click Add Controller

Continues on next page
4 Click Request Write access.

<table>
<thead>
<tr>
<th>If the controller is in mode</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>You will now get Write Access if it is available.</td>
</tr>
<tr>
<td>Manual</td>
<td>A message box on the FlexPendant will allow you to grant remote Write Access to RobotStudio.</td>
</tr>
</tbody>
</table>
6 Working online

6.3 User Authorization

Overview
This section describes the controller's User Authorization System (UAS), which restricts what different users are allowed to do with the robot. This is for protecting data and functionality from unauthorized use.

The user authorization is managed by the controller, which means that the UAS settings remain for the controller regardless of which system it is running. It also means that the UAS settings apply to all tools for communicating with the controller, like RobotStudio or the FlexPendant. The UAS settings defines the users and groups that can access the controller, and what actions they are granted access to.

For procedures, see User Accounts on page 383.

Users
UAS users are accounts with which persons log on to the controller. Furthermore, the users are added to groups to which access grants are given.

The users are defined in the controller by a user name and a password. For logging on to a controller, the user must type in a defined user name with a correct password.

A user can either have the state activated or deactivated in the UAS. When a user is deactivated it is not possible to log on to the controller using that account. It is the UAS administrator that activates and deactivates the users.

The Default user
All controllers have a default user named Default User with a publicly known password robotics. The Default User cannot be removed and the password cannot be changed. However, the user having the grant Manage UAS settings can modify the controller grants and application grants of the Default User.

Groups
In UAS, groups are defined sets of grants for accessing the controller. To the groups you then add the users who shall have the grants defined by the group.

A good practice is to create groups that resembles the professions that work with the robots in your organization. For example, you can create groups for administrators, programmers and operators.

The Default group
All controllers have a default group named Default Group, to which all grants are given and to which the default user belongs. This group cannot be removed, but it can be changed by the user having the grant Manage UAS settings.
There is a risk changing the group membership of the default user. If you by mistake clear the Default User check box or any Default Group grant, you will get a warning. Make sure that there is at least one user defined that has the grant Manage UAS settings. If the Default group and no other group have the grant Manage UAS settings, you may lose your ability to manage users and groups.

Grants

Grants are permissions to perform actions or access data on the controller. You use the grants by giving them to groups, to which you then add the users who shall have the grants.

Grants may be either controller grants or application grants. Depending on the actions that you will perform, you may need several grants. For procedures, see UAS Grant Viewer on page 388.

Controller grants

Controller grants are validated by the robot controller and apply to all tools and devices accessing the controller.

Application grants

Application grants are used by a specific application, for example the FlexPendant, and will only be valid using that application. Application grants can be added by additional options and used in customer applications.
6 Working online

6.4 The System Builder

6.4.1 System Builder Overview

Overview

This section describes how you create, build, modify and copy systems to run on virtual and real controllers. These systems may even be converted to boot media and downloaded to a real controller.

The system points out the robot models and options to use; it also stores configurations and programs for the robots. Therefore, it is good practice to use a unique system for each station even if the stations use the same basic setup. Otherwise, changes in one station may accidently overwrite data used in another station.

About virtual and real systems

The system you run on virtual controllers can either be a real system built on real RobotWare keys or a virtual system built on virtual keys.

When using real systems, the RobotWare keys define which options and robot models shall be used, thus helping you to configure the system correctly. Real systems can be run both on virtual controllers and real IRC5 controllers.

When using virtual keys, all options and robot models are available, which is useful for evaluation purposes, but requires more configuration when creating the system. Systems built on virtual keys can only be run on virtual controllers.

Prerequisites

Creating a system entails applying a predefined template to a station, reusing an existing system or letting RobotStudio propose a system based on a layout.

To create a system, the following conditions must be met:

- The RobotWare media pool must be installed on your PC.
- You must have a RobotWare key for the system, if creating a system to run on a real controller. The RobotWare key is a license key that determines which robot models to use and which RobotWare options to run on the controller. The license key is delivered with the controller.
- If you want to create a system for virtual use only, you can use a virtual key instead. Virtual keys are generated by the wizard. When using virtual keys, you select the robot models and options to use in the Modify Options section of the wizard.
- Downloading to the real controller requires a direct connection from your computer to the service or Ethernet port of the controller.

Administering systems

Systems can be administered from the System Builder dialog box in the following ways:

- View system properties, see Viewing system properties on page 158.
- Build a system, see Building a new system on page 159.

Continues on next page
6 Working online

6.4.1 System Builder Overview

Continued

- Modify or delete a system, see *Modifying a system on page 163*.
- Copy a system, see *Copying a system on page 167*.
- Create a system from backup, see *Creating a system from backup on page 168*.
- Download a system to a controller, see *Downloading a system to a controller on page 169*.
- Create boot media, see *Creating boot media on page 170*. 
All systems you create with the System Builder are stored locally on your computer. It is recommended that you store them in one or more dedicated system directories.

To view system properties and add comments, follow these steps:

1. In the System Builder dialog box, select a system from the Systems box. If necessary, in the System directory list, you can navigate to the folder in which your systems are stored.

2. The system properties are then displayed in the System Properties box. Optionally, type a comment in the Comments box, and click Save.
6.4.3 Building a new system

Overview

The New Controller System Wizard, used for building a new system, is launched from the System Builder.

Starting the wizard

To start the wizard, follow these steps:

1. Click SystemBuilder to bring up a dialog box.
2. In the Actions group, click Create New. This starts the wizard.
3. Read the information on the welcome page and click Next.

Specifying the name and location

To determine where on your computer to store the system you are creating, follow these steps:

1. In the Name box, enter a name for the system you are creating.
2. In the Path box, enter the path to the system directory in which you will store the system.
   You can also click the Browse button and browse to the system directory.
3. Click Next.

Entering the RobotWare keys

The RobotWare keys determine which RobotWare versions and parts to use in the system.

Creating a system to run on either IRC5 controllers or virtual controllers requires at least two keys: one for the controller module and one for each drive module in the cabinet. The keys are delivered together with the controller.

For creating a system to run on virtual controller only (for example, in Virtual IRC5), you can use virtual keys. Virtual keys give access to all options and robot models, but limits the use of the system to virtual controllers only.

To enter the key for the controller module, follow these steps:

1. In the Controller Key box, enter the controller key. You can also click Browse and browse to the key file. If creating a system for virtual use only, select the Virtual Key check box, and the controller key will be generated by the wizard.
2. In the Media Pool box, enter the path to the media pool. You can also click Browse and browse to the folder.system
3. In the RobotWare Version list, select which version of the RobotWare you want to use. Only RobotWare versions that are valid for the used key are available.
4. Click Next.
6 Working online

6.4.3 Building a new system

Continued

Entering the drive keys

To enter the keys for the drive modules:

1. In the Drive Key box, enter the key for the drive module. You can also click the Browse button and browse to the key file. If you used a virtual controller key, a virtual drive key is already generated by the wizard.

2. Click the right arrow button next to the Drive Key box. The key now appears in the Added drive keys list.

For real systems the drive key determines the connected robot model. For virtual systems you select the robot model in the Modify Options page. The default model is IRB140.

3. If you have a MultiMove system, repeat steps 1 and 2 for each drive key to add.

   If you have a MultiMove system, make sure that the keys are numbered in the same way as their corresponding drive modules are connected to the controller module. Use the up and down arrows to rearrange the drive keys, if necessary.

4. If you want to create the system as it is now, click Finish.

   If you want to modify options, or add options, parameter data or additional files to the home directory, click Next.

Adding additional options

Here you can add options, such as external axes and dispense applications, that are not included in the basic system. Options require a license key and must be first imported to the media pool. To add additional options, follow these steps:

1. In the Key box, enter the option key. You can also click the Browse button and browse to the option’s key file.

2. Click the Arrow button.

   The option that the key unlocks is now displayed in the Added Options list.

   **Note**

   If several versions of an additional option exists, only the latest version can be selected. To use an older version, remove the other versions of the additional option from the Mediapool.

3. Repeat steps 1 and 2 for all options you want to include.

4. Choose whether you want to create the system as it is now, or to continue with the wizard.

   If you want to create the system as it is now, click Finish.

   If you want to modify options, or add parameter data or additional files to the home directory, click Next.
Modifying options

Here you can set up and configure the options in your system. For virtual systems, you also select the robot models to use. To modify any options, follow these steps:

1. In the **Option** tree, expand the option folders to the level where you find the option you want to modify.
   Only the options unlocked by the used keys are available.
2. Modify the option.
3. Repeat steps 1 and 2 for all options you want to modify.
4. Choose whether you want to create the system as it is now, or to continue with the wizard.
   If you want to create the system as it is now, click **Finish**.
   If you want to add parameter data or additional files to the home directory, click **Next**.

Adding parameter data

Parameter data is stored in the parameter data files (.cfg files). Each parameter topic has its own parameter file. You can add only one parameter file for each topic. To add parameter data, follow these steps:

1. In the **Parameter data** box, enter the path to the folder for the parameter data files. You can also click the **Browse** button and browse to the folder.
2. In the list of parameter data files, select the file you want to include and press the **Arrow** button. Repeat for all files you want to include.
   The included parameter data files will now appear in the **Added parameter data files** list.
   Repeat steps 1 and 2 for each parameter data file you want to add.
3. Choose whether you want to create the system as it is now, or to continue with the wizard.
   If you want to create the system as it is now, click **Finish**.
   If you want to add additional files to the home directory, click **Next**.

Adding files to the home directory

You can add any type of file to the system’s home directory. When the system is loaded to a controller, these files will also be loaded. To add files to the system's home directory, follow these steps:

1. In the **Files** box, enter the path to the folder for the files you want to include.
   You can also click the **Browse** button and browse to the folder.
2. In the list of files, select the file to add and click the **Arrow** button. Repeat for all files you want to add.
   The added files will now appear in the **Added files** list.
3. Choose whether you want to create the system as it is now, or to continue with the wizard.
   If you want to create the system as it is now, click **Finish**.
   If you want to read a summary before you create the system, click **Next**.
Completing the New Controller System Wizard

To complete the wizard, follow these steps:

1. Read the system summary.
2. If the system is OK, click Finish.
   If the system is not OK, click Back and make modifications or corrections.
6.4.4 Modifying a system

Overview

The **Modify Controller System Wizard**, used to modify existing systems, is launched from the System Builder. The wizard helps you with tasks like changing robots, adding and removing external axes and other options. A system that is running must be first shut down before modification.

Starting the wizard

To start the wizard when creating a new station:

1. If the system is currently running, on the **Controller** menu, point to **Shutdown** and then click **Shutdown**.
2. On the **Controller** menu, click **System Builder** to bring up a dialog box.
3. In the **System directory** list, enter or browse to the system directory. Select a system from the list beneath, review the system properties and add and save any comments.
4. In the **Actions** group, click **Modify**. This starts the wizard.
5. Read the information on the welcome page and click **Next**.

Modifying the program revision

The RobotWare versions that are available for the system are determined by the controller key. The key is essential to the system and cannot be modified.

To use another RobotWare version than the available ones, create a new system with another key.

To optionally modify the program revision, follow the appropriate step or steps:

1. To keep the current RobotWare version, select **Yes** and then click **Next**.
2. To replace the current RobotWare version, select **No, replace it**.
3. In the **Media pool** box, enter the path to the media pool. You can also click the **Browse** button and browse to the folder.
4. In the **New program revision** box, select which version of RobotWare you want to use. Only RobotWare versions that are valid for the RobotWare key are available.
5. Click **Next**.

Adding or removing drive keys

The drive key corresponds to the drive modules in your controller. For MultiMove systems, you have one drive module (and one key) for each robot. The keys for your system are delivered together with the controller.

the system is created with a virtual controller key, virtual drive keys are generated by the wizard. when you have added one virtual drive key for each robot, you select which robot to use for each key on the **Modify Options** page.

To optionally add or remove the keys for the drive modules, follow these steps:

1. To add a key for a drive module, enter the key in the **Enter Drive Key** box. You can also click the **Browse** button and browse to the key file.

Continues on next page
2 Click the right arrow button. The key now appears in the **Added drive key** list.

If you have a MultiMove system, repeat steps 1 and 2 for each drive key to add.

3 To remove a drive module, select the corresponding key in the **Added drive key** list and click **Remove drive key**.

If you have a MultiMove system, repeat step 3 for each drive key to remove.

4 If you have a MultiMove system, make sure that the keys are numbered in the same way as their corresponding drive modules are connected to the controller module. Use the up and down arrows to rearrange the drive keys, if necessary.

5 Choose whether you want to create the system as it is now, or to continue with the wizard.

If you want to create the system as it is now, click **Finish**.

If you want to modify options, parameter data or add files to or remove files from the home directory, click **Next**.

---

**Adding or removing additional options**

To optionally add or remove additional options:

1 To add an additional option, in the **Enter Key** box, enter the option key. You can also click the **Browse** button and browse to the option's key file.

2 Click the **Arrow** button.

The option that the key unlocks is now displayed in the **Added Options** list.

**Note**

If several versions of an additional option exists, only the latest version can be selected. To use an older version, remove the other versions of the additional option from the Mediapool.

3 Repeat steps 1 and 2 for all options you want to include.

4 To remove an additional option, in the **Added options** list, select the option you want to remove.

5 Click **Remove**.

6 Choose whether you want to create the system as it is now, or to continue with the wizard.

If you want to create the system as it is now, click **Finish**.

If you want to modify parameter data or add files to or remove files from the home directory, click **Next**.

---

**Modifying options**

To optionally modify any options, follow these steps:

1 In the **Option** tree, expand the option folders to the level where you find the option you want to modify.

Only the options unlocked by the used keys are available.
2 Modify the option.
3 Repeat steps 1 and 2 for all options you want to modify.
4 Choose whether you want to create the system as it is now, or to continue with the wizard.
   If you want to create the system as it is now, click Finish.
   If you want to modify parameter data or add files to or remove files from the home directory, click Next.

Adding or removing parameter data
Parameter data is stored in the parameter data files (.cfg files). Each parameter topic has its own parameter file. You can add only one parameter file for each topic.

To add or remove parameter data, follow these steps:
1 To add parameter data, in the Parameter data box, enter the path to the folder for the parameter data files. You can also click the Browse button and browse to the folder.
2 In the list of parameter data files, select the file you want to include and press the Arrow button. Repeat for all files you want to include.
   The included parameter data files will now appear in the Added parameter data files list.
   Repeat steps 1 and 2 for each parameter data file you want to add.
3 To remove parameter data, in the Added parameter data files list, select the parameter data file to remove.
4 Click Remove.
5 Choose whether you want to create the system as it is now, or to continue with the wizard.
   If you want to create the system as it is now, click Finish.
   If you want to add to or remove files from the home directory, click Next.

Add files to or remove files from the home directory
You can add any type of file to the system’s home directory, or remove files from it. When the system is loaded to a controller, these files will also be loaded. To optionally add files to or remove files from the system’s home directory, follow these steps:
1 To add files, in the Files box, enter the path to the folder for the files you want to include. You can also click the Browse button and browse to the folder.
2 In the list of files, select the file to add and click the Arrow button. Repeat for all files you want to add.
   The added files will now appear in the Added files list.
3 To remove files, in the Added files list, select the file to remove.
4 Click Remove.
5 Choose whether you want to create the system as it is now, or to continue with the wizard.
   If you want to create the system as it is now, click Finish.

Continues on next page
If you want to read a summary before you create the system, click Next.

Complete the Modify Controller System wizard
To complete the wizard, follow these steps:
1. Read the system summary.
2. If the system is OK, click Finish.
   If the system is not OK, click Back and make modifications or corrections.

Result
Modifications will take effect when the wizard is completed.
If the system has been downloaded to a controller, it must be downloaded again before the modifications will take effect on the controller.
If the system is used by a VC, perform an l-start for the changes to take effect.

Deleting a system
To delete a system, follow this steps:
1. From the System Builder dialog box, select the system and then click Delete.
6.4.5 Copying a system

To copy a system, follow these steps:

1. From the System Builder dialog box, select the system and then click Copy to bring up a dialog box.
2. Enter a name for the new system and a path, and then click OK.
6.4.6 Creating a system from backup

Overview

The Create System from Backup Wizard, which creates a new system from a controller system backup, is launched from the System Builder. In addition, you can change the program revision and options.

Starting the wizard

To start the wizard, follow these steps:

1. From the System Builder dialog box, click Create from Backup. This starts the wizard.
2. Read the information on the welcome page and click Next.

Specifying the name and location

To specify the destination folder, follow these steps:

1. In the Name box, enter a name for the system you are creating.
2. In the Path box, enter the path to the system directory in which you will store the system.
   You can also click the Browse button and browse to the system directory.
3. Click Next.

Locating the backup

To locate a system from backup, follow these steps:

1. In the Backup folder box, enter the path to the backup folder. Alternatively, click the Browse button to browse to it. Click Next.
2. In the Media Pool box, enter the path to the media pool containing the appropriate RobotWare program. Confirm the backup information that now appears in the wizard. Click Next.
6.4.7 Downloading a system to a controller

Overview

All systems you access from the System Builder are stored on your computer. If you wish to run a system on a robot controller, you must first load it to the controller, which then requires a restart.

Load a system

To load a system to a controller, follow these steps:

1. From the System Builder dialog box, select a system and then click Download to Controller to bring up a dialog box.

2. Specify the Destination Controller for the system.

<table>
<thead>
<tr>
<th>You can select by using the...</th>
<th>If...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select controller from list option</td>
<td>the controller has been detected automatically.</td>
</tr>
<tr>
<td>Specify IP address or controller name option</td>
<td>your PC and the robot is connected to the same network. You can only use the controller name in DHCP networks.</td>
</tr>
<tr>
<td>Use service port option</td>
<td>your PC is directly connected to the controller's service port.</td>
</tr>
</tbody>
</table>

3. Optionally, click Test Connection to confirm that the connection between the computer and the Controller is OK.

4. Click Load.

5. Answer Yes to the question Do you want to restart the controller now?

   | Yes | The controller restarts immediately and the downloaded system starts automatically. |
   | No  | The controller does not restart immediately. To start using the downloaded system, you have to: a) perform a C-start or an X-start b) select the system manually |
   | Cancel | The downloaded system is removed from the controller. |
6.4.8 Creating boot media

Overview

Boot media is an entire system which the System Builder packs to a single file and commonly stores on a hard disk or USB memory. The controller then accesses the file through its Ethernet port or USB port, respectively.

Creating boot media

To create boot media, follow these steps:

1. From the System Builder dialog box, create a new system. For creating a new system, see Building a new system on page 159.

2. From the System Builder dialog box, select a new system or an existing system and then click Boot Media.

3. In the Path box, enter the path to the folder where you want to store the boot media file. Alternatively, browse to the location.

4. Click OK.

Result

To load the boot media system to a controller, first connect it and then restart the controller with the advanced restart method X-start.
6.4.9 Examples using the System Builder when offline

6.4.9.1 A MultiMove system with two coordinated robots

Overview

In this example we will use the System Builder to create a coordinated offline system with one IRB2400 and one IRB1600 robot to use in a new RobotStudio station.

Starting the New Controller System Wizard

To create a system like the one described above, follow these steps:

1. Click SystemBuilder to bring up the dialog box.
2. In the dialog box, click Create New to bring up the New Controller System Wizard.
3. Read the welcome text, and click Next to continue to the next page.

Entering the name and path

1. In the Name box, enter the name of the system. The name must not contain blank spaces or non-ASCII characters.
   In this example, name the system MyMultiMove.
2. In the Path box, enter the path for the folder to save the system in, or click the Browse button to browse to the folder or create a new one.
   In this example, save the system in C:\Program Files\ABB Industrial IT\Robotics IT\RobotStudio\ABB Library\Training Systems.
3. Click Next to continue to the next page.

Entering the controller key

1. Select the Virtual key check box. A virtual controller key now appears in the Controller Key box. In this example we will use the default media pool and RobotWare version.
2. Click Next to continue to the next page.

Entering drive keys

1. Click the Right Arrow button next to the Enter Drive key box twice to create one drive key for each robot.
2. Click Next to continue to the next page.

Adding options

1. This system does not require any additional option keys. Click Next and continue to the next page of the wizard.

Modifying options

When creating robot systems from real robot keys, the key sets the options. But since we are using a virtual key, we have to set the options manually.
To set the options necessary for a MultiMove, follow these steps:

1. Scroll down to the **RobotWare / Motion Coordination 1** group and select the **MultiMove Coordinated** check box.

2. Scroll down to the **RobotWare / I/O control** group and select the **Multitasking** and the **Advanced RAPID** check boxes.

3. Scroll down to the **DriveModule1 / Drive module application** group and expand the **ABB Standard manipulator** option. Select the **IRB 2400 Type A** option, manipulator variant **IRB 2400L Type A**.

4. Scroll down to the **DriveModule2 / Drive module application** group and expand the **ABB Standard manipulator** option. Select the **IRB 1600** option, manipulator variant **IRB 1600-5/1.2**.

5. Click Finish and the system will be created.
6.4.9.2 A system with support for one robot and one positioner external axis

Overview
In this example we will use the System Builder to create an offline system to use in a new RobotStudio station with one IRB1600 robot and one IRBP 250D positioner external axis.

Prerequisites
When creating systems for positioner external axes, you need the media pool and the license key file for that specific positioner. In this example we will use a media pool and license key file for a demo positioner.

Paths to files and folders assume that RobotStudio and the RobotWare media pool have been installed at their default locations on Windows XP. If not, adjust the paths accordingly.

Starting the New Controller System Wizard
To create a system like the one described above, follow these steps:
1. Click System Builder to bring up a dialog box.
2. In the dialog box, click Create New to bring up the New Controller System Wizard.
3. Read the welcome text, and click Next to continue to the next page.

Entering the controller key
1. Select the Virtual key check box. A virtual controller key now appears in the Controller Key box. In this example we will use the default media pool and RobotWare version.
2. Click Next to continue to the next page.

Entering drive keys
1. Click the Right Arrow button next to the Enter Drivekey box to create one drive key for the robot.
2. Click Next to continue to the next page.

Adding options
This is where we point out the key file for the positioner.
1. Next to the Enter key box, click the browse button and select the key file.
   In this example, browse to and select the file extkey.kxt in the folder C:\Program Files\ABB Industrial IT\Robotics IT\MediaPool\3HEA-000-00022.01.

Tip
In the MediaPool folder media pools for several standard positioners are installed. They are named by the positioner’s article number, with a suffix that indicates if it is configured for single-robot or MultiMove systems.

Continues on next page
2 Click the Right Arrow button next to the Enter key box to add the key for the positioner.

3 Click Next and continue to the next page of the wizard.

Modifying options

When creating robot systems from real robot keys, the key sets the options. But since we are using a virtual key, we have to set the options manually. To set the options necessary for a positioner, follow these steps:

1 Scroll down to the RobotWare / Hardware group and select the 709-x DeviceNet check box.
   This option is for the communication between the controller and the track external axis.

2 Scroll down to the DriveModule1 / Drive module application group and expand the ABB Standard manipulator option. Select the IRB 1600 option.
   This option sets the robot to an IRB 1600-5/1.2.

3 Scroll down to the DriveModule1 > Drive module configuration group; select the Drive System 04 1600/2400/260 option; expand the Additional axes drive module group and select the R2C2 Add drive option.
   a Expand the Drive type in position Z4 group and select the 753-1 Drive C in pos Z4 option
   b Expand the Drive type in position Y4 group and select the 754-1 Drive C in pos Y4 option
   c Expand the Drive type in position X4 group and select the 755-1 Drive C in pos X4 option

   This option adds drive modules for the positioner axes.

   Note

When using the latest drive system, do the following:
Scroll down to the DriveModule1 > Drive module configuration group; select the Drive System 09 120/140/1400/1600 Compact option; expand the Power supply configuration group and select 1-Phase Power supply or 3-Phase Power supply (as applicable) > Additional axes drive module > Additional drive
   a Expand the Drive type in position X3 group and select the Drive ADU-790A in position X3 option
   b Expand the Drive type in position Y3 group and select the Drive ADU-790A in position Y3 option
   c Expand the Drive type in position Z3 group and select the Drive ADU-790A in position Z3 option

4 Click Finish and the system will be created. When starting the system in a RobotStudio station, you have to set up the system to load a model for the positioner and to get the motions to work properly. See Placing external axes on page 98 for more information.
6.4.9.3 Options settings for systems with positioners

Overview

This is an overview of the RobotWare options to set when creating a system for positioner external axes. Note that besides setting the RobotWare options, you must add an additional option key for the positioner.

Media pools and option keys for the positioners

If you have the media pool and option key for your positioner, you can use these files.

If not, media pools for standard positioners are installed with RobotStudio. The path to these media pools in a default installation is: C:\program files\ABB Industrial IT\Robotics IT\MediaPool. In this folder a media pool for each positioner is located. These are named by the article number of the positioner, with a suffix that indicates if it is configured for a single-robot or a MultiMove system.

In the Add additional options page of the System Builder, you should add the option for the positioner by opening the mediapool folder for the positioner to add and selecting the extkey.kxt file.

Options for positioners in single-robot systems

When adding a positioner to a single-robot system, the positioner will be added to the same task as the robot. Below, the options to set on the Modify Options page of the System Builder for such a system are listed:

- RobotWare > Hardware > 709-x DeviceNet > 709-1 Master/Slave Single
- Optionally, for using the system with ArcWare also add RobotWare > Application arc > 633-1 Arc
- DriveModule 1 > Drive module configuration > Drive System 04 1600/2400/260 > RC2C Add drive > 753-1 Drive C in pos Z4 > 754-2 Drive T in pos Y4 > 755-3 Drive U in pos X4

Options for positioners in MultiMove robot systems

When adding a positioner to a MultiMove robot system, the positioner shall be added to a task of its own (thus you also have to add a drive key for the positioner). Below, the options to set on the Modify Options page of the System Builder for such a system are listed:

- RobotWare > Hardware > 709-x DeviceNet > 709-1 Master/Slave Single
- RobotWare > Motion coordinated part 1 > 604-1 MultiMove Coordinated
  Optionally, expand the MultiMove Coordinated option and select process options for the robots.
- Optionally, for using the system with ArcWare, add RobotWare > Application Arc > 633-1 Arc
- DriveModule 1 > Drive module configuration > Drive System 04 1600/2400/260 > RC2C Add drive > 753-1 Drive C in pos Z4 > 754-2 Drive T in pos Y4 > 755-3 Drive U in pos X4. For the other drive modules, no additional axes should be configured.
6 Working online

6.5 Handle I/O

### Overview
The I/O system handles input and output signals to and from the controller. Below are the parts of the system described, as well as common types of signals. The I/O system window is used to view and set previously configured signals, and to activate and deactivate I/O units.

### The I/O system
The I/O system of a controller consists of I/O buses, I/O units and I/O signals. The I/O buses are the controller's connections for I/O units (for instance I/O boards) and the I/O units contain channels for the actual signals. The I/O buses and units are displayed in the robot view, as child nodes under each controller and the I/O signals are displayed in the I/O window.

### I/O signals
I/O signals are used to communicate between the controller and external equipment, or to change variables within a robot program.

### Input signals
Input signals notify something for the controller, for instance a feeder belt can set an input signal when it has positioned a work piece. The input signal can then be programmed to start a specific part of the robot program.

### Output signals
The controller uses output signals to notify that a specified condition has been fulfilled. For instance, after the robot has finished its sequence, an output signal can be set. This signal can then be programmed to start a feeder belt, update a counter or trigger any other action.

### Simulated signals
A simulated signal is a signal that is manually given a specific value that overrides the actual signal. Thus simulated signals might be useful for testing robot programs without activating or running equipment.

### Virtual signals
Virtual signals are signals that are not configured to belong to a physical I/O unit. Instead, they reside inside the controller's memory. A common use for virtual signals is to set variables and store changes in a robot program.

### Procedures
For using the I/O system window, see Inputs / Outputs on page 351.
For adding a signal, see Add Signals on page 361.
6.6 Configure systems

Configuring system parameters

System parameters may be configured as follows:

• To view topics, types, instances and parameters
• To edit the parameters of an instance
• To copy and paste instances
• To add and delete instances
• To load and save complete configuration files to and from controllers

When working with configurations, the following tools, see Configuration editor on page 361, are useful:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Configuration Editor</td>
<td>With the Configuration Editor you work with the types and instances of a specific topic.</td>
</tr>
<tr>
<td>The Instance Editor</td>
<td>With the Instance Editor, you specify the values of the parameters in the instances of system parameter types.</td>
</tr>
</tbody>
</table>

Note

To edit system parameters, you must have write access to the controller.

Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System parameters</td>
<td>The sum of all parameters that configure the system, these are divided into topics and types.</td>
</tr>
<tr>
<td>Topic</td>
<td>A collection of parameters relating to a specific area, and the highest level in the system parameter structure. Examples are Controller, Communication and Motion.</td>
</tr>
<tr>
<td>Type</td>
<td>A set of parameters for a specific configuration task. A type can be seen as a pattern describing the construction and properties for the parameters included in the task. For instance, the type Motion System defines which parameters shall be used for configuring a motion system.</td>
</tr>
<tr>
<td>Instance</td>
<td>An actualization of a type, an instance is a specific set of parameters with unique values created from a type pattern. In the Configuration Editor, each row in the Instance list is an instance of the type selected in the Type list.</td>
</tr>
<tr>
<td>Parameter</td>
<td>A property to set when configuring the robot system.</td>
</tr>
<tr>
<td>Configuration file</td>
<td>Contains all public parameters of a specific topic.</td>
</tr>
</tbody>
</table>

Viewing configurations

1. To view the topics of a controller, from the Controller tab, expand the Configuration node for the controller.
   All topics in are now displayed as child nodes to the Configuration node.
2. To view the types and instances of a topic, double-click the topic node for the topic to view.

Continues on next page
6 Working online

6.6 Configure systems

Continued

The Configuration Editor is now opened, listing all types of the topic in the Typename list. In the Instance list, each instance of the type selected in the Typename list is displayed as a row. The parameter values of the instances are displayed in the columns of the instance list.

3 To view detailed parameter information for an instance, double-click the instance.

The instance editor now displays the current value, restrictions and limits of each parameter in the instance.

Editing parameters

You can either edit the parameters of one single instance, or you can edit several instances at one time. Editing several instances at one time is useful when you want to change the same parameter in several instances, like when moving signals from one I/O unit to another.

1 In the Controller tab, expand the Controller and the Configuration node and double-click the topic that contains the parameters to edit.

This opens the Configuration Editor.

2 In the Typename list of the Configuration Editor, select the type that the parameter to edit belongs to.

The instances of the type are now displayed in the Instance list of the Configuration Editor.

3 In the Instance list, select the instances to edit and press the Enter Key. To select several instances at once, hold down the SHIFT or CTRL key while selecting.

Alternatively, right-click an instance and then click Edit.

The Instance Editor is now displayed.

4 In the Parameter list of the Instance Editor, select the parameter to edit and change the value of the parameter in the Value box.

When editing several instances at one time, the parameter values you specify will be applied to all instances. For parameters that you do not specify any new value, each instance will keep its existing value for that parameter.

5 Click OK to apply the changes to the configuration database of the controller.

For many parameters, the changes will not take affect until the controller is restarted. If your changes require a restart, you will be notified of this.

You have now updated the controller's system parameters. If you are going to make several changes, you can wait with the restart until all changes are done.

Continues on next page
Adding instances

With the Configuration Editor, you can select a type and create a new instance of it. For example, adding a new instance of the type Signal creates a new signal in the system.

1. In the Controller tab, expand the Controller and the Configuration node and double-click the topic that contains the type of which you want to add an instance.

   This opens the Configuration Editor.

2. In the Type name list of the Configuration Editor, select the type of which you want to add an instance.

3. On the Controller menu, point to Configuration and click Add type (the word type is replaced by the type you selected previously).

   You can also right-click anywhere in the configuration editor and then select Add type from the shortcut menu.

   A new instance with default values is added and displayed in the Instance Editor window.

4. If required, edit the values.

5. Click OK to save the new instance.

   The values in the new instance are now validated. If the values are valid, the instance is saved. Otherwise, you will be notified of which parameter values to correct.

   For many instances, the changes will not take affect until the controller is restarted. If your changes require a restart you will be notified of this.

   You have now updated the controller's system parameters. If the changes require a restart of the controller, the changes will not take affect until you do this. If you are going to make several changes, you can wait with the restart until all changes are done.

Copying an instance

1. In the Controller tab, expand the Controller and the Configuration node and double-click the topic that contains the instance to copy.

   This opens the Configuration Editor.

2. In the Type name list of the Configuration Editor, select the type of which you want to copy an instance.

3. In the Instance list, select one or several instances to copy.

   If you select several instances and they don't have the same value for all parameters, these parameters will have no default values in the new instances.

4. On the Controller menu, point to Configuration and click Copy Type (the word type is replaced by the type you selected previously).

   You can also right-click the instance to copy and then select Copy Type from the shortcut menu.

   A new instance with the same values as the one you copied is added and displayed in the Instance Editor window.

Continues on next page
5 Change the name of the instance. If required, also edit the other values.

6 Click OK to save the new instance.

The values in the new instance are now validated. If the values are valid, the instance is saved. Otherwise, you will be notified of which parameter values to correct.

For many instances, the changes will not take affect until the controller is restarted. If your changes require a restart you will be notified of this.

You have now updated the controller’s system parameters. If the changes require a restart of the controller, the changes will not take affect until you do this. If you are going to make several changes, you can wait with the restart until all changes are done.

Deleting an instance

1 In the Controller tab, expand the Controller and the Configuration node and double-click the topic that contains the type of which you want to delete an instance.

This opens the Configuration Editor.

2 In the Type name list of the Configuration Editor, select the type of which you want to delete an instance.

3 In the Instance list, select the instance to delete.

4 On the Controller menu, point to Configuration and then click Delete type (the word type is replaced by the type you selected previously).

You can also right-click the instance to delete and then select Delete type from the shortcut menu.

5 A message box is displayed, asking if you want to delete or keep the instance. Click Yes to confirm that you want to delete it.

For many instances, the changes will not take affect until the controller is restarted. If your changes require a restart you will be notified of this.

You have now updated the controller’s system parameters. If the changes require a restart of the controller, the changes will not take affect until you do this. If you are going to make several changes, you can wait with the restart until all changes are done.

Save one configuration file

The system parameters of a configuration topic can be saved to a configuration file, stored on the PC or any of its network drives.

The configuration files can then be loaded into a controller. They are thereby useful as backups, or for transferring configurations from one controller to another.

1 In the Controller tab, expand the Configuration node and select the topic to save to a file.

2 On the Controller menu, point to Configuration and select Save System Parameters.

You can also right-click the topic and then select Save System Parameters from the shortcut menu.
3 In the Save As dialog box, browse for the folder to save the file in.
4 Click Save.

### Saving several configuration files

1 In the Controller tab, select the Configuration node.
2 On the Controller menu, point to Configuration and click Save System Parameters.
   You can also right-click the configuration node and then click Save System Parameters.
3 In the Save System Parameters dialog box, select the topics to save to files. Then click Save.
4 In the Browse for Folder dialog box, browse for the folder to save the files in, and then click OK.
   The selected topics will now be saved as configuration files with default names in the specified folder.

### Loading a configuration file

A configuration file contains the system parameters of a configuration topic. They are thereby useful as backups, or for transferring configurations from one controller to another.

When loading a configuration file to a controller, it must be of the same major version as the controller. For instance, you cannot load configuration files from an S4 system to an IRC 5 controller.

1 In the Controller tab, select the Configuration node.
2 On the Controller menu, point to Configuration and select Load Parameters.
   You can also right-click the configuration node and then select Load Parameters from the context menu.
   This opens the Select mode dialog box.
3 In the Select mode dialog box, select how you want to combine the parameters in the configuration file to load with the existing parameters:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>then</th>
</tr>
</thead>
<tbody>
<tr>
<td>replace the entire configuration of the topic with the one in the configuration file.</td>
<td>select Delete existing parameters before loading</td>
</tr>
<tr>
<td>add new parameters from the configuration file to the topic, without modifying the existing ones.</td>
<td>click Load parameters if no duplicates</td>
</tr>
<tr>
<td>add new parameters from the configuration file to the topic and update the existing ones with values from the configuration file. Parameters that only exist in the controller and not in the configuration file will not be changed at all.</td>
<td>click Load parameters and replace duplicates</td>
</tr>
</tbody>
</table>

4 Click Open and browse to the configuration file to load. Then click Open again.
5 In the information box, click OK to confirm that you want to load the parameters from the configuration file.

Continues on next page
When the loading of the configuration file is finished, close the Select mode dialog box.
If a restart of the controller is necessary for the new parameters to take affect, you will be notified of this.
6.7 Handle events

Overview

An event is a message that notifies you that something has happened to the robot system, be it merely a change in operation mode or a severe error that calls for your immediate attention. If the event requires any action from you, this is stated in the event.

Events are displayed in the event logs of the FlexPendant and RobotStudio.

The event log keeps you informed of system status, allowing you to:

- view controller events.
- filter events.
- sort events.
- get detailed information about an event.
- save event log files on your PC.
- clear event records.

Event Log list

The event log list consists of all events matching your filter settings, with the following information for each event:

<table>
<thead>
<tr>
<th>Type</th>
<th>The event type is an indication of the severity of the event.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>The event code is a number that identifies the event message.</td>
</tr>
<tr>
<td>Title</td>
<td>The event title is a short event description.</td>
</tr>
<tr>
<td>Category</td>
<td>The event category is an indication of the source of the event.</td>
</tr>
<tr>
<td>Seq. Number</td>
<td>The sequential number indicates the chronological order of the event.</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Date and time is when the event occurred.</td>
</tr>
</tbody>
</table>

When you select an event in the list, detailed information will appear to the right.

Event type

The event type is an indication of the severity of the event.

There are three types of events:

<table>
<thead>
<tr>
<th>Event type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td>A normal system event, such as starting and stopping programs, change of operating mode, motors on/off and so on. Information messages never require any action from you, but can be useful for error tracking, statistics collecting or monitoring user triggered event routines.</td>
</tr>
<tr>
<td>Warning</td>
<td>An event that you need to be aware of, but not so severe that the process or RAPID program needs to be stopped. Warnings, however, often indicate underlying problems that sooner or later must be solved. Warnings must sometimes be acknowledged.</td>
</tr>
<tr>
<td>Error</td>
<td>An event that prevents the robot system from proceeding. The running process or RAPID program cannot continue, but is stopped. All errors must be acknowledged. Most errors also require some immediate action from you in order to solve the problem.</td>
</tr>
</tbody>
</table>

Continues on next page
6 Working online

6.7 Handle events

Continued

This information is also indicated by color: blue for information, yellow for warning and red for an error which needs to be corrected in order to proceed.

Event code

The event code is a number that identifies the event message. Together with the event date and time each event has a unique identity.

Event title

The event title is a short description of the event.

Event category

The category is an indication of the source of the event.

<table>
<thead>
<tr>
<th>Category</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common</td>
<td>All recent events.</td>
</tr>
<tr>
<td>Operational</td>
<td>Events related to changes in operation or operating mode.</td>
</tr>
<tr>
<td>System</td>
<td>Events related to the current system.</td>
</tr>
<tr>
<td>Hardware</td>
<td>Events related to controller hardware.</td>
</tr>
<tr>
<td>Program</td>
<td>Events related to the running process applications and RAPID programs.</td>
</tr>
<tr>
<td>Motion</td>
<td>Events related to the movement of robots or other mechanical units</td>
</tr>
<tr>
<td>I/O &amp; Communication</td>
<td>Events related to input and output signals, serial or network communication and process buses.</td>
</tr>
<tr>
<td>User</td>
<td>Custom messages that have been programed into RAPID programs.</td>
</tr>
<tr>
<td>Internal</td>
<td>Internal low-level controller errors for ABB service personnel.</td>
</tr>
<tr>
<td>Process</td>
<td>Events related to Industrial Processes options., such as Spot, Arc and Dispense.</td>
</tr>
<tr>
<td>Cfg</td>
<td>Errors in a configuration file.</td>
</tr>
</tbody>
</table>

Depending on how the system is configured, additional categories may exist.

Sequential number

The sequential number indicates the chronological order of the event; the higher the number the more recently the event occurred.

Date and time

Date and time indicate exactly when the event occurred. Along with the event code, this timestamp guarantees that each event has a unique identity.

Event description

When you select an event in the list, detailed information about it will be displayed to the right. This includes a description, and when appropriate also consequences, causes and suggested actions to solve the problem.
Overview

The Event Log automatically logs all controller events once it is started. By default, events are displayed in the chronological order specified by Seq Numbers.

Note

Any modifications to the list you see will never affect the event log of the controller. What you see is just a copy.

Managing events

1. In the Robot View Explorer, select a system.
2. Double-click the Events node.

<table>
<thead>
<tr>
<th>To sort events</th>
<th>Click the header for the column you want to sort by. To switch between ascending and descending sorting, click the header once again.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To filter events</td>
<td>In the Category list select the event category you want displayed.</td>
</tr>
<tr>
<td>To clear the event log</td>
<td>Click Clear. This will not affect the event log of the robot controller. It might still be impossible, however, to retrieve all events from a cleared record once again, as the oldest ones may have been erased from the controller hard disk due to lack of space. It is therefore recommended to save the record to a log file before clearing.</td>
</tr>
</tbody>
</table>

| To save all events to a single log file on the computer | Check the Log to file check box. If it remains checked, the log file will be updated with new events as they occur. |
| To save events of one or several categories to files on the computer | Click Save and then make your category choice. Specify the location for the log file(s) in the Browse For Folder dialog and then click OK. If you select All when selecting categories, a log file for each event category will be created. |

Retrieving controller events

To clear the list and retrieve all existing events from the robot controller:

1. Optionally, save the existing Event Log record.
2. Select whether you want the list to be updated when new events occur, or if you are only interested in viewing events that have already occurred.

<table>
<thead>
<tr>
<th>To ...</th>
<th>...then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get automatic updates when new events occur</td>
<td>check the Auto Update check box. (Checked by default.)</td>
</tr>
<tr>
<td>say no to automatic updates when new events occur</td>
<td>clear the Auto Update check box.</td>
</tr>
</tbody>
</table>

3. Click Get to clear the current list, fetch and display all events that are currently stored in the controller log files.
This page is intentionally left blank
7 File tab

7.1 Overview

Overview

The File tab contains the options to create new station, create new robot system, connect to a controller, save station as viewer, and RobotStudio options.

The following table lists the various options, presented in different tabs, available in the File tab:

<table>
<thead>
<tr>
<th>Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save / Save As</td>
<td>Saves a station.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens a saved station.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes a station.</td>
</tr>
<tr>
<td>Info</td>
<td>Once a station is open in RobotStudio, this tab shows the properties of the station, and also the robot systems and library files that are part of the open station.</td>
</tr>
<tr>
<td>Recent</td>
<td>Displays recently accessed stations.</td>
</tr>
<tr>
<td>New</td>
<td>Creates a new station. See New on page 188.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the contents of the active window.</td>
</tr>
<tr>
<td>Share</td>
<td>Shares data with others.</td>
</tr>
<tr>
<td>Online</td>
<td>Connects to a controller.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays information on installing and licensing RobotStudio. See Installing and licensing RobotStudio on page 40.</td>
</tr>
<tr>
<td>Options</td>
<td>Displays information on RobotStudio Options. See Options on page 193.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes RobotStudio.</td>
</tr>
</tbody>
</table>

- Pack and Go on page 189
- Unpack and Work on page 190
- Station Viewer on page 191
- Add Controller on page 348
- Building a new system on page 159
- Import Options on page 377
7.2 New

Creating an empty station

1. On the File tab, click New.
2. Click Empty Station, and then click Create.
   
   A new empty station is created.

Creating a station with Robot Controller

1. On the File tab, click New.
2. Click Station with Robot Controller.
   
   The available small, medium, large, paint and special purpose robots are listed.
3. From the list, click to select an appropriate robot. Alternatively, click Browse to browse for and select a system.
   
   RobotStudio automatically creates a matching virtual controller for your system.
4. Click Create.

Creating a station with existing Robot Controller

1. On the File tab, click New.
2. Select Station with existing Robot Controller.
3. In the System Pool drop-down list, select the folder which contains the system you need.
   
   The default System Pool path is C:\User\ABB\Documents\RobotStudio\Systems.
   
   You can also add a folder to the System Pool list. To add a folder, click Add., browse to the required folder, and then click Select Folder. To remove a folder from the System Pool list, select it and then click Remove.
4. In the Systems Found list, select a system, and then click Create.

Creating a new RAPID module file

1. On the File tab, click New.
2. Click RAPID Module File.
3. Choose from the following options:
   - Click Module (Program Module) to create a blank RAPID module file.
   - Click Main Module (Program Module) to create a module with a main routine.
   - Click Module (System Module) to create a module with attributes for read-only, view-only and not step-in.
   
   According to the selection you make, the created RAPID module file opens in the RAPID editor.
   
   For more information on managing file based RAPID modules, see Managing file based RAPID modules on page 409.
7.3 Share

7.3.1 Pack and Go

Packing a station

1. On the File menu, click Share and select Pack & Go to open the Pack & Go Wizard.
2. On the Welcome to the Pack & Go Wizard page, click Next.
3. On the Destination page, click Browse and specify the destination directory of the package. Click Next.
   To password protect your Pack & Go file, select the Password protect the package check box. Then, specify the password. To view the password you have typed in, select the Show password check box. When opening the Pack & Go file, this password needs to be provided for the station to load.
4. On the Libraries page, select one of the three options. Click Next.
5. On the Systems page, select Include backups of all robot systems checkbox. Optionally, select Include a media pool for additional options checkbox. Click Next.
6. On the Ready to pack page, review the information and then click Finish.
7. On the Pack & Go finished page, review the results and then click Close.
7 File tab

7.3.2 Unpack and Work

7.3.2 Unpack and Work

Unpacking a station

1. On the File menu, click Unpack & Work to open the Unpack & Work Wizard.
2. On the Welcome to the Unpack & Work Wizard page, click Next.
3. On the Select package page, click Browse and Select the Pack & Go file to unpack and Select the directory where the files will be unpacked. Click Next.
4. On the Controller Systems page, select the RobotWare version and click Browse to select the path to the Media Pool. Optionally, select the check box to automatically restore backup. Click Next.
5. On the Ready to unpack page, review the information and then click Finish.
6. On the Unpack & Work finished page, review the results and then click Close.

Note

If the Pack & Go file was set as password-protected during creation, then that password needs to be provided for the station to load.
7.3.3 Station Viewer

Overview

The Station Viewer can playback a station in 3D on computers that do not have RobotStudio installed. It packages the station file together with files needed to view the station in 3D. It can also play recorded simulations.

Prerequisites

The .NET Framework 4.0 must be installed on the playback computer.

Note

RobotStudio 64-bit edition can create 64-bit Station Viewers. However, a 64-bit station viewer can run only on the Windows 64-bit operating system.

Creating and loading a Station Viewer

1. To create a Station Viewer, on the File menu, click Share and select Save Station as Viewer
2. Specify a file name and save as .exe file.
   - Select the option Show comments on startup and add text in the box to view the comment when the Station Viewer is started.
   - To save the simulation as Station Viewer, go to the Simulation Control group, click Play, and then select Record to Viewer. For more information, see Running a simulation on page 330.
3. To load a Station Viewer, double-click the package (.exe) file on the target computer.
   The results are displayed in the Output window and the embedded station file is automatically loaded and presented in a 3D view.

Configuring user settings of a Station Viewer

To configure the user settings of a Station Viewer, on the File menu, click Options.

Command Buttons

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply</td>
<td>Click this button to save all options in the current page.</td>
</tr>
<tr>
<td>Reset</td>
<td>Click this button to reset to the settings you had before this session all values that you have changed on the current page.</td>
</tr>
<tr>
<td>Default</td>
<td>Click this button to reset to their default values all settings on the current page.</td>
</tr>
</tbody>
</table>

Options: General: Appearance

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select application language</td>
<td>Select the language to be used. The default language is the same as that of the target user's operating system if available, otherwise it is English.</td>
</tr>
<tr>
<td>Select color theme</td>
<td>Select the color to be used.</td>
</tr>
</tbody>
</table>
Options: General: Graphics

<table>
<thead>
<tr>
<th>Select API to use for 3D graphics</th>
<th>Select the low-level API to be used for rendering 3D graphics. The default value is Direct3D, but OpenGL might be faster or stabler. You do not need to restart when changing this option.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background color</td>
<td>Select the color from the color theme, or from the color stored in the stations.</td>
</tr>
</tbody>
</table>

Simulation

When you run a simulation, the movements and visibility of objects are recorded. This recording is optionally included in the Station Viewer.

Simulation control buttons are enabled when the Station Viewer contains a recorded simulation.

Following are the Simulation control buttons:

<table>
<thead>
<tr>
<th>Play</th>
<th>Starts or resumes simulation playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>Stops simulation playback</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets all objects to their initial state and process time display to zero</td>
</tr>
<tr>
<td>Run mode</td>
<td>Select to run the simulation once or continuously</td>
</tr>
<tr>
<td>Process time</td>
<td>Displays the current simulation time</td>
</tr>
</tbody>
</table>

Note

If the simulation executes a VSTA macro, it is not reflected when playing back the simulation in the Station Viewer.
7.4 Options

Common buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply</td>
<td>Click this button to save all options in the current page.</td>
</tr>
<tr>
<td>Reset</td>
<td>Click this button to reset to the settings you had before this session</td>
</tr>
<tr>
<td></td>
<td>all values that you have changed on the current page.</td>
</tr>
<tr>
<td>Default</td>
<td>Click this button to reset to their default values all settings on</td>
</tr>
<tr>
<td></td>
<td>the current page.</td>
</tr>
</tbody>
</table>

Options: General: Appearance

- **Select application language**: Select the language to be used.
- **Select color theme**: Select the color to be used.
- **Show ScreenTips**: Select this check box to view ScreenTips.
- **Display Position Edit boxes with Red/Green/Blue background**: Select the check box if you want to display the position boxes in the modify dialog boxes with colored background. Default value: selected.
- **Group related document windows under one tab**: Select this check box to group related document window under one tab. Modifying this option requires a restart for the changes to take effect.
- **Restore hidden dialogs and messages**: Select this check box to restore dialogs or messages which you may have hidden while using RobotStudio.

Options: General: Licensing

- **View installed licenses**: Click to view the licenses listed by feature, version, type, expiration date and status.
- **Activation Wizard**: Click to activate RobotStudio license.
- **RobotStudio user experience program**:
  - **I want to help improve RobotStudio**
  - **I do not want to participate right now**
  - For RobotStudio Basic users, it is mandatory to participate in the user experience report.
  - For RobotStudio Premium users, you can choose whether or not to participate in the user experience report.

Options: General: Units

- **Quantity**: Select the quantity for which you want to change the units.
- **Unit**: Select the unit for the quantity.
- **Display decimals**: Enter the number of decimals that you want to be displayed.
- **Edit decimals**: Enter the number of decimals that you want when modifying.

Options: General: Advanced

- **Number of undo/redo steps**: The number of operations that can be undone or redone. Lowering this value can decrease memory usage.
- **Warn about running Virtual Controller processes on startup**: Warns of orphaned VC processes.

Continues on next page
### 7.4 Options

**Show acknowledge dialog box when deleting objects**
Warns when deleting objects.

**Show acknowledge dialog box when deleting targets and corresponding move instructions**
Warns when deleting targets and move instructions.

**Bring the output window to front if an error message is displayed**
Select this check box to bring the output window to front if an error message is displayed.

### Options: General: Files & Folders

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Project Folder</td>
<td>Enter the path to your project folder. This will be the folder displayed in the open and save dialog boxes in RobotStudio.</td>
</tr>
<tr>
<td>...</td>
<td>To browse for your project folder, click the browse button.</td>
</tr>
<tr>
<td>Automatically create document subfolders</td>
<td>Select this check box to enable the creation of individual subfolders for document types.</td>
</tr>
<tr>
<td>Enable Autosave</td>
<td>Select the check box to automatically save the station with defined intervals. Default value: cleared</td>
</tr>
<tr>
<td>Interval</td>
<td>Specify the interval between the savings when using Autosave in this box.</td>
</tr>
<tr>
<td>Clear Recent Stations and Controllers</td>
<td>Clears the list of recently accessed stations and controllers</td>
</tr>
<tr>
<td>Document Locations</td>
<td>Launches the Document Locations dialog box. For more information, see The Document Manager window on page 62.</td>
</tr>
</tbody>
</table>

### Options: General: Screenshot

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entire application window</td>
<td>Select this option to capture the entire application.</td>
</tr>
<tr>
<td>Active document window</td>
<td>Select this option to capture the active document window, typically the graphics window.</td>
</tr>
<tr>
<td>Copy to clipboard</td>
<td>Select this check box to save the captured image to the system clipboard.</td>
</tr>
<tr>
<td>Save to file</td>
<td>Select this check box to save the captured image to file.</td>
</tr>
<tr>
<td>Location</td>
<td>Specify the location of the image file. The default location is the &quot;My Pictures&quot; system folder.</td>
</tr>
<tr>
<td>...</td>
<td>Browse for the location.</td>
</tr>
<tr>
<td>File name</td>
<td>Specify the name of the image file. The default name is &quot;RobotStudio&quot; to which is added a date.</td>
</tr>
<tr>
<td>The file suffix list</td>
<td>Select the desired file format. The default format is JPG.</td>
</tr>
</tbody>
</table>

### Options: General: Screen Recorder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Framerate</td>
<td>Specify the framerate in frames per second.</td>
</tr>
<tr>
<td>Start recording after</td>
<td>Select this option to start recording after the specified time.</td>
</tr>
<tr>
<td>Stop recording after</td>
<td>Select this option to stop recording after the specified time.</td>
</tr>
<tr>
<td>Resolution - Same as window</td>
<td>Select this option to use the same resolution as in the graphics window.</td>
</tr>
<tr>
<td>Resolution - Limit resolution</td>
<td>Select this option to scale down the resolution as per the Maximum Width and Maximum Height you specify.</td>
</tr>
</tbody>
</table>

Continues on next page
7 File tab
7.4 Options

Maximum width Specify the maximum width in pixels.
Maximum height Specify the maximum height in pixels.
Video compression Select the video compression format.
Note that DivX format is not supported.
File name and Output file format Enter a file name and a file format. The default format is AVI.
You can also save the output format as WMV and MP4. The recommended format is MP4.

Options: Robotics: RAPID Editor

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show line numbers</td>
<td>Select this check box to view line numbers in the RAPID editor</td>
</tr>
<tr>
<td>Show ruler</td>
<td>Select this check box to show the ruler in the RAPID editor</td>
</tr>
<tr>
<td>Show whitespace</td>
<td>Select this check box to show whitespace characters in the RAPID editor</td>
</tr>
<tr>
<td>Wrap long lines</td>
<td>Select this check box if you want to wrap long lines.</td>
</tr>
<tr>
<td>Convert tabs to spaces</td>
<td>Select this check box to convert tabs to spaces in the RAPID editor</td>
</tr>
<tr>
<td>Tab size</td>
<td>Specify the number of spaces for a Tab press.</td>
</tr>
<tr>
<td>Text styles</td>
<td>Specify the appearance of the various text classes.</td>
</tr>
<tr>
<td>Text color</td>
<td>Specifies the text color of the RAPID editor.</td>
</tr>
<tr>
<td>Background color</td>
<td>Specifies the background color of the RAPID editor.</td>
</tr>
<tr>
<td>Bold</td>
<td>Select this check box for bold-face fonts in the RAPID editor.</td>
</tr>
<tr>
<td>Italic</td>
<td>Select this check box for italicized fonts in the RAPID editor.</td>
</tr>
</tbody>
</table>

Options: Robotics: RAPID Profiler

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default RAPID log file</td>
<td>Specify the name of the default RAPID log file.</td>
</tr>
<tr>
<td>Always ask for filename</td>
<td>Select this check box to manually specify the file name of the log file always.</td>
</tr>
<tr>
<td>Open analysis when logging is stopped</td>
<td>Select this check box to open the analysis after the log is made.</td>
</tr>
</tbody>
</table>

Options: Robotics: Graphical Programming

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show dialog when warning for globally defined workobjects</td>
<td>Select this check box if you want RobotStudio to display a warning when there are workobjects with the same name that have been declared as in other tasks. Default value: selected.</td>
</tr>
<tr>
<td>Show synchronize dialog box after loading program/module</td>
<td>Select this check box if you want the synchronize dialog box to be displayed when you have loaded a program or a module. Default value: selected.</td>
</tr>
<tr>
<td>Show notification that default data is used</td>
<td>Select this check box if you want to be notified that wobj0 and/or tool0 is active and will be used in the current action. Default value: selected.</td>
</tr>
<tr>
<td>Set as active when creating tooldata</td>
<td>Select this check box if you want newly created tooldata to be set as active. Default value: selected.</td>
</tr>
<tr>
<td>Set as active when creating workobjects</td>
<td>Select this check box if you want newly created workobjects to be set as active. Default value: selected.</td>
</tr>
</tbody>
</table>
### 7 File tab

#### 7.4 Options

*Continued*

<table>
<thead>
<tr>
<th>AutoPath</th>
<th>Specify the maximum gap allowed (in millimeters) when creating an AutoPath.</th>
</tr>
</thead>
</table>

### Options: Robotics: Synchronization

<table>
<thead>
<tr>
<th>Use default synchronization locations</th>
<th>Converting data, such as target to Workobject, shall use the default behavior for synchronization locations. Default value: selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show default synchronization locations notification</td>
<td>Notifies of the behavior above. Default value: selected.</td>
</tr>
<tr>
<td>Declaration default locations</td>
<td>Specify the locations for corresponding objects when synchronizing to the VC.</td>
</tr>
</tbody>
</table>

### Options: Robotics: Mechanism

<table>
<thead>
<tr>
<th>Approach Vector</th>
<th>Select the approach vector. Default value: Z.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Travel Vector</td>
<td>Select the travel vector. Default value: X.</td>
</tr>
<tr>
<td>Enable configuration check for jump to target/move instruction</td>
<td>Select this check box if you want to enable the configuration check configurations when jumping to target or move instructions. When selected and a target does not have a validated configuration assigned, you will be asked to set one. When cleared, the configuration closest to the current one is used. Default value: selected.</td>
</tr>
</tbody>
</table>

### Options: Robotics: Virtual Controller

<table>
<thead>
<tr>
<th>Always on top</th>
<th>Select this check box if you want to have the virtual FlexPendant always on top. Default value: selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable transparency</td>
<td>Select this check box if you want parts of the virtual FlexPendant to be transparent. Default value: selected.</td>
</tr>
</tbody>
</table>
| Logging | When the controller is warm started,  
  - Select this check box to log the console output to “console.log” in the controller directory  
  - Select this check box to log the console output to a console window |
| Automatically open virtual Operator Window | Select this check box to automatically open the virtual Operator Window. Default value: Enabled. |

### Options: Online: Authentication

<table>
<thead>
<tr>
<th>Recent Users</th>
<th>Lists the recent users.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove/Remove All</td>
<td>Click these buttons to remove one or all recent users, respectively.</td>
</tr>
<tr>
<td>Enable Automatic Logoff</td>
<td>Select the check box if you want to log off automatically.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Determines the length of the session before being automatically logged off.</td>
</tr>
</tbody>
</table>

### Options: Online: Online Monitor

<table>
<thead>
<tr>
<th>Update Rate (s)</th>
<th>Specifies the update interval.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revolute Joint Limits</td>
<td>Sets the revolution limit for joints.</td>
</tr>
<tr>
<td>Linear Joint Limits</td>
<td>Sets the linear limit for joints.</td>
</tr>
</tbody>
</table>

*Continues on next page*
Singularities | Sets the singularities.

**Options: Graphics: Renderer**

| Select API to use for 3D graphics | Select the low-level API to be used for rendering 3D graphics. The default value is Direct3D. |

**Options: Graphics: Appearance**

| Background color | Click the colored rectangle to change the background color. |
| Gradient | Select the check box if you want to display the background color in gradient style. Default value: cleared. |
| Show floor | Select the check box if you want the floor (at z=0) to be displayed. Change the floor color by clicking the colored rectangle. Default values: selected. |
| Color | Click the colored rectangle to change the color of the floor. |
| Transparent | Select the check box if you want the floor to be transparent. Default values: selected. |
| Show UCS Grid | Select the check box if you want the UCS grid to be displayed. Default value: selected. |
| Grid Space X | Change the UCS grid space in the X coordinate direction by entering the requested value in the box. Default value: 1000 mm (or equivalent in other units). |
| Grid Space Y | Change the UCS grid space in the Y coordinate direction by entering the requested value in the box. Default value: 1000 mm (or equivalent in other units). |
| Show coordinate system | Select the check box if you want the coordinate systems to be displayed. Default value: selected. |
| Show navigation and selection buttons | Select this check box to have the navigation and selection buttons on the graphics window. |

**Options: Graphics: Performance**

| Detail level | Select if the detail level is to be Auto, Fine, Medium or Coarse. Default value: Auto. |
| Cull back-facing triangles | Select the check box if you want to ignore the back-facing triangles. Default value: selected. Culling back-facing triangles improves the graphics performance but may give unexpected display if surfaces in models are not faced correctly. |
| Enable twosided lighting | Select the check box if you want to enable two-sided lighting. Default value: cleared. |
| Cull objects smaller than | Select the size in pixels under which objects will be disregarded. Default value: 2 pixels. |
| Store model data on graphics card (recommended) | Select the check box if you want to store the model data on a graphics card. Default value: cleared. Storing model data on a graphics card improves graphics performance, but causes stability problems for some hardware combinations. |

The settings you make here are generic for all objects in RobotStudio. With the Graphic Appearance dialog box you can, however, override some of these settings for single objects.

Continues on next page
### Options: Graphics: Behavior

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation</td>
<td>Select a navigational activity and then specify the mouse buttons to be used for the selected navigational activity.</td>
</tr>
<tr>
<td>Navigation sensitivity</td>
<td>Select the navigation sensitivity when using the mouse movements or navigation buttons by clicking the bar and dragging it into position. Default value: 1.</td>
</tr>
<tr>
<td>Selection radius (pixels)</td>
<td>Change the selection radius (that is, how close the mouse cursor click must be to an item to be selected) by entering the requested pixel value in the box. Default value: 5.</td>
</tr>
<tr>
<td>Selection highlight</td>
<td>Set if the selected object shall be distinguished in the Graphics window by a color, by an outline or not at all. Default value: color.</td>
</tr>
<tr>
<td>Highlight color</td>
<td>Click the colored rectangle to change the highlight color.</td>
</tr>
<tr>
<td>Activate selection preview</td>
<td>Select the check box to enable temporarily highlighting of items that may be selected when the mouse cursor passes over them. Default value: selected.</td>
</tr>
<tr>
<td>Show local coordinate system for selected objects</td>
<td>Select the check box to show the local coordinate system for the selected objects. Default value: selected.</td>
</tr>
</tbody>
</table>

### Options: Graphics: Geometry

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail Level</td>
<td>Specify the level of detail required when importing geometries. Select Fine, Medium or Coarse as required.</td>
</tr>
</tbody>
</table>

### Options: Simulation: Collision

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform collision detection</td>
<td>Select if collision detection is to be performed during simulation or always. Default value: During simulation.</td>
</tr>
<tr>
<td>Stop simulation at collision</td>
<td>Select this check box if you want the simulation to stop at a collision or at a near miss. Default value: cleared.</td>
</tr>
<tr>
<td>Log collisions to Output window</td>
<td>Select this check box if you want the collisions to be logged to the output window. Default value: selected.</td>
</tr>
<tr>
<td>Log collisions to file</td>
<td>Select this check box if you want to log the collisions to a file. Browse for the file to log in by clicking the browse button. Default value: cleared.</td>
</tr>
<tr>
<td>Enable fast collision detection</td>
<td>Select this check box to enhance the performance by detecting collisions between geometrical bounding boxes instead of geometrical triangles. This might result in falsely reported collisions, since the triangles are the true geometry and the bounding boxes always are larger. All true collisions will, however, be reported. The larger the object, the greater the number of false collisions that are likely to be detected.</td>
</tr>
<tr>
<td>View</td>
<td>Click this button to open the log file specified in the file box in Notepad.</td>
</tr>
<tr>
<td>Clear</td>
<td>Click this button to delete the log file specified in the file box.</td>
</tr>
<tr>
<td>...</td>
<td>Click this button to browse for the file in which you want to log the collisions.</td>
</tr>
</tbody>
</table>
### Options: Simulation: Virtual Time

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Time mode - Free run</td>
<td>This option makes RobotStudio always use the free run mode. Simulations created using the Smart Component are now supported with VC in this mode. As a result, FlexPendant and ScreenMaker applications can be executed on the FlexPendant together with Smart Component simulations.</td>
</tr>
<tr>
<td>Virtual Time mode - Time Slice</td>
<td>This option makes RobotStudio always use the time slice mode.</td>
</tr>
<tr>
<td>Run time slice in parallel for multiple controllers</td>
<td>When simulating a large number of controllers (such as ten controllers), this option may increase performance by utilizing multiple CPU cores. This option is hardware dependent and hence may give different results depending on the computer used.</td>
</tr>
</tbody>
</table>

### Options: Simulation: Accuracy

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation speed</td>
<td>Sets the simulation speed relative to real time. You can define the simulation speed to a maximum of 200%</td>
</tr>
<tr>
<td>As fast as possible</td>
<td>Select this check box to run the simulation as fast as possible. When you select this option, the simulation speed slider is disabled.</td>
</tr>
<tr>
<td>Simulation timestep</td>
<td>Specifies the simulation timestep.</td>
</tr>
</tbody>
</table>
8 Home tab

8.1 Overview

The Home tab

The Home tab contains the controls required for building stations, creating systems, programming paths and placing items.
8 Home tab

8.2 ABB Library

8.2 ABB Library

About this button

With this button, you can choose robots, positioners and tracks from their respective galleries.
8.3 Import Library

About this button

With this button, you can import equipment, geometries, positioners, robots, tools and training objects to your station libraries.

Importing a library

Use this procedure for importing library files to a station:

1. On the Home menu, click Import Library and select one of the following controls:
   - Equipment
   - User Library
   - Documents
   - Locations
   - Browse for Library

   Note
   You can also import component xml files (*.rsxml) to your station.

2. Click Equipment to import predefined ABB mechanism libraries.
3. Click User Library to select the user defined libraries.
4. Click Documents to open the Document Manager window. See The Document Manager window on page 62
6. Click Browse for Library to select the saved library files.
8 Home tab

8.4 Robot System

8.4.1 Robot System

About this button

With the Robot System button, you can either create a system from layout or template, choose an existing system, or select a system from a robot gallery and setup a conveyor tracking mechanism.

Creating a system from layout

1. Click From Layout to bring up the first page of the wizard.
2. In the Name box, enter the name of the system.
3. In the Location box, enter the path to the folder where the system will be stored. Alternatively, click Browse and browse to the folder.
4. In the Media Pool box, enter the path to the media pool. Alternatively, click Browse and browse to the folder.
5. In the RobotWare Version list, select the version of RobotWare you want to use.
6. Click Next.
7. In the Mechanisms box, select the mechanisms that you want to include in the system.
8. Click Next.

The wizard now proposes a mapping of the mechanisms to a specific motion task, in accordance with the following rules:

- Only one TCP robot is allowed per task.
- Up to six motion tasks may be added, but only four TCP robots can be used, and they must be assigned to the first four tasks.
- The number of tasks may not exceed the number of mechanisms.
- If the system contains one TCP robot and one external axis, they will be assigned to the same task. It is, however, possible to add a new task and assign the external axis to it.
- If the system contains more than one TCP robot, any external axes will be assigned to a separate task. It is, however, possible to move them to other tasks.
- The number of external axes in a task is limited by the number of available drive modules in the cabinet (one for large robots, two for medium, three for small).

If only one mechanism was selected in the previous page, this page will not be shown.

Tasks can be added and removed using the respective buttons; mechanisms can be moved up or down using the respective arrows. To map the mechanisms to tasks, follow this step:

9. Optionally, make any edits in the mapping, and then click Next.
10 On the System Option page, you have the option to align Task Frame(s) with the corresponding Base Frame(s).

- For single robot system, select the checkbox to align task frame with base frame:
- For MultiMove Independent system, select the check box to align task frame with base frame for each robot.
- For MultiMove Coordinated system, select the robot from the drop down list and select the check box to align task frame with base frame for the selected robot.

11 Verify the summary and then click Finish.

If the system contains more than one robot, the number of tasks and the baseframe positions of the mechanism should be verified in the System Configuration window.

### Adding a template system

1 Click From Template to bring up a dialog box.
2 In the Select Template System list, either select an appropriate template or click Browse and browse to one.
3 In the Libraries group, select whether to import libraries or to use the existing station libraries.
4 In the System group, enter a name and location, and then click OK.

### Adding an existing system

1 Click Existing to bring up a dialog box.
2 In the Select System Pool list, select a folder.
3 In the Systems Found list, select a system.
4 In the Libraries group, select whether to import libraries or to use the existing station libraries.
5 Click OK.

### Selecting a system from a robot gallery

1 Click Quick System to bring up a gallery, and then click the appropriate robot.

### Setting up a conveyor

1 Click Setup.
2 In the Part Sequence tab, select Part from Available Parts.
   The right arrow button is enabled.
3 Click right arrow button to move the Part to Parts moved by Conveyor list.
4 Click up and down arrow buttons to move the selected part in Parts moved by Conveyor list.
5 In the Part Tracking tab, select Part from Parts moved by Conveyor list.
6 Select CNV1 from the Mechanical Unit list.
8 Home tab

8.4.1 Robot System

Continued

7 Select a workobject from the Workobject list.
8 Click Add. The workobject appears in the list.

If the same workpiece is tracked by more than one robot, add a pair of
workobject for each robot that tracks the workpiece. This procedure has to
be repeated for each workpiece that should be tracked.

9 Click OK.
10 Activate the Conveyor Mechanical Unit (CNV1). See Activate Mechanical
Units on page 329

Removing objects from conveyor
1 Click Setup.

The Conveyor Setup dialog box appears.

2 In the Part Sequence tab, select Part from the Parts moved by Conveyor
list

The left arrow button is enabled.

3 Click left arrow to remove the part from the Parts moved by Conveyor list
to Available Parts list.
8.4.2 External Axis Wizard

Overview

The ABB IRC5 controller is capable of controlling a vast number of mechanical units other than the ABB robot manipulator. Some external equipment such as workpiece positioners and robot tracks are standard ABB equipment for which ABB supplies and maintains controller system configuration files. But in many situations there is a need for customized external equipment.

It is possible to use standard ABB motor units and gear units in customized external equipment. The configuration file of the motor unit or gear unit in isolation is supplied and maintained by ABB. The External Axis Wizard tool simplifies the controller configuration for different combinations of motor units and gear units in customized mechanical units.

Mechanism modeling functionality in RobotStudio makes it is possible to define custom kinematic mechanisms. The External Axis Wizard lets you specify mechanisms to include in the system. First, connect and configure each axis in a mechanism to a corresponding motor unit or gear unit. Then, the template configuration files are used to assemble a complete system configuration according to specification.

Note

The External Axis Wizard can be downloaded from the RobotApps website. To access the RobotApps website, visit www.abb.com/roboticssoftware.

Limitation

For IRC5P systems (used for painting), the External Axis Wizard supports only up to three external axes.

Prerequisites

- Build the station, and import or model the geometry of the mechanism. For information about creating a new station, see Workflow of building a station on page 75.
- Use the Mechanism Modeling functionality to define custom kinematic mechanisms. For more information, see Create Mechanism on page 308.
- Add a virtual controller to the station, and include additional drives corresponding to the axes of the mechanism to the controller system.
- The robot will not be attached to the mechanism. You must manually attach the robot to the external axis after successful configuration by the External Axis Wizard.

Using the External Axis Wizard

1. From the Robot System menu, click External Axis Wizard.

The first page of the wizard appears. It lists the the previously defined mechanisms (including robots) in the Mechanisms box.

Continues on next page
2 From the Mechanisms box, select the mechanisms to include in the system.
   • The mechanism model must be built in such a way that a kinematics model can be created. The joint chain must be defined such that it can be described by Denavit-Hartenberg parameters. The mechanism model must sometimes be modified to be able to keep the flange in the desired position. This can be done automatically by the External Axis Wizard, by adding a locked axis.
   • For adding an additional locked axis, when prompted, click Ok. This is a dummy axis with frame definition. This dummy axis is added to the controller configuration and also to the RobotStudio mechanism. You cannot jog this additional axis.

3 Click Next.
The mechanisms along with their joints are listed.

4 Configure the Mechanical Unit based on the following information. The name of the mechanism in RobotStudio corresponds to the mechanical unit of the motion configuration.
   • Select the drive module (DM1 - DM4) to use for the mechanical unit.
     If the mechanism has more than three joints, or, if there are several external mechanisms which are to be part of the configuration, then you need to use additional drive modules. In such cases, before using the External Axis Wizard, configure the controller system with the appropriate number of drive modules.
   • Optionally, you can use an Activation Relay by selecting the corresponding check box.
     For more information, see Technical reference manual - System parameters (3HAC17076-1).
   • For two axis positioners with rotating axes, where the two axes are in series, you can optionally select the Error Model check box.
     Mechanisms defined with the error model can be calibrated with the FlexPendant using the standard four point method for each axis. This will compensate for deviations present in the real mechanisms.
   • You can configure two mechanical units to share a drive module.
     To share the drive module with a mechanical unit, select that mechanical unit in the Common Drive list. The list shows all mechanisms (except TCP robot) with the same number of joints as the selected one. The joints of the mechanical units use the same logical axis and drive module. Note that the common drive option is not available unless an activation relay is chosen for the mechanical unit. This ensures that two mechanical units sharing a drive cannot be activated at the same time.

5 Configure the joint based on the following information.
   • For each joint select the Motor Unit. You can select a motor unit (MU), or a gear unit (MTD), or an interchange unit (MID). The list is populated with the standard motor and gear units provided by ABB.
Your choice will affect the capacity and cycle time of the external axis.

- **Electronically linked motors** are two motor units that drive the same axis. To link a motor unit to another one electronically, select the respective joint in the **Follow** list.
- The **Drive Unit** list is populated with the available drive units of the system. Each joint will be represented by its selected drive unit.
- You can configure **Logical Axis**, **Transmission**, **Link**, **Board** and **Node** according to your needs.

For more information, see *Technical reference manual - System parameters (3HAC17076-1)*.

---

**Note**

Default values are given for all attributes, except Motor Unit. However, you must review and change to the correct parameters to give a valid configuration.

6 Click **Next**.

The Finish page comes up.

7 To save the configuration to a file, click **Save**.

The configured kinematics of external axis devices are saved to a configuration file.

8 To load the saved configuration to the system on exiting from the wizard, select the **Load Configuration to System** check box.

9 Click **Finish** to exit the wizard.

Use the saved configuration files to assemble a complete controller system configuration according to specification. When a system is configured, the MOC.cfg file with a subset for the external equipment is saved and a virtual controller is started for verification.

---

**Note**

All mechanisms which have been used in this configuration will be disconnected from the library. To maintain these changes in a library file (.rslib), you need to manually save it. This is because the External Axis Wizard may have automatically adjusted the mechanisms to enable them to be configured.
8 Home tab

8.5 Import Geometry

8.5 Import Geometry

Importing geometry

1. On the Home menu, click Import Geometry and select one of the following controls:
   - User Geometry
   - Browse for Geometry

2. Click User Geometry to select the user defined geometry.

3. Click Browse for Geometry to browse to the folder where the geometry is located.
   For predefined geometries, click the Geometry icon to the left in the dialog box.

4. Select the required geometry and click Open.
   If you want the geometry to move with another object, attach it to the requested object, see Attach to on page 438.

   To modify the detail level for import of geometries, see Options on page 193.
8.6 Frame

8.6.1 Frame

Creating a frame

1. Click Frame.
2. In the dialog box, specify the positions for the frame.

<table>
<thead>
<tr>
<th>Table Cell</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>Select the Reference coordinate system to which all positions or points will be related.</td>
</tr>
<tr>
<td>Frame Position</td>
<td>Click in one of these boxes, and then click the frame position in the graphics window to transfer the values to the Frame Position boxes.</td>
</tr>
<tr>
<td>Frame Orientation</td>
<td>Specify the coordinates for the frame orientation.</td>
</tr>
<tr>
<td>Set as UCS</td>
<td>Select this check box to set the created frame as the user coordinate system.</td>
</tr>
</tbody>
</table>
8.6.2 Frame from Three Points

Creating a frame from three points

1. Click Frame from Three points to bring up a dialog box.
2. Decide how you want to specify the frame:

<table>
<thead>
<tr>
<th>To specify the frame using</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>X, Y and Z coordinates, a point on the X axis and a point in the X-Y plane</td>
<td>Position</td>
</tr>
<tr>
<td>two points on the X axis and one point on the Y axis</td>
<td>Three Point</td>
</tr>
</tbody>
</table>

3. If you select **Position**:
   - Enter the **Position** for the object.
   - Enter the **Point on X axis** for the object.
   - Enter the **Point on X-Y plane** for the object.
   - Click **Create**.

4. If you select **Three Point**:
   - Enter the **First Point on X axis** for the object. This is the point closest to the frame’s origin.
   - Enter the **Second Point on X axis** for the object. This is the point further away in the positive X direction.
   - Enter the **Point on Y axis** for the object.
   - Click **Create**.

The Create Frame From Three Points dialog box

<table>
<thead>
<tr>
<th>Position</th>
<th>Select this option if you want to create the frame by using a position and two points.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Position</td>
<td>Click in one of these boxes, and then click the frame position in the graphics window to transfer the values to the Frame Position boxes.</td>
</tr>
<tr>
<td>Point on X axis</td>
<td>Click in one of these boxes, and then click the point position in the graphics window to transfer the values to the Point on X axis boxes.</td>
</tr>
<tr>
<td>Point on X-Y plane</td>
<td>Click in one of these boxes, and then click the point position in the graphics window to transfer the values to the Point on X-Y plane boxes.</td>
</tr>
<tr>
<td>Three Point</td>
<td>Select this option if you want to create the frame by using three points.</td>
</tr>
<tr>
<td>First Point on X axis</td>
<td>Click in one of these boxes, and then click the point position in the graphics window to transfer the values to the First Point on X axis boxes.</td>
</tr>
<tr>
<td>Second Point on X axis</td>
<td>Click in one of these boxes, and then click the point position in the graphics window to transfer the values to the Second Point on X axis boxes.</td>
</tr>
<tr>
<td>Point on Y axis</td>
<td>Click in one of these boxes, and then click the point position in the graphics window to transfer the values to the Point on Y axis boxes.</td>
</tr>
</tbody>
</table>
### Set as UCS

| Set as UCS | Select this check box to set the created frame as the user coordinate system. |

---

**8.6.2 Frame from Three Points**

*Continued*
8 Home tab

8.7 Workobject

Creating a workobject

1. On the Home tab, in the Path Programming group, click Other, and then click Workobject.
   This opens the Create Workobject dialog box.

2. In the Misc Data group, enter the values for the new workobject.

3. In the User Frame group, do one of the following:
   - Set the position of the user frame by entering values for the Position x, y, z and the Rotation rx, ry, rz for the workobject by clicking in the Values box.
   - Select the user frame by using the Frame by points dialog box.

4. In the Object Frame group you can reposition the object frame relative to the user frame by doing any of the following:
   - Set the position of the object frame by selecting values for Position x, y, z by clicking in the Values box.
   - For the Rotation rx, ry, rz, select RPY (Euler XZY) or Quaternion, and enter the rotation values in the Values dialog box.
   - Select the object frame by using the Frame by points dialog box.

5. In the Sync Properties group, enter the values for the new workobject.

6. Click Create. The workobject will be created and displayed under the Targets node under the robot node in the Paths&Targets browser.

The Create Workobject dialog box

<table>
<thead>
<tr>
<th>Name</th>
<th>Specify the name of the workobject.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robot holds workobject</td>
<td>Select whether the workobject is to be held by the robot. If you select True, the robot will hold the workobject. The tool can then either be stationary or held by another robot.</td>
</tr>
<tr>
<td>Moved by mechanical unit</td>
<td>Select the mechanical unit that moves the workobject. This option is applicable only if Programmed is set to False.</td>
</tr>
<tr>
<td>Programmed</td>
<td>Select True if the workobject is to use a fixed coordinate system, and False if a movable (that is, external axes) will be used.</td>
</tr>
<tr>
<td>Position x, y, z</td>
<td>Click in one of these boxes, and then click the position in the graphics window to transfer the values to the Position boxes.</td>
</tr>
<tr>
<td>Rotation rx, ry, rz</td>
<td>Specify the rotation of the workobject in the UCS.</td>
</tr>
<tr>
<td>Frame by points</td>
<td>Specify the frame position of the user frame.</td>
</tr>
<tr>
<td>Position x, y, z</td>
<td>Click in one of these boxes, and then click the position in the graphics window to transfer the values to the Position boxes.</td>
</tr>
<tr>
<td>Rotation rx, ry, rz</td>
<td>Specify the rotation of the workobject.</td>
</tr>
<tr>
<td>Frame by points</td>
<td>Specify the frame position of the object frame.</td>
</tr>
<tr>
<td>Storage type</td>
<td>Select PERS or TASK PERS. Select the Storage Type TASK PERS if you intend to use the workobject in multimove mode.</td>
</tr>
<tr>
<td>Module</td>
<td>Select the module in which to declare the workobject.</td>
</tr>
</tbody>
</table>
8.8 Tooldata

Creating tooldata

1 In the Layout browser, make sure the robot in which to create the tooldata is set as the active task.

2 On the Home tab, in the Path Programming group, click Other, and then click Tooldata.
   This opens the Create Tooldata dialog box.

3 In the Misc Data group:
   • Enter the Name of the tool.
   • Select whether the tool is to be held by the robot in the Robot holds tool list.

4 In the Tool Frame group:
   • Define the Position x, y, z of the tool.
   • Enter the Rotation rx, ry, rz of the tool.

5 In the Load Data group:
   • Enter the Weight of the tool.
   • Enter the Center of gravity of the tool.
   • Enter the Inertia of the tool.

6 In the Sync Properties group:
   • In the Storage type list, select PERS or TASK PERS. Select TASK PERS if you intend to use the tooldata in MultiMove mode.
   • In the Module list, select the module in which to declare the tooldata.

7 Click Create. The tooldata appears as a coordinate system in the graphics window.
Teaching a target

To teach a target, follow these steps:

1. In the Layout browser, select the workobject and tool for which you want to teach the target.

2. Jog the robot to the preferred position. To jog a robot linearly, its VC must be running.

3. Click Teach Target.

4. A new target will be created in the browser, under the active workobject node. In the graphics window a coordinate system will be created at the TCP position. The configuration of the robot at the target will be saved.
8.9.2 Create Target

Creating a target

1. In the Layout browser, select the workobject in which you want to create the target.
2. Click Create Target to bring up a dialog box.
3. Select the Reference coordinate system you want to use to position the target:

<table>
<thead>
<tr>
<th>If you want to position the target</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>absolute in the world coordinate system of the station</td>
<td>World</td>
</tr>
<tr>
<td>relative to the position of the active workobject</td>
<td>Work Object</td>
</tr>
<tr>
<td>in a user-defined coordinate system</td>
<td>UCS</td>
</tr>
</tbody>
</table>

4. In the Points box, click Add New and then click the desired position in the graphics window to set the position of the target. You can also enter the values in the Coordinates boxes and click Add.
5. Enter the Orientation for the target. A preliminary cross will be shown in the graphics window at the selected position. Adjust the position, if necessary. To create the target, click Create.
6. If you want to change the workobject for which the target is to be created, expand the Create Target dialog box by clicking the More button. In the WorkObject list, select the workobject in which you want to create the target.
7. If you want to change the target name from the default name, expand the Create Target dialog box by clicking the More button and entering the new name in the Target name box.
8. Click Create. The target will appear in the browser and in the graphics window.

Note

The created target will not get any configuration for the robot axes. To add the configuration values to the target, use either ModPos or the Configurations dialog box.
If using external axes, the position of all activated external axes will be stored in the target.

The Create Target dialog box

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Click in one of these boxes, and then click the position in the graphics window to transfer the values to the Position boxes.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specify the orientation of the target.</td>
</tr>
<tr>
<td>Add</td>
<td>Click this button to add a point and its coordinates to the Points list.</td>
</tr>
</tbody>
</table>

Continues on next page
### 8 Home tab

#### 8.9.2 Create Target

*Continued*

<table>
<thead>
<tr>
<th>Modify</th>
<th>Click this button to modify an already defined point, after you have selected it in the Points list and entered new values.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Points</td>
<td>The target points. To add more points, click <strong>Add New</strong>, click the desired point in the graphics window, and then click <strong>Add</strong>.</td>
</tr>
<tr>
<td>More/Less</td>
<td>Click this button to expand or collapse parts of the create target dialog box.</td>
</tr>
<tr>
<td>Target name</td>
<td>Here you can change the name of the target you are creating. It is visible only when the create target dialog box is expanded.</td>
</tr>
<tr>
<td>Workobject</td>
<td>Here you can change the workobject in which the target is to be created. It is visible only when the create target dialog box is expanded.</td>
</tr>
</tbody>
</table>
8.9.3 Create Jointtarget

Creating a jointtarget

1. Click **Create Jointtarget** to bring up a dialog box.
2. If you want to change the default name of the jointtarget, enter the new name in the **Name** box.
3. In the **Axes Values** group, do as follows:
   - For the **Robot axes**, click the **Values** box and then click the down arrow. The **Joint Values** dialog box will be displayed. Enter the joint values in the boxes and click **Accept**.
   - For the **Joint axes**, click the **Values** box and then click the down arrow. The **Joint Values** dialog box will be displayed. Enter the joint values in the boxes and click **Accept**.
4. Click **Create**. The jointtarget will appear in the browser and in the graphics window.

The Create Jointtarget dialog box

<table>
<thead>
<tr>
<th>Name</th>
<th>Specify the name of the jointtarget.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robot axes</td>
<td>Click the <strong>Values</strong> list, enter the values in the <strong>Joint values</strong> dialog box and click <strong>Accept</strong>.</td>
</tr>
<tr>
<td>External axes</td>
<td>Click the <strong>Values</strong> list, enter the values in the <strong>Joint values</strong> dialog box and click <strong>Accept</strong>.</td>
</tr>
<tr>
<td>Storage Type</td>
<td>Select the <strong>Storage Type</strong> <strong>TASK PERS</strong> if you intend to use the jointtarget in multimove mode.</td>
</tr>
<tr>
<td>Module</td>
<td>Select the module in which you want to declare the jointtarget.</td>
</tr>
</tbody>
</table>
8 Home tab

8.9.4 Create Targets on Edge

Overview

Targets on Edge creates targets and move instructions along the edges of the geometric surface by selecting target points in the graphics window. Each point on a geometric edge has certain properties that can be used to position robot targets relative to the edge.

Creating targets on edge

1. On the Home tab, click Target and select Create Targets on Edge. The Targets on Edge dialog box appears.

   Note
   The selection mode in graphics window is automatically set to Surface, and the snap mode is set to Edge.

2. Click on the surface of the body or part to create target points. The closest point on the adjacent edge is calculated and added to the list box on as target points Point 1, Point 2 ....

   Note
   When an edge is shared between two surfaces, the normal and tangent directions depend on the surface selected.

3. Use the following variables to specify how a target is related to a point on the edge.

<table>
<thead>
<tr>
<th>Select...</th>
<th>to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical offset</td>
<td>specify the distance from the edge to the target in the surface normal direction.</td>
</tr>
<tr>
<td>Lateral offset</td>
<td>specify the distance from the edge to the target perpendicular to the edge tangent.</td>
</tr>
<tr>
<td>Approach angle</td>
<td>specify the angle between the (inverse) surface normal and the approach vector of the target.</td>
</tr>
<tr>
<td>Reverse travel direction</td>
<td>specify if the travel vector of the target is parallel or inversely parallel to the edge tangent.</td>
</tr>
</tbody>
</table>

   Note
   For each target point, a preview of the approach and travel vectors are displayed as arrows and as a sphere representing the point on the edge in the graphics window. The preview of the arrows are updated dynamically once the variables are modified.

4. Click Remove to remove the target points from the list box.

Continues on next page
5 Click More to expand the **Create Targets on Edge** dialog box and to choose the following advanced options:

<table>
<thead>
<tr>
<th>Use...</th>
<th>to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target name</td>
<td>change the target name from the default name to a new user defined name</td>
</tr>
<tr>
<td>Task</td>
<td>select the task for which to add targets. By default, active task in the station is selected.</td>
</tr>
<tr>
<td>Workobject</td>
<td>select the workobject for which you want to create the targets on edge</td>
</tr>
<tr>
<td>Insert Move Instructions In</td>
<td>create Move instructions in addition to targets, which will be added to the selected path procedure. The active process definition and process template will be used.</td>
</tr>
</tbody>
</table>

6 Click Create.

The target points and Move instructions (if any) are created and are displayed in the Output window and graphics window.
8 Home tab

8.10 Empty Path

8.10 Empty Path

Creating an empty path

1 In the Paths&Targets browser, select the folder in which you want to create the path.

2 Click Empty Path.

3 To set the correct motion properties for the targets, select the active process in the Change Active Process box in the Elements toolbar.

4 If the active template is set to MoveAbsJoint, then:
   • A target that is dragged into a path will be converted into a jointtarget (recognized by a different icon on in the browser).
   • Jointtargets and their instructions can only use wobj0 and tool0.
   • One target can not be used as different types, for example, MoveJoint, but must be deleted and re-created.
   • When the target has been synchronized with the virtual controller, the jointtarget values will be calculated and inserted in the RAPID program.
8.11 AutoPath

Overview
AutoPath helps in generating accurate paths (linear and circular) based on CAD geometry.

Prerequisites
You need to have a geometric object with edges, curves, or both.

Creating autopath
Use this procedure to generate an autopath:

1. In the Home tab, click Path and select AutoPath.
   The AutoPath dialog box appears.

2. Select the edge or curve of the geometric object for which you want to create an autopath.
   The selection is listed as edges between <Start> and <End> in the graphic window.

   Note
   • If in a geometric object, you select curve (instead of an edge), then all the points that result in the selected curve are added as edges to the list in the graphic window.
   • Ensure you always select continuous edges.

3. Click Remove to delete the recently added edge from the graphic window.

   Note
   To change the order of the selected edges, select Reverse check box.

4. You can set the following Approximation Parameters:

<table>
<thead>
<tr>
<th>Select or enter values in</th>
<th>to</th>
</tr>
</thead>
<tbody>
<tr>
<td>MinDist(mm)</td>
<td>Set the minimum distance between the generated points. That is, points closer than the minimum distance are filtered.</td>
</tr>
<tr>
<td>ChordDev(mm)</td>
<td>Set the maximum deviation from the geometric description allowed for the generated points.</td>
</tr>
<tr>
<td>MaxRadius(mm)</td>
<td>Determines how large a circle radius has to be before considering the circumference as a line. That is, a line can be considered as a circle with infinite radius.</td>
</tr>
<tr>
<td>Linear</td>
<td>Generate a linear move instruction for each target.</td>
</tr>
<tr>
<td>Circular</td>
<td>Generate circular move instructions where the selected edges describe circular segments.</td>
</tr>
<tr>
<td>Constant</td>
<td>Generate points with a constant distance.</td>
</tr>
</tbody>
</table>

The Reference Surface box shows the side of the object that is taken as normal for creating the autopath.

Continues on next page
5 Click Create to generate a new autopath. A new path is created and move instructions are inserted for the generated targets as set in the Approximation parameters.

Note
The targets are created in the active workobject.

6 Click Close.
8.12 MultiMove

Overview

For browsing between the pages of the MultiMove window, click the tabs in the navigation pane. By default the tabs are arranged in an order that corresponds to the typical workflow:

Setup tab

<table>
<thead>
<tr>
<th>System Config</th>
<th>Select System</th>
<th>Here you select the system that contains the robots to program.</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>Each robot in the system is presented in its own row in this grid. In the columns you make the settings as described below.</td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>Select this check box to use the robot in the MultiMove program.</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Specify if the robot holds the tool or the work piece.</td>
<td></td>
</tr>
<tr>
<td>Robot</td>
<td>Displays the name of the robot.</td>
<td></td>
</tr>
</tbody>
</table>

Path Config

| Update     | Click this button to update the paths in the grid if any of the paths have been changed. The button turns red if a change has been detected and an update is necessary. |
| Paths       | Each path in the station is presented in its own row in this grid. In the columns you make the settings as described below. |
| Enable      | Select this check box for the paths to use for the program. |
| Order       | Displays the order in which the paths will be executed. To change the order, use the lists in the path column for rearranging the rows in which the paths appear. |
| Path        | Sets the path to be executed here. |

Start Position

| Select Robot that other shall jump to | When creating a new start position, select a robot that the other will try to reach here. |
| Apply       | Jumps the other robots to the new start position. |

Motion Behavior tab

This is used for specifying constraints and rules for how the robots shall move relative to each other. The default setting is no particular constraints, which results in the fewest joint movements. However, changing the motion behavior might be useful for:

- Locking the orientation or position of the tool.
- Optimizing cycle time or reachability by allowing tolerances.

Continues on next page
• Avoiding collisions or singularity by restricting joint motions.

Both Joint Influence and TCP Constraints restrict the robot’s motions. Changes in these settings might result in lower performance or situations where it is impossible to find proper solutions. The weight values for Joint Weights and TCP Constraints set how much the setting for each joint or TCP direction shall affect the robots relative to each other. It is the difference between the weight values that matters, not the absolute values. If contradicting behaviors have been set, the one with the lowest weight value will win.

Tool Tolerance, instead of restricting, enables more motions. Therefore, tolerances may improve cycle and process times and enhance the reachability of the robots. Tolerances, too, have weight value; here is set how much the robots shall use the tolerance. A low value indicates that the tolerance will be used a lot, while a high value means that the robots will try to avoid using the tolerance.

The joint influence controls the balance of how much the robots will use their joints. Decreasing the weight value for one axis will restrict the motion for this axis, while increasing it will promote motion on this axis relative to alternative axes.

The TCP constraints control the position and orientation of the tool. Enabling a TCP constraint will decrease the motion of the tool and increase the motion of the work piece.

The tool tolerances control the allowed deviation between the tool and the work piece. By default, tolerances are not enabled, which means that no deviation is allowed. Enabling a tolerance, if applicable, might improve motion performance. For example, if the tool is symmetric around its Z axis, you can enable the Rz tolerance without affecting the accuracy of the generated paths.

The tool offset sets a fixed distance between the tool and the paths.

<table>
<thead>
<tr>
<th>Joint Influence</th>
<th>Select Robot</th>
<th>Select the robot’s joints to constrain in this box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joints for Robot</td>
<td></td>
<td>Displays the robot’s joints and their constraint weights. Each joint is presented in its own row.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
<td>Displays which axis the constraint affects.</td>
</tr>
<tr>
<td>Influence</td>
<td></td>
<td>Specify how much the motion for the axis is constrained. 0 means a locked axis, while 100 means no constraint relative to default constraint values.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TCP Constraints</th>
<th>Active TCP</th>
<th>This grid displays the position and rotations of the TCP together with their constraint weights.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td></td>
<td>Select this check box to activate the constraint for this TCP pose.</td>
</tr>
<tr>
<td>Pose</td>
<td></td>
<td>Displays the TCP pose that is affected by the constraint.</td>
</tr>
<tr>
<td>Value</td>
<td></td>
<td>Specify the pose value to constrain at. Either type the value, or click the Pick from TCP button to use the values of the current TCP position.</td>
</tr>
</tbody>
</table>
Specify how much the motion for the TCP value is constrained. 0 means a locked TCP at this pose, while 100 means no constraint relative to default constraint values.

<table>
<thead>
<tr>
<th>Influence</th>
<th>Specify how much the motion for the TCP value is constrained. 0 means a locked TCP at this pose, while 100 means no constraint relative to default constraint values.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool Tolerance Enable</td>
<td>Select this check box to activate the tolerance for this tool pose.</td>
</tr>
<tr>
<td>Pose</td>
<td>Displays the tool pose that is affected by the constraint.</td>
</tr>
<tr>
<td>Value</td>
<td>Specify the pose value to apply the tolerance around.</td>
</tr>
<tr>
<td>Influence</td>
<td>Specify the size of the tolerance. 0 means no deviation is allowed, while 100 means all deviations are allowed.</td>
</tr>
<tr>
<td>Tool Offset Enable</td>
<td>Select this check box to activate the offset for this tool pose.</td>
</tr>
<tr>
<td>Pose</td>
<td>Displays the tool pose that is affected by the offset setting.</td>
</tr>
<tr>
<td>Offset</td>
<td>Specify the value of the offset here.</td>
</tr>
</tbody>
</table>

Create Paths tab

This tab is used for creating RobotStudio paths for the MultiMove robots. The created paths will accord with the motions displayed during the most recently played test simulation.

With the settings group you set up the MultiMove properties that connect the tasks for the tool robot and work piece robot to each other.

With the WP robot settings group you set up the properties for the task that will be generated for the work piece robot.

The generate path group contains the button that creates the paths.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Start ID</th>
<th>Specify the first ID number for the synchronization of the instructions for the robots.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID step index</td>
<td>Specify the gap between the succeeding ID numbers.</td>
<td></td>
</tr>
<tr>
<td>Sync ident prefix</td>
<td>Specify a prefix for the syncident variable, which connects the sync instructions in the tasks for the tool robot and the work piece robot with each other.</td>
<td></td>
</tr>
<tr>
<td>Task list prefix</td>
<td>Specify a prefix for the tasklist variable, which identifies the tasks for the tool robot and work piece robot to synchronize.</td>
<td></td>
</tr>
<tr>
<td>Path Prefix</td>
<td>Specify a prefix for the generated paths.</td>
<td></td>
</tr>
<tr>
<td>Target Prefix</td>
<td>Specify a prefix for the generated targets.</td>
<td></td>
</tr>
<tr>
<td>WP robot settings WP Workobject</td>
<td>Specify the work object to which the targets generated for the work piece robot shall belong.</td>
<td></td>
</tr>
</tbody>
</table>
Specify which tool data the work piece robot shall use when reaching its targets.

**Generate Paths**

Create paths

Clicking this button generates paths in RobotStudio for the latest tested motions according to the settings specified.

**MultiTeach tab**

With this tab you teach complete synchronized move instructions for the robots in the MultiMove program.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Path Prefix</th>
<th>Specify a prefix for the paths to create.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Prefix</td>
<td>Specify a prefix for the generated targets here.</td>
<td></td>
</tr>
<tr>
<td>Start ID</td>
<td>Specify the first ID number for the synchronization of the instructions for the robots.</td>
<td></td>
</tr>
<tr>
<td>ID step index</td>
<td>Specify the gap between the succeeding ID numbers.</td>
<td></td>
</tr>
<tr>
<td>Sync ident prefix</td>
<td>Specify a prefix for the syncident variable, which connects the sync instructions in the tasks for the tool robot and the work piece robot with each other.</td>
<td></td>
</tr>
<tr>
<td>Task list prefix</td>
<td>Specify a prefix for the tasklist variable, which identifies the tasks for the tool robot and work piece robot to synchronize.</td>
<td></td>
</tr>
<tr>
<td>Select type of Sync instruction</td>
<td>Select the type of synchronization to use. <em>Coordinated</em> implies that all move instructions are synchronized for the robots. <em>Semicoordinated</em> implies that the robots work independently at some times and wait for each other at other (like when repositioning the work piece). For detailed information about the coordination types, see the Application manual - Multimove.</td>
<td></td>
</tr>
</tbody>
</table>

**Setup**

Select the robots for teaching targets. This grid also displays the workobjects and tools that will be used for the targets.

**Teach**

MultiTeach Information

Displays a hierarchal tree which contains the created move instructions. The tree is organized the same way as the tree in the Layout browser.

**MultiTeach**

Creates move instructions for the robots selected in the settings to their current positions. The created move instructions are immediately inserted at their correct places in the MultiTeach Information tree.
Test tab

RobotStudio’s MultiMove window has a page with commands for testing multimove programs. Its default placement is at the bottom of the MultiMove window.

The status group displays the status of the simulation, that is, whether the current settings have been tested or if errors have occurred.

In addition to the status group, information from the virtual controller is also displayed in RobotStudio’s Output window during simulation.

<table>
<thead>
<tr>
<th>Play</th>
<th>&lt;&lt; &lt; &gt; &gt;&gt;</th>
<th>Jumps the robots, respectively, to the previous and next targets in paths. The double arrow buttons jump several targets at once, while the single arrow buttons jump one target for each click.</th>
</tr>
</thead>
</table>
| Play     |           | Click this button to move the robots along the paths. Play also has a list box in which you can activate the following commands:  
  • Save current position: Saves the current start position. Since the calculated motions are based on the robot start position saving the start position is useful when testing alternative solutions.  
  • Restore saved position: Moves the robots back to the saved start positions.  
  • Restore last closed loop position: Moves the robots back to the list used start position.  
  • Close loop: Finds a suitable start position based on the robots’ current positions and prepares the calculation of movements.  
  • Calculate: Calculates and executes the movements. |
| Simulation speed |             | Sets the speed at which the simulation is performed. |
| Settings     | Stop at end | Select this check box to make the simulation stop after running the paths one time. If cleared, the simulation will continue playing over and over until it is stopped manually. |
| Settings     | Simulate Online | Select this check box to run the simulation as the movements are calculated. This is useful for troubleshooting purposes, since it displays and reports targets the robot cannot reach. |
The MultiMove configure system wizard

The MultiMove configure system wizard guides you through configuring robots and workobjects for MultiMove system. If the workobjects are not configured correctly when the MultiMove functions are started, you will be asked whether to run the wizard. You can also start it manually from the Tools page of MultiMove.

The wizard contains four pages, the information pane at the bottom indicates the current page.

<table>
<thead>
<tr>
<th>Workpiece robot</th>
<th>The workpiece robot page contains a list in which you select the robot that holds the workpiece. Only one robot can be set up as workpiece robot. If your station has several robots that hold the workpiece, set up one of them as workpiece robot and the other as tools robots, and create paths for these robots in which they only hold the workpiece.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool robots</td>
<td>The tool robots page contains a list in which you select the robots that operate on the work piece. All robots selected as tools robots will be coordinated to the workpiece robot. Any robot of the system that is selected neither as workpiece robot or tool robot will not be coordinated.</td>
</tr>
<tr>
<td>Workobjects</td>
<td>The Workobjects page contains a box for each tool robot in which you specify the workobject in which the targets for the MultiMove paths shall be created. The wizard will attach this workobject to the workpiece robot, for enabling MultiMove. Either type in a name for a new Workobject to create in the box, or select the Use existing WorkObject check box and then select one from the list.</td>
</tr>
<tr>
<td>Result</td>
<td>The Result page displays a summary of the station configuration. Either click Done to finish or Previous to go back and change the setup.</td>
</tr>
</tbody>
</table>

**Note**

The wizard will not help you configure the RobotWare system correctly. If the correct options are not used you will not be able to synchronize generated MultiMove paths to the virtual controller, even if you can use the MultiMove functions in RobotStudio.
The Analyze path tool

This tool checks whether existing paths are coordinated correctly for MultiMove. The analyzer opens in a window of its own and contains three pages. The information pane at the bottom indicates the current page.

<table>
<thead>
<tr>
<th>Select Paths</th>
<th>Enable</th>
<th>Select to include the task in the analysis.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td></td>
<td>Displays the name of the task.</td>
</tr>
<tr>
<td>Path</td>
<td></td>
<td>Select the path to analyze for the current task.</td>
</tr>
<tr>
<td>Analyze</td>
<td>Analyze</td>
<td>Click this button to start the analysis.</td>
</tr>
<tr>
<td>Report</td>
<td>reportok</td>
<td>OK. The paths are compatible in the specified aspect.</td>
</tr>
<tr>
<td></td>
<td>reportin</td>
<td>Information. The paths are not fully compatible in the specified aspect, but the robot program may still be executable.</td>
</tr>
<tr>
<td></td>
<td>reporter</td>
<td>Error. The paths are not compatible in the specified aspect, and the robot program is not executable.</td>
</tr>
</tbody>
</table>

The Recalculate ID tool

This is one of the tools for working manually with MultiMove programs. It sets new sync ID arguments to the move instructions in a MultiMove path. By using the tool with the same start ID and ID step index on all paths that shall be synchronized, you can be sure that the IDs match if all paths contain the same number of move instructions.

<table>
<thead>
<tr>
<th>Title</th>
<th>Displays the name of the path to recalculate IDs for.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start ID</td>
<td>Sets the number of the first ID in the path.</td>
</tr>
<tr>
<td>ID Step index</td>
<td>Sets the size of the step to increase the ID number for each move instruction.</td>
</tr>
<tr>
<td>Only update instructions that has ID defined</td>
<td>Select this check box to recalculate only those IDs for instructions that have existing IDs. Clear this check box to also create IDs for instructions that have no IDs (for example, if you have added new move instructions that shall be coordinated).</td>
</tr>
<tr>
<td>The Only update instructions between SyncMove On/Off check box</td>
<td>Select this check box to affect only those move instructions that belong to already synchronized parts of the path. Clear this check box to update IDs for instructions in all parts of the path.</td>
</tr>
</tbody>
</table>
The Convert path to MultiMove path tool

This is one of the tools for working manually with MultiMove programs. It adds sync ID arguments to all move instructions in the path and, optionally, SyncMoveOn/Off instructions, thus preparing an ordinary path for MultiMove use.

You use the tool on one path a time, so for creating a MultiMove program, you convert one path for each robot and then create a tasklist and syncidents which you add to the Sync instructions.

<table>
<thead>
<tr>
<th>Title</th>
<th>Displays the name of the path to recalculate IDs for.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start ID</td>
<td>Sets the number of the first ID in the path.</td>
</tr>
<tr>
<td>ID Step index</td>
<td>Sets the size of the step to increase the ID number for each move instruction.</td>
</tr>
<tr>
<td>Add SyncMove On/Off before and after</td>
<td>Select this check box to add instructions that start and stop the synchronization.</td>
</tr>
</tbody>
</table>

The Create Tasklist tool

This is one of the tools for working manually with MultiMove programs. It creates a variable of the RAPID data type tasks, which identifies the tasks that will be synchronized. In each SyncMoveOn or WaitSyncTask instruction, you then specify which tasklist to use.

<table>
<thead>
<tr>
<th>Tasklist name</th>
<th>Specifies the name of the tasklist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tasks that will be included</td>
<td>Select the check box for each task to include in the list.</td>
</tr>
</tbody>
</table>

The Create SyncIdent tool

This is one of the tools for working manually with MultiMove programs. It creates a variable of the RAPID data type SyncIdent, which identifies the sync instructions that shall be synchronized.

<table>
<thead>
<tr>
<th>SyncIdent name</th>
<th>Specifies the name of the SyncIdent variable to create.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tasks that SyncIdent will be created in</td>
<td>Select the check box for each task to use this SyncIdent in.</td>
</tr>
</tbody>
</table>
8.13 Teach Instruction

Teaching a move instruction

1. In the Layout browser, make sure the settings for active robot, workobject, tool, motion type and path are appropriate for the move instruction to create.
2. Jog the robot to the desired location. If jogging the robot using the freehand mode, you can also use snap modes for snapping its TCP to objects in the station.
3. Click Teach Instruction. A move instruction is now created last in the path.
Creating a move instruction and a corresponding target

To create a move instruction, follow these steps:

1. Click Move Instruction to bring up a dialog box.
2. Select the Reference coordinate system for the move instruction.
3. Enter the Position to reach for the move instruction by clicking Add New in the Coordinates box and then click the required to-points in the graphics window. You can also enter the values in the Coordinates boxes and click Add.
4. Enter the Orientation for the move instruction.
5. By clicking the More/Less button, you can expand or collapse the Create Move Instruction dialog box. When the dialog box has been expanded, you can change the Target name and the Work object to which the target (with the move instruction) will belong.
6. Click Create to create the move instruction. The move instruction will appear under the path node as a reference to the target.

The Create Move Instruction dialog box for joint target movements

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Here you can change the name of the target you create when creating the move instruction.</td>
</tr>
<tr>
<td>Robot axes</td>
<td>Specify the joint values for the robot. Select the box and click the list to set the values.</td>
</tr>
<tr>
<td>External axes box</td>
<td>Specify the joint values for external axes, if any exist in the station. Select the box and click the list to set the values.</td>
</tr>
<tr>
<td>Storage Type</td>
<td>Click this button to expand or collapse parts of the create move instruction dialog box.</td>
</tr>
<tr>
<td>Module</td>
<td>Specify the module in which the joint target shall be declared.</td>
</tr>
</tbody>
</table>
8.15 Action Instruction

Creating an action instruction

1 In the Paths&Targets browser, select where to insert the action instruction.

<table>
<thead>
<tr>
<th>To insert the action instruction</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>at the beginning of a path</td>
<td>the path</td>
</tr>
<tr>
<td>after another instruction</td>
<td>the proceeding instruction</td>
</tr>
</tbody>
</table>

2 Right click Path and select Insert Action Instruction.

The Create Action Instruction dialog box appears.

3 From the Instruction Templates list, select the action instruction to create.

4 Optionally, modify instruction arguments in the Instruction Arguments grid.

For detailed information about the arguments for each instruction, see the Action Instruction on page 235.

5 Click Create.
8 Home tab

8.16 Instruction Template Manager

8.16 Instruction Template Manager

Overview

The Instruction Template Manager is used to add support for instructions other than the default set that comes with the RobotStudio.

For example, a robot controller system with the RobotWare Dispense option has specialized move instructions related to gluing like DispL and DispC. You can manually define the instruction templates for these using the Instruction Template Manager. The instruction templates are exported to XML format and reused later.

RobotStudio has pre-defined XML files that are imported and used for robot controller systems with the appropriate RobotWare options. These XML files have both the Move and Action instructions.

It is recommended to use RobotStudio ArcWelding PowerPac while using RobotWare Arc.

The instruction template supports the following Robotware options:

- Cap (Continuous Application Process)
- Disp (Dispense)
- Trigg (Fixed Position Events)
- Spot Pneumatic
- Spot Servo
- Spot Servo Equalizing
- Paint

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Buttons for importing, exporting and validating.</td>
</tr>
</tbody>
</table>

Continues on next page
The instruction template tree. This hierarchal tree set organizes the templates. Templates are always the lowest level nodes. For details about specific nodes in the tree, see item 5 and below.

Brief description for editing and creating instruction templates.

The Instruction grid. All arguments and settings for the object selected in the tree are displayed here. Only white boxes are editable. Red values indicate that the values are invalid.

The Instruction templates top node. Here you can see to which task the templates belong.

The Action instructions node contains everything related to action instruction templates.

An Action instruction description node, here represented by the Set DO instruction, defines the arguments that can be set for the action instruction templates of that kind. You can create action instruction descriptions for all action instructions known by the system running on the virtual controller.

An Action instruction template node, here represented by Default, contains instances of the action instruction descriptions, with defined values for the arguments.

The Move instructions node contains everything related to move instruction templates.

The Move instruction descriptions node contains all move instructions descriptions for the task. If the description for an instruction is not present in the list, right-click this node to add it. You can create move instruction descriptions for all move instructions known by the system running on the virtual controller.

An Action instruction description node, here represented by the MoveAbsJ node, defines the arguments that can be set for the move instruction templates of that kind. Unlike action instructions, instruction templates related to a certain move instruction descriptions are not stored in child nodes under the description, due to a more complex hierarchy.

The Process definitions node, which gathers all process definitions, contains sets of process templates which in turn contain instruction templates optimized for specific processes.

A Process definition node, here represented by the generic Move process, contains sets of process templates which in turn contain instruction templates optimized for specific processes.

A Process template node, here represented by the generic Default process, contains sets of move instruction templates with argument values optimized for specific processes. A process template can hold one move instruction template for each move instruction type defined by a move instruction description.

A Move instruction template node, here represented by MoveJ, contains instances of move instruction descriptions with argument values customized for specific processes.

Importing a template
1. Click Import to bring up the Open File dialog box.
2. Select the file to import, and click OK.
Exporting a template

1 Select an exportable node in the tree view and click Export to bring up the Save File dialog box.
2 Click OK.

Validating the templates

1 Select a node in the tree view and click Validate.

Any invalidity will be reflected by the icons and ToolTips of the respective node and reported in the Output window.
8.17 Settings

8.17.1 Task

Selecting a Task

Select a task from the Task drop-down list. The selected task indicates active task, to which new workobjects, tooldata, target, empty path or path from curve will be added.
8 Home tab

8.17.2 Workobject

8.17.2 Workobject

Selecting a Workobject

Select a workobject from the Workobject drop-down list. The selected workobject indicates active workobject, to which new targets and move instructions are added.
8.17.3 Tool

Selecting a Tool

Select a tool from the Tool drop-down list. The selected tool indicates active tool, to which move instructions are added.
8.18 The Freehand Group

8.18.1 Move

Moving an item

1. In the Layout browser, select the item you want to move.
2. Click Move.
3. In the graphics window, click one of the axes and drag the item into position.
8.18.2 Rotate

Rotating an item

1. In the Layout browser, select the item you want to rotate.
2. Click Rotate.
3. In the graphics window, click one of the rotational rings and drag the item into position.
   If you press the ALT key while rotating, the item will snap 10 degrees at a time.
Jogging the joints of a robot

1. In the Layout browser, select the robot you want to move.
2. Click Jog Joint.
3. Click the joint you want to move and drag it to the preferred position.
   If you press the ALT key when jogging the joints of the robot, the robot will move 10 degrees at a time. If you press the f key, the robot will move 0.1 degree at a time.
8.18.4 Jog Linear

Jogging the TCP of a robot

1. In the Layout browser, select the robot you want to move.
2. In the Freehand group, click Jog Linear. A coordinate system will be displayed at the TCP of the robot.
3. Click the axis you want to move and drag the TCP to the preferred position.
   If you press the f key while jogging the robot linearly, the robot will move with a smaller step size.
8.18.5 Jog Reorient

Reorienting the TCP rotation

1. In the Layout browser, select the robot you want to reorient.
2. In the Freehand group, click Jog Reorient.
   An orientation ring appears around the TCP.
3. Click the orientation ring and drag the robot to rotate the TCP to the preferred position.
   The X, Y, and Z orientation appears with units.

   **Note**

   If you press the ALT key while reorienting, the robot moves by 10 units
   and if you press the F key, it moves by 0.1 unit.

   **Note**

   The behavior of orientation differs with the different reference coordinate
   system (World, Local, UCS, Active Workobject, Active Tool).
8.18.6 MultiRobot Jog

Jogging robots in multirobot mode

1. In the Freehand group, click MultiRobot Jog. Select the robots to be jogged from the list of available robots.
2. Select the jogging mode, jog one of the robots and the other ones will follow the movement.
8 Home tab

8.19 The 3D View group

8.19 The 3D View group

Overview

The 3D View group helps you to choose view settings, control graphics view and create new views, and to show/hide the selected targets, frames, paths, parts, and mechanisms. The following options are available:

- 3D Settings
- Show/Hide
- View

3D Settings

You can select the following different view settings of the graphics window.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Size</td>
<td>To view the frame in large, medium and small sizes.</td>
</tr>
<tr>
<td>• Large</td>
<td></td>
</tr>
<tr>
<td>• Medium</td>
<td></td>
</tr>
<tr>
<td>• Small</td>
<td></td>
</tr>
<tr>
<td>Projection</td>
<td>To view the orthographic and perspective view of the object.</td>
</tr>
<tr>
<td>• Orthographic</td>
<td></td>
</tr>
<tr>
<td>• Perspective</td>
<td></td>
</tr>
<tr>
<td>Representation</td>
<td>To view the objects as a surface, wireframe, both surface and wireframe, by removing hidden lines.</td>
</tr>
<tr>
<td>• Surface</td>
<td></td>
</tr>
<tr>
<td>• Wireframe</td>
<td></td>
</tr>
<tr>
<td>• Both</td>
<td></td>
</tr>
<tr>
<td>• Hidden-line removal</td>
<td></td>
</tr>
</tbody>
</table>

Show/Hide

You can either show or hide the following options:

- Target Names
- Frame Names
- Path Names
- All Targets/Frames
- All Paths
- All Parts
- All Mechanisms

View

You can control the graphics view and create new views.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View All</td>
<td>To view all the objects in the station.</td>
</tr>
</tbody>
</table>
### 8.19 The 3D View group

**Continued**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Orientation</td>
<td>To view the objects in the following different orientations.</td>
</tr>
<tr>
<td></td>
<td>• Front</td>
</tr>
<tr>
<td></td>
<td>• Back</td>
</tr>
<tr>
<td></td>
<td>• Right</td>
</tr>
<tr>
<td></td>
<td>• Left</td>
</tr>
<tr>
<td></td>
<td>• Top</td>
</tr>
<tr>
<td></td>
<td>• Bottom</td>
</tr>
<tr>
<td>New View</td>
<td>Adds a new View tab in the graphics window.</td>
</tr>
<tr>
<td>Create Viewpoint</td>
<td>Stores the location and direction of a virtual camera in the 3D</td>
</tr>
<tr>
<td></td>
<td>environment. For more information, see <a href="#">Viewpoint on page 250</a>.</td>
</tr>
<tr>
<td>Create Markup</td>
<td>Creates text markup. For more information, see <a href="#">Markup on page 252</a>.</td>
</tr>
</tbody>
</table>
8 Home tab

8.20 Viewpoint

8.20 Viewpoint

Overview

A Viewpoint stores the location and direction of a virtual camera in the 3D environment. It stores points of interest in a station and to create camera movements during simulation.

Creating Viewpoint

You can create a viewpoint in a station in two ways:

1. In the Home tab, click View and select Create Viewpoint.
2. In the Layout browser, right-click the station and select Create Viewpoint.

A viewpoint is created and displayed (as an eye icon) in the layout browser to the left.

The position and direction of the Viewpoint can also be visualized as an arrow in the 3D graphics. By default, the newly created viewpoints are not visible and cannot be selected by clicking on the graphics.

Viewpoint functions

In the Layout browser, right-click Viewpoint to perform these function:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to Viewpoint</td>
<td>Moves the active 3D view to the location stored in the viewpoint.</td>
</tr>
<tr>
<td>Set to current</td>
<td>Modifies the viewpoint to the current location and direction of the active 3D view. This action cannot be undone.</td>
</tr>
<tr>
<td>Visible</td>
<td>Toggles the visibility of the viewpoint 3D representation. This action cannot be undone.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the viewpoint. This action cannot be undone.</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames the viewpoint. This action cannot be undone.</td>
</tr>
</tbody>
</table>

Move to Viewpoint

You can also move active 3D view to the location stored in the Viewpoint using Event manager.

2. Add an event. See Event Manager on page 322

   The Create new event dialog box appears.

3. Select Simulation under Activation and Simulation time under Event trig type. Click Next.
4. Set the activation time. Click Next.
5. Select Move to Viewpoint from Set Action type. Click Next.
6. Select the viewpoint from select Viewpoint and set the transition time.

Continues on next page
7 Click Finish.
Move to viewpoint function is also executed when replaying the simulation in a Station Viewer.
8 Home tab

8.21 Markup

Overview

A markup is a text box displayed in the 3D graphics. It is similar to the temporary text shown when performing measurement or freehand movement, but it is part of the station.

The markup is displayed as a node in the layout browser and remains so when the station is saved. It appears as text bubble pointing to a position in the graphics window.

Creating Markup

Use this procedure to create markup to an object

1. In the Home tab, click View and select Create Markup.
   The Create Markup dialog box appears.

   Note
   Alternatively, in the Layout browser, right-click the station and select Create Markup for the dialog box to appear.

2. In the Markup Text field, enter a name for the markup text.
3. In the Pointer position field, set the position of the pointer.
4. Select Always on top if you want to display the text on top.
5. Click Create.

Markup functions

In the Layout browser, right-click Markup to perform the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible</td>
<td>Shows or hides the markup in the 3D graphics.</td>
</tr>
<tr>
<td>Modify Markup</td>
<td>Modifies the Markup properties.</td>
</tr>
<tr>
<td>Attach to</td>
<td>Attaches the markup to another graphical object.</td>
</tr>
<tr>
<td>Detach</td>
<td>Detaches the attached markup.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the markup.</td>
</tr>
<tr>
<td>Rename</td>
<td>Changes the name of the markup object.</td>
</tr>
</tbody>
</table>

Modify Markup

Use this procedure to modify the markup properties:

1. In the Layout browser, right-click the markup and select Modify Markup.
   The Modify Markup dialog box appears.

2. Modify the markup text, pointer position or text position.
3. Click Apply for the changes to take effect.
4. Click Close.
9 Modeling tab

9.1 Overview

The Modeling tab

The Modeling tab contains the controls for creating and grouping components, creating bodies, measurements and CAD operations.
9 Modeling tab

9.2 Component Group

9.2 Component Group

Creating a component group

1. Click Component Group. The Group node will be displayed in the Layout browser.
2. Click the objects to add to the group. Drag them to the Group node.
9.3 Empty Part

Creating an empty part

1. Click Empty Part. The Part node will be displayed in the Layout browser.
9 Modeling tab

9.4 Smart Component

9.4.1 Smart Component

Overview

Smart Component is a RobotStudio object (with or without a 3D graphical representation) that has the behavior which can be implemented by code-behind and/or aggregation of other Smart Components.

Terminology

The following table describes the different terminologies that you come across when working with Smart Component.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code behind</td>
<td>A .NET class associated with a Smart Component that can implement custom behavior by reacting to certain events, for example simulation time steps and changes in property values.</td>
</tr>
<tr>
<td>[Dynamic] property</td>
<td>An object attached to a Smart Component that has value, type and certain other characteristics. The property value is used by code behind to control the behavior of the Smart Component.</td>
</tr>
<tr>
<td>[Property] binding</td>
<td>Connects the value of one property to the value of another property.</td>
</tr>
<tr>
<td>[Property] attributes</td>
<td>Key-value pairs that contain additional information about a dynamic property, for example value constraints.</td>
</tr>
<tr>
<td>[I/O] signal</td>
<td>An object attached to a Smart Component that has a value and a direction (input/output), analogous to I/O signals on a robot controller. The signal value is used by code behind to control the behavior of the Smart Component.</td>
</tr>
<tr>
<td>[I/O] connection</td>
<td>Connects the value of one signal to the value of a different signal.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>The process of connecting several Smart Components using bindings and/or connections in order to implement a more complex behavior.</td>
</tr>
<tr>
<td>Asset</td>
<td>Data object contained in a Smart Component. Uses include code behind assembly and localized resources.</td>
</tr>
</tbody>
</table>
9.4.2 Smart Component Editor

Overview
The Smart Component Editor allows you to create, edit, and aggregate Smart Components using a graphical user interface. It is an alternative to using the xml based library compiler.

Layout of a Smart Component Editor
It consists of an icon, the name, the description for the component wherein the description can be modified by typing in the text box, and a combo box.

The combo box specifies the language for editing localized strings (captions and descriptions) in the component. The default language is always English, even if the application language is different. For more information, see Assets on page 259.

The Smart Component Editor consists of the following tabs:
- The Compose tab on page 258
- The Properties and Bindings tab on page 261
- The Signals and Connections tab on page 264
- The Design tab on page 267

Opening a Smart Component Editor
Click Smart Component or select Edit Component from the context menu. The Smart Component Editor window appears.

Protecting a Smart Component from edits
You can protect a Smart Component from being edited. To protect the smart component, right-click the smart component, and then click Protected. You can also optionally specify a password that will be required to unlock the component for edits.

Protecting a Smart Component hides its internal structure and protects it from edits. You can use this feature to hide the complexity in the smart component, and to secure the functionality. Child components in a protected smart component are hidden in all RobotStudio browsers and also in the Signal Analyzer browser.

Note
Protecting a Smart Component in this manner is a way of hiding complexity, and is not for providing security or securely protecting it.
9 Modeling tab

9.4.3 The Compose tab

Overview

The Compose tab consists of the following:

- Child components on page 258
- Saved States on page 259
- Assets on page 259

Child components

It is a list box that displays all the objects contained by the component. Objects connected to a library have an overlay that indicates that the objects are locked. Smart Components are displayed first followed by other type of objects.

If an object is selected from the list, the following commands are displayed in the right panel:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add component</td>
<td>Adds a child object to the component from the list. You can select a built-in base Smart Component, a new empty Smart Component, a library from file or a geometric part from file. Base components are organized as sub-menus based on the usage. For example, Signals and Properties, Sensors, Actions and so on. Recently used base components are listed at the top. For more information about base Smart Component, see Basic Smart Components on page 268.</td>
</tr>
<tr>
<td>Edit parent</td>
<td>Sets the context of the Editor to the parent of the component that is currently being edited. If the parent is the station, see Station Logic on page 328.</td>
</tr>
<tr>
<td>Disconnect from library</td>
<td>Disconnects the selected object from library, allowing it to be edited.</td>
</tr>
<tr>
<td>Export to XML</td>
<td>Opens a dialog box where you can export and save the component definition along with its properties as an *.rsxml file</td>
</tr>
</tbody>
</table>

Right-click on the selected object to display the following context menu items

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Sets the context of the Editor to the selected child object.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the child object.</td>
</tr>
<tr>
<td>Show in Browser</td>
<td>Indicates if the object should be displayed in the Layout browser.</td>
</tr>
<tr>
<td>Set as Role</td>
<td>Sets the object as the Role of the component. The Smart Component will inherit certain characteristics of the Role object. For example, attaching a component with a tool as Role to a robot will cause a ToolData to be created.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Property editor dialog box for the object. See Property Editor on page 285.</td>
</tr>
</tbody>
</table>
### Saved States

The state of the component can be saved to be restored later. The state contains selected modifiable aspects of the component and its child components at the time when the state was saved. The following commands are available:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Current State</td>
<td>Opens the Save Current State dialog box. See Save Current State on page 259.</td>
</tr>
<tr>
<td>Restore Selected State</td>
<td>Restores the component to the selected state.</td>
</tr>
<tr>
<td>Details</td>
<td>Opens a window that displays detailed information about the selected state.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected state.</td>
</tr>
</tbody>
</table>

#### Save Current State

1. In the Name text box, enter a name for the state. If a state with the same name already exists, you will be asked to overwrite the existing state.
2. In the Description text box, enter the description for the state.
3. In the Values to save, select the value to be saved.
4. Select the check box to save the state of all child components.

**Note**

When working on a station level,
- In the Values to save, you can also select certain Virtual Controller values in the saved states.
- You need not select the option Recursive as the state of the station is always saved.

For more information, see Station Logic on page 328.

### Assets

The assets contained in the component are displayed as grid. The following commands are available:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Asset</td>
<td>Opens a dialog box and allows you to browse and select any file as an asset.</td>
</tr>
<tr>
<td>Set Icon</td>
<td>Opens a dialog box and allows you to browse and select an image that represents a Smart Component.</td>
</tr>
<tr>
<td>Update All Assets</td>
<td>Replaces the data of all the assets with the data of the corresponding file on the disk. If the file is not available, a warning message is displayed in the output window.</td>
</tr>
<tr>
<td>View</td>
<td>Opens the selected asset in the associated program</td>
</tr>
<tr>
<td>Save</td>
<td>Opens a dialog box and allows you to save the selected asset.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected asset.</td>
</tr>
</tbody>
</table>

Continues on next page
9 Modeling tab

9.4.3 The Compose tab

Continued

Note

The text resources (descriptions) for properties and signals are stored in an asset called Resources.<language-id>.xml. If this is deleted, the texts for that language will be empty and the default (English) will be used. The default language when authoring a component is always English, regardless of the application language.
9.4.4 The Properties and Bindings tab

Overview
The Properties and Bindings tab consists of the following:
   • Dynamic Properties on page 261
   • Property Bindings on page 262

Dynamic Properties
The dynamic properties contained in the component are displayed in a grid.
The following commands are available

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Dynamic Property</td>
<td>Opens the Add Dynamic Property dialog box. See Add or Edit Dynamic Property on page 261.</td>
</tr>
<tr>
<td>Expose Child Property</td>
<td>Opens the Expose Child Property dialog box. See Expose Child Property on page 262.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Edit Dynamic Property dialog box for the selected property.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected property.</td>
</tr>
</tbody>
</table>

Add or Edit Dynamic Property
The Add Dynamic Property dialog box allows you to create a new dynamic property or edit an existing property.
The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property Identifier</td>
<td>Specifies an identifier for the property. The identifier must be alphanumeric, start with a letter and must be unique.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the property.</td>
</tr>
<tr>
<td>Read-only</td>
<td>Indicates if the property value should be possible to modify in GUI such as the Property Editor.</td>
</tr>
<tr>
<td>Property Type</td>
<td>Specifies the type of the property from a list of allowed types.</td>
</tr>
<tr>
<td>Property Value</td>
<td>Specifies the value of the property. The control is updated when you change the property type and/or attributes.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Allows you to add, remove, and modify property attributes. The following lists the available attributes:</td>
</tr>
<tr>
<td></td>
<td>• MinValue</td>
</tr>
<tr>
<td></td>
<td>• MaxValue</td>
</tr>
<tr>
<td></td>
<td>• Quantity</td>
</tr>
<tr>
<td></td>
<td>• Slider</td>
</tr>
<tr>
<td></td>
<td>• AutoApply</td>
</tr>
<tr>
<td></td>
<td>Numeric attributes are specified in SI units.</td>
</tr>
</tbody>
</table>

Note
When editing an existing property, the Identifier and Type controls are locked and cannot be modified. If the input is valid the OK button is enabled, allowing you to add or update the property. If not, an error icon is displayed.

Continues on next page
9 Modeling tab

9.4.4 The Properties and Bindings tab

Continued

Expose Child Property

The Expose Child Property dialog box allows you to add a new property and bind to an existing property in a child object. The new property will have the same type and attributes as the child property.

The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property Identifier</td>
<td>Identifier of the new property. By default, this is the same as the identifier of the selected child property.</td>
</tr>
<tr>
<td>Binding Direction</td>
<td>Specifies the direction of the property binding</td>
</tr>
<tr>
<td>Source or Target Object</td>
<td>Specifies the child object for which to expose a property.</td>
</tr>
<tr>
<td>Source or Target Property</td>
<td>Specifies the child property.</td>
</tr>
</tbody>
</table>

Property Bindings

The property bindings contained in the component are displayed in a grid.

The following commands are available:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Binding</td>
<td>Opens the Add Binding dialog box.</td>
</tr>
<tr>
<td>Add Expression Binding</td>
<td>Opens the Add Expression Binding dialog box.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Edit Binding or Edit Expression Binding dialog box, depending on the type of binding selected.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected binding.</td>
</tr>
</tbody>
</table>

Add or Edit Binding

The Add Binding dialog box allows you to create or edit a property binding.

The following options are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Object</td>
<td>Specifies the owner of the source property.</td>
</tr>
<tr>
<td>Source Property</td>
<td>Specifies the source of the binding.</td>
</tr>
<tr>
<td>Target Object</td>
<td>Specifies the owner of the target property.</td>
</tr>
<tr>
<td>Target Property</td>
<td>Specifies the target of the binding. Only properties of the same type as the source property type are listed.</td>
</tr>
<tr>
<td>Allow cyclic binding</td>
<td>Allows the target property to be set two times in the same context, which otherwise generates an error. The target list box, besides dynamic properties also displays some common properties such as object transform that can only be used as target and not as source.</td>
</tr>
</tbody>
</table>
Add or Edit Expression Binding

The Add Expression Binding dialog box allows you to specify a mathematical expression as the source of a property binding.

The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>Specifies the mathematical expressions. The following lists the allowable mathematical expressions:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Allowed operators</strong>: +, - (unary and binary) *, /, ^ (power), Sin(), Cos(), Sqrt(), Atan() and Abs().</td>
</tr>
<tr>
<td></td>
<td>• <strong>Allowed operands</strong>: Numeric constants, PI, and Numeric dynamic properties on the current smart component and any child smart components.</td>
</tr>
<tr>
<td></td>
<td>The text box has the IntelliSense-like functionality which allows you to select from the available properties. If the expression entered in the text box is invalid, an error icon is displayed.</td>
</tr>
<tr>
<td>Target Object</td>
<td>Specifies the owner of the target property.</td>
</tr>
<tr>
<td>Target Property</td>
<td>Specifies the target of the binding. Only numeric properties are listed.</td>
</tr>
</tbody>
</table>
9 Modeling tab

9.4.5 The Signals and Connections tab

Overview

The Signals and Connections tab consists of the following:

- I/O Signals on page 264
- I/O Connections on page 265

I/O Signals

The I/O Signals contained in the component are displayed in a grid.

The following commands are available:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add I/O Signals</td>
<td>Opens the Add I/O Signals dialog box.</td>
</tr>
<tr>
<td>Expose Child Signal</td>
<td>Opens the Expose Child Signal dialog box.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Edit Signal dialog box.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected signal.</td>
</tr>
</tbody>
</table>

Add or Edit I/O signals

The Add I/O Signals dialog box allows you to edit an I/O signal, or add one or more I/O signals to the component.

The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Signal</td>
<td>Specifies the type and direction of the signal. The following are the available types of signals:</td>
</tr>
<tr>
<td></td>
<td>• Digital</td>
</tr>
<tr>
<td></td>
<td>• Analog</td>
</tr>
<tr>
<td></td>
<td>• Group</td>
</tr>
<tr>
<td>Signal Base Name</td>
<td>Specifies the name of the signal. The name must contain an alphanumeric character and start with a</td>
</tr>
<tr>
<td></td>
<td>letter (a-z or A-Z). If more than one signal is created, numeric suffixes specified by Start Index</td>
</tr>
<tr>
<td></td>
<td>and Step are added to the names.</td>
</tr>
<tr>
<td>Signal Value</td>
<td>Specifies the initial value of the signal.</td>
</tr>
<tr>
<td>Description</td>
<td>Text that describes the signal. When creating multiple signals, all will have the same description.</td>
</tr>
<tr>
<td>Auto-reset</td>
<td>Specifies that a digital signal should have transient behavior. This applies to digital signals only.</td>
</tr>
<tr>
<td></td>
<td>Indicates that the signal value is automatically reset to 0.</td>
</tr>
<tr>
<td>Number of Signals</td>
<td>Specifies the number of signals to create.</td>
</tr>
<tr>
<td>Start Index</td>
<td>Specifies the first suffix when creating multiple signals.</td>
</tr>
<tr>
<td>Step</td>
<td>Specifies the suffix interval when creating multiple signals.</td>
</tr>
<tr>
<td>Minimum</td>
<td>Specifies the minimum value for an analog signal. This applies to Analog signal only.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Specifies the maximum value for an analog signal. This applies to Analog signal only.</td>
</tr>
<tr>
<td>Control</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hidden</td>
<td>Indicates if the property should not be visible in GUI such as the Property Editor and I/O Simulator.</td>
</tr>
<tr>
<td>Read only</td>
<td>Indicates if the property value should be possible to modify in GUI such as the Property Editor and I/O Simulator.</td>
</tr>
</tbody>
</table>

**Note**

When editing an existing signal, only the *Signal Value* and *Description* can be modified, while all other controls are locked.

If the input is valid, *OK* is enabled allowing you to create or update the signal. If not, an error icon is displayed.

**Expose Child signal**

The *Expose Child Signal* dialog box allows you to add a new I/O signal that is connected to a signal in a child object.

The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Name</td>
<td>Specifies the name of the signal to be created. By default, it is the same as the name of the selected child signal.</td>
</tr>
<tr>
<td>Child Object</td>
<td>Specifies the object for which to expose a signal.</td>
</tr>
<tr>
<td>Child Signal</td>
<td>Specifies the child signal.</td>
</tr>
</tbody>
</table>

**I/O Connections**

The I/O Connections contained in the component are displayed in a grid.

The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add I/O Connection</td>
<td>Opens the Add I/O Connection dialog box.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Edit I/O Connection dialog box.</td>
</tr>
<tr>
<td>Manage I/O Connections</td>
<td>Opens the Manage I/O Connections dialog box.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected connection.</td>
</tr>
<tr>
<td>Move Up or Move Down</td>
<td>Sorts by moving the selected connections up and down the list.</td>
</tr>
</tbody>
</table>

**Add or Edit I/O Connection**

The *Add I/O Connection* dialog box allows you to create an I/O connection or edit an existing connection.

The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Object</td>
<td>Specifies the owner of the source signal.</td>
</tr>
<tr>
<td>Source Signal</td>
<td>Specifies the source of the connection. The source must either be an output from a child component, or an input to the current component.</td>
</tr>
<tr>
<td>Target Object</td>
<td>Specifies the owner of the target signal.</td>
</tr>
</tbody>
</table>
### Manage I/O Connections

The Manage I/O Connections dialog box displays a graphical view of the I/O connections of the component. It allows you to add, remove, and modify connections. Only digital signals are displayed.

The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source / Target Signals</strong></td>
<td>Lists the signals used in the connections, source signals to the left and target signals to the right. Each signal is specified by the owner object and the signal name.</td>
</tr>
<tr>
<td><strong>Connections</strong></td>
<td>Displays connections as an arrow from source to target.</td>
</tr>
<tr>
<td><strong>Logic Gates</strong></td>
<td>Specifies a logic operator and a delay time. It performs digital logic on input signals.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>- <strong>Add Source</strong> - Adds a source signal to the left.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add Target</strong> - Adds a target signal to the right.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add Logic Gate</strong> - Adds a logic gate at the center</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Removes the selected signal, connection or logic gate.</td>
</tr>
</tbody>
</table>

### Managing I/O connections

Use this procedure to add, remove, and create new I/O connections:

1. Click **Add** and select **Add Source** or **Add Target** or **Add Logic Gate** to add a source signal or target signal or logic gate respectively.
2. Move the cursor towards the **Source Signal** until a cross hair appears.
3. Click and drag the left mouse button towards the logic gate to create a new I/O connection.
4. Select the signal, connection, or logic gate and click **Remove** to delete.
9.4.6 The Design tab

Overview
The Design tab displays a graphical view of the structure of the component. It includes the child components, internal connections, properties and bindings. The Smart Component can be organized on the viewing screen and their viewing position will be stored with the station.

Using the Design tab
You can do the following in the Design tab:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move child components and their positions.</td>
<td>• Click Auto Arrange to organize the components coherently.</td>
</tr>
<tr>
<td></td>
<td>• Use the Zoom slider to zoom the view.</td>
</tr>
<tr>
<td>Select a component from the graphical view.</td>
<td>Connections and bindings are color coded and highlighted to avoid confusion. By default, Show Bindings, Show Connections, and Show unused check-box are selected.</td>
</tr>
<tr>
<td></td>
<td>• De-select Show Bindings check-box to hide the bindings.</td>
</tr>
<tr>
<td></td>
<td>• De-select Show Connections check-box to hide the connections.</td>
</tr>
<tr>
<td></td>
<td>• De-select Show unused check-box to hide the unused components.</td>
</tr>
<tr>
<td>Create connections and bindings</td>
<td>1 Select the source signal or property. The cursor is displayed as a pen.</td>
</tr>
<tr>
<td></td>
<td>2 Drag and drop the cursor on the target signal or property.</td>
</tr>
<tr>
<td></td>
<td>If the target is valid, a connection and binding is created.</td>
</tr>
<tr>
<td></td>
<td>If the target is invalid, the cursor changes to &quot;not allowed&quot; symbol.</td>
</tr>
</tbody>
</table>
9.4.7 Basic Smart Components

Overview

The base components represent a complete set of basic building block components. They can be used to build user defined Smart Components with more complex behavior.

This lists the basic Smart Components available and are described in the following sections:

- Signals and Properties on page 268
- Parametric Primitives on page 272
- Sensors on page 274
- Actions on page 277
- Manipulators on page 279
- Other on page 281

Signals and Properties

LogicGate

The signal Output is set by the logical operation specified in Operator of the two signals InputA and InputB, with the delay specified in Delay.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>The logical operator to use. The following lists the various operators: • AND • OR • XOR • NOT • NOP</td>
</tr>
<tr>
<td>Delay</td>
<td>Time to delay the output signal.</td>
</tr>
</tbody>
</table>

Signals

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InputA</td>
<td>The first input.</td>
</tr>
<tr>
<td>InputB</td>
<td>The second input.</td>
</tr>
<tr>
<td>Output</td>
<td>The result of the logic operation.</td>
</tr>
</tbody>
</table>

LogicExpression

Evaluates a logic expression.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The expression to evaluate.</td>
</tr>
<tr>
<td>Operator</td>
<td>The following lists the various operators: • AND • OR • NOT • XOR</td>
</tr>
</tbody>
</table>
### LogicMux

Output is set according to:
\[
\text{Output} = (\text{Input A} \times \text{NOT Selector}) + (\text{Input B} \times \text{Selector})
\]

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selector</td>
<td>When low, the first input is selected. When high, the second input is selected.</td>
</tr>
<tr>
<td>InputA</td>
<td>Specifies the first input.</td>
</tr>
<tr>
<td>InputB</td>
<td>Specifies the second input.</td>
</tr>
<tr>
<td>Output</td>
<td>Specifies the result of the operation.</td>
</tr>
</tbody>
</table>

### LogicSplit

The LogicSplit takes Input and sets OutputHigh to the same as Input, and OutputLow as the inverse of Input.

PulseHigh sends a pulse when Input is set to high, and PulseLow sends a pulse when Input is set to low.

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Specifies the input signal.</td>
</tr>
<tr>
<td>OutputHigh</td>
<td>Goes high (1) when input is 1.</td>
</tr>
<tr>
<td>OutputLow</td>
<td>Goes high (1) when input is 0.</td>
</tr>
<tr>
<td>PulseHigh</td>
<td>Sends pulse when input is set to high.</td>
</tr>
<tr>
<td>PulseLow</td>
<td>Sends pulse when input is set to low.</td>
</tr>
</tbody>
</table>

### LogicSRLatch

The LogicSRLatch has one stable state.
- When Set=1, Output=1 and InvOutput=0
- When Reset=1, Output=0 and InvOutput=1

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set</td>
<td>Sets the output signal.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the output signal.</td>
</tr>
<tr>
<td>Output</td>
<td>Specifies output signal.</td>
</tr>
<tr>
<td>InvOutput</td>
<td>Specifies Inverse output signal.</td>
</tr>
</tbody>
</table>

### Converter

Converts between property values and signal values.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AnalogProperty</td>
<td>Converts to AnalogOutput.</td>
</tr>
<tr>
<td>DigitalProperty</td>
<td>Converts to DigitalOutput.</td>
</tr>
<tr>
<td>GroupProperty</td>
<td>Converts to GroupOutput.</td>
</tr>
<tr>
<td>BooleanProperty</td>
<td>Converts from DigitalInput and to DigitalOutput.</td>
</tr>
</tbody>
</table>
9 Modeling tab

9.4.7 Basic Smart Components

Continued

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DigitalInput</td>
<td>Converts to DigitalProperty.</td>
</tr>
<tr>
<td>DigitalOutput</td>
<td>Converted from DigitalProperty.</td>
</tr>
<tr>
<td>AnalogInput</td>
<td>Converts to AnalogProperty.</td>
</tr>
<tr>
<td>AnalogOutput</td>
<td>Converted from AnalogProperty.</td>
</tr>
<tr>
<td>GroupInput</td>
<td>Converts to GroupProperty.</td>
</tr>
<tr>
<td>GroupOutput</td>
<td>Converted from GroupProperty.</td>
</tr>
</tbody>
</table>

VectorConverter

Converts between Vector3 and X, Y, and Z values.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Specifies the X-value of Vector.</td>
</tr>
<tr>
<td>Y</td>
<td>Specifies the Y-value of Vector.</td>
</tr>
<tr>
<td>Z</td>
<td>Specifies the Z-value of Vector</td>
</tr>
<tr>
<td>Vector</td>
<td>Specifies the vector value.</td>
</tr>
</tbody>
</table>

Expression

The Expression consists of numeric literals (including PI), parentheses, mathematical operators +,-,*,/(^ (power) and mathematical functions sin, cos, sqrt, atan, abs. Any other strings are interpreted as variables, which are added as additional properties. The result is displayed in Result.

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>Specifies the expression to evaluate.</td>
</tr>
<tr>
<td>Result</td>
<td>Specifies the result of evaluation.</td>
</tr>
<tr>
<td>NNN</td>
<td>Specifies automatically generated variables.</td>
</tr>
</tbody>
</table>

Comparer

The Comparer compares First value with Second value, using Operator. Output is set to 1 if the condition is met.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ValueA</td>
<td>Specifies the first value.</td>
</tr>
<tr>
<td>ValueB</td>
<td>Specifies the second value.</td>
</tr>
<tr>
<td>Operator</td>
<td>Specifies the comparison operator.</td>
</tr>
<tr>
<td></td>
<td>The following lists the various operators:</td>
</tr>
<tr>
<td></td>
<td>• ==</td>
</tr>
<tr>
<td></td>
<td>• !=</td>
</tr>
<tr>
<td></td>
<td>• &gt;</td>
</tr>
<tr>
<td></td>
<td>• &gt;=</td>
</tr>
<tr>
<td></td>
<td>• &lt;</td>
</tr>
<tr>
<td></td>
<td>• &lt;=</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>True if the comparison evaluates to true, otherwise false.</td>
</tr>
</tbody>
</table>
Counter

Count is increased when the input signal Increase is set, and decreased when the input signal Decrease is set. Count is reset when the input signal Reset is set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Specifies the current count.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase</td>
<td>Adds one to the Count when set to True.</td>
</tr>
<tr>
<td>Decrease</td>
<td>Subtracts one from the Count when set to True.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the Count to zero when set to high.</td>
</tr>
</tbody>
</table>

Repeater

Pulses Output signal Count number of times.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Number of times to pulse Output.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to high (1) to pulse Output Count times.</td>
</tr>
<tr>
<td>Output</td>
<td>Output pulse.</td>
</tr>
</tbody>
</table>

Timer

The Timer pulses the Output signal based on the given interval.

If Repeat is unchecked, one pulse will be triggered after the time specified in Interval. Otherwise, the pulse will be repeated at the interval given by Interval.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>StartTime</td>
<td>Specifies the time to pass before the first pulse.</td>
</tr>
<tr>
<td>Interval</td>
<td>Specifies the simulation time between the pulses.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Specifies if the signal should be pulsed repeatedly or only once.</td>
</tr>
<tr>
<td>Current time</td>
<td>Specifies the current simulation time.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Set to True to activate the timer, and False to deactivate it.</td>
</tr>
<tr>
<td>Output</td>
<td>Sends pulses at the specified time intervals.</td>
</tr>
</tbody>
</table>

StopWatch

The StopWatch measures time during simulation (TotalTime). A new lap can be started by triggering the Lap input signal. LapTime shows the current lap time. The time is only measured when Active is set to 1. The times are reset when the input signal Reset is set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TotalTime</td>
<td>Specifies the accumulated time.</td>
</tr>
<tr>
<td>LapTime</td>
<td>Specifies the current lap time.</td>
</tr>
<tr>
<td>AutoReset</td>
<td>If true, TotalTime and LapTime will be set to 0 when the simulation starts.</td>
</tr>
</tbody>
</table>
9 Modeling tab

9.4.7 Basic Smart Components

Continued

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Set to True to activate the stop watch, and False to deactivate it.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets Total time and Lap time when set to high.</td>
</tr>
<tr>
<td>Lap</td>
<td>Starts a new lap.</td>
</tr>
</tbody>
</table>

### Parametric Primitives

**ParametricBox**

The ParametricBox generates a box with dimensions specified by length, width, and height.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SizeX</td>
<td>Specifies the length of the box in the X-axis direction.</td>
</tr>
<tr>
<td>SizeY</td>
<td>Specifies the length of the box in the Y-axis direction.</td>
</tr>
<tr>
<td>SizeZ</td>
<td>Specifies the length of the box in the Z-axis direction</td>
</tr>
<tr>
<td>GeneratedPart</td>
<td>Specifies the generated part.</td>
</tr>
<tr>
<td>KeepGeometry</td>
<td>False to remove the geometry data from the generated part. This can make other components such as Source execute faster.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Set to high (1) to update the generated part.</td>
</tr>
</tbody>
</table>

**ParametricCircle**

The ParametricCircle generates a circle with a given radius.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius</td>
<td>Specifies the radius of the circle.</td>
</tr>
<tr>
<td>GeneratedPart</td>
<td>Specifies the generated part.</td>
</tr>
<tr>
<td>GeneratedWire</td>
<td>Specifies the generated wire object.</td>
</tr>
<tr>
<td>KeepGeometry</td>
<td>False to remove the geometry data from the generated part. This can make other components such as Source execute faster</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Set to high (1) to update the generated part.</td>
</tr>
</tbody>
</table>

**ParametricCylinder**

The ParametricCylinder generates a cylinder with the dimensions given by Radius and Height.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius</td>
<td>Specifies the radius of the cylinder.</td>
</tr>
<tr>
<td>Height</td>
<td>Specifies the height of the cylinder.</td>
</tr>
<tr>
<td>GeneratedPart</td>
<td>Specifies the generated part.</td>
</tr>
<tr>
<td>KeepGeometry</td>
<td>False to remove the geometry data from the generated part. This can make other components such as Source execute faster.</td>
</tr>
</tbody>
</table>

Continues on next page
### ParametricLine

The ParametricLine generates a line with a given end point or a given length. If either of them is changed, the other one will be updated accordingly.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EndPoint</td>
<td>Specifies the end point for the line.</td>
</tr>
<tr>
<td>Length</td>
<td>Specifies the length of the line.</td>
</tr>
<tr>
<td>GeneratedPart</td>
<td>Specifies the generated part.</td>
</tr>
<tr>
<td>GeneratedWire</td>
<td>Specifies the generated wire object.</td>
</tr>
<tr>
<td>KeepGeometry</td>
<td>False to remove the geometry data from the generated part. This can make other components such as Source execute faster.</td>
</tr>
</tbody>
</table>

### LinearExtrusion

The LinearExtrusion extrudes SourceFace or SourceWire along the vector given by Projection.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SourceFace</td>
<td>Specifies the face to extrude.</td>
</tr>
<tr>
<td>SourceWire</td>
<td>Specifies the wire to extrude.</td>
</tr>
<tr>
<td>Projection</td>
<td>Specifies the vector to extrude along.</td>
</tr>
<tr>
<td>GeneratedPart</td>
<td>Specifies the generated part.</td>
</tr>
<tr>
<td>KeepGeometry</td>
<td>False to remove the geometry data from the generated part. This can make other components such as Source execute faster.</td>
</tr>
</tbody>
</table>

### CircularRepeater

The CircularRepeater creates a number of given copies of Source around the center of the SmartComponent with a given DeltaAngle.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Specifies the object to copy.</td>
</tr>
<tr>
<td>Count</td>
<td>Specifies the number of copies to create.</td>
</tr>
<tr>
<td>Radius</td>
<td>Specifies the radius of the circle.</td>
</tr>
<tr>
<td>DeltaAngle</td>
<td>Specifies the angle between the copies.</td>
</tr>
</tbody>
</table>

### LinearRepeater

The LinearRepeater creates a number of copies of Source, with the spacing and direction given by Offset.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Specifies the object to copy.</td>
</tr>
</tbody>
</table>
MatrixRepeater

The MatrixRepeater creates a specified number of copies in three dimensions, with the specified spacing of the object in Source.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Specifies the object to copy.</td>
</tr>
<tr>
<td>CountX</td>
<td>Specifies the number of copies in the X-axis direction.</td>
</tr>
<tr>
<td>CountY</td>
<td>Specifies the number of copies in the Y-axis direction.</td>
</tr>
<tr>
<td>CountZ</td>
<td>Specifies the number of copies in the Z-axis direction.</td>
</tr>
<tr>
<td>OffsetX</td>
<td>Specifies the offset between the copies in the X-axis direction.</td>
</tr>
<tr>
<td>OffsetY</td>
<td>Specifies the offset between the copies in the Y-axis direction.</td>
</tr>
<tr>
<td>OffsetZ</td>
<td>Specifies the offset between the copies in the Z-axis direction.</td>
</tr>
</tbody>
</table>

Sensors

CollisionSensor

The CollisionSensor detects collisions and near miss events between the First object and the Second object. If one of the objects is not specified, the other will be checked against the entire station. When the Active signal is high and a collision or a near miss event occurs and the component is active, the SensorOut signal is set and the parts that participate in the collision or near miss event are reported in the first colliding part and second colliding part of the Property editor.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object1</td>
<td>The first object to check for collisions.</td>
</tr>
<tr>
<td>Object2</td>
<td>The second object to check for collisions.</td>
</tr>
<tr>
<td>NearMiss</td>
<td>Specifies the near miss distance.</td>
</tr>
<tr>
<td>Part1</td>
<td>The part of First object that has a collision.</td>
</tr>
<tr>
<td>Part2</td>
<td>The part of Second object that has a collision.</td>
</tr>
<tr>
<td>CollisionType</td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Near miss</td>
</tr>
<tr>
<td></td>
<td>• Collision</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Specifies if the CollisionSensor is active or not.</td>
</tr>
<tr>
<td>SensorOut</td>
<td>True if there is a NearMiss or Collision.</td>
</tr>
</tbody>
</table>
LineSensor

The LineSensor defines a line by the Start, End, and Radius. When an Active signal is high, the sensor detects objects that intersect the line. Intersecting objects are displayed in the ClosestPart property and the point on the intersecting part that is closest to the line sensors start point is displayed in the ClosestPoint property. When intersection occurs the SensorOut output signal is set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Specifies the start point.</td>
</tr>
<tr>
<td>End</td>
<td>Specifies the end point.</td>
</tr>
<tr>
<td>Radius</td>
<td>Specifies the radius.</td>
</tr>
<tr>
<td>SensedPart</td>
<td>Specifies the part that intersects the line sensor. If several parts intersect, then the one closest to the Start point is listed.</td>
</tr>
<tr>
<td>SensedPoint</td>
<td>Specifies the point on the intersecting part, closest to the Start point.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Specifies if the LineSensor is active or not.</td>
</tr>
<tr>
<td>SensorOut</td>
<td>True if the sensor intersects with an object.</td>
</tr>
</tbody>
</table>

PlaneSensor

The PlaneSensor defines a plane by Origin, Axis1, and Axis2. When the Active input signal is set the sensor detects objects that intersect this plane. Intersecting objects are displayed in the SensedPart property and when intersection occurs the SensorOut output signal is set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin</td>
<td>Specifies the origin of the plane.</td>
</tr>
<tr>
<td>Axis1</td>
<td>Specifies the first axis of the plane.</td>
</tr>
<tr>
<td>Axis2</td>
<td>Specifies the second axis of the plane.</td>
</tr>
<tr>
<td>SensedPart</td>
<td>Specifies the part that intersects the PlaneSensor. If several parts intersect, then the one listed first in the Layout browser is selected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Specifies if the PlaneSensor is active or not.</td>
</tr>
<tr>
<td>SensorOut</td>
<td>True if the sensor intersects with an object.</td>
</tr>
</tbody>
</table>

VolumeSensor

The VolumeSensor detects objects that are inside or partly inside a box-shaped volume. The volume is defined by a Corner Point, the Length, Height, and Width of the sides and the orientation angles.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CornerPoint</td>
<td>Specifies the local origin of the box.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specifies the orientation (Euler ZYX) relative to Reference.</td>
</tr>
<tr>
<td>Length</td>
<td>Specifies the length of the box.</td>
</tr>
</tbody>
</table>

Continues on next page
9 Modeling tab

9.4.7 Basic Smart Components

Continued

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Specifies the width of the box.</td>
</tr>
<tr>
<td>Height</td>
<td>Specifies the height of the box.</td>
</tr>
<tr>
<td>Percentage</td>
<td>The percentage of the volume to react on. Set to 0 to react on all objects.</td>
</tr>
<tr>
<td>PartialHit</td>
<td>Allow an object to be sensed if only a part of it is inside the volume sensor.</td>
</tr>
<tr>
<td>SensedPart</td>
<td>The last object that either entered or left the volume.</td>
</tr>
<tr>
<td>SensedParts</td>
<td>The objects sensed in the volume</td>
</tr>
<tr>
<td>VolumeSensed</td>
<td>The total volume sensed</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Set to high (1) to activate the sensor.</td>
</tr>
<tr>
<td>ObjectDetectedOut</td>
<td>Goes high (1) when an object is detected within the volume. Is reset immediately after an object has been detected.</td>
</tr>
<tr>
<td>ObjectDeletedOut</td>
<td>Goes high (1) when an object is detected to leave the volume. Is reset immediately after an object has left the volume.</td>
</tr>
<tr>
<td>SensorOut</td>
<td>Goes high (1) when the volume is full.</td>
</tr>
</tbody>
</table>

PositionSensor

The PositionSensor monitors the position and orientation of an object. The position and orientation of an object is updated only during the simulation.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Specifies the object to monitor.</td>
</tr>
<tr>
<td>Reference</td>
<td>Specifies the reference coordinate system (Parent or Global).</td>
</tr>
<tr>
<td>ReferenceObject</td>
<td>Specifies the reference object, if Reference is set to Object.</td>
</tr>
<tr>
<td>Position</td>
<td>Specifies the position of the object relative to Reference.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specifies the orientation (Euler ZYX) relative to Reference.</td>
</tr>
</tbody>
</table>

ClosestObject

The ClosestObject defines a Reference object or a Reference point. When the Execute signal is set, the component finds the ClosestObject, ClosestPart, and the Distance to the reference object, or to the reference point if the reference object is undefined. If RootObject is defined, the search is limited to that object and its descendants. When finished and the corresponding properties are updated the Executed signal is set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReferenceObject</td>
<td>Specifies the object to get the closest object to.</td>
</tr>
<tr>
<td>ReferencePoint</td>
<td>Specifies the point to get the closest object to.</td>
</tr>
<tr>
<td>RootObject</td>
<td>Specifies the object whose children to search. Empty means entire station.</td>
</tr>
<tr>
<td>ClosestObject</td>
<td>Specifies the object closest to Reference object or Reference point.</td>
</tr>
</tbody>
</table>

Continues on next page
### Properties and Description

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClosestPart</td>
<td>Specifies the part closest to Reference object or Reference point.</td>
</tr>
<tr>
<td>Distance</td>
<td>Specifies the distance between the Reference object and the Closest object.</td>
</tr>
</tbody>
</table>

### Signals and Description

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to find the Closest part.</td>
</tr>
<tr>
<td>Executed</td>
<td>Sends a pulse when completed.</td>
</tr>
</tbody>
</table>

### Actions

#### Attacher

The Attacher will attach Child to Parent when the Execute signal is set. If the Parent is a mechanism, the Flange to attach to must also be specified. When the input Execute is set, the child object is attached to the parent object. If Mount is checked, the child will also be mounted on the parent, with the Offset and Orientation specified. The output Executed will be set when finished.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent</td>
<td>Specifies the object to attach to.</td>
</tr>
<tr>
<td>Flange</td>
<td>Specifies the Index of mechanism flange to attach to.</td>
</tr>
<tr>
<td>Child</td>
<td>Specifies the object to attach.</td>
</tr>
<tr>
<td>Mount</td>
<td>If true, the object to attach mounts on the attachment parent.</td>
</tr>
<tr>
<td>Offset</td>
<td>Specifies the position relative to the attachment parent when using Mount.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specifies the orientation relative to the attachment parent when using Mount.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to attach.</td>
</tr>
<tr>
<td>Executed</td>
<td>Sends a pulse when completed.</td>
</tr>
</tbody>
</table>

#### Detacher

The Detacher will detach the Child from the object it is attached to when the Execute signal is set. If Keep position is checked, the position will be kept. Otherwise the child is positioned relative to its parent. When finished, the Executed signal will be set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child</td>
<td>Specifies the object to detach.</td>
</tr>
<tr>
<td>KeepPosition</td>
<td>If false, the attached object is returned to its original position.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to remove the attachment.</td>
</tr>
<tr>
<td>Executed</td>
<td>Sends a pulse when completed.</td>
</tr>
</tbody>
</table>
9 Modeling tab

9.4.7 Basic Smart Components

Continued

Source

The Source property of the source component indicates the object that should be cloned when the Execute input signal is received. The parent of the cloned objects is specified by the Parent property and a reference to the cloned object is specified by the Copy property. The output signal Executed signifi es that the clone is complete.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Specifies the object to copy.</td>
</tr>
<tr>
<td>Copy</td>
<td>Specifies the copied object.</td>
</tr>
<tr>
<td>Parent</td>
<td>Specifies the parent to the copy. If not specified, the copy gets the same parent as the source.</td>
</tr>
<tr>
<td>Position</td>
<td>Specifies the position of the copy relative its parent.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specifies the orientation of the copy relative its parent.</td>
</tr>
<tr>
<td>Transient</td>
<td>Marks the copy as transient if created during simulation. Such copies are not added to the undo queue and are automatically deleted when the simulation is stopped. This is used to avoid increased memory consumption during simulation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to create a copy of the object.</td>
</tr>
<tr>
<td>Executed</td>
<td>Sends a pulse when completed.</td>
</tr>
</tbody>
</table>

Sink

The Sink deletes the object referenced by the Object property. Deletion happens when the Execute input signal is received. The Executed output signal is set when the deletion is finished.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Specifies the object to remove.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to remove the object.</td>
</tr>
<tr>
<td>Executed</td>
<td>Sends a pulse when completed.</td>
</tr>
</tbody>
</table>

Show

When the Execute signal is set, the object referenced in Object appears. When finished, Executed signal will be set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Specifies the object to show.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to show the object.</td>
</tr>
<tr>
<td>Executed</td>
<td>Sends a pulse when completed.</td>
</tr>
</tbody>
</table>
Hide

When the Execute signal is set, the object referenced in Object will be hidden. When finished, Executed signal will be set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Specifies the object to hide.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to hide the object.</td>
</tr>
<tr>
<td>Executed</td>
<td>Sends a pulse when completed.</td>
</tr>
</tbody>
</table>

Manipulators

LinearMover

The LinearMover moves the object referenced in the Object property with a speed given by the Speed property in the direction given by the Direction property. The motion starts when the Execute input signal is set and stops when Execute is reset.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Specifies the object to move.</td>
</tr>
<tr>
<td>Direction</td>
<td>Specifies the direction to move the object.</td>
</tr>
<tr>
<td>Speed</td>
<td>Specifies the speed of movement.</td>
</tr>
<tr>
<td>Reference</td>
<td>Specifies the coordinate system in which values are specified. It can be Global, Local, or Object.</td>
</tr>
<tr>
<td>ReferenceObject</td>
<td>Specifies the reference object, if Reference is set to Object.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to start move the object, and False to stop.</td>
</tr>
</tbody>
</table>

Rotator

The Rotator rotates the object referenced in the Object property with an angular speed given by the Speed property. The axis of rotation is given by CenterPoint and Axis. The motion starts when the Execute input signal is set and stops when the Execute is reset.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Specifies the object to rotate.</td>
</tr>
<tr>
<td>CenterPoint</td>
<td>Specifies the point to rotate around.</td>
</tr>
<tr>
<td>Axis</td>
<td>Specifies the axis of the rotation.</td>
</tr>
<tr>
<td>Speed</td>
<td>Specifies the speed of the rotation.</td>
</tr>
<tr>
<td>Reference</td>
<td>Specifies the coordinate system in which values are specified. It can be Global, Local, or Object.</td>
</tr>
<tr>
<td>ReferenceObject</td>
<td>Specifies the object which are relative to CenterPoint and Axis, if Reference is set to Object.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to start rotating the object, and False to stop.</td>
</tr>
</tbody>
</table>
9 Modeling tab

9.4.7 Basic Smart Components

Continued

Positioner

The Positioner takes an Object, Position, and Orientation as properties. When the Execute signal is set the object is repositioned in the given position relative to the Reference. When finished the Executed output is set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Specifies the object to position.</td>
</tr>
<tr>
<td>Position</td>
<td>Specifies the new position of the object.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specifies the new orientation of the object.</td>
</tr>
<tr>
<td>Reference</td>
<td>Specifies the coordinate system in which values are specified. It can be Global, Local, or Object.</td>
</tr>
<tr>
<td>ReferenceObject</td>
<td>Specifies the object which are relative to Position and Orientation, if Reference is set to Object.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True to start move the object, and False to stop.</td>
</tr>
<tr>
<td>Executed</td>
<td>Set to 1 when operation is completed.</td>
</tr>
</tbody>
</table>

PoseMover

The PoseMover has a Mechanism, a Pose, and Duration as properties. When the Execute input signal is set the mechanism joint values are moved to the given pose. When the pose is reached the Executed output signal is set.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanism</td>
<td>Specifies the mechanism to move to a pose.</td>
</tr>
<tr>
<td>Pose</td>
<td>Specifies the Index of the pose to move to.</td>
</tr>
<tr>
<td>Duration</td>
<td>Specifies the time for the mechanism to move to the pose.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to True, to start or resume moving the mechanism.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses the movement.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the movement.</td>
</tr>
<tr>
<td>Executed</td>
<td>Pulses high when the mechanism has reached the pose.</td>
</tr>
<tr>
<td>Executing</td>
<td>Goes high during the movement.</td>
</tr>
<tr>
<td>Paused</td>
<td>Goes high when paused.</td>
</tr>
</tbody>
</table>

JointMover

The JointMover has a Mechanism, a set of Joint Values and a Duration as properties. When the Execute input signal is set the mechanism joint values are moved to the given pose. When the pose is reached the Executed output signal is set. The GetCurrent signal retrieves the current joint values of the mechanism.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanism</td>
<td>Specifies the mechanism to move to a pose.</td>
</tr>
<tr>
<td>Relative</td>
<td>Specifies if J1-Jx are relative to the start values, rather than absolute joint values.</td>
</tr>
<tr>
<td>Duration</td>
<td>Specifies the time for the mechanism to move to the pose.</td>
</tr>
</tbody>
</table>

Continues on next page

© Copyright 2008-2013 ABB. All rights reserved.
### Joint values

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1 - Jx</td>
<td>Joint values.</td>
</tr>
</tbody>
</table>

### Signals

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetCurrent</td>
<td>Retrieve current joint values.</td>
</tr>
<tr>
<td>Execute</td>
<td>Set to True to start moving the mechanism.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses the movement</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the movement</td>
</tr>
<tr>
<td>Executed</td>
<td>Pulses high when the mechanism has reached the pose.</td>
</tr>
<tr>
<td>Executing</td>
<td>Goes high during the movement.</td>
</tr>
<tr>
<td>Paused</td>
<td>Goes high when paused.</td>
</tr>
</tbody>
</table>

### Other

**GetParent**

The GetParent returns the parent object of the input object. The executed signal is triggered if a parent is found.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child</td>
<td>Specifies the object to whose parent is to be found.</td>
</tr>
<tr>
<td>Parent</td>
<td>Specifies the parent of the child</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>Goes high (1) if the parent exists.</td>
</tr>
</tbody>
</table>

**Note**

The Child list for Properties:GetParent does not show every part or object in the station. However, if you do not find the required part or object in the list, then add it from the browser or graphic window by clicking it.

### GraphicSwitch

Switches between two parts, either by clicking on the visible part in the graphics or by setting and resetting the input signal.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PartHigh</td>
<td>Displayed when the signal is high.</td>
</tr>
<tr>
<td>PartLow</td>
<td>Displayed when the signal is low.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input signal.</td>
</tr>
<tr>
<td>Output</td>
<td>Output signal.</td>
</tr>
</tbody>
</table>
9 Modeling tab

9.4.7 Basic Smart Components

Continued

Highlighter

The Highlighter temporarily sets the color of the Object to the RGB-values specified in Color. The color is blended with the original color of the objects as defined by Opacity When the signal Active is reset, Object gets its original colors.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Specifies the object to highlight.</td>
</tr>
<tr>
<td>Color</td>
<td>Specifies the RGB-values of the highlight color.</td>
</tr>
<tr>
<td>Opacity</td>
<td>Specifies the amount to blend with the object’s original color (0-255).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>True sets the highlight. False restores the original color.</td>
</tr>
</tbody>
</table>

Logger

Prints a message in the output window.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>Format string. Supports variables like {id:type}, where type can be d (double), i (int), s (string), o (object)</td>
</tr>
<tr>
<td>Message</td>
<td>Formatted message.</td>
</tr>
<tr>
<td>Severity</td>
<td>Message severity: 0 (Information), 1 (Warning), 2 (Error).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to high (1) to print the message.</td>
</tr>
</tbody>
</table>

MoveToViewPoint

Moves to the selected viewpoint in the given time, when the input signal Execute is set. The output signal Executed is set when the operation is completed.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewpoint</td>
<td>Specifies the viewpoint to move to.</td>
</tr>
<tr>
<td>Time</td>
<td>Specifies the time to complete the operation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to high (1) to start the operation.</td>
</tr>
<tr>
<td>Executed</td>
<td>Goes high (1) when the operation is completed.</td>
</tr>
</tbody>
</table>

ObjectComparer

Determines if ObjectA is the same as ObjectB.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ObjectA</td>
<td>Specifies the object to compare.</td>
</tr>
<tr>
<td>ObjectB</td>
<td>Specifies the object to compare.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>Goes high if the objects are equal.</td>
</tr>
</tbody>
</table>
Queue

The Queue represents a FIFO (first in, first out) queue. The object in Back is added to the queue when the signal Enqueue is set. The front object of the queue is shown in Front. The object in Front is removed from the queue when the signal Dequeue is set. If there are more objects in the queue, the next object is shown in Front. All objects in the queue are removed from the queue when the signal Clear is set.

If a transformer component (such as LinearMover) has a queue component as its Object, it will transform the contents of the queue, rather than the queue itself.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Specifies the object to enqueue.</td>
</tr>
<tr>
<td>Front</td>
<td>Specifies the first object in queue.</td>
</tr>
<tr>
<td>Queue</td>
<td>Contains unique IDs of the queue’s elements.</td>
</tr>
<tr>
<td>NumberOfObjects</td>
<td>Specifies the number of objects in the queue.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enqueue</td>
<td>Adds the object in Back to the end of the queue.</td>
</tr>
<tr>
<td>Dequeue</td>
<td>Removes the object in Front from the queue.</td>
</tr>
<tr>
<td>Clear</td>
<td>Removes all objects from the queue.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the object in Front from the queue and from the station.</td>
</tr>
<tr>
<td>DeleteAll</td>
<td>Clears the queue and removes all objects from the station.</td>
</tr>
</tbody>
</table>

SoundPlayer

Plays the sound specified by Sound Asset when the input signal Execute is set. The asset must be a .wav file.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SoundAsset</td>
<td>Specifies the sound file that should be played. Must be a .wav file.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to high to play the sound.</td>
</tr>
</tbody>
</table>

StopSimulation

Stop a running simulation when the input signal Execute is set.

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to high to stop the simulation.</td>
</tr>
</tbody>
</table>

Random

Random generates a random number between Min and Max in Value when Execute is triggered.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min</td>
<td>Specifies minimum value.</td>
</tr>
<tr>
<td>Max</td>
<td>Specifies maximum value.</td>
</tr>
<tr>
<td>Value</td>
<td>Specifies a random number between Min and Max.</td>
</tr>
</tbody>
</table>
9 Modeling tab

9.4.7 Basic Smart Components

*Continued*

<table>
<thead>
<tr>
<th>Signals</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute</td>
<td>Set to high to generate a new random number.</td>
</tr>
<tr>
<td>Executed</td>
<td>Goes high when the operation is completed.</td>
</tr>
</tbody>
</table>
9.4.8 Property Editor

Overview

The Property editor is used to modify the values of dynamic properties and I/O signals for a Smart Component. By default, the Property editor is displayed as a tool window to the left.

Each dynamic property is represented by a control. The type of control that is displayed depends on the property type and property attributes.

Properties with the Hidden flag set to true are not displayed. Read-only properties cannot be modified but are only displayed.

The values are validated according to the property attributes. If an invalid value is entered, an error icon is displayed next to the control and the Apply button is disabled.

If you set the AutoApply attribute of a property to true, the value is applied whenever you change the value in the control. You can apply the values of other properties by clicking the Apply button. If the component has no properties without AutoApply, then the Apply button will never be enabled.

You can toggle the value of a digital signal by clicking the control. Similarly, you can change the value of an analog or group signal by entering the new value in the text box.

Opening the Property editor

You can open the Property editor dialog box in any one of the following ways:

- Right-click context menu for a Smart Component and select Properties.
- Launches automatically when the Smart Component Editor is started.
- Launched when you add a base component. See Basic Smart Components on page 268.
9 Modeling tab

9.4.9 The Simulation Watch window

Overview

The Simulation Watch allows you to monitor the values of dynamic properties and I/O signals in Smart Components. It specifies the simulation that should be paused when a value changes or meets a condition.

Layout of the Simulation Watch window

The Simulation Watch window by default takes the lower tab area in the RobotStudio GUI.

The window contains a list view of four columns with one row for each watch item:

<table>
<thead>
<tr>
<th>Watch item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break</td>
<td>Specifies the Simulation break point and Break Condition. For more information, see <em>Setting Breakpoints on page 287</em>.</td>
</tr>
<tr>
<td>Object</td>
<td>Specifies the object that owns the property or signal (for station signals the name of the station is displayed).</td>
</tr>
<tr>
<td>Property/Signal</td>
<td>Specifies the watched property or signal.</td>
</tr>
<tr>
<td>Value</td>
<td>Specifies the current value of the property or signal.</td>
</tr>
</tbody>
</table>

Adding and Deleting the Watch items

Use this procedure to add or delete a watch item.

1. In the Simulation Watch window, right-click and select **Add** to display the Add submenu.

   The Add submenu displays a recursive view of all the smart components, their properties and signals. The top level submenu displays the station signals.

   - **Note**: Watch items that are already watched are not displayed in the recursive view.

2. From the Add submenu, select property or signal to add a single property or signal of a component.

3. From the Add submenu, select **Add all** to add all the properties and signals of a component.
4 In the Simulation Watch window, right-click on the row of the watch item and select Delete to delete one or more watch items.

Note
The Watch items are saved in the station and are restored when the station is opened.

Setting Breakpoints
You can set the breakpoint in one of the following ways:

1 To set the simulation breakpoint, select the check box next to a watch item.

Note
By default, the simulation is paused whenever the value of the property or signal changes.

2 In the Simulation Watch window, right-click on the row of the watch item and select Break Condition.

The Break Condition dialog box appears.

• Set the simulation to paused, when the value meets a certain logical condition. The condition can be viewed in the Break column of the Watch window.

• When a breakpoint is reached, the simulation is paused which is indicated by both the Play and Stop buttons being enabled.

• If the Simulation Watch window is hidden behind the other windows, it is brought to the front and the text of the corresponding watch item turns red.

Note
• Break condition can be specified only for the properties of numeric and string types, and not for the object types.

• After the current simulation time step is completed, all the remaining Smart component events are executed before the simulation is actually paused.
9 Modeling tab

9.5 Solid

Creating a solid

1. Click Solid and then click the type of solid you want to create to bring up a dialog box.

2. Enter requested values in the dialog box and click Create. For detailed information about the specific dialog box for the curve to create, see below:

The Create Box dialog box

![Diagram of a box with dimensions labeled A, B, C, D.]

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the Reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corner Point (A)</td>
<td>Click in one of these boxes, and then click the corner point in the graphics window to transfer the values to the Corner Point boxes, or type the position. The corner point will be the local origin of the box.</td>
</tr>
<tr>
<td>Orientation</td>
<td>If the object shall be rotated relative to the reference coordinate system, specify the rotation.</td>
</tr>
<tr>
<td>Length (B)</td>
<td>Specify the box dimension along its X axis.</td>
</tr>
<tr>
<td>Width (C)</td>
<td>Specify the box dimension along its Y axis.</td>
</tr>
<tr>
<td>Height (D)</td>
<td>Specify the box dimension along its Z axis.</td>
</tr>
</tbody>
</table>

The Create Box from 3-Points dialog box

![Diagram of a box with points A, B, C labeled.]

| Reference          | Select the Reference coordinate system to which all positions or points will be related. |

Continues on next page
Corner Point (A)

This point will be the local origin of the box. Either type the position, or click in one of the boxes and then select the point in the graphics window.

Point on diagonal of XY-plane (B)es

This point is the corner, diagonal to the local origin. It sets the X and Y directions of the local coordinate system, as well as the dimension of the box along these axes. Either type the position, or click in one of the boxes and then select the point in the graphics window.

Indication Point Z-axis (C)

This point is the corner above the local origin, it sets the Z direction of the local coordinate system, as well as the dimension of the box along the Z axis. Either type the position, or click in one of the boxes and then select the point in the graphics window.

The Create Cone dialog box

The Create Cylinder dialog box

Continues on next page
Reference | Select the Reference coordinate system to which all positions or points will be related.
---|---
Base Center Point (A) | Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Base Center Point boxes, or type the position. The center point will be the local origin of the cylinder.
Orientation | If the object shall be rotated relative to the reference coordinate system, specify the rotation.
Radius (B) | Specify the radius of the cylinder.
Diameter | Specify the diameter of the cylinder.
Height (C) | Specify the height of the cylinder.

The Create Pyramid dialog box

Reference | Select the Reference coordinate system to which all positions or points will be related.
---|---
Base Center Point (A) | Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Base Center Point boxes, or type the position. The center point will be the local origin of the pyramid.
Orientation | If the object shall be rotated relative to the reference coordinate system, specify the rotation.
Center to Corner Point (B) | Either type the position, or click in the box and then select the point in the graphics window.
Height (C) | Specify the height of the pyramid.
Number of Sides | Specify the number of sides of the pyramid. The maximum number of sides is 50.

The Create Sphere dialog box

Reference | Select the Reference coordinate system to which all positions or points will be related.
---|---
Base Center Point (A) | Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Base Center Point boxes, or type the position. The center point will be the local origin of the cylinder.
Orientation | If the object shall be rotated relative to the reference coordinate system, specify the rotation.
Center to Corner Point (B) | Either type the position, or click in the box and then select the point in the graphics window.
Height (C) | Specify the height of the pyramid.
Number of Sides | Specify the number of sides of the pyramid. The maximum number of sides is 50.
Select the Reference coordinate system to which all positions or points will be related.

<table>
<thead>
<tr>
<th>Reference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center Point (A)</td>
<td>Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Center Point boxes, or type the position. The center point will be the local origin of the sphere.</td>
</tr>
<tr>
<td>Radius (B)</td>
<td>Specify the radius of the sphere.</td>
</tr>
<tr>
<td>Diameter</td>
<td>Specify the diameter of the sphere.</td>
</tr>
</tbody>
</table>
Creating a surface

1. Click Surface and then click the type of solid you want to create to bring up a dialog box.
2. Enter requested values in in the dialog box and click Create. For detailed information about the specific dialog box for the curve to create, see below:

The Create Surface Circle dialog box

![Circle Diagram]

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the Reference coordinate system, to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center Point (A)</td>
<td>Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Center Point boxes, or type the position. The center point will be the local origin of the circle.</td>
</tr>
<tr>
<td>Orientation</td>
<td>If the object shall be rotated relative to the reference coordinate system, specify the rotation.</td>
</tr>
<tr>
<td>Radius (B)</td>
<td>Specify the radius of the circle.</td>
</tr>
<tr>
<td>Diameter</td>
<td>Specify the diameter of the circle.</td>
</tr>
</tbody>
</table>

The Create Rectangle dialog box

![Rectangle Diagram]

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the Reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Point (A)</td>
<td>Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Start Point boxes, or type the position. The start point will be the local origin of the rectangle.</td>
</tr>
</tbody>
</table>
If the object shall be rotated relative to the reference coordinate system, specify the rotation.

**Orientation**

If the object shall be rotated relative to the reference coordinate system, specify the rotation.

**Length (B)**

Specify the length of the rectangle.

**Width (C)**

Specify the width of the rectangle.

---

The Create Surface Polygon dialog box

![Polygon Diagram]

**Reference**

Select the Reference coordinate system to which all positions or points will be related.

**Center Point**

Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Center Point boxes, or type the position. The center point will be the local origin of the polygon.

**First Vertex Point**

Either type the position, or click in one of the boxes and then select the point in the graphics window.

**Vertices**

Specify the number of the vertices here. The maximum number of vertices is 50.

---

The Create Surface from Curve dialog box

**Select Curve from graphics**

Select a curve by clicking it in the graphics window.
9 Modeling tab

9.7 Curve

Creating a curve

1. Click Curve and then click the curve you want to create to bring up a dialog box.
2. Enter requested values in the dialog box and click Create. For detailed information about the specific dialog box for the curve to create, see below:

The Create Line dialog box

![Create Line Diagram]

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the Reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start point (A)</td>
<td>Click in one of these boxes, and then click the start point in the graphics window to transfer the values to the Start Point boxes.</td>
</tr>
<tr>
<td>End Point (B)</td>
<td>Click in one of these boxes, and then click the end point in the graphics window to transfer the values to the End Point boxes.</td>
</tr>
</tbody>
</table>

The Create Circle dialog box

![Create Circle Diagram]

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the Reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center point (A)</td>
<td>Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Center Point boxes.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specify the orientation coordinates for the circle.</td>
</tr>
<tr>
<td>Radius (A-B)</td>
<td>Specify the radius of the circle.</td>
</tr>
<tr>
<td>Diameter</td>
<td>Alternatively, specify the diameter.</td>
</tr>
</tbody>
</table>
The Create Three Points Circle dialog box

Reference  | Select the Reference coordinate system to which all positions or points will be related.
---|---
First Point (A)  | Click in one of these boxes, and then click the first point in the graphics window to transfer the values to the First Point boxes.
Second Point (B)  | Click in one of these boxes, and then click the second point in the graphics window to transfer the values to the Second Point boxes.
Third Point (C)  | Click in one of these boxes, and then click the third point in the graphics window to transfer the values to the Third Point boxes.

The Create Arc dialog box

Reference  | Select the Reference coordinate system to which all positions or points will be related.
---|---
Start Point (A)  | Click in one of these boxes, and then click the start point in the graphics window to transfer the values to the Start Point boxes.
Mid Point (B)  | Click in one of these boxes, and then click the second point in the graphics window to transfer the values to the Mid Point boxes.
End Point (C)  | Click in one of these boxes, and then click the end point in the graphics window to transfer the values to the End Point boxes.
The Create Elliptical Arc dialog box

![Diagram of an elliptical arc]

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the Reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center Point (A)</td>
<td>Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Center Point boxes.</td>
</tr>
<tr>
<td>Major Axis End Point (B)</td>
<td>Click in one of these boxes, and then click the end point for the major axis of the ellipse in the graphics window to transfer the values to the Major Axis End Point boxes.</td>
</tr>
<tr>
<td>Minor Axis End Point (C)</td>
<td>Click in one of these boxes, and then click the end point for the minor axis of the ellipse in the graphics window to transfer the values to the Minor Axis End Point boxes.</td>
</tr>
<tr>
<td>Start Angle (α)</td>
<td>Specify the start angle for the arc, measured from the major axis.</td>
</tr>
<tr>
<td>End Angle (β)</td>
<td>Specify the end angle for the arc, measured from the major axis.</td>
</tr>
</tbody>
</table>

The Create Ellipse dialog box

![Diagram of an ellipse]

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the Reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center Point (A)</td>
<td>Click in one of the Center Point boxes, and then click the center point in the graphics window to transfer the values to the Center Point boxes.</td>
</tr>
<tr>
<td>Major Axis End Point (B)</td>
<td>Click in one of these boxes, and then click the end point for the major axis of the ellipse in the graphics window to transfer the values to the Major Axis End Point boxes.</td>
</tr>
<tr>
<td>Minor Radius (C)</td>
<td>Specify the length of the minor axis of the ellipse. The minor radius will be created perpendicular to the major axis.</td>
</tr>
</tbody>
</table>

Continues on next page
The Create Rectangle dialog box

Reference | Select the Reference coordinate system to which all positions or points will be related.
Start Point (A) | Click in one of these boxes, and then click the start point in the graphics window to transfer the values to the Start Point boxes. The rectangle will be created in the positive coordinate directions.
Orientation | Specify the orientation coordinates for the rectangle.
Length (B) | Specify the length of the rectangle along the x axis.
Width (C) | Specify the width of the rectangle along the y axis.

The Create Polygon dialog box

Reference | Select the Reference coordinate system to which all positions or points will be related.
Center Point (A) | Click in one of these boxes, and then click the center point in the graphics window to transfer the values to the Center Point boxes.
First Vertex Point (B) | Click in one of these boxes, and then click the first vertex point in the graphics window to transfer the values to the First Vertex Point boxes. The distance between the center point and the first vertex point will be used for all vertex points.
Vertices | Specify the number of points to be used when creating the polygon. The maximum number of vertices is 50.
### The Create Polyline dialog box

<table>
<thead>
<tr>
<th><strong>Reference</strong></th>
<th>Select the Reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Point Coordinates</strong></td>
<td>Specify each node of the polyline here, one at a time, by either typing the values, or by clicking in one of these boxes, and then selecting the point in the graphics window to transfer its coordinates.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>Click this button to add a point and its coordinates to the list.</td>
</tr>
<tr>
<td><strong>Modify</strong></td>
<td>Click this button to modify an already defined point, after you have selected it in the list and entered new values.</td>
</tr>
<tr>
<td><strong>List</strong></td>
<td>The nodes of the polyline. To add more nodes, click Add New, click the desired point in the graphics window, and then click Add.</td>
</tr>
</tbody>
</table>

### The Create Spline dialog box

<table>
<thead>
<tr>
<th><strong>Reference</strong></th>
<th>Select the Reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Point Coordinates</strong></td>
<td>Specify each node of the spline here, one at a time, by either typing the values, or by clicking in one of these boxes, and then selecting the point in the graphics window to transfer its coordinates.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>Click this button to add a point and its coordinates to the list.</td>
</tr>
<tr>
<td><strong>Modify</strong></td>
<td>Click this button to modify an already defined point, after you have selected it in the list and entered new values.</td>
</tr>
<tr>
<td><strong>List</strong></td>
<td>This nodes of the spline. To add more nodes, click Add New, click the desired point in the graphics window, and then click Add.</td>
</tr>
</tbody>
</table>
9.8 Border

Creating a curve

1. Click Border and then click the border you want to create to bring up a dialog box.
2. Enter requested values in the dialog box and click Create. For detailed information about the specific dialog box for the border to create, see below:

The Create Border Between Bodies dialog box

To use the create border between bodies command, the station must contain at least two objects.

<table>
<thead>
<tr>
<th>First Body</th>
<th>Click in this box and then select the first body in the graphics window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second Body</td>
<td>Click in this box and then select the second body in the graphics window.</td>
</tr>
</tbody>
</table>

The Create Border Around Surface dialog box

To use the create border around surface command, the station must contain at least one object with a graphical representation.

| Select Surface | Click in this box and then select a surface in the graphics window. |

Continues on next page
To use the create border from points command, the station must contain at least one object.

**Selected Object**
Click in this box and then select an object in the graphics window.

**Point Coordinates**
Specify the points that define the border here, one at a time, by either typing the values, or by clicking in one of these boxes, and then selecting the point in the graphics window to transfer its coordinates.

**Add**
Click this button to add a point and its coordinates to the list.

**Modify**
Click this button to modify an already defined point, after you have selected it in the list and entered new values.

**List**
The points that define the borders. To add more points, click Add New, click the desired point in the graphics window, and then click Add.
### 9.9 Intersect

#### The Intersect dialog box

![Intersect Diagram](xx060009)

<table>
<thead>
<tr>
<th><strong>Keep Original</strong></th>
<th><strong>Select this check box to keep the original bodies when creating the new body.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intersect... (A)</strong></td>
<td><strong>Select the body from which you want to make an intersection (A) by clicking it in the graphics window.</strong></td>
</tr>
</tbody>
</table>
| **...and (B)** | **Select the body with which you want to make an intersection (B) by clicking it in the graphics window.**  
A new body will be created based on the common area between the selected bodies A and B. |
9 Modeling tab

9.10 Subtract

The Subtract dialog box

<table>
<thead>
<tr>
<th>Keep Original</th>
<th>Select this check box to keep the original bodies when creating the new body.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subtract... (A)</td>
<td>Select the body from which you want to subtract (A) by clicking it in the graphics window.</td>
</tr>
<tr>
<td>...with (B)</td>
<td>Select the body you want to subtract (B) by clicking it in the graphics window. A new body will be created based on the area of body A subtracted with the common volume between body A and B.</td>
</tr>
</tbody>
</table>
9 Modeling tab

9.11 Union

The Union dialog box

<table>
<thead>
<tr>
<th>Keep Original</th>
<th>Select this check box to keep the original bodies when creating the new body.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Union... (A)</td>
<td>Select the body that you want to unify (A) by clicking it in the graphics window.</td>
</tr>
<tr>
<td>...and (B)</td>
<td>Select the body that you want to unify (B) by clicking it in the graphics window. A new body will be created based on the areas of the two selected bodies A and B.</td>
</tr>
</tbody>
</table>
9 Modeling tab

9.12 Extrude Surface or Curve

Extruding a surface or curve

1. From the selection level toolbar, select Surface or Curve, as appropriate.
2. In the graphics window, select the surface or curve you wish to extrude. Click Extrude Surface or Extrude Curve, as appropriate. The Extrude Surface or Curve dialog box opens below the Modeling browser.
3. For extrusion along a vector, fill in the values.
   For extrusion along a curve, select the Extrude Along Curve option. Click the Curve box, and select the curve in the Graphics window.
4. If you wish the form to appear as a surface model, clear the Make Solid check box.
5. Click Create.

The Extrude Surface or Curve dialog box

<table>
<thead>
<tr>
<th>Surface or Curve</th>
<th>Denotes the surface or curve to be extruded. To select the surface or curve, first click in the box, then select the surface or curve in the graphics window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extrude Along Vector</td>
<td>Enables extrusion along a specified vector.</td>
</tr>
<tr>
<td>From Point (mm)</td>
<td>The start point of the vector.</td>
</tr>
<tr>
<td>To Point (mm)</td>
<td>The end point of the vector.</td>
</tr>
<tr>
<td>Extrude Along Curve</td>
<td>Enables extrusion along a specified curve.</td>
</tr>
<tr>
<td>Curve</td>
<td>Denotes the curve used as a sweep path.</td>
</tr>
</tbody>
</table>

To select the curve, first click the box, then the curve in the graphics window.
9.12 Extrude Surface or Curve

*Continued*

| Make Solid | Select this check box to convert the extruded form into a solid. |
9 Modeling tab

9.13 Line from Normal

9.13 Line from Normal

Creating a line from normal

1. Click Surface Selection.
2. Click Line to Normal to bring up a dialog box.
3. Click on a face to select it in the Select Face box.
4. In the Length box, specify a length for the line.
5. Optionally, select the Invert Normal check box to invert the direction of the line.
6. Click Create.
9.14 The Measure Group

Tip
Make sure to select the appropriate snap mode and selection levels before making your measurements.

Measuring distances or angles

1 Click the type of measurement you want to use:

<table>
<thead>
<tr>
<th>To measure the</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>distance between two points you select in the graphics window.</td>
<td>Point to point</td>
</tr>
<tr>
<td>angle defined by three points you select in the graphics window.</td>
<td>Angle</td>
</tr>
<tr>
<td>The first point to select is the converging point, thereafter you</td>
<td></td>
</tr>
<tr>
<td>shall select one point on each line.</td>
<td></td>
</tr>
<tr>
<td>diameter, with the circle defined by three points you select from</td>
<td>Diameter</td>
</tr>
<tr>
<td>the graphics window.</td>
<td></td>
</tr>
<tr>
<td>closest distance between two objects you select in the graphics</td>
<td>Minimum distance</td>
</tr>
<tr>
<td>window.</td>
<td></td>
</tr>
</tbody>
</table>

The mouse pointer will turn into a ruler when you have activated any of the measurement functions.

2 In the graphics window, select the points or objects to measure between. Information about the measuring points is displayed in the Output window. The results will be displayed in the Measurements tab in the Output window when all points have been selected.

3 Optionally, repeat step 3 for making a new measurement of the same type.

Tip
You can also activate and deactivate the measurement functions from the measurement toolbar.
Create Mechanism

Create a new mechanism

1. Click Create Mechanism.
   The Mechanism Modeler opens in create mode.
2. In the Mechanism Model Name box, enter a mechanism name.
3. From the Mechanism Type list, select a mechanism type.
4. In the tree structure, right-click Links, and then click Add Link to bring up the Create Link dialog box.
   A suggested name appears in the Link Name box.
5. In the Selected Part list, select a part (which will be highlighted in the graphics window) and click the arrow button to add the part to the Parts list box.
   The Selected Part list then automatically selects the next part, if any more are available. Add these, as required.

   **Note**
   Parts that are part of a library or mechanism cannot be selected.

6. Select a part in the Parts list box, enter any values in the Selected Parts group boxes, and then click Apply to Part.
   Repeat for each part, as required.
7. Click OK.
8. In the tree structure, right-click Joints, and then click Add Joint to bring up the Create Joint dialog box.
   A suggested name appears in the Joint Name box.
9. Complete the Create Joint dialog box, and then click OK.
10. In the tree structure, right-click Frame/Tool Data, and then click Add Frame/Tool to bring up the Create Frame/Tool dialog box.
    A suggested name appears in the Frame/Tool Data name box.
11. Complete the Create Frame/Tool dialog box, and then click OK.
    The validity criteria for the Frame/Tool node are as follows:
12. In the tree structure, right-click Calibration, and then click Add Calibration to bring up the Create Calibration dialog box.
13. Complete the Create Calibration dialog box, and then click OK.
14. In the tree structure, right-click Dependency, and then click Add Dependency to bring up the Create Dependency dialog box.
15. Complete the Create Dependency dialog box, and then click OK.
16. If all nodes are valid, compile the mechanism, see *Compiling a mechanism on page 309.*

Create Conveyor mechanism

1. Click Create Mechanism.
   The Mechanism Modeler opens in create mode.
2 In the **Mechanism Model Name** dialog box, enter a mechanism name.
3 From the **Mechanism Type** list, select **Conveyor**.
4 From the **Selected Part** list, select **Part**.
5 In the **Position of Calibration frame** list, enter the base frame values relative to the local origin of the selected graphic component.
6 In the **Conveyor length** box, enter the length of the conveyor.
   The **Compile Mechanism** button is enabled.
7 In the **Attachment Points** box, set the **Pitch** and **Count** value.
8 Click **Add** to create new attachment points.
9 Click **Compile Mechanism**, to compile the mechanism. See *Compiling a mechanism on page 309*.
10 In the **Layout** browser, right-click the conveyor mechanism and select **Save As Library**. Close the station.
11 Build a new system. See *Building a new system on page 159*.
   On the **Modify Options** page of the System Builder, scroll down to the **Motion coordination part 3** group and select **606-1 Conveyor Tracking** check box.
12 Create new station using this new system. See *Robot System on page 204*.
   After starting the system, when asked to select the library for the conveyor mechanism browse and select the already saved library.

**Compiling a mechanism**

When compiling, a new mechanism, created in the create mode of the Mechanism Modeler, is added to the station with the default name "Mechanism_" followed by an index number.

When compiling, an existing editable mechanism, modified in the modify mode of the Mechanism Modeler, is saved without any poses, joint mapping or transition times.

To compile a mechanism, follow these steps:

1 To compile a new or edited mechanism, click **Compile Mechanism**.
   The mechanism is inserted into the active station. The link parts are cloned with new names, but the corresponding links will update their part references. When the Mechanism modeler is closed, these cloned parts will be removed.
2 The Mechanism Modeler now switches to modify mode. To complete the mechanism, see below.

**Completing or modifying a mechanism**

To complete the modeling of a mechanism, follow these steps:

1 If the values in the **Joint Mapping** group are correct, click **Set**.
2 Configure the Poses grid. To add a pose, click **Add** and then complete the **Create Pose** dialog box. Click **Apply**, followed by **OK**.
   To add a pose, click **Add** and then complete the **Create Pose** dialog box. Click **Apply**, followed by **OK**.
To edit a pose, select it in the grid, click Edit, and then complete the Modify Pose dialog box. Click OK.

To remove a pose, select it in the grid and then click Remove.

3 Click Edit Transition Times to edit transition times.
4 Click Close.

The Create Mechanism dialog box

<table>
<thead>
<tr>
<th>Mechanism Model Name</th>
<th>Specifies the model name of the mechanism.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanism Type</td>
<td>Specifies the mechanism type.</td>
</tr>
<tr>
<td>Tree structure</td>
<td>The components of the mechanism in a tree structure. The tree structure will not be visible unless the mechanism is editable. Each node (link, joint, frame, calibration and dependency) can be edited in its own dialog box, see below.</td>
</tr>
<tr>
<td>Compile Mechanism</td>
<td>Click this button to compile the mechanism. This button will not be visible unless the mechanism is editable and the mechanism model name is valid.</td>
</tr>
</tbody>
</table>

The Create Conveyor Mechanism dialog box

<table>
<thead>
<tr>
<th>Mechanism Model Name</th>
<th>Specifies the model name of the conveyor mechanism.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanism Type</td>
<td>Specifies the different mechanism types.</td>
</tr>
<tr>
<td>Selected Part</td>
<td>Specifies the part to be selected for the conveyor.</td>
</tr>
<tr>
<td>Position of Calibration frame</td>
<td>Specifies the baseframe value relative to the local origin of the selected graphic component.</td>
</tr>
<tr>
<td>Conveyor Length</td>
<td>Specifies the length of the conveyor.</td>
</tr>
<tr>
<td>Attachment Points</td>
<td>Specifies the conveyor position to attach the workpieces.</td>
</tr>
<tr>
<td>Compile Mechanism</td>
<td>Click this button to compile the mechanism. This button will not be visible unless the mechanism is editable and the mechanism model name is valid.</td>
</tr>
</tbody>
</table>

The Create/Modify Link dialog box

A link is a moving component of a mechanism. Selecting a link node will highlight it in the graphics window.

<table>
<thead>
<tr>
<th>Link Name</th>
<th>Specifies the name of the link.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Part</td>
<td>Specifies the parts to add to the Part list box.</td>
</tr>
<tr>
<td>Set as BaseLink</td>
<td>The BaseLink is where the kinematical chain begins. This must be the parent of the first joint. A mechanism may have only one BaseLink.</td>
</tr>
</tbody>
</table>
The Create/Modify Joint dialog box

A joint is the axis where two links move in relation to each other, rotationally or prismatically. Selecting a joint node will display a yellow-green line in the graphics window.

<table>
<thead>
<tr>
<th>Joint Name</th>
<th>Specifies the name of the joint.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joint Type.</td>
<td>Specifies the joint type. The default option is Rotational. Changing the Joint Type clears the Joint Limits below.</td>
</tr>
<tr>
<td>Parent Link</td>
<td>Specifies the parent link, usually the first joint of the mechanism.</td>
</tr>
<tr>
<td>Child Link</td>
<td>Specifies the child link. To be valid, the parent and child links may not be identical to each other, and the pair must be unique.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box to make the joint active. An active joint is one that a user can move, while an inactive joint is a slave to an active joint.</td>
</tr>
<tr>
<td>Joint Axis</td>
<td>This group specifies the axis around or along which the child moves.</td>
</tr>
<tr>
<td>First Position</td>
<td>Specify the start point of the axis vector.</td>
</tr>
<tr>
<td>Second Position</td>
<td>Specify the end point of the axis vector.</td>
</tr>
<tr>
<td>Jog Axis</td>
<td>Demonstrates how the child link moves along its axis.</td>
</tr>
<tr>
<td>Limit Type</td>
<td>Specifies the limits in each direction to which a joint may move. The options are Constant, Variable and No.</td>
</tr>
<tr>
<td>Joint Limits</td>
<td>This group is visible in Constant or Variable mode.</td>
</tr>
<tr>
<td>Min Limit</td>
<td>Specifies the minimum joint limit.</td>
</tr>
<tr>
<td>Max Limit</td>
<td>Specifies the maximum joint limit.</td>
</tr>
<tr>
<td>Joint Limits</td>
<td>This group is visible in Constant or Variable mode.</td>
</tr>
</tbody>
</table>

Continues on next page
9 Modeling tab

9.15 Create Mechanism

Continued

In Variable mode, variable limit points may be added as an advanced way of delimiting the area of movement.

Variable Limits

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds a selected point to the Point list box.</td>
</tr>
<tr>
<td>Remove</td>
<td>Click this button to remove a selected point from the Point list box.</td>
</tr>
</tbody>
</table>

The Modify Frame/Tool Data dialog box

A frame/tool data node determines the link and location of a frame.

<table>
<thead>
<tr>
<th>Frame/Tool name</th>
<th>Specifies the name of the frame or tool data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Belongs to Link</td>
<td>Specifies the link to which the frame or tool belongs.</td>
</tr>
<tr>
<td>Position</td>
<td>Specify the position of the transform.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specify the orientation of the transform.</td>
</tr>
<tr>
<td>Select values from target/Frame</td>
<td>Select this box to select the values from a target or frame, which is selected in the box beneath the check box.</td>
</tr>
<tr>
<td>Tool Data</td>
<td>This group is visible if the mechanism is a tool.</td>
</tr>
<tr>
<td>Mass</td>
<td>Specifies the mass of the tool.</td>
</tr>
<tr>
<td>Center of Gravity</td>
<td>Specify the center of gravity of the tool.</td>
</tr>
<tr>
<td>Moment of Inertia</td>
<td>( lx, ly, lz ) Specify the moment of inertia of the tool.</td>
</tr>
</tbody>
</table>
The Create Dependency dialog box

A dependency is a relationship between two joints, by either a factor or a complex formula.

<table>
<thead>
<tr>
<th>Joint</th>
<th>Specifies the joint whose motion will be controlled by other joints.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use LeadJoint and factor</td>
<td>Select this option to specify a lead joint and factor.</td>
</tr>
<tr>
<td>LeadJoint</td>
<td>Specifies the lead joint.</td>
</tr>
<tr>
<td>Factor</td>
<td>This list holds a double which denotes the extent to which the lead joint will control the main joint.</td>
</tr>
<tr>
<td>Use Formula</td>
<td>Select this option to enter a formula in the box.</td>
</tr>
</tbody>
</table>

The Modify Mechanism dialog box

The Modify Mechanism dialog box contains the objects found in the Create mechanism dialog box, as well as the following:

<table>
<thead>
<tr>
<th>Joint Mapping</th>
<th>These boxes handle the joint mapping of the mechanism. When editing, the mechanism must be disconnected from its library. The values must be integers from 1 – 6 in ascending order.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set</td>
<td>Click this button to set the joint mapping.</td>
</tr>
<tr>
<td>Poses</td>
<td>Displays the poses and their joint values. Selecting a pose will move the mechanism to it in the graphics window.</td>
</tr>
<tr>
<td>Add</td>
<td>Click this button to bring up the Create Pose dialog box for adding a pose.</td>
</tr>
<tr>
<td>Edit</td>
<td>Click this button to bring up the Modify Pose dialog box for editing a selected pose. A SyncPose cannot be edited unless the mechanism is disconnected from its library.</td>
</tr>
<tr>
<td>Remove</td>
<td>Click this button to remove the selected pose. A single SyncPose cannot be removed.</td>
</tr>
<tr>
<td>Set Transition Times</td>
<td>Click this button to edit the transition times.</td>
</tr>
</tbody>
</table>

The Create/Modify Pose dialog box

<table>
<thead>
<tr>
<th>Pose Name</th>
<th>Specifies the name of the pose. If the pose is a SyncPose, this box is not editable. The names &quot;HomePosition&quot; and &quot;SyncPosition&quot; are disallowed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Pose</td>
<td>Select this box to specify the home pose of the mechanism. If selected, the non-editable pose name will be &quot;HomePose&quot;.</td>
</tr>
<tr>
<td>Launch Joint Jog Tool</td>
<td>Click this button to bring up the joint jog tool.</td>
</tr>
<tr>
<td>Use Current</td>
<td>Click this button to set the current joint values in the Joint Values group.</td>
</tr>
<tr>
<td>Reset Values</td>
<td>Click this button to reset the joint values in the Joint Values group to what they were when the dialog box was opened.</td>
</tr>
<tr>
<td>Joint Values</td>
<td>Specify the joint values of the pose.</td>
</tr>
</tbody>
</table>

Continues on next page
The Set Transition Times dialog box

The **Set Transition Times** dialog box is designed like a distance table in a road atlas. The default values are zero.

<table>
<thead>
<tr>
<th>From Pose</th>
<th>Specifies the start of the transition for the named pose.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Pose</td>
<td>Specifies the end of the transition for the named pose.</td>
</tr>
</tbody>
</table>

Continued
9.16 Create Tool

Creating a tool

You can create a robot hold tool by using the Create Tool Wizard. The wizard allows you to easily create a tool from an existing part or by using a dummy part to represent a tool. To create a tool complete with tooldata, follow these steps:

1. Click Create Tool.
2. In the Tool Name box, enter a tool name and choose one of the following options:
   - Use Existing: Select one of the existing parts from the list. The selected part will represent the tool graphics. The selected part must be a single part. Parts with attachments cannot be selected.
   - Use Dummy: A cone will be created to represent the tool.

3. Continue entering the Mass of the tool, the Center of Gravity and the Moment of Inertia Ix, Iy, Iz, if these values are known. If you do not know the correct values, the tool can still be used for programming motions, but this data must be corrected before running the program on real robots or measuring cycle times.

   Tip

   If the tool is built from materials with a similar density, you can find the center of gravity by clicking the tool model using the Center of gravity snap mode.

4. Click Next to go the next page of the wizard.
5. In the TCP Name box, enter a name for the Tool Center Point (TCP). The default name is the same as the name of the tool. If creating several TCPs for one tool, each TCP must have a unique name.
6. Enter the position of the TCP relative to the world coordinate system, which represents the tool mounting point, by any of the methods below:

   Method | Description
   --- | ---
   Read values from existing target or frame | Click in the Values from Target/Frame box, then select the frame either in the graphics window or the Paths&Targets browser.
   Enter position and orientation manually | In the Position and Orientation boxes, type the values. If Use Dummy Part is selected, the position value cannot be 0,0,0. At least one coordinate has to be > 0 in order for a cone to be created.

7. Click the arrow right button to transfer the values to the TCP(s): box.
8. If the tool shall have several TCPs, repeat steps 5 to 7 for each TCP.
9. Click Done.

Continues on next page
9 Modeling tab

9.16 Create Tool

Continued

The tool is created and appears in the Layout browser and in the graphics window.

Creating tool data for an existing geometry

To create tool data for an existing geometry, follow these steps:

1. Make sure the robot in which to create the tool data is selected.
2. Click Create Tool and select Use Existing and the imported tool from the list.
3. Enter the requested data in the boxes in the Create Tool Wizard.
4. Attach the tool by dragging it to the robot.

What to do next

To make the tool ready to use, do one of the following:

- To make the robot hold the tool, attach the tool to the robot.
- In the graphics window, check the position and orientation of the TCP. If it is incorrect, modify the values in the tool frame part of the tool data.
- To simplify future usage of the created tool, save it as a library. On the File menu, click Save As Library. Browse to the folder where you want to store the tool component, enter a name for the tool component and click Save.
10 Simulation tab

10.1 Overview

The Simulation tab contains the controls for setting up, configuring, controlling, monitoring and recording simulations.
10 Simulation tab

10.2 Create Collision Set

10.2 Create Collision Set

Overview

A collision set contains two groups, *Objects A* and *Objects B*, in which you place the objects to detect any collisions between them. When any object in *Objects A* collides with any object in *Objects B*, the collision is displayed in the graphical view and logged in the output window. You can have several collision sets in the station, but each collision set can only contain two groups.

Creating a collision set

1. Click Create Collision Set to create a collision set in the Layout browser.
2. Expand the collision set and then drag one of the objects to the *ObjectsA* node to check for collisions.
   If you have several objects you want to check for collisions with objects in the *ObjectsB* node, for example, the tool and the robot, drag all of them to the *ObjectsA* node.
3. Drag the objects to the *ObjectsB* node to check for collisions.
   If you have several objects you want to check for collisions with objects in the *ObjectsA* node, for example, the work piece and the fixture, drag all of them to the *ObjectsB* node.

Tip

Selecting a collision set or one of its groups (*Objects A* or *Objects B*) highlights the corresponding objects in the graphical window and the browser. Use this feature to quickly check what objects have been added to a collision set or to one of its groups.
10.3 Simulation Setup

Overview

The Simulation Setup dialog box is used to perform the following two main tasks.

- Setting up the sequence and entry point in the robot program
- Creating simulation scenarios for different simulated objects

Prerequisites

To set up a simulation, the following conditions must be met:

- At least one path must have been created in the station.
- The paths to be simulated must have been synchronized to the virtual controller.

The Setup Simulation dialog box

The Setup Simulation dialog box consists of the following two tabs,

- Program Sequence
- Simulation Scenarios

Program Sequence

From this tab, you can perform the combined task of configuring the program sequence and program execution such as entry point, and running the execution mode.

The Program Sequence tab consists of the following:

<table>
<thead>
<tr>
<th>Select Active Tasks</th>
<th>Displays all running IRC5 controllers in the station along with the tasks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution Sequence</td>
<td>Displays the procedures in the main entry routine of the task. The sequence of the procedures shows the sequence of execution.</td>
</tr>
<tr>
<td>&lt;Task Name&gt;</td>
<td>X</td>
</tr>
<tr>
<td>&lt;-</td>
<td>Click the arrow left button to transfer the selected procedure to the Main Sequence box. The procedure will be added last to the sequence.</td>
</tr>
<tr>
<td>X</td>
<td>Click this button to remove the selected procedures or sequences from the Main sequence box.</td>
</tr>
<tr>
<td>arrow up</td>
<td>Click the arrow up button to move the sequence up in the list in the Main Sequence box or in the Available Procedures box.</td>
</tr>
<tr>
<td>arrow down</td>
<td>Click the arrow down button to move the sequence down in the list in the Main Sequence box or in the Available Procedures box.</td>
</tr>
<tr>
<td>Available Procedures</td>
<td>Displays all procedures available in the controller. These procedures can be added to the execution sequence.</td>
</tr>
</tbody>
</table>
### Entry point

The task starts its execution in the routine specified by the Entry point. You can setup several simulations at the same time.

1. Click **Entrypoint**, the Select entry point dialog box appears.
2. Click **Select entry point** for drop down to select the routine to be used as entry point. By default, the value is set to **main**.
3. Click **Select module** drop down to select the module in the task. By default, the value is set to **Module1**.
4. Click **OK**.

### Run mode

You can change the run mode between continuous and single cycle mode by toggling the radio buttons.

- **Continuous**: In this mode, the main routine is executed over and over again until you stop the program.
- **Single**: In this mode, the main routine is executed once and thereafter the program is stopped.

### Simulation Scenarios

From this tab, you can create simulation scenarios containing different simulated objects and connect each scenario with a predefined state to ensure that the correct state is applied to all project objects before running the scenario.

If you want to simulate a specific part or segment of the cell where not all simulated objects in the cell are included, you can set up a new scenario and add only the objects needed for simulation.

The Simulation Scenarios tab consists of the following:

| Scenarios | Lists all station scenarios. By default, at least one scenario is created when you create a station. Select the check box to make the scenario active. Active scenarios cannot be deleted and there should always be one active scenario.
| --- | --- |
| Add | Click **Add** to create a new scenario.
| Remove | Click **Remove** to delete the selected scenario. Click the scenario in the list view to rename it.

| Simulated object | Displays all objects that can be part of a simulation. Objects that utilize simulation time can be part of a simulation. For example, Virtual Controllers and Smart Components. When you create a new scenario, all objects are selected by default.

| Saved State | When you set the scenario to active and start the simulation, you can connect a saved state for each scenario and restore this state to all objects that are part of the state. The **Saved State** drop-down contains all saved states in the station, as well as the entries with no state. By default, no state is connected to the scenario. For more on Saved states, see [Saved States on page 259](#).

### Setting up a simulation

1. Click **Simulation Setup** to bring up the **Setup Simulation** dialog box.
2. From the **Program Sequence** tab, select the tasks to be active during simulation in the **Select Active Tasks** box.
3. Select the run mode as either **Continuous** or **Single Cycle**.

---

**Continued on next page**
4 In the **Main Sequence** box, select the execution sequence of the procedure in the tasks main entry routine.

5 From the **Available Procedures** list, transfer the procedures to be active in the simulation to the **Main Sequence** box by selecting them and clicking the left arrow button between the lists. (This creates a procedure call in the main procedure).

6 To start the simulation from procedure other than the actual **Main** procedure, click **Entry point** and set the entry point and module. By default, entry point is set to **Main** and module as **Module1**.

7 Click **Apply** to set the simulation. If you click **OK**, the simulation will be set and the dialog box will be closed.

---

**Creating simulation scenarios**

1 Click **Simulation Setup** to bring up the **Setup Simulation** dialog box.

2 From the **Simulation Scenarios** tab,
   - Click **Add** to create a new scenario in the **Scenarios** box.
   - Click **Remove** to delete the selected scenario from the **Scenarios** box.

When you create a new scenario, by default, all objects are selected in the **Scenarios** box.

3 Select a saved state for the scenario from the **Saved State** drop down.
10 Simulation tab

10.4 Event Manager

**10.4 Event Manager**

Creating an event

1. Click Event Manager.
2. Click Add to open the New Event Wizard.
3. Complete the New Event wizard to create the event.

Event manager main parts

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Task pane. Here you create new events, or copy or delete existing events selected in the Event grid.</td>
</tr>
<tr>
<td>2</td>
<td>The Event grid. Displays all events in the station. Here you select events to edit, copy or delete.</td>
</tr>
<tr>
<td>3</td>
<td>The Trigger editor. Here you edit the properties of the events trigger. The upper part of the trigger editor is the same for all triggers, and the lower part adapts to the selected trigger type.</td>
</tr>
<tr>
<td>4</td>
<td>The Action editor. Here you edit the properties of the events action. The upper part of the action editor is the same for all actions, and the lower part adapts to the selected action type.</td>
</tr>
</tbody>
</table>

The task pane parts

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Starts the Create New Event Wizard.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the event selected in the Event grid.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the event selected in the Event grid.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the Event manager.</td>
</tr>
<tr>
<td>Export</td>
<td></td>
</tr>
<tr>
<td>Import</td>
<td></td>
</tr>
</tbody>
</table>

Continues on next page
The event grid columns

In the event grid, each row is a an event and the columns in the grid display their properties:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Activation**    | Displays whether the event is active or not.  
On = The action is always carried out when the trigger event occurs.  
Off = The action is not carried out when the trigger event occurs.  
Simulation = The action is only carried out if the trigger event occurs when running a simulation. |
| **Trigger Type**  | Displays the type of condition that triggers the action.  
I/O signals changed = Changes a digital I/O signal.  
I/O Connection = Simulates the behavior of a Programmable Logic Controller (PLC).  
Collision = Starts or ends a collision or near-miss between objects in a collision set.  
Simulation time = Sets the activation time.  
*Note:* The Simulation time button is enabled once the activation is set to Simulation.  
The trigger type cannot be changed in the trigger editor. If you want another trigger type than the current one, create a completely new event. |
| **Trigger System**| When the trigger type is I/O Signal Trigger, this column displays to which system the signal used as trigger belongs.  
A dash (-) signifies a virtual signal. |
| **Trigger Name**  | The name of the signal or collision set used as trigger. |
| **Trigger Parameter** | Displays the condition of the event under which triggering occurs.  
0 = The I/O signal used as trigger switches to false.  
1 = The I/O signal used as trigger switches to true.  
Started = A collision starts within the collision set used as trigger.  
Ended = A collision ends within the collision set used as trigger.  
Near miss started = A near-miss starts within the collision set used as trigger.  
Near miss ended = A near-miss ends within the collision set used as trigger. |
### Column Description

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Type</strong></td>
<td>Displays the action type that occurs in conjunction with the trigger. I/O Signal Action = Changes the value of a digital input or output signal. Attach Object = Attaches an object to another. Detach Object = Detaches an object from another. Turn On/Off Simulation Monitor = Toggles the simulation monitor of a specific mechanism. Turn On/Off Timer = Toggles the process timer. Move Mechanism to Pose = Moves the selected mechanism to a predefined pose and thereafter sends a station signal. Activates or deactivates the process timer. Move Graphical Object = Moves a graphical object to a new position and orientation. Show/Hide Graphical Object = Shows or hides the graphical object. Do Nothing = No action occurs. Multiple = The event triggers multiple actions, either all at once or one at a time, each time the trigger is activated. Each action can be viewed in the action editor.</td>
</tr>
<tr>
<td><strong>Action System</strong></td>
<td>When the action type is Change I/O, this column displays the system to which the signal to change belongs. A dash (-) signifies a virtual signal.</td>
</tr>
<tr>
<td><strong>Action Name</strong></td>
<td>Displays the name of the signal to change, when the action type is Change I/O.</td>
</tr>
<tr>
<td><strong>Action Parameter</strong></td>
<td>Displays the condition after the action has occurred. 0 = The I/O signal will be set to false. 1 = The I/O signal will be set to true. On = Turns the process timer on. Off = Turns the process timer off. Object1 -&gt; Object2 = Displays the object to which another will be attached when the action type is Attach object. Object1 &lt;- Object2 = Displays the object from which another will be detached when the action type is Detach object. Ended = A collision ends within the collision set used as trigger. Near miss started = A near-miss starts within the collision set used as trigger. Near miss ended = A near-miss ends within the collision set used as trigger. Multiple = Signifies multiple actions.</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Displays the time when the event trigger was executed.</td>
</tr>
</tbody>
</table>

*Continues on next page*
10 Simulation tab

10.4 Event Manager

Continued

The trigger editor parts

In the trigger editor you set the properties of the trigger. The upper part of the editor is common for all types of triggers, and the lower part adapts to the trigger type at hand.

Parts common to triggers

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activation</td>
<td>Sets whether the event is active or not.</td>
</tr>
<tr>
<td></td>
<td><strong>On</strong> = The action is always carried out when the trigger event occurs.</td>
</tr>
<tr>
<td></td>
<td><strong>Off</strong> = The action is not carried out when the trigger event occurs.</td>
</tr>
<tr>
<td></td>
<td><strong>Simulation</strong> = The action is only carried out if the trigger event</td>
</tr>
<tr>
<td></td>
<td>occurs when running a simulation.</td>
</tr>
<tr>
<td>Comments</td>
<td>Text box for comments and notes about the event.</td>
</tr>
</tbody>
</table>

Parts specific to I/O signal triggers

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Controller</td>
<td>Select the system to which the I/O to use as a trigger belongs.</td>
</tr>
<tr>
<td>Signals</td>
<td>Displays all signals that can be used as triggers.</td>
</tr>
<tr>
<td>Trigger Condition</td>
<td>For digital signals, sets whether the event shall trigger when the signals are set as true or false.</td>
</tr>
<tr>
<td></td>
<td>For analog signals, which are only available for station signals, the event shall trigger under any of the following conditions: Greater than, Greater/Equal, Less than, Less/Equal, Equal to, Not equal to.</td>
</tr>
</tbody>
</table>

Parts specific to I/O connection triggers

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Opens a dialog box for adding an activator signal to the Activator Signals pane.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes a selected activator signal.</td>
</tr>
<tr>
<td>Add &gt;</td>
<td>Opens a dialog box for adding an operator symbol to the Connections pane.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes a selected operator symbol.</td>
</tr>
<tr>
<td>Delay (s)</td>
<td>Specifies the delay in seconds.</td>
</tr>
</tbody>
</table>

Parts specific to Collision triggers

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collision Type</td>
<td>Set the kind of collision to use as trigger.</td>
</tr>
<tr>
<td>Started</td>
<td>= Triggers when a collision starts.</td>
</tr>
<tr>
<td>Ended</td>
<td>= Triggers when a collision ends.</td>
</tr>
<tr>
<td>Near miss started</td>
<td>= Triggers when a near-miss starts.</td>
</tr>
<tr>
<td>Near miss ended</td>
<td>= Triggers when a near-miss ends.</td>
</tr>
<tr>
<td>Collision set</td>
<td>Select the collision set to use as trigger.</td>
</tr>
</tbody>
</table>
The action editor parts

In the action editor you set the properties of the actions for the event. The upper part of the editor is common to all types of actions, and the lower part adjusts to the selected action.

Parts common to all actions

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Action</td>
<td>Adds a new action that occurs when the triggering condition fulfills. You can add several different actions that either are performed at once or one at a time each time the event triggers. The following types of actions are available:</td>
</tr>
<tr>
<td></td>
<td>Change I/O = Changes the value of a digital input or output signal.</td>
</tr>
<tr>
<td></td>
<td>Attach object = Attaches an object to another.</td>
</tr>
<tr>
<td></td>
<td>Detach object = Detaches and object from another.</td>
</tr>
<tr>
<td></td>
<td>Turn On/Off Timer = Activates or deactivates the process timer.</td>
</tr>
<tr>
<td></td>
<td>Do Nothing = No action occurs (might be useful for manipulating sequences of actions).</td>
</tr>
<tr>
<td>Remove Action</td>
<td>Removes the action selected in the Added Actions list.</td>
</tr>
<tr>
<td>Cyclic</td>
<td>When selected, the actions are performed one at a time each time the trigger occurs. When all actions in the list have been performed, the event will restart with the first action in the list. When cleared, all actions are performed at once every time the trigger occurs.</td>
</tr>
<tr>
<td>Added Actions</td>
<td>Lists all actions of the event, in the order they will be executed.</td>
</tr>
<tr>
<td>Arrow</td>
<td>Rearranges the order in which the actions are executed.</td>
</tr>
</tbody>
</table>

Parts specific to I/O Actions

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Controller</td>
<td>Displays all systems of the station. Select the system to which the I/O to change belongs.</td>
</tr>
<tr>
<td>Signals</td>
<td>Displays all signals that can be set.</td>
</tr>
<tr>
<td>Action</td>
<td>Sets whether the event shall set the signals to true or false. If the action is connected to an I/O Connection, this group will not be available.</td>
</tr>
</tbody>
</table>

Parts specific to Attach actions

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach object</td>
<td>Select an object in the station to attach.</td>
</tr>
<tr>
<td>Attach to</td>
<td>Select the object in the station to attach to.</td>
</tr>
<tr>
<td>Update position / Keep position</td>
<td>Update position = Moves the local origin of the attached object to the attachment point of the other object when making the attachment. For mechanisms, the attachment point is the TCP or the flange; for other objects, it is the local origin. Keep position = Keeps the current position of the object to attach when making the attachment.</td>
</tr>
<tr>
<td>Flange index</td>
<td>If the mechanism you attach the object to has several flanges (attachments points), select the one to use.</td>
</tr>
</tbody>
</table>
### Parts specific to Detach actions

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detach object</td>
<td>Select an object in the station to detach.</td>
</tr>
<tr>
<td>Detach from</td>
<td>Select the object in the station to detach from.</td>
</tr>
</tbody>
</table>

### Parts specific to Turn On/Off Simulation Monitor actions

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanism</td>
<td>Selects the mechanism.</td>
</tr>
<tr>
<td>Turn Simulation Monitor On/Off</td>
<td>Sets whether the action shall start or stop the simulation monitor function.</td>
</tr>
</tbody>
</table>

### Parts specific to Turn On/Off Timer actions

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn On/Off Timer</td>
<td>Sets whether the action shall start or stop the process timer.</td>
</tr>
</tbody>
</table>

### Parts specific to Move Mechanism to Pose actions

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanism</td>
<td>Selects the mechanism.</td>
</tr>
<tr>
<td>Pose</td>
<td>Selects between SyncPose and HomePose.</td>
</tr>
<tr>
<td>Station signal to set when Pose reached</td>
<td>Lists the station signals that are sent after the mechanism reaches its pose.</td>
</tr>
<tr>
<td>Add Digital</td>
<td>Click this button to add a digital signal to the grid.</td>
</tr>
<tr>
<td>Remove</td>
<td>Click this button to remove a digital signal from the grid.</td>
</tr>
</tbody>
</table>

### Parts specific to Move Graphical Object actions

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphical Object to Move</td>
<td>Select a graphical object in the station to move.</td>
</tr>
<tr>
<td>New Position</td>
<td>Sets the new position of the object.</td>
</tr>
<tr>
<td>New Orientation</td>
<td>Sets the new orientation of the object.</td>
</tr>
</tbody>
</table>

### Parts specific to Show/Hide Graphical Object actions

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphical Object</td>
<td>Select a graphical object in the station.</td>
</tr>
<tr>
<td>Show/Hide</td>
<td>Sets whether the object is shown or hidden.</td>
</tr>
</tbody>
</table>

### Parts specific to Call VSTA Macro action

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Macros</td>
<td>Displays all available macros in the station.</td>
</tr>
</tbody>
</table>
10.5 Station Logic

Introduction to Station Logic

The Station Logic has some of the characteristics of a Smart Component. It can be used to work with these characteristics on the station level.

The Station Logic editor consists of the following tabs similar to that of a Smart Component editor:

- Compose
- Properties and Bindings
- Signals and Connections
- View

For more information on the characteristics of a Smart Component editor, see Smart Component on page 256.

Opening Station Logic

You can launch Station Logic in any of the following two ways:

- In the Simulation tab, click Reset and select Manage States.
- In the Layout browser, right-click the station and select Station Logic.

Differences between Station Logic and Smart Component

The following table lists some of the differences while working with Station Logic and a Smart Component:

<table>
<thead>
<tr>
<th>Smart Component</th>
<th>Station Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Editor window consists of a text box displaying the description of the component that is used for modifying the text.</td>
<td>The Editor window do not have the description text box wherein the description can be modified.</td>
</tr>
</tbody>
</table>
| The Compose tab has the following options:  
  - Child components  
  - Saved States  
  - Assets | The Compose tab has the following options:  
  - Child components  
  - Saved States |
| The Properties and Bindings tab has the following options:  
  - Dynamic Properties  
  - Property Bindings | The Properties and Bindings tab has the following options:  
  - Property Bindings |
| In the Signals and Connections tab, when working with Add or Edit I/O Connections, you do not have the option of selecting the VCs in the station from the the Source Object and Target Object list. | You can create connections to and from I/O signals in a VC. In the Signals and Connections tab, when working with Add or Edit I/O Connections, you have the option of selecting the VCs in the station from the the Source Object and Target Object list. |
10.6 Activate Mechanical Units

To activate or deactivate mechanical units manually

1. Click Activate Mechanical Units to bring up a dialog box.
2. In the Activate Mechanical Units dialog box, select the check boxes for the mechanical units to set as active. When activating a mechanical unit that shares a common drive unit, the other mechanical unit sharing that drive unit will be deactivated automatically.
10 Simulation tab

10.7 Simulation Control

10.7 Simulation Control

Running a simulation

1 Click Enable Process Timer to activate the process timer.
2 In the Simulation Control group,

<table>
<thead>
<tr>
<th>Click...</th>
<th>to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play/Resume</td>
<td>start and resume the simulation.</td>
</tr>
<tr>
<td></td>
<td>• The Pause button is enabled once you start the simulation.</td>
</tr>
<tr>
<td></td>
<td>• The Play button is changed to Resume once you pause the simulation.</td>
</tr>
<tr>
<td></td>
<td>• Click Resume to resume the simulation.</td>
</tr>
<tr>
<td>Play and select Record to Viewer</td>
<td>start the simulation and to record it to a Station Viewer.</td>
</tr>
<tr>
<td></td>
<td>The Save As dialog box appears where the simulation is saved.</td>
</tr>
<tr>
<td>Pause/Step</td>
<td>pause and step the simulation.</td>
</tr>
<tr>
<td></td>
<td>• The Pause button is changed to Step once you start the simulation.</td>
</tr>
<tr>
<td></td>
<td>• Click Step to run the simulation in steps.</td>
</tr>
<tr>
<td></td>
<td>You can set the simulation timestep. See Options:Simulation:Accuracy on page 199.</td>
</tr>
<tr>
<td>Reset</td>
<td>reset the simulation to its initial state. See Resetting simulation on page 330.</td>
</tr>
</tbody>
</table>

Note

The Record to Viewer option is a special recording mode that allow simulations created using Smart Components to be viewed in the Station Viewer.

Resetting simulation

1 In the Simulation Control group, click Reset to reset the simulation.
2 Click Reset and select Save Current state to store states of objects and VCs to be used in a simulation scenario. For more information, see Save Current State on page 259.
3 Click Reset and select Manage states to launch Station Logic. For more information, see Station Logic on page 328.
10.8 I/O Simulator

Setting I/O signals using the I/O Simulator

1. Click I/O Simulator. This opens the I/O simulator.
2. If the station contains several systems, select the appropriate one in the Select System list.
3. In the Filter list and I/ORange list, make selections that display the signals to set. Depending on the filter used, you might also set a filter specification.
4. To change the value of a digital I/O signal, click it.
   To change the value of an analog signal, type the new value in the value box.

The I/O Simulator window

With RobotStudio’s I/O simulator you view and manually set existing signals, groups and cross-connections during program execution, thus making it possible to simulate or manipulate the signals.

The I/O simulator displays the signals for one system at a time in groups of 16 signals. For handling large sets of signals, you can filter which signals to display and also create custom lists with favorite signals for quick access.
<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td><strong>Filter Specification</strong>. Select the filter for limiting the signal display. For example, if Board is set as filter type, then you select the board whose signals you want to view.</td>
</tr>
<tr>
<td>4</td>
<td><strong>Inputs</strong>. Displays all input signals that pass the applied filter. If more than 16 signals pass, only 16 signals at a time are displayed. Then use the I/O range list to select the signals to view.</td>
</tr>
<tr>
<td>5</td>
<td><strong>Outputs</strong> Displays all output signals that pass the applied filter. If more than 16 signals pass, only 16 signals at a time are displayed. Then use the I/O range list to select the signals to view.</td>
</tr>
<tr>
<td>6</td>
<td><strong>Edit Lists</strong>. Click this button to create or edit lists of favorite signals.</td>
</tr>
<tr>
<td>7</td>
<td><strong>I/O Range</strong>. When more than 16 signals pass the filter, use this list to select the range of signals to display.</td>
</tr>
</tbody>
</table>

### Types of signal filters

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board</td>
<td>Displays all signals on a specific board. To select a board, use the Filter Specification list.</td>
</tr>
<tr>
<td>Group</td>
<td>Displays all signals that belong to a specific group. To select a group, use the Filter Specification list.</td>
</tr>
<tr>
<td>User List</td>
<td>Displays all signals in a favorite list. To select a list, use the Filter Specification list.</td>
</tr>
<tr>
<td>Digital Inputs</td>
<td>Displays all digital input signals of the system.</td>
</tr>
<tr>
<td>Digital Outputs</td>
<td>Displays all digital output signals of the system.</td>
</tr>
<tr>
<td>Analog Inputs</td>
<td>Displays all analog input signals of the system.</td>
</tr>
<tr>
<td>Analog Outputs</td>
<td>Displays all analog output signals of the system.</td>
</tr>
</tbody>
</table>

### Signal icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="value 1" /></td>
<td>Digital signal with value 1.</td>
</tr>
<tr>
<td><img src="image" alt="value zero" /></td>
<td>Digital signal with value 0.</td>
</tr>
<tr>
<td><img src="image" alt="cross connect" /></td>
<td>The cross in the upper right corner indicates that the signals are a cross-connection.</td>
</tr>
<tr>
<td><img src="image" alt="inverted" /></td>
<td>The -1 in the upper right corner indicates that the signal is inverted.</td>
</tr>
<tr>
<td><img src="image" alt="value box" /></td>
<td>Value box for groups or analog signals.</td>
</tr>
</tbody>
</table>
### 10.9 Monitor

#### The TCP Trace tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable TCP Trace</td>
<td>Select this check box to activate tracing of the TCP path for the selected robot.</td>
</tr>
<tr>
<td>Trace length</td>
<td>Specify the maximum length of the trace in millimeters.</td>
</tr>
<tr>
<td>Trace Color</td>
<td>Displays the color of the trace when no alerts are activated. To change the color of the trace, click the colored box.</td>
</tr>
<tr>
<td>Alert color</td>
<td>Displays the color of the trace when any of the alerts defined on the Alerts tab exceeds a threshold value. To change the color of the trace, click the colored box.</td>
</tr>
<tr>
<td>Clear Trace</td>
<td>Click this button to remove the current trace from the graphics window.</td>
</tr>
</tbody>
</table>

#### The Alerts tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Simulation Alerts</td>
<td>Select this check box to activate simulation alerts for the selected robot.</td>
</tr>
<tr>
<td>Log Alerts to Output Window</td>
<td>Select this check box to see a warning message when a threshold value is exceeded. If TCP trace is not enabled, this is the only display of the alert.</td>
</tr>
<tr>
<td>TCP Speed</td>
<td>Specify the threshold value for TCP speed alerts.</td>
</tr>
<tr>
<td>TCP Acceleration</td>
<td>Specify the threshold value for TCP acceleration alerts.</td>
</tr>
<tr>
<td>Wrist Singularity</td>
<td>Specify how close joint five can be to zero rotation before alerting.</td>
</tr>
<tr>
<td>Joint Limits</td>
<td>Specify how close each joint can be to its limits before alerting.</td>
</tr>
</tbody>
</table>
Stopwatch for measuring process time
The Stopwatch feature is used for measuring the time taken between two trigger points in a process, and also for the process as a whole. The two trigger points are called the Start Trigger and the End Trigger.

When a stopwatch is setup, the timer starts when the Start Trigger occurs, and stops when the End Trigger occurs.

Setting up a Stopwatch
1 On the Simulation tab, in the Monitor group, click Stopwatch. The Stopwatch settings dialog appears.
2 Specify a Name for the stopwatch.
3 Select a Start Trigger and an End Trigger for the stopwatch.
   The following parameters are listed for selection as triggers:
   • Simulation Start
   • Simulation Stop
   • Target Changed
     Additionally, specify the mechanical Unit and the target.
   • I/O Value
     Additionally, specify the source mechanical unit from where the signal comes, the type of I/O signal and the value of the signal.
4 Click Add.
10.11 Signal Analyzer

10.11.1 Signal Analyzer for both real and virtual controllers

The Signal Analyzer functionality helps in displaying and analyzing signals from a robot controller. Using the Signal Analyzer, you can optimize the robot program. The Signal Analyzer functionality is present for both virtual and real controllers. The following section describes the Signal Analyzer functionality for virtual controllers, though it includes certain common features.
10 Simulation tab

10.11.2 Signal Setup

10.11.2 Signal Setup

Overview

This feature allows you to configure the signals to be saved for the next simulation. The signals are recorded from the controller information stream and are stored in the station.

Layout of Signal Setup

The Signal Setup window displays all the signals available for recording. It also displays the signals selected for recording.

The Signal Setup window has the following options:

- Select Signals view
- Current Setup view
- Refresh

Select Signals view

Displays all the available source signals. By default, the source tree is expanded. In the source tree, you can select the check-box and add the signal to the Current Setup view.

The signals are organized in a hierarchical tree structure. You can expand or collapse the nodes (except the signal nodes which are at the lowest level) either from the context menu or double-click the node.

Current Setup view

Displays all the selected signals.

To remove a signal, Right-click the signal and select Delete.

Refresh

The Signal Setup window, by default, will be updated automatically, if a signal is added or removed. However, in some cases, a manual refresh may be needed.

In the Signal Setup window, click Refresh to ensure all signals are displayed in the window.

Available signals

The following tables show the signals that are available for setting up. You can subscribe to a maximum of 12 signals simultaneously.

<table>
<thead>
<tr>
<th>Category</th>
<th>Available signals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller Signals</td>
<td>Total Motor Power (only for Virtual Controller). See the description provided after this table.</td>
</tr>
<tr>
<td></td>
<td>Total Power Consumption (only for Virtual Controller). See the description provided after this table.</td>
</tr>
<tr>
<td>EventLog</td>
<td>All domains</td>
</tr>
<tr>
<td>I/O System</td>
<td>All signals</td>
</tr>
</tbody>
</table>
### Category | Available signals
--- | ---
Joint | J1–J6
    | Near Limit. See the description provided after this table.
Target | Fine Point
    | Target Changed
TCP | Maximum Linear Acceleration in World
    | Orientation Q1–Q4 Current Workobject
    | Orientation Speed in Current Workobject
    | Pos X, Y, Z in Current Workobject
    | Robot Configuration cf1, cf4, cf6, cfX
    | Speed in Current Workobject
Smart Components | All signals

**Total Motor Power**

The signal Total Motor Power shows the sum of the instantaneous power for each joint. It may be positive or negative.

The instantaneous power for a specific joint is positive when it accelerates and negative when it decelerates. If one joint is accelerating at the same time as another is decelerating, then the negative energy from the decelerating joint is reused for the accelerating joint. If the sum of the instantaneous power of all joints is negative then the power surplus cannot be reused but is burned off in the bleeder.

**Total Power Consumption**

The signal Total Power Consumption is the integral of the positive part of the Total Motor Power, plus the estimated power consumption of the controller cabinet.

**Near Limit**

Near Limit checks the distance to the closest limit for each joint. If any joint is less than 20 degrees from a limit, the Near Limit signal will show the current value. Otherwise, the value of the signal will be constant at 20 degrees. If more than one joint is below 20 degrees from a limit, then the one that is closest will be looked at.

### Setting up the signals

Use this procedure to configure the signals to be saved for the next simulation:

1. Load a station with system. See *New on page 188*.
2. In the Simulation tab, click Signal Analyzer and select Signal Setup.
   The Signal Setup window appears.
3. In the Select Signals view, select the signals to be configured and stored for simulation.
   The selected signals are added in the Current Setup window.
4. In the Current Setup view, right-click Station Database and select Enabled.

*Continues on next page*
This ensures that all selected signals will be recorded whenever a simulation is running.

**Note**

- Disabling the station database will stop the recording but stores the configuration and all completed recordings in the station.

**Note**

- You can analyze the recorded signals. See *Layout and usage on page* 339.
- You can organize the saved signal data. See *History on page* 342.
- Disable signal recording as soon as the analysis is completed to avoid the station file size to increase.

**Note**

It is not possible to subscribe to signals connected to a unit of type LOCAL_GENERIC. Attempting to do so produces this error message in the Output window:

Failed to subscribe on signal: ...
10.11.3 Layout and usage

Layout of Signal Analyzer

The following figure shows the layout of the Signal Analyzer.

![Signal Analyzer Layout](image)

1. Toolbar: Displays a toolbar with options to configure and to work with the Signal Analyzer.
2. Digital signal values: Displays a colored bar representing a segment where the signal is set.
3. Analog signal values: Displays analog and numeric signal values.
4. Events: Displays discrete events, such as EventLog messages.
5. Signals table: Displays information about all recorded signals for the current data session.

**Toolbar**

The toolbar displays the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop-down list</td>
<td>For selecting the signal recording to be displayed. These signals are also available in Signal History. See History on page 342.</td>
</tr>
<tr>
<td>Timer slider</td>
<td>For moving the time forward and backward.</td>
</tr>
<tr>
<td>Zoom in/out buttons</td>
<td>For zooming in / out the time axis.</td>
</tr>
<tr>
<td>Live data button</td>
<td>For enabling data to be shown live, that is, as recorded during a simulation.</td>
</tr>
<tr>
<td>Crosshair button</td>
<td>For displaying the crosshairs following the mouse.</td>
</tr>
<tr>
<td>Auto scale button</td>
<td>For enabling / disabling vertical axis autoscaling.</td>
</tr>
<tr>
<td>Line marker button</td>
<td>For displaying the line markers for each sample in the analog / numeric graph.</td>
</tr>
<tr>
<td>Save button</td>
<td>For exporting the data to a file. The data can be saved in Microsoft Excel 2007 format and tab delimited text format.</td>
</tr>
</tbody>
</table>

*Continues on next page*
Digital signal values

It displays one row per digital signal, showing the signal state over time. A solid colored bar indicates the signal is set (value=1), otherwise the signal is cleared (value=0). The signal name is displayed to the left.

Move the mouse over the colored bars to view additional information like the time stamps when the signal was set and reset.

Analog signal values

It displays a 2D line graph for each analog signal. It consists of the following:

- Left-side vertical axis
- Horizontal axis displaying time in seconds
- Plot area displaying the signal graphs
- Optional right-side vertical axis.

You can configure the individual signals to use the right-side vertical axis scale from the signals table at the bottom of the window. This axis is hidden by default.

The following actions can be performed in this segment:

- Scale the vertical axes: If you select the autoscale button in the toolbar, then the vertical axes will automatically scale to ensure that the line graphs are visible. You can modify the vertical scale using the mouse if the cursor is over the axis value area. This automatically deselects the autoscale button.
- Pan and Zoom time axis: If the cursor is over the central, main area of the plot, then you can scale, pan, and zoom the time axis using the mouse.

Events

It displays one row per selected event category. Each event is indicated with a diamond shaped icon. Click this icon to display a popup with more information about the event.

Signals table

Displays information about each recorded signal. This enables you to configure settings for each signal such as color, visibility, whether to use left or right vertical axis and so on.

Using the Signal Analyzer

Use this procedure to analyze the recorded signal data:

1. Set up the signals to be analyzed. See Setting up the signals on page 337.
2. Record signal data by running a simulation. See Setting up the signals on page 337.
3. In the Simulation tab, click Signal Analyzer.
The Signal Analyzer window appears.

Note

- If the station does not contain any saved signal data, you will then have to setup the signals to analyze and record by running a simulation. See *Signal Setup on page 336*.
- You can organize the saved signal data. See *History on page 342*.
10 Simulation tab

10.11.4 History

Overview

This feature displays and helps in organizing saved signal recordings of the current RobotStudio station.

Layout of Signal History

You can do the following from the Signal History window:

- Click the column header to sort the history in ascending or descending order.
- Click the drop-down to group the history as View By Today or View by Order.

Organizing the Signal History

Use this procedure to organize the signal history:

1. Create a saved signal data in the station. See Setting up the signals on page 337.
2. In the Simulation tab, click Signal Analyzer and select History. The Signal History window with all the stored signal history elements are displayed.

   Note

   The signal history elements in the Signal History window is updated automatically whenever the signals are setup and the simulation is started / stopped.

3. In the Signal History window, right-click a history element and select:
   - Analyze: To open the Signal Analyzer window.
   - Export: To save selected history elements to a file.
   - Delete: To remove the selected signal recording permanently.
   - Rename: To rename the signal recording.

   Note

   Disable signal recording as soon as the analysis is completed to avoid the station file size to increase.
10.12 Record Movie

Prerequisites
For optimal results, first configure the options, see Options:General:Screen Recorder on page 194.

Recording the screen
1. In the Record Movie group, click Record application to capture the entire application window, or Record graphics to capture just the graphics window.
2. When you are done, click Stop Recording. A dialog box appears in which you may choose to save the recording or discard it.
3. Click View Recording to playback the latest capture.

Recording the simulation
1. In the Record Movie group, click Record Simulation to record the next simulation to a video clip.
2. When you are done, click Stop Recording.
   The simulation is saved in a default location which is displayed in the output window.
3. Click View Recording to playback the recording.
   The recording of simulation starts when you click Play in the Simulation tab.

Note
Record Simulation gives better output quality than Record application or Record graphics.
10.13 Conveyor Tracking Mechanism

10.13.1 Conveyor Tracking

Overview

Conveyor tracking is the function where the robot follows a workobject mounted on a moving conveyor.

This section describes *how to create a conveyor, add and remove objects to and from the conveyor, create targets during tracking, and simulate conveyor.*

For more information, see the *Application manual - Conveyor tracking.*

Conveyor tracking mechanism

This procedure describes the workflow for making a conveyor tracking system work in RobotStudio.

1. Create a conveyor mechanism. See *Create Conveyor mechanism on page 308.*
2. Setup the conveyor. See *Setting up a conveyor on page 205* and *Encoder Unit on page 398.*
   
   For information on setting up a conveyor tracking station with two robots working on the same conveyor, see *Conveyor tracking station with two robots on page 77.*
3. Jog the conveyor as well as the robot and teach some targets. See *Mechanism Joint Jog on page 457.*
4. Simulate the conveyor. See *Conveyor Simulation on page 345.*
5. Remove objects from conveyor. See *Removing objects from conveyor on page 206.*
10.13.2 Conveyor Simulation

Running a conveyor simulation

1. Create Action Instructions. See *Action Instruction on page 235*.

   Create the following five action instructions along with Move instructions:
   ConfL\Off, ActUnit CNV1, WaitWObj Workobject_1, DropWObj Workobject_1, and DeactUnit CNV1.

   The following program is an example showing how the sequence of instructions appears:

   ![Diagram](image)

   action_i

   **Note**

   If an error occurs while executing the program, the controller reaches Guard state. In this state, RobotStudio cannot execute the program during the next simulation. To recover from this state, open the Control Panel and switch to Manual Mod and then to Auto Mode.

   For more information, see *Application manual - Conveyor Tracking*.

2. Synchronize to VC. See *Synchronize to VC on page 401*.

3. Set up the Simulation. See *Simulation Setup on page 319*.

4. Click Simulation.

   The Conveyor Simulation dialog appears.

5. In the Conveyor Speed box, set the speed during simulation.

   To move the conveyor in the backward direction, select the Reverse check box.

*Continues on next page*
10 Simulation tab

10.13.2 Conveyor Simulation

Continued

6 Click Apply.
7 Click Play to run the simulation.

Note

The conveyor speed and direction can be changed while running the simulation. To jump the conveyor back to the start position, click Reset. This button remains enabled as long as the station has at least one conveyor.
11 Controller tab

11.1 Real and virtual controllers

The Controller tab contains the controls for managing the real controller and also the controls for synchronization, configuration and tasks assigned to the virtual controller.

RobotStudio allows you to work with an off-line controller, which is a virtual IRC5 controller running locally on your PC. This offline controller is also referred to as the virtual controller (VC). RobotStudio also allows you to work with the real physical IRC5 controller, which is simply referred to as the real controller.

The features on the Controller tab can be categorized as follows:

- Features for both virtual and real controllers
- Features for real controllers
- Features for virtual controllers

For more information on working with a real controller, see Working online on page 149.
11 Controller tab

11.2 Features for both virtual and real controllers

11.2.1 Add Controller

Adding and connecting to a controller

You can connect to real or virtual controller using the **Add Controller** button. To connect to a real controller, on the **Controller** tab click the arrow next to the **Add Controller** icon, and then click one of the following commands as per your requirement:

- One Click Connect - For connecting to the service port of the controller
- Add Controller - For adding available controllers to the network

**Note**

For connecting RobotStudio to a real controller over the Ethernet (LAN), the controller system must have the RobotWare option **PC-interface**. This option is not required when connecting through the service port.

To start and connect to a virtual controller, on the **Controller** tab click the arrow next to the **Add Controller** icon, and then click **Start Virtual Controller**.

**One Click Connect**

The One Click Connect feature allows connecting to a robot controller, that is connected to the service port, in a single step. You need to do the following before using this feature:

- Connect the computer to the controller service port.
- Ensure that the network settings on the PC is correct. DHCP should either be enabled or the IP address should have a specific value. For more information on network settings, see **Network settings on page 151**.

On the **Controller** tab, click the arrow next to the **Add Controller** icon, and then click **One Click Connect**.

**Add Controller**

1. In the **Controller** tab, click **Add Controller** to bring up a dialog box in which all available controllers are listed.
2. If the controller is not found in the list, type its IP address in the **IP Address** box, and then click **Refresh**.
3. Select the controller in the list and click **OK**.
The `StartVirtualController` command allows you to start and stop a virtual controller, using a given system path and without needing a station.

**Tip**

You can use the `StartVirtualController` command when you require a virtual controller as emulator while developing PC SDK or RobotWare Additional Options. You can also use this command when you need to use the Configuration editor or the RAPID editor without requiring a station.

Clicking `StartVirtualController` under `Add Controller` opens the `Start Virtual Controller` dialog box. In this dialog box, specify the following:

1. In the `System Pool` drop-down list specify the location and folder of your PC where the required virtual controller system are stored.
   
   To add a folder to this list, click `Add` and then browse to and select the folder to be added. To remove a folder from the list, click `Remove`.

2. The `Systems Found` table lists the virtual controller systems found in the selected system folder. Click a system to select to select it for starting.

3. Select the required check boxes:
   - I-Start, to start the VC with the current system and the default settings
   - Local login
   - Handle Write Access automatically
11 Controller tab

11.2.2 Events

Events log

To view the events log of the controller, on the Controller tab in the Controller Tools group, click Events. This opens the Event log. The severity of each event is indicated by its background color; blue for information, yellow for warning and red for an error which needs to be corrected in order to proceed.

You can perform the following operations on the Event log.

- Click any event to view a brief description about the event.
- The Auto Update check box is selected by default, so that new events appear in the list as they occur.
  
  Clearing the check box to disable automatic update. Selecting it again, fetches and displays the events missed while it was cleared.
- You can filter the event log list based on the category of the event or based on any text in its displayed details.
  
  To filter the list based on any required text, specify it in the Text box.
  
  To filter based on the events categories, use the Category drop-down list. The list contains the following different event categories.
  - Common (the default category, includes all categories)
  - Operational
  - System
  - Hardware
  - Program
  - Motion
  - IO & Communication
  - User
  - Internal
  - Process
  - Configuration
  - RAPID
- To clear the current event record, click Clear. This does not affect the event log of the controller, which can be retrieved again by clicking the Get button.
- To retrieve and display all events currently stored in the controller, click Get
- To save the event records of the selected event categories to log files on the computer, click Save.
- To enables all events currently in the Common Event Log to be saved to a log file on the computer, select the Log to file check box.
  
  The log file will be updated with all new events as they occur.
11.2.3 Inputs / Outputs

I/O System

You can view and set input and output signals in the I/O System window. To open this window, on the Controller tab, in the Controller Tools group, click Inputs/Outputs.

The following details of I/O signals are available in the I/O System window:

- **The Name column**
  This column shows the name of the signal. The name is set by the I/O unit’s configuration and cannot be changed from the I/O system.

- **The Type column**
  This column shows which type of signal it is, by using any of the abbreviations described below. The signal type is set by the I/O unit’s configuration and cannot be changed from the I/O system.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DI</td>
<td>Digital input signal</td>
</tr>
<tr>
<td>DO</td>
<td>Digital output signal</td>
</tr>
<tr>
<td>AI</td>
<td>Analog input signal</td>
</tr>
<tr>
<td>AO</td>
<td>Analog output signal</td>
</tr>
<tr>
<td>GI</td>
<td>Group of signals, working as one input signal</td>
</tr>
<tr>
<td>GO</td>
<td>Group of signals, working as one output signal</td>
</tr>
</tbody>
</table>

- **The Value column**
  This column shows the value of the signal. The value can be changed by double-clicking the signal row.

- **The Min Value column**
  This column displays the minimum value that the signal can have.

- **The Max Value column**
  This column displays the maximum value that the signal can have.

- **The Logical State column**
  This column shows whether the signal is simulated or not. When a signal is simulated, you specify a value that overrides the actual signal. Changing the logical state by turning the simulation on or off can be done from the I/O system.

- **The Unit column**
  This column shows to which I/O unit the signal belongs. This is set by the I/O unit’s configuration and cannot be changed from the I/O system.

- **The Bus column**
  This column shows to which I/O bus the signal belongs. This is set by the I/O bus’ configuration and cannot be changed from the I/O system.

- **The Label column**

*Continues on next page*
This column displays the Signal Identification Label as defined in the I/O Configuration database.

You can filter the I/O system window to view only a subset of all signals. You can filter the view using the following parameters:

- **Name and Label** - Use the free-text edit boxes above these columns. The resulting view will show signals that contain the entered text string in the respective field.
- **Simulated** - Select this check box to view simulated signals only
- **Unit, Bus, and Category** - Use the drop-down list boxes above each column to select the required option for the respective parameter. The resulting view will show only those signals that have the selected option.
- **Clear filter** - Click this button to reset the view, and show all signals again.
11.2.4 ScreenMaker

Overview

ScreenMaker is a tool in RobotStudio for creating customized FlexPendant user interfaces without the need to learn Visual Studio development environment and .NET programming.

For more information on ScreenMaker, see ScreenMaker tab on page 491.

Prerequisites

Note

ScreenMaker is not available in RobotStudio 5.15 64-bit edition.

To use ScreenMaker, you should have:

• RobotStudio with Premium license.
• RobotWare FlexPendant Interface option enabled. See Testing on Virtual controller/Real controller on page 353.
• Microsoft .NET Compact Framework 2.0 installed.

For more information on the system requirements, hardware requirements, and the supported Operating Systems, see RobotStudio Release Notes.

Testing on Virtual controller/Real controller

RobotWare FlexPendant Interface option is required for ScreenMaker applications.

NOTE! RobotWare PC Interface option is required only when using ScreenMaker for Robots on a LAN (to get the data from the controller, bind, and deploy). If there is no PC Interface option, service port can be used to design and deploy screens.
11 Controller tab
11.2.4 ScreenMaker

Continued

Launching ScreenMaker

You can launch ScreenMaker either from the Controller tab.

1 In the Controller tab, click the arrow next to the FlexPendant icon.
2 Click ScreenMaker.

ScreenMaker is launched as a new tab.
The connection to all connected virtual and real controllers can be established.

Note

For more information, see Managing ScreenMaker projects on page 504.
11.2.5 Restart a controller

When to restart a controller

Some operations require a restart of the controller to take effect. When working in RobotStudio, you will be notified when a restart is necessary.

Warm restart

Typically, you need to make an ordinary warm restart of a controller when:

• You have changed the baseframe of any of the robots belonging to that controller.
• You have changed the robot's configuration, either with the Configuration Editor or by loading new configuration files.
• You have added new options or hardware to the system.
• A system failure has occurred.

Advanced restart options

The controller can be restarted with the following advanced restart options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I-Start</td>
<td>Restarts the controller with the current system and the default settings. This restart discards the changes made to the robot's configuration. It reverts the current system to the state it had when it was installed on the controller (an empty system). This restart deletes all RAPID programs, data and custom configurations that have been added to the system.</td>
</tr>
<tr>
<td>P-Start</td>
<td>Restarts the controller with the current system and reinstall RAPID. This restart deletes all RAPID program modules. It can be useful if the system has changed in such a way that the programs no longer are valid, for instance if system parameters used by the program are changed.</td>
</tr>
<tr>
<td>X-Start</td>
<td>This restart applies only to real controllers. This restart saves the current system, with the current settings, and starts the boot application on the FlexPendant from which you can choose a new system to start with. You can also configure the controller's network settings from the boot application.</td>
</tr>
<tr>
<td>C-Start</td>
<td>This restart applies only to real controllers. This restart deletes the current system and starts the boot application on the FlexPendant from which you can choose a new system to start with. You can also configure the controller's network settings from the boot application.</td>
</tr>
<tr>
<td>B-Start</td>
<td>This restart applies only to real controllers. Restarts the controller with the current system and the last known good settings. This restart restores changes made to the robot's configuration to a previously good state.</td>
</tr>
</tbody>
</table>

Restarting a virtual controller

1 In the Controller browser, select the controller to restart.

Continues on next page
2 In the **Controller Tools** group, click the arrow next to the **Restart** icon, and then select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Warmstart** | Restarts the VC and activates the changes made to the system.  
This is the default option if you directly click **Restart**. |
| **I-start** | Restarts the VC with the current system and the default settings. |
| **P-start** | Restarts the VC with the current system and reinstalls RAPID. |

The options for **Restart** are also present in the context menu when you right-click a controller in the **Controller** browser.

### Restarting a real controller

The following are the prerequisites for restarting a real controller:

- You must have Write access to the controller you are restarting.
- For the advanced restart methods X-start and C-start, you must have access to the controller’s FlexPendant.

To restart a real controller:

1. In the **Controller** browser, select the controller to restart.
2. In the **Controller Tools** group, click the arrow next to the **Restart** icon, and then select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Warmstart</strong></td>
<td>Restarts the real controller and activates the changes made to the system.</td>
</tr>
</tbody>
</table>
| **Advanced** | The controller can be restarted with the following advanced restart options:  
- **I-start**  
- **P-start**  
- **X-start** (FlexPendant required)  
- **C-start** (FlexPendant required)  
- **B-start** |

The options for **Restart** are also present in the context menu when you right-click a controller in the **Controller** browser.
11.2.6 Back up a system

Overview

When backing up a system you copy all the data needed to restore the system to its current state:

- Information about software and options installed on the system.
- System's home directory and all its content.
- All robot programs and modules in the system.
- All configuration and calibration data of the system.

Prerequisites

To backup a system you must have:

- Write access to the controller
- Logged on to the controller with appropriate grants. For more information, see User Authorization on page 154.

Creating a Backup

To create a backup, follow these steps:

1. In the Controller browser, select the system you want to backup from the browser.
2. Click Backup and select Create Backup.
   The Create Backup dialog box appears.
3. Enter a new backup name and specify a location for the backup, or keep the default ones.
4. Click Backup.
   The progress of the backup is displayed in the Output window.

Backup folder

When the backup is complete you will have a folder with the name of the backup in the specified location. This folder contains a set of subfolders which together comprise the backup.

⚠️ CAUTION

If the contents of the Backup folder are changed, then it will not be possible to restore the system from backup.

<table>
<thead>
<tr>
<th>Subfolders</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backinfo</td>
<td>Contains information necessary for re-creating the system's software and options from the mediapool.</td>
</tr>
<tr>
<td>Home</td>
<td>Contains a copy of the system's home directory content.</td>
</tr>
<tr>
<td>Rapid</td>
<td>Contains one subfolder for each task in the system's program memory. Each of these task folders contains separate folders for program modules and system modules.</td>
</tr>
<tr>
<td>Syspar</td>
<td>Contains the system's configuration files.</td>
</tr>
</tbody>
</table>
11 Controller tab

11.2.6 Back up a system

Continued

Note

The contents of the PIB board of a IRC5P system (a controller system for painting) will not be included with the regular RobotStudio backup. Please use the backup function of the FlexPaintPendant to include the PIB content.
11.2.7 Restore a system

Overview

When restoring a system from backup, the current system gets the same content as when the backup was performed. Restoring a system replaces the following contents in the current system with the content from the backup:

- All RAPID programs and modules in the system.
- All configuration and calibration data of the system.

Note

The system’s home directory and all its content are copied from the backup to the current system.

Prerequisites

To restore a system you must have:

- Write access to the controller.
- Logged on to the controller with appropriate grants. For more information, see User Authorization on page 154.

Restoring a system

Note

Before proceeding, make sure that the system from the backup is compatible with the controller you are restoring.

To restore a system, follow these steps:

1. In the Controller browser, select the system you want to restore.
2. Click Backup and select Restore Backup.
   The Restore from Backup dialog box appears.
3. In the Restore from Backup dialog box, select which backup to use for restoring the system.
4. Click Restore.
   The progress of the restore appears in the Output window. The controller is automatically restarted to load the restored system.
   If the system from the backup does not originate from the controller you are restoring, you get the following message about the mismatch.

![Message dialog box]

en0900001061
11.2.8 System Builder

Functions of the System Builder

For procedures using the various functions of the System Builder, see System Builder Overview on page 156.
11.2.9 Configuration editor

From the Configuration Editor you view and edit the system parameters of a specific topic in a controller. The Instance Editor is a complementary editor with which you edit the details of a type instance (a row in the Configuration Editor's instance list). The Configuration Editor has a direct communication with the controller. This means that changes you make are applied to the controller as soon as you complete the command.

With the Configuration Editor, including the Instance Editor, you can:
- view types, instances, and parameters
- edit instances and parameters
- copy and paste instances within a topic
- add and delete instances

Layout of the Configuration Editor

The Configuration Editor consists of the Type name list and the Instance list.

The Type name list displays all available configuration types for the selected topic. The list of types is static. This means you cannot add, delete or rename types.

The Instance list displays all system parameters of the type selected in the Type name list. Each row in the list is an instance of the system parameter type. The columns show each specific parameter and its value for each instance of the parameter type.

The Configuration editor has the following options:
- Controller
- I/O
- Communication
- Motion
- Man-machine communication
- Add Signals

Add Signals

You must have write access to the controller to be able to open the add signal window.

<table>
<thead>
<tr>
<th>Type of Signal</th>
<th>Defines the type of signal.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Base Name</td>
<td>Defines the name for one or more signals.</td>
</tr>
<tr>
<td>Assigned to Unit</td>
<td>Defines the I/O unit to which the signal belongs.</td>
</tr>
<tr>
<td>Signal Identification Label</td>
<td>Optionally, offers filtering and sorting based on this category.</td>
</tr>
<tr>
<td>Number of Signals</td>
<td>Defines the number of signals to add in a range</td>
</tr>
<tr>
<td>Start Index</td>
<td>Defines the index (number) to start the range with.</td>
</tr>
<tr>
<td>Step</td>
<td>Defines the number which the index should increase with.</td>
</tr>
<tr>
<td>Unit Mapping Start</td>
<td>Defines the bits in the I/O memory map of the assigned unit to which the signal is mapped.</td>
</tr>
</tbody>
</table>

Continues on next page
### 11 Controller tab

### 11.2.9 Configuration editor

*Continued*

<table>
<thead>
<tr>
<th>Category</th>
<th>Optionally, offer filtering and sorting based on this category.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Level</td>
<td>Defines the write access to I/O signals for categories of I/O controlling clients connected to the robot controller.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Specifies the I/O signal value to be used at the start.</td>
</tr>
<tr>
<td>Value at System and Power Failure</td>
<td>Specifies whether the output I/O signal should keep its current value or take the I/O signal's default value in case of system failure or at a power fail.</td>
</tr>
<tr>
<td>Store Value at Power Failure</td>
<td>Specifies if the I/O signal should be set to the value stored in the permanent memory pool or not at the start.</td>
</tr>
<tr>
<td>Invert Physical Value</td>
<td>Applies an inversion between the physical value of the signal and its logical representation in the system.</td>
</tr>
</tbody>
</table>

**Layout of the Instance editor**

The Instance Editor lists the parameters and their values in the open instance. In the Value column you can view and edit the value of the parameter. When you click a row, the lower section of the Instance Editor window displays the type of parameter, restrictions for the parameter value and other conditions for the parameter.
11.2.10 Load Parameters

Prerequisite

You must have write access to the controller.

Loading a configuration file

1. In the Controller browser, select the system and expand the Configuration node.
2. Click Load Parameters to bring up a dialog box.
3. In the dialog box, select how you want to combine the parameters in the configuration file to load with the existing parameters:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>replace the entire configuration of the topic with the one in the configuration file.</td>
<td>Delete existing parameters before loading</td>
</tr>
<tr>
<td>add new parameters from the configuration file to the topic, without modifying the existing ones.</td>
<td>Load parameters if no duplicates</td>
</tr>
<tr>
<td>add new parameters from the configuration file to the topic and update the existing ones with values from the configuration file. Parameters that only exist in the controller and not in the configuration file will not be changed at all.</td>
<td>Load parameters and replace duplicates</td>
</tr>
</tbody>
</table>
4. Click Open and browse to the configuration file to load. Then click Open again.
5. In the information box, click OK to confirm that you want to load the parameters from the configuration file.
6. When the loading of the configuration file is finished, close the Select mode dialog box.
   If a restart of the controller is necessary for the new parameters to take affect, you will be notified of this.
11 Controller tab

11.2.11 Save Parameters

Overview
The system parameters of a configuration topic can be saved to a configuration file, stored on the PC or any of its network drives. The configuration files can then be loaded into a controller. They are thereby useful as backups, or for transferring configurations from one controller to another.

File-naming conventions
The configuration files should be named with a name that relates to their corresponding topics. When saving configuration files, the correct name for each file will be suggested by default.

Saving a configuration file
1. In the Controller browser, select the system and expand the Configuration node.
2. Click Save Parameters and select the topic to save to a file and click Save.
3. In the Save As dialog box, browse for the folder to save the file in.
4. Click Save.

Saving several configuration files
1. Select the Configuration node.
2. Click Save System Parameters.
3. In the Save System Parameters dialog box, select the topics to save to files. Then click Save.
4. In the Browse for Folder dialog box, browse for the folder to save the files in.
   Then click OK.
   The selected topics will now be saved as configuration files with default names in the specified folder.
11.2.12 Transfer

Overview

The transfer function allows easy transfer of offline-created RAPID programs to the real robot on the shop floor. This means that you can transfer data from a virtual controller (which is offline) to a real controller (which is online). As part of the transfer function you can also compare the data present in the virtual controller with that present in the real controller and then select which data to transfer.

You can also use the transfer function to transfer data from a virtual controller to another virtual controller.

Relations for transfer of data

To transfer data, you must first set up a Relation between the two controllers. A Relation defines the rules for the transfer of data between the two controllers.

Creating a Relation

When you have two controllers listed in the Controller browser, you can create a Relation between them. To create a Relation:

1. On the Controller tab, in the Transfer group, click Create Relation. The Create Relation dialog box is displayed.
2. Enter a Relation Name for the relation.
3. Specify the First Controller, from the list. This must be a virtual controller. The First Controller, also called the Source, owns the data being transferred.
4. Specify the Second Controller, from the list. This can either be a real controller or another virtual controller. The Second Controller, also called the Target, receives the data being transferred.
5. Click Ok.

The relation between the controllers is now created.

After this, the Relation dialog box opens, using which you can configure and execute the transfer. Relations of a controller are listed under its Relations node in the Controller browser.

Note

The properties of the relation are saved in a XML file under INTERNAL in the owner controller’s system folder.

Transferring data

You can configure the details of the transfer of data and also execute the transfer, in the Relation dialog box.

Continues on next page
Configuring the transfer

Before executing a transfer, you can configure the data to be transferred, under the **Transfer Configuration** heading. Configure using these guidelines:

- Use the check boxes in the **Included** column to include or exclude the corresponding items shown in the tree structure. All items in a module that are included will be transferred. Other non-listed items of a module such as comments, records and so on will be automatically included in the transfer.

- The **Action** column shows a preview of the transfer’s result, based on the items you include or exclude.

- If a module exists both in the source and the target controllers, and the **Action** column shows **Update**, then click **Compare** in the Analyze column. This opens the **Compare** box which shows two versions of the module in different panes. The affected lines are highlighted and you can also step through the changes. You can choose one of the following options for the comparison:
  - **Source with target** - Compares the source module with the target module
  - **Source with result** - Compares the source module with the module that will be the result of the transfer operation

- **BASE** (module), wobjdata and tooldata are excluded by default.

- wobjdata wobj0, tooldata tool0, and loaddata load0 of the BASE module are unavailable for inclusion.

A task can be transferred only if:

- Write access to the target controller is present (must be manually retrieved).
- Tasks are not running.
- Program execution is in the stopped state.

Executing the transfer

After you have configured the transfer, you can execute it.

Under the **Transfer** heading, the Source and Target modules are shown along with the arrow showing the direction of the transfer. You can change the direction of the transfer by clicking **Change Direction**. This also switches the source and target modules.

To execute the transfer click **Transfer now**. A dialog showing a summary of the transfer appears. Click **Yes** to complete the transfer. The result of the transfer is displayed for each module in the output window.

The **Transfer now** button is disabled if:

- None of the included tasks can be transferred.
- Write access is required but not held.
Note

If one of several modules fail, then the following error message is displayed.

Module xxx.zzz has failed. Do you want to continue?
11 Controller tab

11.2.13 Signal Analyzer

Analyzing signals from the controller

The Signal Analyzer functionality helps in displaying and analyzing signals from a robot controller. Using the Signal Analyzer, you can optimize the robot program.

The Signal Analyzer functionality is present for both virtual and real controllers. The following section describes the Signal Analyzer functionality for real controllers.

For information on the Signal Analyzer functionality for virtual controllers, see Signal Analyzer on page 335.

To open the Signal Analyzer, on the Controller tab, in the Controller Tools group, click Signal Analyzer. Alternatively, you can open the Signal Analyzer using the context menu in the Signal History window.

Note

The Signal Analyzer command in the Controller Tools group is enabled only if the selected controller is a real controller, or if the controller tree has only one real controller.

For information about the layout of the Signal Analyzer, see Layout of Signal Analyzer on page 339.

Turning the signal recording on and off

To turn the recording of signals on or off, use the Start recording and Stop recording buttons.

To start the recording, click Start recording.
To stop the recording, click Stop recording. The recording stops and the recorded session is saved.

Configuring signals for the next recording

To configure the signals which are to be saved during the next signal recording session, use the Signal Setup window. For this, click the arrow next to the Signal Analyzer icon, and then click Signal Setup. The Signal Setup window appears.

The signals that are available for configuration are shown in the Signal Setup window. For the list of available signals, see Available signals on page 336.

For information on setting up the signals, see Setting up the signals on page 337.
The signal data from each signal recording session is saved. To view these, click the arrow next to the Signal Analyzer icon, and then click History. For more information, see History on page 342.

**Note**

The signal data from each signal recording session is saved as a .sdf file at the following location. The History feature uses these files.

C:\Users\<your user name>\AppData\Local\ABB Industrial IT\Robotics IT\RobotStudio\SignalAnalyzer

This path is for a PC with a standard installation of Windows 7 or 8 (English version). The path may differ if you have a customized installation or use Windows XP.
11 Controller tab

11.2.14 Safety Configuration

11.2.14 Safety Configuration

Overview

For information on safety configuration, see:

- Application manual - SafeMove
- Application manual - Electronic Position Switches
11.3 Features for real controllers

11.3.1 Request Write Access

Overview
You need Write access for editing programs and configurations or in any other way to change data on the controller.

Prerequisites for Write access
You can get Write access to any controller as long as the prerequisites are fulfilled.

<table>
<thead>
<tr>
<th>When the Controller is in Mode</th>
<th>This has to be fulfilled:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>The Write access must not be taken by any other user.</td>
</tr>
<tr>
<td>Manual</td>
<td>The remote Write access must be granted on the FlexPendant. For safety reasons, a FlexPendant user can also recall this remote Write access in manual mode.</td>
</tr>
</tbody>
</table>

If the prerequisites are not fulfilled you will be denied, or lose, the Write access. This means that if you have Write access in auto mode and the controller is switched over to manual mode you will lose the Write access without any warning. This is because the FlexPendant unit by default has the Write access in manual mode, for safety reasons. The same will happen if the remote Write access in manual mode is recalled from the FlexPendant unit.

Result
The Controller Status window will be updated when the request for Write access is granted.
If the Write access is denied, a message is displayed.
11 Controller tab

11.3.2 Release Write Access

11.3.2 Release Write Access

Overview

Several users can be logged on to a single controller but only one can have the write access. You can release the write access when you do not need it anymore.

Result

The Controller Status window will be updated when your access right has changed from read/write to read only.
11.3.3 Authenticate

Overview

The data, functionality, and commands on a controller are protected by a User Authorization system (also called UAS). The UAS restricts the parts of the system the user has access to. Different users can have different access grants.

You can perform the following functions from the Authenticate menu:

- Login as a Different User
- Log off
- Log off all controllers
- Edit User Accounts
- UAS Grant Viewer

Login as a Different User

1. In the Authenticate menu, click Login as a Different User. The Add new user dialog box appears.
2. In the Username box, enter the user name you want to log on as.
3. In the Password box, enter the password for the user name you are logging on as.
4. Click OK.

Note: If you have previously logged on as a different user and wish to revert as default user, click Login as Default User.

Log off

In the Authenticate menu, click Log off to log the user off from the controller.

Log off all controllers

In the Authenticate menu, click Log off to log the user off from all the controllers.

Edit User Accounts

For more information on User Accounts, see User Accounts on page 383.

UAS Grant Viewer

For more information on UAS Grant Viewer, see UAS Grant Viewer on page 388.
11 Controller tab

11.3.4 File transfer

Overview
You can transfer the files and folders between the PC and a controller through the File Transfer window.

Prerequisites
The following are the prerequisites to be met:
• The PC must be connected to the same network as the controller, or connected to the service port of the controller.
• You must be logged on to the controller as a user with UAS grants that allows file transferring.

Transferring files and folders
Use this procedure to transfer files and folders between the PC and a controller:
1 In the Controller Tools group, click File Transfer.
   The File Transfer window appears.
2 In the PC explorer, browse to the folder from or to which you want to transfer the data.
3 In the Controller explorer, browse to the folder from or to which you want to transfer the data.
4 Select the item to transfer from the list.
   To select several items at once, do one of the following:

<table>
<thead>
<tr>
<th>To select</th>
<th>then press</th>
</tr>
</thead>
<tbody>
<tr>
<td>several adjacent items</td>
<td>the SHIFT key and select the first and the last item.</td>
</tr>
<tr>
<td>several non-adjacent items</td>
<td>the CTRL key and select each item.</td>
</tr>
<tr>
<td>all items in the list</td>
<td>the keys <strong>CTRL + A</strong></td>
</tr>
</tbody>
</table>

5 When the files and folder to transfer are selected, do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>then press</th>
</tr>
</thead>
<tbody>
<tr>
<td>cut the files</td>
<td><strong>CTRL + X</strong></td>
</tr>
<tr>
<td>copy the files</td>
<td><strong>CTRL + C</strong>, or click Arrow</td>
</tr>
</tbody>
</table>
6 Place the insertion point either in the **PC explorer** or the **Controller explorer** and click **CTRL + V**.

**Note**

In the **PC explorer** or **Controller explorer** window, right-click to view the following context menu:
- Transfer
- One level up
- Open
- Refresh
- Cut
- Copy
- Paste
- Delete
- Remove
11 Controller tab

11.3.5 FlexPendant Viewer

Overview

FlexPendant Viewer is an add-in to RobotStudio that retrieves and displays a screenshot from the FlexPendant. The screenshot is generated automatically at the moment of the request.

Prerequisites

The controller you want to retrieve screen shots from must be added to your robot view.

A FlexPendant must be connected to the controller. If no FlexPendant is currently connected (option Hot plug is installed and the jumper plug is used) then no screen shot can be retrieved.

Using FlexPendant Viewer

1. Make sure you are connected to the controller.
2. In the Controller Tools group, click the arrow next to the FlexPendant icon, and then click FlexPendant Viewer. A screen shot will be displayed in the workspace.
3. To reload the screen shot, click Reload in the workspace.
4. To set an automatic reload period for the screen shot, click on the menu Tools, point to FlexPendant Viewer and click Configure. Set the desired reload period and select the check-box Activated. Then click OK.

Results on the controller

The screenshot will automatically be saved as a file on the controller. When a new request is sent, a new screenshot is generated and saved, overwriting the previous file.

No message will be displayed on the FlexPendant.
11.3.6 Import Options

**Importing system options**

1. In the **Configuration** group, click **Import Options** to bring up a dialog box.
2. In the **Option source** box, enter the path to the folder where the options to import are located. You can also click the Browse button and browse to the folder.
3. In the **Media Pool destination** box, enter the path to the media pool you want to store the options in. You can also click the Browse button and browse to the media pool folder.
4. Select the options to import and click **Import**.

   To select several options at once, do one of the following:

<table>
<thead>
<tr>
<th>To select</th>
<th>then hold down</th>
</tr>
</thead>
<tbody>
<tr>
<td>several adjacent options</td>
<td>the SHIFT key and select the first and the last option.</td>
</tr>
<tr>
<td>several non-adjacent options</td>
<td>the CTRL key and select each option.</td>
</tr>
</tbody>
</table>

5. Click **OK**.

**Removing system options**

1. In the **Configuration** group, click **Import Options** to bring up a dialog box.
2. In the **Media Pool destination** list, enter the path to the media pool from which you want to delete the options. You can also click the Browse button and browse to the media pool folder.
3. Select the options to delete and click **Remove**.

   To select several options at once, do one of the following:

<table>
<thead>
<tr>
<th>To select</th>
<th>then hold down</th>
</tr>
</thead>
<tbody>
<tr>
<td>several adjacent options</td>
<td>the SHIFT key and select the first and the last option.</td>
</tr>
<tr>
<td>several non-adjacent options</td>
<td>the CTRL key and select each option.</td>
</tr>
</tbody>
</table>

4. Click **OK**.
11.3.7 Properties

Overview
You can perform the following from the Properties menu:

• Renaming the controller
• Setting the controller date and time
• Setting the Controller ID
• Viewing controller and system properties
• Handling the Device Browser

Renaming the controller
The controller name is an identification of the controller that is independent of the system or the software running on the controller. Unlike the controller ID, the controller name does not have to be unique for each controller.

Note
The controller name must be written with characters from the ISO 8859-1 (Latin 1) character set.

1 In the Configuration group, click Properties, and then click Rename.
   The Rename Controller dialog box appears.
2 Enter the new name of the controller in the dialog box.
3 Click OK.
   The new name will be activated when the controller is restarted.
   You will be prompted to either click Yes to restart the controller immediately or click No to restart later.

Setting the controller date and time
You can either set the date and time to the same as the computer you are working from, or you can specify the date and time manually.

Use this procedure to set the controller date and time:

1 In the Configuration group, click Properties, and then click Date and Time.
   The Set Date and Time dialog box appears.
2 In the Set Controller’s date and time, click the arrow next to the date and time list to set the date and time of the controller.

Note
Click Get local computer’s time to set the date and time of the controller to the same as the computer you are working on.

Setting the Controller ID
The Controller ID is by default set to the serial number of the controller and is thereby a unique identifier of the controller.

Continues on next page
The Controller ID is a unique identifier for the controller and should not be changed. However, if the hard disk of the controller is replaced, the ID will be lost and you must set it back to the serial number of the controller.

**Note**

You must Request Write Access to the controller before setting the controller ID.

1. In the **Configuration** group, click **Properties**, and then click **Controller ID**. The Set Controller ID dialog box appears.
2. Enter the Controller ID and then click **OK**.

**Note**

Use only characters from the ISO 8859-1 (Latin 1) character set and no more than 40 characters.

### Viewing controller and system properties

You can view the following properties for a controller and its running system.

<table>
<thead>
<tr>
<th>Controller Properties</th>
<th>System Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot Application</td>
<td>Control Module</td>
</tr>
<tr>
<td>Controller ID</td>
<td>Drive Module #1</td>
</tr>
<tr>
<td>Controller Name</td>
<td>Serial Number</td>
</tr>
<tr>
<td>Installed Systems</td>
<td>System Name</td>
</tr>
<tr>
<td>Network Connections</td>
<td></td>
</tr>
</tbody>
</table>

1. In the **Configuration** group, click **Properties**, and then click **Controller and System Properties**. The Controller and System Properties window appears.
2. In the tree view at the left of the window, browse to the node for which you want to view the properties.

   The properties of the selected object are displayed in the Properties list to the right of the window.

### Viewing the Device Browser

The Device Browser displays the properties and trends of the various hardware and software devices in a robot controller. To open the Device Browser, in the **Configuration** group, click **Properties**, and then click **Device Browser**.

**Displaying the properties of a device**

In the tree view, browse to the node for which you want to view the properties and then click it. The properties of the selected object, along with their corresponding values, are listed to the right of the tree view.

**Updating the tree view**

Press F5, to update the tree view.

*Continues on next page*
11 Controller tab

11.3.7 Properties

Continued

Alternatively, right-click inside the tree view pane, and then click Refresh.

Displaying a trend

Select a device in the tree view and then double-click any property, that has a numerical value, in the right-hand panel. This opens a trend view. The trend view collects data at a rate of one sample per second.

Hiding, stopping, starting or clearing a trend

Right-click anywhere on the trend view and then click the required command.

Saving system diagnostics

You can create a System Diagnostics data file from RobotStudio.

To save a System Diagnostics data file to your PC, in the Configuration group, click Properties, and then click Save system diagnostics.
11.3.8 Go Offline

Overview

The main purpose of this feature is to create a new station with a VC similar to the connected real controller. This helps a robot technician to work offline, and not just when connected to the real controller.

Using Go Offline

1. Connect the PC to a real controller.
2. On the Controller tab, click Request Write Access.
   For more information on Request Write Access, see Request Write Access on page 371.
3. Click Go Offline.
   The Go Offline dialog box is displayed.
4. Enter a name for the system and browse for the location to save the system.
   A new station is created with a VC with the same configuration as the real controller.

Note

Go Offline transfers additional options from a real controller and installs them on the PC. A Relation is automatically created between the virtual controller and the real controller.

For more information on Relations, see Transfer on page 365
11 Controller tab

11.3.9 Online Monitor

11.3.9 Online Monitor

This feature allows you to remotely monitor the robot connected to a real controller. It displays a 3D layout of the connected robot controller and enhances user’s current perception of reality by adding motion visualization augmentation.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Online Monitor shows only TCP robots, and not external axes. When connecting the Online Monitor to a virtual controller, the motion is shown only if the virtual controller is using Free-Run mode, not the Time Slice mode.</td>
</tr>
</tbody>
</table>

Using Online Monitor

The following procedure describes the Online Monitor feature in RobotStudio:

1. Connect the PC to a controller and add the controller. See Add Controller on page 348.
2. Click Online Monitor.

The 3D view of the mechanical units of the controller system is displayed in the graphics window.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The robot view is refreshed every second with the current jointvalues of all the mechanical units.</td>
</tr>
</tbody>
</table>

Indication of TCP

A cone is automatically created to indicate the active tool data being used. The cone has its base in the robot wrist and its tip at the location of the tool data.

Kinematic Limitations

When the Kinematic Limitation button is enabled, the graphical 3D viewer indicates whether the robot is at a joint limit or at a singularity.

For joint limits, the corresponding link is highlighted in yellow to indicate a warning and in red to indicate an error. The tolerance limits are defined in RobotStudio Options - Online - Online Monitor.

For singularity, a markup indicates when the axis 5 is close to singularity. The singularity level is also defined in RobotStudio Options.
11.3.10 User Accounts

Overview

All the procedures below require the following steps to be taken before managing the details:

1. In the Controller browser, select the controller to which you want to manage a user or group.
2. From the Controller tab, click Request Write Access to provide write access to the controller.
3. In the Controller tab, click Authenticate and select Edit User Accounts, for administering UAS accounts, grants, and groups.

Users tab

With the Users tab you set which users will be able to log on to the controller and which groups the users shall belong to.

Users tab Parts

1. The Add button. Opens a dialog box for adding new users.
2. The Edit button. Opens a dialog box for changing the log on name and password of the user.
3. The Delete button. Deletes the selected user account from the controller.

Continues on next page
11 Controller tab

11.3.10 User Accounts

Continued

4 The Users on this Controller list. Shows the user accounts defined on this controller. The list has two columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>The name of the user account</td>
</tr>
<tr>
<td>Status</td>
<td>Shows if the account is activated or deactivated. When deactivated, it is not possible to log on using that account.</td>
</tr>
</tbody>
</table>

5 The Activated/Deactivated item box. Changes the status of the user account.

6 The User’s groups/User’s grants list.

The User’s groups list shows which group(s) the user is a member of. For changing the membership of a group, select or clear the checkbox in front of the group name.

The User’s grants list shows the available grants for the selected User’s group(s). When selecting a grant from the User’s grants list, a description of the selected grant appears.

Adding a user

1 On the Users tab, click Add to bring up a dialog box.
2 In the UserName box, enter the user name. Use only characters from the ISO 8859-1 (Latin 1) character set and no more than 16 characters.
3 In the Password box, enter the user’s password. The password you type in will not be visible. Use only characters from the ISO 8859-1 (Latin 1) character set and no more than 16 characters.
4 In the Retype Password box, enter the user’s password again.
5 Click OK to add the new user and close the dialog box.
6 Click OK.
Deleting a user

1. On the Users tab, select the user to delete from the Users on this controller list and click Delete.
2. To the question Are you sure you want to remove this user?, answer Yes.
3. Click OK.

Setting up group membership

1. On the Users tab, select the user from the Users on this controller list.
2. In the User’s groups list, select the groups the user shall be a member of.
3. Click OK.

Changing a name or password

1. On the Users tab, select the user to edit from the Users on this controller list and click Edit user.
   This opens the Edit dialog box.
2. To change the user name, enter the new name in the User Name box. Use only characters from the ISO 8859-1 (Latin 1) character set and no more than 16 characters.
3. To change the password, enter the new password in the Password box, then retype the password in the Retype Password box. Use only characters from the ISO 8859-1 (Latin 1) character set and no more than 16 characters.
4. Click OK to save the changes to the user and close the dialog box.
5. Click OK.

Activating or deactivating a user

1. On the Users tab, select the user from the Users on this controller list and click the status text (Activated or Deactivated). An item box appears and you can change the status.
   The user's new state is now displayed in the status column of the Users on this controller list.
2. Click OK.

Exporting a user list

On the Users tab, select the user from the Users for this Controller list and click Export.
This opens a Save as dialog box, in which you specify the name and location for the file with the user list.

Importing a user list

On the Users tab, select the user from the Users for this Controller list and click Import.
This opens an Open file dialog box, in which you browse to the file with the list to import.

Continues on next page
When you have selected the file, the ImportOptionsForm dialog appears.

<table>
<thead>
<tr>
<th>Select ...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete existing users and groups before importing</td>
<td>Earlier groups and users will be deleted.</td>
</tr>
<tr>
<td>Advanced options</td>
<td>A new dialog appears. Import users but don't replace duplicates means that you will not replace the existing users. Import users and replace duplicates means that you will replace the existing users. Import groups but don't replace duplicates means that you will not replace the existing groups. Import groups and replace duplicates means that you will replace the existing groups.</td>
</tr>
</tbody>
</table>

Adding a group

1. On the Groups tab, click Add.
   This opens the Add new group dialog box.
2. In the Group Name box, enter the name of the group. Use only characters from the ISO 8859-1 (Latin 1) character set and no more than 16 characters.
3. Click OK to add the new group and close the dialog box.
4. Click OK.

Renaming a group

1. On the Groups tab, select the group to rename from the Groups on this controller list and click Rename.
   This opens the Rename Group dialog box.
2. In the Group Name box, enter the name of the group. Use only characters from the ISO 8859-1 (Latin 1) character set and no more than 16 characters.
3. Click OK to rename the group and close the dialog box.
4. You will now be asked if you want the users who belong to this group to continue belonging to a group with the old name as well as the new one.

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Let the users of the group be members to groups with both the old and the new name. However, the old group will no longer be defined in the controller's UAS since it is replaced by the new group. This option might be useful if you plan to recreate the old group, or copy the user's settings to another controller who has the old group defined.</td>
</tr>
<tr>
<td>No</td>
<td>Delete the user's memberships to the old group. This is to just replace the old group name with the new one.</td>
</tr>
<tr>
<td>Cancel</td>
<td>To cancel the change and keep the old group name, with its user's memberships.</td>
</tr>
</tbody>
</table>

5. Click OK.
Deleting a group

1 On the Groups tab, select the group to delete from the Groups on this controller list and click Delete.

2 You will now be asked if you want the users who belong to this group to continue belonging to it though it is not valid.

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Let the users of the group remain members to it even if it is no longer defined in the controller's UAS. This option might be useful if you plan to recreate the group, or copy the user's settings to another controller who has the group defined.</td>
</tr>
<tr>
<td>No</td>
<td>Delete the user's memberships to the group.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel the change and keep the group, with its user's memberships.</td>
</tr>
</tbody>
</table>

3 Click OK.

Giving grants to a group

1 On the Groups tab, select the group from the Groups on this controller list.

2 In the Controller grants/Application grants list, select the grants to give to the group.

3 Click OK.
11.3.11 UAS Grant Viewer

Overview

The UAS Grant Viewer page displays information about the grants provided to the user currently logged in and the groups owning them.

1. In the Authenticate menu, click UAS Grant Viewer. The UAS Grants window appears.

Examples of common actions to perform

<table>
<thead>
<tr>
<th>Action</th>
<th>Necessary grants</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename the controller</td>
<td>Modify controller properties</td>
</tr>
<tr>
<td>(A restart of the controller is necessary)</td>
<td>Remote warm start</td>
</tr>
<tr>
<td>Change system parameters and load configura-</td>
<td>Modify configuration</td>
</tr>
<tr>
<td>tion files</td>
<td>Remote warm start</td>
</tr>
<tr>
<td>Install a new system</td>
<td>Administration of installed system</td>
</tr>
<tr>
<td>Perform a backup</td>
<td>Backup and save</td>
</tr>
<tr>
<td>(A restart of the controller is necessary)</td>
<td>Remote warm start</td>
</tr>
<tr>
<td>Restore a backup</td>
<td>Restore a backup</td>
</tr>
<tr>
<td>(A restart of the controller is necessary)</td>
<td>Remote warm start</td>
</tr>
<tr>
<td>Load/delete modules</td>
<td>Load program</td>
</tr>
<tr>
<td>Create new module.</td>
<td>Load program</td>
</tr>
<tr>
<td>Edit code in RAPID modules</td>
<td>Edit RAPID code</td>
</tr>
<tr>
<td>Save modules and programs to disk</td>
<td>Backup and save</td>
</tr>
<tr>
<td>Start program execution from Task Window</td>
<td>Execute program</td>
</tr>
</tbody>
</table>

Continues on next page
### Controller grants

<table>
<thead>
<tr>
<th>Action</th>
<th>Necessary grants</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new I/O signal, that is, add a new instance of the type Signal</td>
<td>Modify configuration</td>
</tr>
<tr>
<td>(A restart of the controller is necessary)</td>
<td>Remote warm start</td>
</tr>
<tr>
<td>Set the value of an I/O signal</td>
<td>I/O write access</td>
</tr>
<tr>
<td>Access to controller disks from File Transfer window</td>
<td>Read access to controller disks</td>
</tr>
<tr>
<td></td>
<td>Write access to controller disks</td>
</tr>
</tbody>
</table>

#### Full access

This grant includes all controller grants, also new grants added in future RobotWare versions. The grant does not include any application grants or the **SafetyController configuration** grant.

#### Manage UAS settings

Gives access to read and write the UAS configuration, that is to read, add, remove and modify UAS users and groups.

#### Execute program

Gives access to perform the following:
- Start/step program (stop is always allowed)
- Move PP to Main
- Execute service routines

#### Perform ModPos and HotEdit

Gives access to perform the following:
- Modify or teach positions in RAPID code (ModPos)
- During execution modify positions in RAPID code as single points or as a path (HotEdit)
- Restore ModPos/HotEdit positions to original
- Modify current value of any RAPID variable

#### Modify current value

Gives access to modify current value of any RAPID variable. This grant is a subset of the grant **Perform ModPos and HotEdit**.

#### I/O write access

Gives access to perform the following:
- Set I/O signal value
- Set signal as simulated and remove simulation
- Set I/O unit and bus as enabled/disabled

#### Backup and save

Gives access to perform a backup and to save modules, programs and configuration files.

#### Restore a backup

Gives access to restore backup and perform B-start.

#### Modify configuration

Gives access to modify the configuration database, that is to load configuration files, change system parameter values and add/delete instances.

#### Load program

Gives access to load/delete modules and programs.

#### Remote warm start

Gives access to perform warm start and shutdown from a remote location. No grant is required to perform warm start via a local device, as for example the FlexPendant.

#### Edit RAPID code

Gives access to perform the following:
- Modify code in existing RAPID modules
- Frame calibration (tool, workobj)
- Commit ModPos/HotEdit positions to current values
- Rename program

Continues on next page
### Program debug
Gives access to perform the following:
- Move PP to routine
- Move PP to cursor
- HoldToRun
- Activate/deactivate RAPID tasks
- Request write access from the FlexPendant
- Enable/disable non-motion execution

### Decrease production speed
Gives access to decrease speed from 100% in Auto mode. This grant is not required if speed is already below 100%, or controller is in Manual mode.

### Calibration
Gives access to perform the following:
- Fine calibrate mechanical unit
- Calibrate base frame
- Update/clear SMB data

Frame calibration (tool, wobj) requires the grant Edit RAPID code. Manual offset of mechanical unit calibration data and loading new calibration data from file require the grant Modify configuration.

### Administration of installed systems
Gives access to perform the following:
- Install new system
- P-start
- I-start
- X-start
- C-start
- Select System
- Install system from device

This grant gives full FTP access, that is, the grant gives the same rights as Read access to controller disks and Write access to controller disks.

### Read access to controller disks
Gives external read access to controller disks. This grant is only valid for explicit disk access, for example with an FTP client or the File Manager of RoboStudio.

It is possible, for example, to load a program from /hd0a without this grant.

### Write access to controller disks
Gives external write access to controller disks. This grant is only valid for explicit disk access, for example with an FTP client or the File Manager of RoboStudio.

It is possible, for example, to save a program to the controller disk or perform a backup without this grant.

### Modify controller properties
Gives access to set controller name, controller ID and system clock.

### Delete log
Gives access to delete messages in the controller Event Log.

### Revolution counter update
Gives access to update the revolution counter.

### Safety Controller configuration
Gives access to perform a configuration of the Safety Controller. This is valid only for the PSC-option and is not included in the Full access grant.

Continued on next page
**Application grants**

<table>
<thead>
<tr>
<th>Access to the ABB menu on FlexPendant</th>
<th>Value true gives access to the ABB menu on the FlexPendant. This is the default value if a user does not have the grant. Value false means that the user cannot access the ABB menu when the controller is in Auto mode. The grant has no effect in Manual mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log off FlexPendant user when switching to Auto mode</td>
<td>A user having this grant is automatically logged off from the FlexPendant when switching from Manual mode to Auto mode.</td>
</tr>
</tbody>
</table>
11.4 Features for virtual controllers

11.4.1 Virtual FlexPendant

Opening a Virtual FlexPendant

You can open a virtual FlexPendant in one of the following ways:

1. On the Controller tab, in the Controller Tools group, click the arrow next to the FlexPendant icon, and then click Virtual FlexPendant.
2. Press the keyboard shortcut, CTRL + F5.

Note

The Virtual FlexPendant is applicable while running a virtual controller. For information on specifying the appearance and placement of virtual FlexPendant, see Options on page 193.
11.4.2 Control Panel

The Control Panel dialog box

<table>
<thead>
<tr>
<th>Operation Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>This option corresponds to the Auto mode on the FlexPendant. Moving between the Auto and Manual Full Speed options must proceed via the Manual option.</td>
</tr>
<tr>
<td>Manual</td>
<td>This option corresponds to the Manual mode on the FlexPendant.</td>
</tr>
<tr>
<td>Manual Full Speed</td>
<td>This option corresponds to the Manual 100% mode on the FlexPendant. Moving between the Auto and Manual Full Speed options must proceed via the Manual option.</td>
</tr>
<tr>
<td>Motors On</td>
<td>Click this button to turn on the motors.</td>
</tr>
<tr>
<td>Enable Device</td>
<td>In a manual mode, click this button to simulate holding the enabling device to turn on the motors.</td>
</tr>
<tr>
<td>Release Device</td>
<td>In a manual mode, click this button to turn off the motors.</td>
</tr>
<tr>
<td>Reset Emergency Stop</td>
<td>If the controller enters the emergency stop state, click this button to reset the state.</td>
</tr>
</tbody>
</table>
11.4.3 Shutdown

Shutting down a controller

1. In the Controller browser, select the controller to shut down.
2. Right-click the controller, and then click Shutdown.

Note

Suppose you want to restart the controller, select Warmstart. For more information on restarting a controller, see Restart a controller on page 355.
11.4.4 Set Task Frames

Modifying Task frame

1. On the Controller tab, in the Virtual Controller group, click Task Frames. The Modify Task Frames dialog box appears.
2. Set the reference to World, UCS, or Local.
3. Edit the position and orientation of task frames in the Task Frames coordinate box.
4. Click Apply.

To the question, Do you also want to move the Base Frames(s)?
   - Click Yes to move the base frame, but keeps its relative placement to the task frame.
   - Click No. The following question appears Do you want to update the controller configuration and restart?. Click Yes to restart the controller and update the base frame configuration of the connected VC.

Note

If there are any stationary RAPID objects (tooldata, workobjects) connected to the robot, the following question appears Do you want to keep the positioning of all stationary RAPID objects?
   - Click Yes to keep all the stationary RAPID objects in their global coordinates.
   - Click No to move all the stationary RAPID objects along with the base frame (same coordinates relative to base frame).
11 Controller tab

11.4.5 Edit System

Overview

The Edit System window contains functions for making and viewing advanced system configurations, such as changing controller and baseframe positions, calibrating and setting up external axes.

The left side of the Edit System window contains a hierarchical tree with which you browse to different aspects of the system. The right side contains a property sheet for the aspect selected in the tree. Below are short descriptions of the property sheets for each aspect node of the tool.

⚠️ CAUTION

Editing the system may result in corrupted systems or unexpected robot behaviors. Be sure to understand the effects of the changes before proceeding.

The System node

The system node contains a box with information about the system and a button for loading new parameters (configuration files) to the system.

The task node

The task node has no property page.

The mechanism folder node

The property page of this node contains controls for mapping and setting axis and joints. It is from this page you set up external axes.

The mechanism library node

The property page of this node contains controls for changing the baseframe of the robot or mechanism. Here, too, you specify whether the baseframe is moved by another mechanism (coordinated motion), like a track external axis.

Updating the baseframe position

1. Move the mechanical unit (robot or external axis) to its new location using the ordinary tools for moving and placing objects.

2. In the Controller browser, select the controller for the mechanical unit.

3. On the Controller tab, in the Virtual Controller group, click Edit System. This opens the System Configuration dialog.

4. Select the node for the mechanical unit in the hierarchical tree. The baseframe property sheet for the robot is now displayed.

5. Select the baseframe position values to use after restarting the robot.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller values</td>
<td>Reset all changes to the baseframe made since the last time the system was started.</td>
</tr>
</tbody>
</table>
To select the baseframe:

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stored station values</td>
<td>Reset all changes made to the baseframe since the last time the station was saved. Optionally, you can enter new values in the baseframe coordinate boxes (relative to the controller world coordinate system).</td>
</tr>
<tr>
<td>Use current station values</td>
<td>Read and use the current location of the baseframe. Optionally, you can enter new values in the baseframe coordinate boxes (relative to the controller world coordinate system).</td>
</tr>
</tbody>
</table>

6 Click OK.

Note

For information on adding a track from the Edit System tool, see *Track motion of type RTT or IRBTx003 on page 83*. 
11.4.6 Encoder Unit

Configuring an Conveyor Encoder Unit

1. Click Encoder Unit.
   The Configure Conveyor Encoder Unit dialog box appears.
   Alternatively, the Configure Conveyor Encoder Unit dialog box can be opened from the Paths&Targets browser. Right-click a station in the browser, select Configuration, and then click Encoder Unit.
2. Select CNV1 from the Mechanical Unit list.
3. In the Parameters box, enter the values for Maximum Distance, Minimum Distance, Queue Tracking Distance and Start Window Width.

   Note
   If any of the parameter values are changed, the controller must be restarted.

4. Click OK.
5. Click Yes to restart the controller.
12 RAPID tab

12.1 Overview of the RAPID tab

The RAPID tab provides tools and functionalities for creating, editing, and managing RAPID programs. You can manage RAPID programs which are online on a real controller, offline on a virtual controller, or standalone programs which are not part of a system.
12.2 Synchronize to Station

Synchronizing to the station

1. On the RAPID tab, in the Access group, click the arrow next to the Synchronize icon, and then click Synchronize to Station.
2. Select the paths to be synchronized to the station from the list.
3. Click OK.

The message Synchronization to Station completed is displayed in the Output window.

Note

This function is also present in the Controller group on the Home tab.
12.3 Synchronize to VC

Synchronizing to the virtual controller

1. On the RAPID tab, in the Access group, click the arrow next to the Synchronize icon, and then click Synchronize to VC.
2. Select the elements to be synchronized to the VC from the list.
3. Click OK.

The message Synchronization to VC completed is displayed in the Output window.

Note

This function is also present in the Controller group on the Home tab.
12.4 Edit RAPID code

Editing RAPID code using RAPID Editor

The RAPID editor enables you to view and edit programs loaded into a controller, both real and virtual. The integrated RAPID editor is useful for editing all robot tasks other than robot motion. With the RAPID editor you can edit the RAPID code of the program modules and system modules. Each module you open appears in an editor window of its own, where you can add or edit RAPID code.

For examples of using the RAPID editor, see Examples of using the RAPID editor on page 426.

General RAPID Editor features

The following are the general features of the RAPID Editor:

• **Read-only documents** - If the document is read-only (for example, due to lack of mastership), then the background of the editor area will be light gray instead of the normal white. Typing in an editor that is in the read-only state results in a dialog asking you whether RobotStudio should acquire write access.

• **Syntax highlighting** - Text is highlighted in different colors depending on their token classification (such as keyword, identifier and so on). You can configure these colors in the File tab, under Options:Robotics:RAPID Editor. For more information, see Options:Robotics:RAPID Editor on page 195.

In addition to token classification, the editor also shows different colors for built-in and installed identifiers (such as MoveL) and also for identifiers declared in user code.

• **Quick-Info tooltips** - When you hover the mouse pointer over a symbol (such as a data declaration or procedure call), a tooltip is displayed describing the symbol. For many built-in symbols (such as MoveJ) a short description is also displayed. For symbols corresponding to a data declaration, the current value is also displayed.

• **Context-sensitive help** - Pressing F1 when the cursor is on a RAPID programming construct, such as an instruction, opens the related section in the RAPID reference manual, instead of the main RobotStudio help.

• **Auto-indent cursor on return** - When you press Enter, the cursor is automatically indented by the appropriate amount on the following line. For example, after typing a PROC header, pressing ENTER will indent the cursor one tab (or the corresponding number of spaces, depending on settings).

• **Completion list** - When you type in code in the editor, a pop-menu which lists possible code suggestion maybe displayed depending on the kind of RAPID code construct being written. The suggestions listed also depend on where in the document the cursor is.

Pressing comma (,), semi-colon (;), colon (:), equal sign (=), Spacebar, Tab, or Enter keys automatically inserts the selected item. Press Esc to cancel the list.

Continues on next page
• **Auto-completion** - After typing or completing a procedure call (such as MoveJ), pressing the Tab key will fill in all required parameters. Note that this is only available for certain built-in procedures, such as those listed in the *Insert Instruction* menu.

• **Argument information** - While typing in procedure calls and function calls, tooltips showing argument information are displayed.

• **Collapsible regions** - Certain regions of the code can be collapsed. For example, Data declarations area, routines, IF/WHILE/FOR statements and so on.

• **Error highlighting** - Red squiggly lines appear under errors in the code. All syntax errors and a subset of semantic errors are indicated in this manner.

• **Zooming in and out** - In the RAPID editor you can zoom in and zoom out of the code display. Click the plus (+) and minus (-) buttons at the top right corner of the RAPID editor window to zoom in and zoom out.

  **Tip**

  The Zoom in Zoom out feature is also present in the *RAPID Tasks, Rapid Editor, Configuration Editor, Event viewer, and I/O windows.*

• **Cut, copy, paste and drag and drop** - These standard commands for clipboard handling of text are supported.

• **Undo and redo** - Standard commands for undo and redo operations are supported.

• **Selection modes** - You can select text by character, row and column.

• **Line numbers** - Line numbers for the RAPID code lines are displayed in the left margin of the editor.

• **Keyboard shortcuts** - For keyboard shortcuts in the RAPID Editor, see *Keyboard shortcuts on page 72.*

---

**Starting the RAPID Editor**

To open a RAPID module in the RAPID editor, in the Controller browser right-click on a RAPID module, and then click **RAPID Editor**.

The RAPID code of the module opens in the editor window.

  **Tip**

  You can view the graphical layout, without closing the editor, by clicking the graphics window tab.

**Editing a RAPID program**

The Edit group on the RAPID tab has commands which help in editing the lines of code in the RAPID Editor. Other than standard functions such as Cut, Copy, and Paste, the following functions are present in the Edit group:

• **Comment** – To comment out selected lines

  Uncomment – To uncomment commented lines
The comment and uncomment buttons in the ribbon will add/remove comment characters (“!”) at the beginning of the selected line(s).

- Indent – To increase the indent of selected line(s) by four white spaces
- Unindent – To decrease the indent of selected line(s) by four white spaces

The indent and unindent buttons in the ribbon will move the selected code line(s) one tab position to the right/left.

- Format Document - Auto-formats the active document by arranging the spaces and tabs in the RAPID code.
- Uppercase Keywords - To change RAPID keywords from lowercase to uppercase. This function operates on the current document.
- Format Selection – This function is similar to Format Document, but with the difference that it operates on currently selected text.
- Convert Spaces to Tabs - Converts consecutive spaces to the corresponding number of tabs. This function operates on the current selection.
- Convert Tabs to Spaces - Does the opposite of function above.

Note

To make formatting easier, the tabs and white spaces can be indicated by arrows and dots, respectively. To enable this go to Options:Robotics:RAPID Editor (Options:Robotics:RAPID Editor on page 195) and then select the Show whitespace check box.

By default a Tab consists of four whitespaces. To change this, go to Options:Robotics:RAPID Editor and set the Tab size as your require.

Edited lines are denoted by change bars which remain until the edits are applied. Also, the RAPID Editor’s tab sports an asterisk (“”) until the edits are applied.

Adding code snippets

Code Snippets are pieces of code which you can insert into the RAPID Editor. To view and select a code snippet, in the Insert group, click Snippet.

The list which appears show two kinds of code snippets:

- Predefined code snippets
- User defined code snippets

The following are the predefined code snippets in RobotStudio:

- Array of num, 2x2x4
- Array of num, 2x4
- Array of num, 2x4x2
- Array of num, 4x2
- Module header
- Procedure with parameters
- Procedure with error handler
- Robtarget declaration
- Tooldata declaration

Continues on next page
12 RAPID tab

12.4 Edit RAPID code

Continued

- Workobject declaration

You can also create your own code snippets or save a section of existing code from the RAPID editor as a code snippet. Such user created code snippets are also listed along with the predefined snippets.

To save a section of existing code, from the RAPID editor, as a code snippet:

1. Select the code you wish to save as a snippet.
2. In the Insert group, click the arrow next to the Snippet icon, and then click Save Selection as Snippet.
   
The Save As dialog box appears. Specify a name for the snippet and save it. The RobotStudio .snippet files are saved in the following folder.

   C:\<Documents and Settings>\<user name>\RobotStudio\Code Snippets

To insert a snippet in the RAPID editor, click the arrow next to the Snippet icon, and then click the required snippet from the listed snippets.

Note

The folder <Documents and Settings> may be configured with different names, for example, Data. It may also be translated on localized versions of Windows. Snippets can also be edited in an XML editor such as Microsoft Visual Studio. For information on creating customized code snippets, see http://msdn.microsoft.com/.

Inserting instructions

To insert a predefined instruction into the code:

1. Place the cursor at the required point in the RAPID code.
2. In the Insert group, click Instruction.
   
   A list of pre-defined instructions is shown.

   The instruction is inserted into the code where the cursor is placed. RobotStudio generates and inserts default arguments to the instruction, using similar rules as the FlexPendant.

Applying and verifying the edits

To apply the changes made in the editor to the system and also to check the program go to the Controller group, and click the arrow next to the Apply icon. Then:

- To apply only the changes in made in the module, currently shown in the editor, click Apply Changes.
  
  Alternatively, you can also directly click the Apply icon

- To apply the changes made in all modified modules, click Apply All.

Continues on next page
12 RAPID tab

12.4 Edit RAPID code

Continued

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Apply commands are enabled only if there are changes waiting to be applied. When possible, RobotStudio will try to commit the changes without losing the program pointer. If this is not possible, you will be asked if it is OK to lose the program pointer.</td>
</tr>
</tbody>
</table>

To verify the syntactic and semantic correctness of the modules, in the Test and Debug group, click Check Program.
12.5 Find and replace RAPID code

Overview

The Find group, on the RAPID tab contains commands for performing Find and Replace actions on the code in the RAPID editor.

Quick Find

Enter the search string in the Quick find box and then press Enter or F3. If an instance is found, it is highlighted. Press F3 again to search for the next instance.

Go to line

Enter a line number in the Go to line box and press Enter. The cursor moves to the corresponding line in the RAPID editor.

Jump To

The Jump To list has an item for each routine and data declaration in the program module. Click an item to move to its location in the code.

Find or Replace

Click Find/Replace to open the Find/Replace dialog box. This dialog box provides standard find/replace functionality in addition to the following:

- Use the Look in list box to specify where to look for in a find/replace operation. You can choose to search in the Current Document, Current System or in a folder on your PC (you can browse to a folder to specify it).
- The Search Results window displays the results of a Find operation. Double-click a search result to go to the corresponding instance in the RAPID editor. If the instance is from a module which is not in the RAPID editor, then the module automatically opens in the editor.

Go To Definition

The Go To Definition command is enabled for an identifier in the RAPID Editor context menu if the source code for the corresponding symbol definition is available. Click Go To Definition to move the cursor to (and select) the corresponding symbol definition. This action detects symbol definitions such as routine declarations, data declarations and record definitions.

Find Unused References

Click Find unused references in Task to see all data declarations in the task of the active module document that are not used anywhere. The results are shown in the Search Results window. Click Find unused references in Module to see unused data declarations in the current module.

Find All References

The Find All References command is enabled for identifiers in the editor code. For a given identifier, click Find All References to search through the entire task for uses of the same identifier (including its definition). Note that this is not just a

Continues on next page
12.5 Find and replace RAPID code

Continued

string search. It takes RAPID scoping rules into account. For PERS and syncident data, this function searches the other tasks for a matching global symbol and return the uses of those.
12.6 Manage RAPID modules

Managing file based RAPID modules
File based RAPID modules can be opened in the editor in four different ways:

• Using the Open command on the File tab
• Using the New:RAPID Module File command on the File tab. For more information, see Creating a new RAPID module file on page 188.
• Double-clicking a module in the File browser of the RAPID tab. For more information on the File browser, see Manage RAPID files and backups on page 412.
• Right-clicking the Files nodes and selecting Open in the File browser of the RAPID tab. For more information on the File browser, see Manage RAPID files and backups on page 412.

Tip
For file based modules, the standard file commands are applicable: Save/Save As will save the module; Open will open a module and Close will close the module.

The Apply Changes command is disabled for file based modules. It is applicable only for controller based modules.

Creating a new RAPID module
1 On RAPID tab, in the Controller browser, right-click a task and then click New Module.
   The Create Module dialog box opens.
2 Enter a module name.
3 Select the Module type as Program or System, as required.
4 Select one of the following options:
   • No Step-In - The module cannot be entered during step-wise execution.
   • Read-only - The module cannot be modified.
   • View-only - The module cannot be modified, but the attribute can be removed.
5 Click Create.

Loading a RAPID module
1 On RAPID tab, in the Controller browser, right-click a task and then click Load Module.
2 Browse to and select the module to be loaded to your station, and then click Open.

Saving a RAPID module as another
1 On RAPID tab, in the Controller browser, right-click a module and then click Save Module As.
2 Browse to the location where the new module is to be saved and then click Save.
12.7 Edit RAPID data

RAPID Data Editor overview

The RAPID Data Editor allows you direct access to RAPID data values, which you can view and edit.

To open the RAPID Data Editor, on the RAPID tab go to the Controller browser, right-click a RAPID module, and then click RAPID Data Editor. This opens the Data window which shows the data declarations in that particular module.

Data declarations are grouped according to their data types. All data declarations belonging to a data type are shown in a table below it. Each row corresponds to a data declaration and shows the contents of the declaration.

Using the RAPID Data Editor

- Editing the values of a row opens the changed value in the RAPID Editor window. The new value is shown in both the Data editor and also the RAPID editor. This means that the changes made in the RAPID data editor are seen in the RAPID editor, and vice-versa.

  Tip

  A asterisk (*) on the window tab indicates that the changes have not been saved.

- You can select multiple cells and edit them together.
- You can create, edit or delete a data declaration from the RAPID Data Editor.
- To delete a data declaration, select the row and click the Delete button beside it.
- To add a new declaration, click New Declaration next to the required data type. This adds a new row to the table below it having some default properties and values, which can be edited. However, you cannot add a declaration of a data type that is not already present in the module. In such a case you need to manually add the declaration to the module using the RAPID Editor.

  Note

  The RAPID Data Editor only shows data declarations that contain editable values.
12.8 Manage RAPID files and backups

Managing RAPID files

In the Files browser, right-click the File node and then click Open. The Open File dialog box appears, using which you can browse to and open system module (*.sys), RAPID modules (*.mod), and Configuration files (*.cfg) which are residing on your PC or on a network.

Upon opening a RAPID or system module file, it opens in the RAPID editor. The system parameters file (*.cfg) open in a notepad-like editor but is unlike the RAPID editor. To save the changes made in an editor, click the Save button on the Quick Access Toolbar.

Note

When you open standalone RAPID modules, the editor may show the code as having syntax errors if the variable declarations exist in another module.

Managing system backups

Right-click Backup and click Browse, to browse to and open system backups.

The structure of the backup is reflected in the Files browser under the Backups node. There is one node for each task defined in the system. The RAPID modules of each task are shown as its child nodes in the tree view. The editor will find data declared in other modules and correctly mark the code as being syntactically and semantically correct.

The contents of the HOME folder are shown in a separate folder. RAPID modules of the HOME folder will be edited in the standalone mode, which means that the editor will not find data declared in other modules. The reason is that the editor cannot know in which context (task) the module should be treated.

The SYSPAR folder will show the configuration files.

Note

There is no syntax check or intellisense for editing configuration files.
12.9 Manage RAPID code on the controller

12.9.1 Manage RAPID programs

### Loading a RAPID program

To load a RAPID program to a station:

1. On the RAPID tab, in the Controller group, click the arrow next to the Program icon and then click Load Program.
   Alternatively, in the Controller browser, right-click the active task under the station, and then click Load Program.
2. In the Open dialog box that appears, browse to the location of the program to be loaded to your station and click Open.

### Saving a program

1. On the RAPID tab, in the Controller group, click the arrow next to the Program icon and then click Save Program As.
   Alternatively, in the Controller browser, right-click the active task under the station, and then click Save Program As.
2. In the Save As dialog box that appears, browse to the location where you want to save your program, and click Save.

### Renaming a program

1. On the RAPID tab, in the Controller group, click the arrow next to the Program icon and then click Rename Program.
   Alternatively, in the Controller browser, right-click the active task under the station, and then click Rename Program.
2. In the Rename dialog box that appears, enter a new name for your program, and click Ok.

### Deleting a program

To delete the entire program under a task in a station, in the Controller group, click the arrow next to the Program icon and then click Delete Program.
Alternatively, in the Controller browser, right-click the task under the station, and then click Delete Program.
12 RAPID tab

12.9.2 RAPID Tasks

12.9.2 RAPID Tasks

Overview

The RAPID Tasks window shows the configured tasks of the selected controller and their state, in a tabular form. To open the RAPID Tasks window, in the Controller group click RAPID Tasks.

The following table describes the columns displayed for each task.

<table>
<thead>
<tr>
<th>Task Name</th>
<th>The task name, as defined by the controller configuration in topic Controller, type Task. For information on topic Controller type Task, see the Technical Reference Manual for System Parameters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>A task can be of type Normal, Static, or SemiStatic. This is defined by the controller configuration in topic Controller, type Task. For information on topic Controller type Task, see the Technical Reference Manual for System Parameters.</td>
</tr>
<tr>
<td>Mechanical Unit</td>
<td>Shows which mechanical unit group is used for the task. This is defined by the controller configuration in topic Controller, type Task. For information on topic Controller type Task, see the Technical Reference Manual for System Parameters.</td>
</tr>
<tr>
<td>Run Mode</td>
<td>Defined by the Run Mode setting in RobotStudio. For more information on Run Mode, see Run mode of the controller on page 416.</td>
</tr>
<tr>
<td>State</td>
<td>Displays the task execution state. A task can be in state Ready, Running, or Stopped.</td>
</tr>
<tr>
<td></td>
<td>• Ready: The program has no PP (program pointer). To set the program pointer, use the Program Pointer menu of the RAPID Tab. Alternatively, use the FlexPendant.</td>
</tr>
<tr>
<td></td>
<td>• Running: The program is running.</td>
</tr>
<tr>
<td></td>
<td>• Stopped: The program has stopped. For more information on the Program Pointer (PP), see Using the Program Pointer on page 421.</td>
</tr>
<tr>
<td>TrustLevel</td>
<td>Handles the system behavior when a SemiStatic or Static task is stopped or not executable. The possible values here are NoSafety, SysFail, SysHalt or SysStop.</td>
</tr>
<tr>
<td></td>
<td>A SemiStatic or Static task can only be stopped if it has TrustLevel as NoSafety. The TrustLevel is defined by the controller configuration in topic Controller, type Task.</td>
</tr>
<tr>
<td></td>
<td>For information on topic Controller type Task, see the Technical Reference Manual for System Parameters.</td>
</tr>
<tr>
<td>Program Name</td>
<td>The name of the program in the specific task.</td>
</tr>
<tr>
<td>Module Name</td>
<td>The current module name.</td>
</tr>
<tr>
<td>Routine Name</td>
<td>The current routine name.</td>
</tr>
<tr>
<td>Task in Foreground</td>
<td>Use this to set priorities between tasks. The current task will execute only if the foreground task is idle. This is defined by the controller configuration in topic Controller, type Task.</td>
</tr>
</tbody>
</table>

Continues on next page
Task execution state

A task can be activated, started, and stopped from the Controller browser, with the following limitations:

- Only Normal tasks can be activated and deactivated. Background tasks will always be automatically activated.
- Background tasks of type Static and SemiStatic can only be started and stopped if they have TrustLevel NoSafety.
  For detailed information about the different TrustLevel values, see the Technical reference manual - system parameters.
- You need to have write access and the appropriate grant.
- The limitations concerning task execution that hold for the FlexPendant also apply to RobotStudio.

The following table shows cases where task execution state cannot be changed.

<table>
<thead>
<tr>
<th>If...</th>
<th>RobotStudio gives a message that informs the user that...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the user does not have the grant Execute program or Full access</td>
<td>the operation is not possible.</td>
</tr>
<tr>
<td>the user changes from manual mode to automatic mode, or vice versa, the user loses the write access and</td>
<td>the operation is not possible.</td>
</tr>
<tr>
<td>the motors are in off state</td>
<td>the Start operation is not possible.</td>
</tr>
</tbody>
</table>

Note

It is not possible to override the controller’s safety system, that is, you cannot stop a background task (Static and SemiStatic) that has the TrustLevel set to a value other than NoSafety.

For detailed information about the different TrustLevel values, see Technical reference manual - system parameters.

Activating, starting and stopping tasks

To activate a task, right-click the task in the Controller browser and then turn on the Active command.

If the prerequisites are met, you can operate the task, such as start and stop the task, move the program pointer to main and set the run mode.

To start a task, right-click the task in the Controller browser and then click Start Task. You can start Normal tasks, but you can only start a Static or SemiStatic task if the TrustLevel is set to NoSafety.

CAUTION

When starting a task, the manipulator axes may move very quickly and sometimes in unexpected ways! Make sure no personnel is near the manipulator arm!

To stop a task, right-click the task in the Controller browser and then click Stop Task. You can stop Normal tasks, but you can only stop a Static or SemiStatic task if the TrustLevel is set to NoSafety.
The Run Mode indicates the mode of the controller. It has the following two options:

- Continuous
- Single

You can set the run mode of the controller in the following ways:

- On the RAPID tab, in the Controller group, click Run Mode and then click either Continuous or Single.
- This method is only applicable to virtual controllers in a station.

  On the Simulation tab, in the Configure group, click Simulation Setup and then select Continuous or Single in the Setup Simulation dialog box.
12.9.4 Adjust Robtargets

Overview

The Adjust Robtargets feature helps in recalculating and changing the robtarget data (tooldata and workobject data) while maintaining the joint angles of the robot. The robtarget data related to the specified source tooldata and workobject will be adjusted for usage with the new tooldata and workobject.

Prerequisites

- You should have a controller (virtual or real) running with one or more modules containing procedures with a sequence of move instructions expressed with a defined tool and workobject.
- You should have RobotStudio Premium license to use this feature.
- The Execute button of the feature Adjust Robtargets will be enabled only if the selected tool data or workobject data have the same properties, such as robhold, ufprog, ufmech and so on.

Note

Inline targets, arrays, event records, and offsets are not supported. Relative tool is also not supported. Circular move instruction (MoveC) is supported.

Using Adjust Robtargets

Note

Take a backup copy of your modules before adjusting your robtargets.

The following procedure describes the Adjust Robtargets feature in RobotStudio:

1. On the RAPID tab, in the Controller browser, select a RAPID task or module under the RAPID icon. Then click Adjust Robtargets on the RAPID tab. Alternatively, right-click the RAPID task or module in the Controller browser, and then click Adjust Robtargets in the context menu.

Note

You can access Adjust Robtargets from the Controller tab also. Right-click the RAPID task or module in the Controller browser and then click Adjust Robtargets in the context menu.

2. If the module you want to adjust is selected, the go to Step 5. Otherwise continue with the next step.

3. On the RAPID tab, in the Controller group, click Adjust Robtargets.

The Robtarget Adjust dialog box appears.

Continues on next page
4 Select a task from the **Task** drop-down list and module from the **Module** drop-down list.

**Note**

In the **Module** drop-down list, you can either select a particular module or <ALL> to update.

5 Select the source robtarget data (that is, the data defined in the selected task) from **Old tooldata** and **Old wobjdata** drop-down list.

6 Select the destination robtarget data (that is, new tooldata and workobject) from **New tooldata** and **New wobjdata** drop-down list.

7 Click **Execute**.

The **Execute** button is enabled only if source robtarget data (that is, old tooldata and workobject) and destination robtarget data (that is, new tooldata and workobject) are different.

The module searches for move instructions that use the specified old tooldata or workobject and recalculates the robtarget data for the new tooldata and workobject.

For example,

1 Select “tool0” as the source tool and “wobj0” as the source workobject.
2 Select “toolb” as the new tool and “wobjb” as the new workobject.
3 Click Execute.

Robtargets of “tool0” and “wobj0” will be replaced with re-calculated robtargets which correspond to the same robot configuration (all joint angles will be the same), and with the new tool “toolb” and “wobjb”. Note that both the tooldata and the wobjdata are replaced independently.

**Update instruction**

By default, the **Update instruction** check box is selected. This means that move instructions using the specified source (old) tooldata and workobject will be updated to use the target (new) tooldata and workobject in addition to recalculating the robtargets.

If the **Update instruction** check box is cleared, the robtargets will be recalculated, but the move instructions will not be updated. They will still use the source tooldata and workobject.

This feature is useful after the calibration of tooldata and workobject. After calibration, you might still want to use the old names of the tooldata and workobject, but update their values and recalculate the robtargets accordingly. The following sample procedure illustrates how this can be accomplished.

**Sample procedure**

**Prerequisite:** RAPID module with robtargets and move instructions that use uncalibrated tooldata tool1, and workobject wobj1.

1 Calibrate your tooldata tool1, and workobject wobj1. Store the new values in tool1_calib and wobj1_calib, respectively. Keep the old values of the uncalibrated tooldata and workobject in tool1, and wobj1.
2 Open the Adjust robtargets tool and clear the **Update instruction** check box. Select your RAPID module, enter `tool1`, and `wobj1` as your old tooldata and wobjdata, and `tool1_calib`, and `wobj1_calib` as the new tooldata and wobjdata, respectively.

3 Click **Execute**, and apply the changes to the controller from the RAPID Editor.

4 In the RAPID Editor, rename your tooldata `tool1` to `tool1_uncalib`, and `tool1_calib` to `tool1` and apply the changes to the controller. Also, perform the same for `wobj1`.

Now, your robtargets are updated to match the calibrated values of `tool1` and `wobj1`.

**Limitations**

If a robtarget is used more than once but with different tools or workobjects, then a message **Target is referenced** is displayed in the output window.
12 RAPID tab

12.10 Test and debug

12.10.1 Commands for testing and debugging

The Test and Debug group on the RAPID tab consists of the following commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Starts the execution of all normal RAPID tasks in the system.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the execution of all normal RAPID tasks in the system.</td>
</tr>
<tr>
<td>Step over</td>
<td>Starts and executes one statement in all normal tasks in the system.</td>
</tr>
<tr>
<td>Step in</td>
<td>Starts and executes into a routine, while stopping at the begin-ning of the routine.</td>
</tr>
<tr>
<td>Step out</td>
<td>Executes all remaining statements of the current routine, and stops after the call to the current routine.</td>
</tr>
<tr>
<td>Breakpoint: Ignore breakpoints</td>
<td>Ignores all breakpoints during simulation.</td>
</tr>
<tr>
<td>Breakpoint: Toggle breakpoint</td>
<td>Toggles a breakpoint at the cursor.</td>
</tr>
<tr>
<td>Check Program</td>
<td>Verifies the syntactic and semantic correctness of the RAPID modules.</td>
</tr>
</tbody>
</table>

Other tools such as the Program Pointer (PP) and the RAPID Profiler, which aid in testing and debugging RAPID code, are explained in detail in the following sections.
12.10.2 Using the Program Pointer

How the Program Pointer helps

During program execution, the Program Pointer (PP) points to the line of code that is currently executing.

The function Follow Program Pointer keeps the program pointer visible during program execution by automatically scrolling the RAPID editor window according to the movements of the program pointer. To enable the function, in the Test and Debug group on the RAPID tab, click the arrow next to the Program Pointer icon and then select Follow Program Pointer.

Note

While the program executes, you can see the program pointer jump across modules only if those modules are already open in the editor. Hence, you can decide in which modules you wish to follow the program pointer in, and keep them open.

The other commands in the Program Pointer menu are:

- Go To Program Pointer – To show the current location of the program pointer in the RAPID editor
- Go To Motion Pointer – To show the current location of the motion pointer in the RAPID editor
- To set the program pointer at a particular line code or code segment and then start program execution from that point, use the Set Program Pointer options. You can choose from the following options:
  - Set Program Pointer to Main in all tasks
  - Set Program Pointer to Cursor
  - Set Program Pointer to Routine

Maintaining the Program Pointer

The RAPID code can only be edited when the controller is not running, that is when it is in state Ready or Stopped. In Ready state the program pointer is not set, but in Stopped state the Program Pointer is set to a specific location of the program. For limited changes to the RAPID code of a controller in Stopped state, the current location of the program pointer can be maintained. After such an edit you can resume program execution from where it was without having to reset the program pointer.

Note

If the edit is too large for the program pointer to be maintained then a warning message is displayed to convey this.

The program pointer cannot be maintained, for example, when editing the line of code at which the program pointer is located. Editing that line of code results in

Continues on next page
resetting the program pointer. In effect, the program will start from the beginning when the controller is started after the edit.

**WARNING**

Starting program execution after the program pointer has been reset will cause the robot to move along the shortest path from its current location to the first point of the program.
12.10.3 Using the RAPID Profiler

What's RAPID Profiler

The RAPID Profiler analyzes the execution times on procedure level, identifies critical procedures and reports these during the execution of RAPID code.

Prerequisites for using the RAPID Profiler

- You should have RobotStudio Premium license to use this feature.
- You should have a controller with one or more executable tasks running.
- When using the RAPID Profiler with a real controller, you require more than 25 MB of free controller disk space.

Note

The RAPID Profiler will automatically stop if either of the following controller events is generated by the controller. This is to avoid disturbing the robot operation.

- 20192, Disk memory low (less than 25 MB free storage left)
- 20179, Disk memory critically low (less than 10 MB free storage left, program execution is stopped)

How to use the RAPID Profiler

To use the RAPID Profiler:

1. Set the Program Pointer at a desired point in the RAPID code from where you wish to start your analysis. For example, set the program pointer to Main in all tasks.
2. On the RAPID tab, in the Test and Debug group, click the arrow next to the RAPID Profiler icon and then click Start.
3. Start the simulation.
   In the background the RAPID Spy feature logs the data about the program’s execution.
4. After the program execution ends, click the arrow next to the RAPID Profiler icon and then click Stop.
5. On the RAPID tab, in the Test and Debug group, click the arrow next to the RAPID Profiler icon and then click Analyze.
   The RAPID Profiler window appears, showing the results of the analysis.
   Click Export to Excel to export the results to a Microsoft Excel spreadsheet file.
   To view the log file of the analysis, click the arrow next to the RAPID Profiler icon and then click Open log file.

Execution of the Rapid Profiler based on RobotWare version

Depending on the RobotWare version, the RAPID Profiler is executed in one of the following methods:

- For controller systems with RobotWare versions prior to 5.14, the RAPID instructions SpyStart and SpyStop must be inserted at the RAPID execution...
start and end, respectively. When the program is run, a Spy log file is generated. You can open the file for analysis by the RAPID Profiler. Use the RAPID Profiler menu option *Browse for Spy log* to open the log file.

For more information about Spy instructions, see *Technical reference manual* - *RAPID Instructions, Functions and Data types*.

**Note**

When the RAPID Profiler is used to analyze a log file, there is no information about in which procedure the *SpyStart* command is executed. The triggering procedure defaults to `<SpyStart Procedure>`.

- For RobotWare version 5.14 or later, the log file can be generated automatically. Activate the RAPID Profiler and run the program of the controller. When the program execution stops, the results are presented to the user.
12.11 RAPID Watch window

Viewing variables and I/O signals

The RAPID Watch window displays the following details of selected variables and I/O signals during program execution.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays variable name</td>
</tr>
<tr>
<td>Value</td>
<td>Displays variable value</td>
</tr>
<tr>
<td>Type</td>
<td>Displays type of datatype</td>
</tr>
<tr>
<td>Source</td>
<td>Displays system name</td>
</tr>
</tbody>
</table>

You can view and edit the RAPID data of the variables in the RAPID watch window, both during program execution and when the controller is stopped. However, you can only view, but not edit, I/O signals in the watch window.

To view a variable or I/O signal in the RAPID Watch window, you need to first add it to the window. In the RAPID editor, right-click the required variable or I/O signal, and then click Add Watch.

By default, during program execution the values of the variables are automatically refreshed in the watch window every 2 seconds. You can also manually refresh the values.

To enable or disable automatic refresh, in the context menu, select or clear the Auto Refresh command.

To do a manual refresh, in the context menu, click Refresh (keyboard shortcut F5).

Note

- CONST variables cannot be edited.
- On closing RobotStudio, the variables and signals added to the watch window are removed.

On the RAPID Watch window, right-click to display the following context menu:

<table>
<thead>
<tr>
<th>Item</th>
<th>Used for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copying the value</td>
</tr>
<tr>
<td>Paste</td>
<td>Pasting the copied value</td>
</tr>
<tr>
<td>Delete</td>
<td>Deleting the watch item</td>
</tr>
<tr>
<td>Select All</td>
<td>Selecting all the items</td>
</tr>
<tr>
<td>Clear All</td>
<td>Clearing all the variables and signals from the watch window</td>
</tr>
<tr>
<td>Refresh</td>
<td>Manually updating the values of the variables and signals</td>
</tr>
<tr>
<td>Auto Refresh</td>
<td>Automatically refreshing the values displayed in the watch window at regular intervals</td>
</tr>
</tbody>
</table>
12 RAPID tab

12.12 Examples of using the RAPID editor

Overview

This section provides examples illustrating several useful functions of the RAPID editor including IntelliSense, code snippets and the watch window.

Editing

Assume that you wish to create an infinite loop whereby the controller receives commands from a line PLC. The controller communicates with the PLC using digital I/O signals, but you have forgotten the exact name of the function that reads an input signal.

1. Using code snippets, create a new procedure.
2. On the Rapid tab, in the Insert group, click Instruction.
   A drop-down list of available instructions is displayed.
3. On the Instruction menu, point to I/O, and then click DOutput.
4. Press the spacebar to display the parameter information ToolTip. As you enter parameters, the ToolTip is updated, displaying the current argument in bold. The ToolTip is closed either by concluding the instruction with a semicolon (;), or by pressing ESC.

Tip

At any time you may press CTRL + Spacebar to complete what you have begun typing. This will either bring up a narrowed-down list of selectable parameters, or, if only one selection remains, will automatically complete your text.

Tip

After typing the name of an identifier or an instruction, press the TAB key to automatically fill in the default arguments or parameters. For instructions, the last used argument of each type will be used.

Searching

Assume that you have programmed targets and motion instructions and synchronized them to the controller. The number of targets is large, so you decide to distribute them among several modules.

You may have forgotten in which module your main procedure is found.

1. Press CTRL + F to bring up the Find and Replace dialog box.
2. In the Find what box, type "PROC main". Since no modules are open, in the Look In list, select Current System, and then click Find All.
   The search result is displayed in the Search Results window.
3. Double-click the line matching your search to launch the RAPID editor.

Continues on next page
Adding breakpoints

Now that you have finished editing, you may want to test your loop and add some breakpoints.

1. Place the insertion on the new statement and press F9 to set a breakpoint.
2. Ensure that the Ignore breakpoints button in the editor toolbar is not clicked, and click the Play button on the Simulation toolbar.
   The program will run and then stop at the breakpoint.
3. To run the program statement by statement, click the Step over button in the editor toolbar.

Executing

You might want to debug your loop or monitor a specific variable.

1. In the RAPID editor browser, right-click the procedure you want to set as entry point, and then click Set Program Pointer to Routine.
2. In the RAPID tab, click the Play button.
   The program will run and then stop at the next breakpoint.
3. Select a variable for monitoring and drag it to the watch window.
4. Restart the loop and monitor the variable at each iteration.
This page is intentionally left blank

The Add-Ins browser shows the installed PowerPacs, General add-ins and VSTA add-ins.

You can use Visual Studio Tools for Applications for creating your own VSTA add-ins.

For instruction on building General add-ins visit the ABB Robotics Developer Center web site at http://developercenter.robotstudio.com.

General add-ins are loaded from the following folder on your PC:

C:\Program Files (x86)\Common Files\ABB Industrial IT\Robotics IT\RobotStudio\Addins

**Note**

For the RobotStudio 5.15 64-bit edition:

- PowerPacs, Visual Studio Tools for Applications, and any customized add-ins that use PC-SDK are not supported
- Add-ins will be loaded from the following folder:

  C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.15\Bin64\Addins

  This is the path on a PC with Microsoft Windows 7 64-bit English version, on default installation. For customized installations and for operating system versions in other languages, this path may differ.
13 Add-Ins tab

13.2 Building a VSTA add-in

13.2 Building a VSTA add-in

1  On the Add-Ins tab, click Visual Studio Tools for Applications.
2  Create a new project or open an existing one. Compose or edit as required.
3  To build the add-in, from the Build menu, click Build.
   The add-in will be loaded in RobotStudio and appear as a user add-in in the Add-In browser.
4  Save the project to your hard disk if you want the add-in to remain with the user. Otherwise, open a station, right-click in the Add-In browser and then click Add to Station.
13.3 Gearbox Heat Prediction

Overview

The Gearbox Heat Prediction Tool is an add-in for RobotStudio which helps predict heat problems in the gearboxes. When the temperature is above a predefined value, you can adjust the cycle to reduce the temperature or order a fan that can cool down the gear.

Robots with compact gearboxes have a risk of getting overheated under certain circumstances. The gearbox temperature is supervised by Service Information System (SIS). It is a software function within the robot controller, that simplifies maintenance of the robot system. It supervises the operating time and mode of the robot, and alerts the operator when a maintenance activity is scheduled. It also supervises large robots from damaging the motors during high load operations with a safety shutdown.

The temperature supervision is based on an algorithm that predicts the stationary temperature of the gearboxes and motors of the robot. The algorithm predicts the heat based on the character of the robot motion and also the room temperature. Intensive motion (high average speed and/or high average torque and/or short wait time) will increase the heat of the gearbox and motors.

To avoid overheat, SIS stops the robot if the temperature becomes too high. For large robots, there is an option to add a cooling fan to axis 1, 2 and sometimes axis 3 to allow the robot to run even with a heavy duty program.

Note

Gearbox Heat Prediction is not supported for Tool and External axis.

Prerequisites

1 RobotStudio 5.14.02 or later.
2 RobotWare 5.14.01 or later.
3 RobotStudio station with controller having a programmed cycle that includes payload for the robot.

Calculating the Gearbox Heat

Use the following procedure for predicting the heat generated by the robot:
1 Create a new station or open a saved station. See New on page 188
   The Gearbox heat button is now visible in the Add-Ins tab.
2 In the Add-Ins tab, click Gearbox Heat.
   The Gearbox Heat Prediction window opens.
3 In the Add-Ins tab, select Enabled to enable the Gearbox Heat Prediction tool.

Note

For a manipulator without compact gear, Gearbox Heat Prediction is disabled.

Continues on next page
4 Run a simulation. See *Running a simulation on page 330*

**Note**

If the RobotStudio license is expired, the Play button in the Simulation tab will be disabled. As such, you will be unable to run the simulation from the Simulation tab. In such a scenario, use the Play button which will now be visible in the Gearbox Heat Prediction tab window to run the simulation.

**Note**

The data is recorded during the simulation only if the Gearbox Heat tool is enabled. After the recording is finished, you can perform another recording or perform a calculation for heat related problems.

5 In Cycles, define the behavior of the cycle for predicting the heat generated by the robot:

- **Continuous**: Select this option if you want the robot to continuously calculate the predictions without waiting time between two consecutive cycles.
- **Number of cycles per hour**: Select this option if you want to manually specify the number of cycles per hour for calculation.
- **Waiting time between cycles (sec)**: Select this option to specify the waiting between cycles. Specify the waiting time in seconds.

6 In Ambient Temperature, define the ambient temperature.

- Use the slider to change the temperature.
- Select *Use temperature from controller(s)* to reset the ambient temperature.

**Note**

The ambient temperature used in the calculations should be the same that is used in the configuration of the actual robot in its real environment.

7 Calculate the result in either of the following ways:

- In the Recordings section, either *double-click* a recording or select a recording and click *Calculate*.
- In the System section, either *double-click* a controller or select a controller and click *Calculate*.

**Note**

- The Recordings section displays the recordings to be analyzed when Gearbox Heat Prediction is enabled.
- The System section displays all the available controllers. Data for all controllers are recorded at all times and you can select the controller to be analysed from the list.
The results are displayed for each joint and with fans for the joints that can have fans installed as an option.

**Note**

The following factors influence the heat accumulated:
- Axis speed
- Payload
- Room temperature (ambient temperature)
- Waiting time (to allow robot to cool down)

**Note**

The calculated energy is displayed as different heat levels:
- **Green**: Indicates no heat problem
- **Orange**: Indicates it is recommended to install a fan.
- **Red**: Indicates a fan must be installed.
- **Grey**: Indicates it is not possible to calculate the possible energy level for this joint.
- **Not available**: Indicates the joints that cannot have a fan installed.

**Note**

Recommended action is displayed along with the warning level for each joint.
- **Joint**: Represents the joint.
- **Without fan**: Displays the percentage of heat levels calculated to the corresponding joint without fan.
- **With fan**: Displays the percentage of heat levels calculated to the corresponding joint with fan.
- **Action**: Displays the recommended action.
13.4 Integrated Vision

The Integrated Vision system add-in provides a robust and easy-to-use vision system for general purpose Vision Guided Robotics (VGR) applications. The system features a complete software and hardware solution that is fully integrated with the IRC5 robot controller and the RobotStudio programming environment. The vision capability leverages on the Cognex InSight® smart camera family, with embedded image processing and an Ethernet communication interface.

RobotStudio has been equipped with a vision programming environment that exposes the full palette of Cognex EasyBuilder® functionality with robust tools for part location, part inspection and identification. The RAPID programming language has been extended with dedicated instructions and error tracing for camera operation and vision guidance.

For more information, see Application manual - Integrated Vision
14 Context menus

14.1 Add to Path

Creating a move instruction based on an existing target

1. Select the target for which to create the move instruction.
2. From the Home menu, in the Path Programming group, select the type of move instruction to create.
3. Click Add to Path.

The move instruction will appear under the path node as a reference to the original target.
14 Context menus

14.2 Align Frame Orientation

14.2 Align Frame Orientation

The Align Frame Orientation dialog box

<table>
<thead>
<tr>
<th>Reference</th>
<th>Specify the frame or target for which you want to align the selected objects here.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Axis</td>
<td>The axis you specify here will be aligned as on the reference target/frame for all selected objects.</td>
</tr>
<tr>
<td>Lock Axis</td>
<td>The axis you specify here will not be changed on the selected objects by the align function, but will keep its orientation.</td>
</tr>
</tbody>
</table>
14.3 Align Target Orientation

Aligning target orientation

1. Select the targets whose orientation you wish to change.
2. Click Align Target Orientation to bring up a dialog box.
3. In the Reference box, specify the target whose orientation you want to use as reference, by first click in the box and then selecting the target either from the graphics view or the Layout browser.
4. In the Align Axis box, select the axis whose orientation you want to copy from the reference target to the selected ones.
5. In the Lock Axis box, select the axis to rotate the target around. The orientation of this axis will not be changed on the targets. For example, if the Z axis of all targets are orientated normally to the surface of the work piece and you want to keep it this way, you should lock the Z axis.
6. Click Apply.

Tip

You can change the Align and Lock axis and click Apply again to reorientate the targets until you deselect them.
14 Context menus

14.4 Attach to

14.4 Attach to

Attaching an object

1 In the Layout browser, right-click the child object, click Attach to and click the parent object in the list.

Attaching an object by drag and drop

1 In the Layout browser, drag the child object to the parent object.
2 In the displayed message, click the corresponding button:

<table>
<thead>
<tr>
<th>To</th>
<th>Click</th>
</tr>
</thead>
<tbody>
<tr>
<td>attach the child object and move it to</td>
<td>Yes</td>
</tr>
<tr>
<td>the attachment point</td>
<td></td>
</tr>
<tr>
<td>attach the child object and keep its</td>
<td>No</td>
</tr>
<tr>
<td>position</td>
<td></td>
</tr>
<tr>
<td>not perform the attachment</td>
<td>Cancel</td>
</tr>
</tbody>
</table>
14.5 Configurations

Auto Configuration

Use this procedure for setting the configuration of all targets in the path that are marked as *The configuration is not verified*:

**Note**

For all targets in the path, the function will ignore any existing unverified configuration and replaces it with optimal configuration with respect to the configuration of the preceding target.

1. In the Paths&Targets browser, right-click a path, select Configurations and then select Auto Configuration.

The robot now steps through each target in the path and sets the configurations.

**Note**

- If the first target in the path has no configuration assigned, then the configurations tool appears.
- If the first target has a configuration assigned, then the one assigned will be used.

The result of auto configuration varies depending on the configuration of the first target.

The configuration for targets in the path that have a verified configuration, will not be re-assigned.

Reset Configurations

The configuration data which is a part of the target, when reset, is optimized by Auto Configuration. As a result, the target / move instruction icon will change and is marked as *The configuration is not verified*.

Use this procedure for resetting the configuration:

**Note**

You can reset the configuration of a path, target, or move instruction.

1. In the Paths&Targets browser, right-click a path, select Configurations and then select Reset Configurations.

**Note**

To reset the configuration of a target or move instruction,
In the Paths&Targets browser, right-click a target or move instruction, and select Reset Configuration.
Verify Configurations

Use this procedure for verifying the existing configuration:

Note

Targets and Move instructions marked as *The configuration is not verified* can be verified with respect to the configuration.

1. In the Paths&Targets browser, right-click a path, select Configurations and then select Verify Configurations.

Note

If the existing configuration is correct, then the move instruction is set as verified.
If the configuration is incorrect, then the target is set as unreachable.
14.6 Check Reachability

Checking the reachability

You can use the Check Reachability function to check whether targets are reachable or not. If you select a path for the check, then the reachability of all move instructions in the path is checked. This function provides an easy reachability check which you can use for initial positioning of the robot, its workobject, paths and targets.

The Check Reachability function ignores the robot axis configuration. The function indicates a target as being reachable if it can be reached with any robot axis configuration, and ignores the defined robot axis configuration.

Note

The Check Reachability feature does not verify whether a path can be executed or not.

1. In the Paths&Targets browser, right-click the workobject or target or path to be checked for reachability.
2. Click Reachability to see the reachability status of the selected object.

The frames for the selected object change color in the graphic window based on the reachability status.

<table>
<thead>
<tr>
<th>Color</th>
<th>Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>The object can be reached.</td>
</tr>
<tr>
<td>Red</td>
<td>The object cannot be reached at its current position.</td>
</tr>
</tbody>
</table>
14 Context menus

14.7 Configurations

14.7 Configurations

Manually setting a robot axis configuration for single targets

1. In the Paths&Targets browser, select a target and then click Configurations to bring up a dialog box.

2. If more than one configuration solution exist, examine them by clicking them, one at a time.
   The position of the robot with the selected configuration will be displayed in the graphics window, and the joint values for the configuration will be displayed in the joint values list below the configurations list.
   In most cases, selecting a configuration similar to the previous one is the best choice.

3. Select the configuration to use and click Apply.
14.8 Convert Frame to Workobject

Converting a frame to a workobject

1. In the Layout browser, select a frame.
3. Optionally, rename or edit the workobject in any way.
14.9 Convert to Move Circular

Prerequisites
At least two targets, the via-point target and the end point target, must have been created.
A path containing at least the via-point target and the end point target, in correct order, must have been created.

Converting to Move Circular

1 In the Paths & Targets browser, expand the path node that contains the move instruction to be converted.
2 Select the move instruction that contains the via-point of the circular motion together with the succeeding move instruction, which will serve as the end point. You can select several instructions by holding down the SHIFT key while clicking the instructions.
3 Click Convert to Move Circular. The two selected move instructions will be converted to a circular move instruction, which includes the via-point and the end point.

Tip
To convert two move instructions to a circular motion, you can also select and right-click both move instructions at once and then click Convert to Circular.
14.10 Copy / Apply Orientation

Copying and applying an orientation

1. In the browser, select the object or target from which to copy the orientation.
2. On the Modify menu, click Copy Orientation.
3. In the browser, select the object or target to which to apply the orientation.
4. On the Modify menu, click Apply Orientation. This can be performed on several targets or a group of selected targets.
14 Context menus

14.11 Detach

14.11 Detach

Detaching an object

1. In the Layout browser, right-click the attached object (child) and then click Detach. The child will be detached from the parent and return to its position before the attachment.
14.12 Execute Move Instruction

Prerequisites

The move instruction must exist.
A virtual controller must be running for the robot with the move instruction.

Executing a move instruction

1. In the Paths&Targets browser, browse to the motion instruction to execute through the Controller, Tasks and Paths nodes.
2. Click Execute move instruction. The TCP of the active robot will move from the current location to the motion instruction according to the programmed motion properties. If the target for the motion instruction does not have a stored configuration, the robot will use the configuration nearest the current one.
14 Context menus

14.13 External Axis Interpolation

14.13 External Axis Interpolation

Prerequisites
You need to have a path selected and a robot with external axis configured.

Interpolating external axis
1 In the Paths&Targets browser, select a path, right-click and select Interpolate External Axis.
   The Interpolate External Axis dialog box appears.
2 Select the mechanical unit from the Mechanical Unit drop-down list.
3 Select the axis to interpolate from the Axis drop-down list.
4 In the Interpolation drop-down list,

<table>
<thead>
<tr>
<th>select...</th>
<th>to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>set a constant value for the axis in each robtarget. You can set the value from the Value drop-down list.</td>
</tr>
<tr>
<td>TCP Offset</td>
<td>calculate an axis value such that the</td>
</tr>
<tr>
<td></td>
<td>• For a linear axis, robot base is translated the offset distance relative to the target along the axis direction.</td>
</tr>
<tr>
<td></td>
<td>• For a rotating axis, external axis value is calculated so that the angle between the TCP approach direction and the rotational axis zeroposition is kept constant at the offset angle.</td>
</tr>
</tbody>
</table>

5 Click Apply.
14.14 Graphic Appearance

Overview

With the graphic appearance dialog box you set the graphic properties for an individual object. The settings made here override the generic settings made in the options dialog box. The dialog box contains one view group where you select the part of the object to affect, and three tabs with settings.

Graphic Appearance: The View group

| Selection | Select the parts of the object whose appearance you wish to change. When Body or Surface/Curve is selected, you select the object to work with in the preview display. To change the appearance of a part:
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. On the Modify menu, click Graphic Appearance. A color box with the following options appears - Metals, Light colors, medium colors, Dark colors.</td>
</tr>
<tr>
<td></td>
<td>2. Select any of the options to change the appearance.</td>
</tr>
</tbody>
</table>

Graphic Appearance: The Rendering tab

<table>
<thead>
<tr>
<th>Backface culling</th>
<th>Select this check box to view only the front sides (the direction of the positive normal) of the faces in the model. This improves the graphics performance and indicates the directions of the faces in the model. Clear this check box to also display the back sides of the faces in the model. This ensures that the model is displayed correctly even if the faces are in the wrong direction. If a model with faces in the wrong direction is used for programming, you might get unpredicted results.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Twosided lightning</td>
<td>Select this check box to light the object from two sides. Clear this check box to light the object from one side.</td>
</tr>
<tr>
<td>Flat shade</td>
<td>Select this check box to change the appearance of shades.</td>
</tr>
<tr>
<td>Flip normals</td>
<td>Click this button to change the direction of all faces on the model.</td>
</tr>
<tr>
<td>Line width</td>
<td>Specify the width of lines in the object here.</td>
</tr>
<tr>
<td>The detail level options</td>
<td>Select the detail level of the model here. Only the levels selected in the Options dialog box when the object was created or imported are available.</td>
</tr>
</tbody>
</table>

Graphic Appearance: The Colors tab

| Simple Color     | Click this color box to select another color for the object.                                                      |
| Transparency     | Use this slider to control the transparency of the object.                                                        |
| The color boxes  | Set the color of the object for different light situations here.                                                  |
| Shininess        | Specify the reflectiveness of the object here.                                                                     |

Continues on next page
### Graphic Appearance: The Textures tab

<table>
<thead>
<tr>
<th>Effect</th>
<th>Specifies the type of graphic effect to be used on the selected part.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Basic: Simple texturing/environment mapping or just a solid color.</td>
</tr>
<tr>
<td></td>
<td>• Anisotropic: Brushed metal effect simulating an anisotropic light model</td>
</tr>
<tr>
<td></td>
<td>• Bump Mapping: Texture that specifies the bumpiness of the surface</td>
</tr>
<tr>
<td></td>
<td>• Parallex Mapping: Improved version of bump mapping</td>
</tr>
</tbody>
</table>

#### Note
Anisotropic, Bump Mapping and Parallex Mapping requires DirectX9-class hardware to be correctly displayed in the 3D window.

<table>
<thead>
<tr>
<th>Base texture</th>
<th>Specifies the basic structure of the selected part. It is a standard 24-bit image displayed on a 3D surface.</th>
</tr>
</thead>
</table>

#### Note
Transparency of textures is provided only for .png images.

<table>
<thead>
<tr>
<th>Environment map</th>
<th>Provides a highly reflective appearance to the surface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal/Bump Map</td>
<td>Specifies a texture that defines the bumpiness of the surface. This option is enabled only during Bump mapping and Parallex mapping effect.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Blend with material</th>
<th>Select this check box to blend the texture with the colors and properties specified on the Material tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swap u/v</td>
<td>Click this button to swap the horizontal and vertical directions of the texture.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Modify</th>
<th>Select along which directions the commands listed below shall be applied. u is the horizontal axis of the texture. v is the vertical axis of the texture.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Normalize</th>
<th>Click this button to set the ratio between the dimensions of the object and the texture to 1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip</td>
<td>Click this button to invert the coordinates along the selected axes. This is the same as mirroring around the other axis.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stretch</th>
<th>Click this button to stretch the texture along the selected axes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shrink</td>
<td>Click this button to shrink the texture along the selected axes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Shift &lt;</th>
<th>Click this button to move the texture along the selected axes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift&gt;</td>
<td>Click this button to move the texture along the selected axes.</td>
</tr>
</tbody>
</table>
14.15 Go to Visualization and Go to Declaration

**Go to Visualization**

The **Go to visualization** context menu command is available for targets in the RAPID editor. It takes you to the 3D graphical widow to show you where the target is found.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>This command requires that the RAPID code has been synchronized to the station.</td>
</tr>
</tbody>
</table>

**Go to Declaration**

In the Paths & Targets browser, the **Go To Declaration** context menu command is available for targets. This command takes you back to the target in the RAPID editor.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>This command requires that the RAPID code has been synchronized to the virtual controller.</td>
</tr>
</tbody>
</table>
14 Context menus

14.16 Interpolate Path

14.16 Interpolate Path

Reorienting targets in a path by interpolation

1. In the Layout browser or the graphics window, select the path with the targets to reorient.
2. Click Interpolate Path. to bring up a dialog box.
3. With the Interpolate type options, select whether to use Linear or Absolute interpolation.
   Linear interpolation distributes the difference in orientation evenly, based on the targets' positions along the length of the path. By contrast, absolute interpolation distributes the difference in orientation evenly, based on the targets' sequence in the path.
4. If using the Select Start/End option, select the start and end targets for the interpolation in the Start target and End target boxes, respectively.
5. Optionally, with the Lock Axis options, select an axis to lock.
6. Click Apply.
14.17 Invert

Inverting the direction of a face

1. Right-click in the Modeling browser, point to Filter and make sure that both Show Bodies and Show Faces are selected.

2. In the Modeling browser, expand the node for the object and browse down to and select the face which direction you want to invert.

3. In the Modeling browser, expand the node for the object and browse down to and select the face whose direction you want to invert.

4. Click Invert. If the option backface culling is activated, the face will now shift from visible to not visible, or the other way around, depending on from which direction you view the face. If backface culling is deactivated, there will be no visible indication that the direction of the face has been inverted.
Jumping to a target

1. In the Paths&Targets browser, browse to the target to jump to through the Controller, Tasks and WorkObjects nodes.

2. Click Jump to target.
   
   If the target has a valid configuration for the robot axes stored, the active TCP of the robot will immediately be positioned at the target. If no valid configuration is stored, the Select Robot configuration dialog box is displayed.

3. In the Select Robot Configuration dialog box, select a suitable configuration solution and click Apply. The selected configuration is now stored with the target.

**Note**

You can deactivate the configuration check when jumping to targets. The robot will then use the configuration solution closest to the current one when reaching the target. For more information, see Options on page 193.
14.19 Linked Geometry

Overview

The Linked Geometry feature allows you to load geometry from a shared repository. If the source file is updated, then the station will be updated with a single click.

Adding Link

You can add a link to a geometry in two ways:

1. In the Home tab, click Import Geometry to open a dialog box. Select the option Link to Geometry.
2. In the Layout browser, right-click an existing part in the station and select Add Link. A dialog box opens where you can select the CAD file to be linked.

Editing Link

To edit an existing link:

1. In the Layout browser, right-click an existing part in the station.
2. Select the option Link to Geometry and click Edit Link.

Deleting Link

To delete an existing link:

1. In the Layout browser, right-click an existing part in the station.
2. Select the option Link to Geometry and click Delete Link.

Updating Linked Geometry

To update a linked geometry:

1. In the Layout browser, right-click an existing part in the station, component group or the station.
2. Select the option Link to Geometry and click Update Linked Geometry. The update result is displayed in the output window.

Note

When you select a component group or a station, all linked geometries within the group or station is updated. If the timestamp on the file is newer than the timestamp stored in the station, all corresponding parts will be updated from the source location.
14 Context menus

14.20 Modify Library Component

14.20 Modify Library Component

Modifying a library component

1 In the Layout browser, select the library you wish to modify.
2 Click Disconnect Library.
3 Select the library and then make any modifications to it.
4 Select the modified library, and then click Save As Library.
14.21 Mechanism Joint Jog

**Jogging the joints of a robot**

1. In the Layout browser, select the robot.
2. Click Mechanism Joint Jog to bring up a dialog box.
3. Each row in the Jog Joints dialog box represents a joint of the robot. Jog the joints either by clicking and dragging the bar at each row, or by using the arrows to the right of each row.

Set the length of each step in the Step box.

### The Mechanism Joint Jog dialog box

<table>
<thead>
<tr>
<th>Joint</th>
<th>Move the joints of the objects by dragging the slider on the row corresponding to each joint. Alternatively, click the buttons to the right of the row, or type a value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cfg</td>
<td>The current configuration value.</td>
</tr>
<tr>
<td>TCP</td>
<td>The current position of the TCP.</td>
</tr>
<tr>
<td>Step</td>
<td>Specify the length of the joint movements for each click of the buttons to the right of each joint row.</td>
</tr>
<tr>
<td>External Axis</td>
<td>If the robot uses external axes, you can select an axis to jog from this list. The external axes must belong to the same task as the object you are jogging for occurring in this list. If no external axes are present in the same task, this list is not available.</td>
</tr>
<tr>
<td>Lock TCP</td>
<td>Select this check box to reposition the robot according to the jogging of the external axis. For track-external axes the robot will reposition so that the TCP is locked relative to the world coordinate system. For positioner-external axes the robot will reposition so that the position of the robot’s TCP is locked relative to the attachment point of the positioner. The robot will move with the positioner the same way as when using multi-robot jog. If no external axes are present in the same task, this check box is not available.</td>
</tr>
<tr>
<td>External axes joint</td>
<td>Move the joint of the external axes by dragging the slider on the row corresponding to each joint. Alternatively, click the buttons to the right of the row, or type a value. If no external axes are present in the same task, this check box is not available.</td>
</tr>
</tbody>
</table>

### Jogging a conveyor

1. Create Empty Path. See Empty Path on page 222.
2. In the Layout browser, select the conveyor.
3. Right-click Conveyor Mechanism and select Mechanical Joint Jog.
   The Joint Jog dialog box appears.
4. Jog the conveyor by moving the slider and click Teach Instruction.
   A move instruction is added to the path.

*Continues on next page*
Note

When you jog the conveyor mechanism, objects on the conveyor are also moved.

• If you jog the conveyor mechanism beyond the maximum distance, the workobject will be dropped.

• If you jog the conveyor mechanism beyond the zero position, the workobject that belongs to the first part is attached to the conveyor attachment point. If the workobject is dropped in Teach Mode, you can jog the conveyor backwards to connect it again.
14.22 Mechanism Linear Jog

Jogging the TCP of a robot by using the Linear Jog dialog box

1. In the Layout browser, select the robot.
2. Click Mechanism Linear Jog to bring up a dialog box.
3. Each row in the Linear Jog dialog box represents a direction or rotation for the TCP. Jog the TCP along the preferred direction or rotation, either by clicking and dragging the bar at each row, or by using the arrows to the right of each row.
4. From the Reference list, you can select the coordinate system that you want to jog the robot relative to.
5. In the Step box, specify the step movement per deg/rad.
The Mirror Path dialog box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate</td>
<td>Select this option to keep the existing path when mirroring.</td>
</tr>
<tr>
<td>Replace</td>
<td>Select this option to remove the existing path after mirroring.</td>
</tr>
<tr>
<td>X-Y, X-Z and Y-Z</td>
<td>Select the plane to mirror the path around with these options. The plane is defined by the selected axes and position of the reference coordinate system selected below.</td>
</tr>
<tr>
<td>Reference</td>
<td>Select the frame or coordinate system to define the mirror plane in. To use another frame than any of the predefined ones, select Select Frame from the list and specify the frame in the box below.</td>
</tr>
<tr>
<td>Select Frame</td>
<td>If Select Frame is used as Reference frame, specify the frame to use here by first clicking in the box and then selecting the frame from the graphics window or the Layout browser.</td>
</tr>
<tr>
<td>Flip axis X/YZ</td>
<td>Select one of these options to mirror the orientation of the targets. When any of these are selected, the robot will approach the targets in a mirrored way. The axis you select will change the most for achieving the mirrored orientation, while the other one will be kept as near to its current direction as possible. The axis that is set to the robot’s approach vector cannot be selected.</td>
</tr>
<tr>
<td>Keep orientation</td>
<td>Select this option to keep the orientation of the targets. When selected, the robot will go to the mirrored position, but approach the target from the same direction as for the original target.</td>
</tr>
<tr>
<td>Mirror Robot Configuration</td>
<td>Select this option to also mirror the robot axis configuration for the targets. Selecting this option will mirror the robot’s motions completely. For using this option, the following conditions must be met: - The Reference frame must be set to Baseframe. - The Mirror plane must be set to X-Z. - The tool of each move instruction must have its TCP in the X-Z plane of tool0. - All targets in the path must have robot axis configuration set. - The virtual controller must be running.</td>
</tr>
<tr>
<td>More / Less</td>
<td>Click this button to show or hide the commands for naming and location of generated targets and paths.</td>
</tr>
<tr>
<td>New path name</td>
<td>Specify the name of the path that will be generated by the mirroring here.</td>
</tr>
<tr>
<td>Target prefix</td>
<td>Specify a prefix for the targets that will be generated by the mirroring here.</td>
</tr>
<tr>
<td>Receiving robot</td>
<td>Specify the robot task in which the new targets and path shall be created.</td>
</tr>
<tr>
<td>Receiving work object</td>
<td>Specify the work object in which the new targets shall be created.</td>
</tr>
</tbody>
</table>
14.24 Mirror

Mirroring a part

1 In the Layout browser, select the part to mirror and right-click.
2 Select Mirror and then click one of the following options from the context menu:

<table>
<thead>
<tr>
<th>select...</th>
<th>to create a new part..</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mirror YZ</td>
<td>around YZ plane</td>
</tr>
<tr>
<td>Mirror ZX</td>
<td>around ZX plane</td>
</tr>
<tr>
<td>Mirror XY</td>
<td>around XY plane</td>
</tr>
</tbody>
</table>

Note

The mirror feature is applicable only to objects of type body and part that contains geometry. Parts and and bodies that are imported without geometry cannot be mirrored. See Libraries, geometries and CAD files on page 36.

For information on mirroring a path, see Mirror Path on page 460.
14 Context menus

14.25 Modify Curve

**14.25 Modify Curve**

**Extending a curve with a straight line in the direction of the curve’s tangent**

1. Click **Modify curve** to bring up a dialog box.
2. Select **Extend** as modify method and then click the curve segment, close to the appropriate vertex.
   
   Note that when you rest the pointer over the curve the endpoint closest to the pointer is highlighted. This is the endpoint that will be selected for extension when you click the curve.
3. In the **Distance from endpoint** box, enter the length of the extension. In the graphics window a yellow line displays a preview of the extension.
4. Click **Apply**.

**Joining curves**

1. Click **Modify curve** to bring up a dialog box.
2. Select **Join** as modify method and then click the curves to join in the graphics window. The curves may be either intersecting or adjacent to be joined.
   
   The **Selected curves** list displays the curves that will be joined. To remove a curve from the list, select the list entry and press the **DEL** key.
3. In the **Tolerance** list, enter a value in millimeters. Adjacent curves whose end points lie within the tolerance will be valid for the operation.
4. Click **Apply**.

**Projecting curves on a surface**

1. Click **Modify curve** to bring up a dialog box.
2. Select **Project** as modify method and then click the curves to project in the graphics window.
   
   Note that when you rest the pointer over the curve, the projection direction is displayed. The project direction is always the negative Z direction of the User Coordinate System. To change the projection direction, create a new frame with the desired orientation and set it as user coordinate system.
   
   The **Selected curves** list displays the curves that will be projected. To remove a curve from the list, select the list entry and press the **DEL** key.
3. Click in the **Target bodies** list and then click the bodies to project on in the graphics window. The bodies must be in the projection direction and be big enough to cover the projected curves.
   
   To remove a bodies from the list, select the list entry and press the **DEL** key.
4. Click **Apply**. A new curve will now be created in a new part, wrapped around the surface of the selected bodies.

**Reversing curves**

1. Click **Modify curve** to bring up a dialog box.
2. Select **Reverse** as modify method and then click the curves to reverse in the graphics window.

*Continues on next page*
Note that when resting the pointer over a curve, the current direction of the curve is displayed by yellow arrows.

The Selected curves list displays the curves that will be reversed. To remove a curve from the list, select the list entry and press the DEL key.

3 Click Apply. The curves will now be reversed.

### Splitting a curve

1. Click **Modify curve** to bring up a dialog box.
2. Select **Split** as modify method and then click the curve at the point to split at. Only open curves can be split.
   
   Note that when you rest the pointer over the curve, point of the split is highlighted. This point is affected by the current snap mode setting.
3. Click **Apply**. The curve will now be split to two separate curves in the same part.

### Trimming a curve

1. Click **Modify curve** to bring up a dialog box.
2. Select **Trim** as modify method and then click the curve segment to trim.
   
   Note that when you rest the pointer over the curve, the closest vertices are highlighted. The segment between these points will be trimmed.
3. Click **Apply**. The selected part of the curve will now be removed.

### Generic content of the Modify Curve dialog box

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Extend</strong></td>
<td>Extend a curve at any vertex with a straight line in the direction of the curve’s tangent.</td>
</tr>
<tr>
<td><strong>Join</strong></td>
<td>Join two or more curves into one. The original curves will be deleted when joining curves.</td>
</tr>
<tr>
<td><strong>Project</strong></td>
<td>Project a curve onto a surface or a body, creating a new curve on the target part.</td>
</tr>
<tr>
<td><strong>Reverse</strong></td>
<td>Reverse the direction of curves.</td>
</tr>
<tr>
<td><strong>Split</strong></td>
<td>Split a curve in two bodies. Only open curves can be split.</td>
</tr>
<tr>
<td><strong>Trim</strong></td>
<td>Cut a segment of a curve between intersection or end points.</td>
</tr>
</tbody>
</table>
### Extend-specific information

<table>
<thead>
<tr>
<th>Selected curve</th>
<th>Display the name of the curve to extend. Select the curve by clicking it in the graphics window. Note that when you rest the pointer over the curve the endpoint closest to the pointer is highlighted. This is the endpoint that will be selected for extension when you click the curve.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint to extend</td>
<td>Display the position of the endpoint to extend. To change the endpoint, select the curve again, but click it closer to the other endpoint.</td>
</tr>
<tr>
<td>Distance from endpoint</td>
<td>Type the length of the extension here. You can also click a point in the graphics window to set the length. A yellow line indicates the length of the extension.</td>
</tr>
</tbody>
</table>

### Join-specific information

<table>
<thead>
<tr>
<th>Selected curves</th>
<th>Display the names of the curves to join. Select the curves by clicking them in the graphics window. To remove a curve from the list, select the list entry and press the DEL key. The curves may be either intersecting or adjacent to be joined.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tolerance</td>
<td>Specifies the distance within which the end points of adjacent curves may lie to be joined.</td>
</tr>
</tbody>
</table>
### Project-specific information

| Selected curve | Display the name of the curves to project. Select the curves by clicking them in the graphics window.  
Note that when you rest the pointer over the curve the projection direction is displayed. The project direction is always the negative Z direction of the User Coordinate System. To change the projection direction, create a new frame with the desired orientation and set it as user coordinate system. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Target bodies</td>
<td>Display the name of the bodies to project the curve on. Select the bodies by first clicking in the box and then clicking the bodies in the graphics window.</td>
</tr>
</tbody>
</table>

### Reverse-specific information

| Selected curves | Display the names of the curves to reverse. Select the curves by clicking them in the graphics window.  
Note that when resting the pointer over a curve the current direction of the curve is displayed by yellow arrows. |
|----------------|---------------------------------------------------------------------------------------------------------|
14 Context menus

14.25 Modify Curve

Continued

Split-specific information

<table>
<thead>
<tr>
<th>Selected curve</th>
<th>Display the name of the curve to split. Select the curve by clicking it in the graphics window. Note that when you rest the pointer over the curve, the point where the split will be is highlighted. This point is affected by the current snap mode setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point on curve</td>
<td>These boxes show the position of the split point. To change the split point, select the curve again, but click another part of it.</td>
</tr>
</tbody>
</table>

Trim-specific information

<table>
<thead>
<tr>
<th>Selected curve</th>
<th>Display the name of the curve to trim. Select the curve by clicking it in the graphics window. Note that when you rest the pointer over the curve the closest vertexes are highlighted. It is the segment between those points that will be cut.</th>
</tr>
</thead>
<tbody>
<tr>
<td>First section endpoint</td>
<td>Display the position of the first trimming point.</td>
</tr>
<tr>
<td>Second section endpoint</td>
<td>Display the position of the second trimming point.</td>
</tr>
</tbody>
</table>
14.26 Modify External Axis

Modifying external axis positions in targets

1. Select the targets (one or several) you want to modify, either in the Layout browser or in the graphics window. If you select several targets, the values you specify will be applied to all selected targets.

2. Click Modify External Axis to bring up a dialog box.

3. Edit the values of the axis by performing any of the following:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type a new position value for an axis</td>
<td>In the Eax column, select the value of the external axis you want to edit, and enter the new value.</td>
</tr>
<tr>
<td>Jog the axis to the new position</td>
<td>Use the arrow buttons to the left of the Joint Values column for jogging the axis. Then click the right arrow button between the Joint values column and the Eax column to transfer the current joint value to the Eax value.</td>
</tr>
</tbody>
</table>

4. Click Apply.

The Modify External Axis dialog box

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>Jog the joint of the external axis corresponding to each row by clicking the &lt; button.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Jog the joint of the external axis corresponding to each row by clicking the &gt; button.</td>
</tr>
<tr>
<td>value box</td>
<td>Enter the axis value for the corresponding joint of the external axis in the value box.</td>
</tr>
<tr>
<td>&lt;-&gt;</td>
<td>With the arrow left button, you transfer the value from the Eax box to the corresponding value box.</td>
</tr>
<tr>
<td>-&gt;</td>
<td>With the arrow right button, you transfer the value from the value box to the corresponding Eax box.</td>
</tr>
<tr>
<td>Eax</td>
<td>Specify the value of the corresponding joint of the external axis.</td>
</tr>
</tbody>
</table>
14 Context menus

14.27 Modify Instruction

Modifying an instruction

1. In the Paths&Targets browser, select the instruction you want to modify. If you want to apply the same properties to several instructions, press the CTRL key and select them.

2. Click Modify Instruction to bring up a dialog box.

3. For move instructions, select joint or linear motion in the Motion type list.

4. In the Instruction Argument group, modify the values for the instruction. For details about each argument, see the selected instruction in the RAPID Reference Manual. For an overview of the arguments for move instructions, see below.

5. When you have finished modifying, click Apply.

Arguments for move instructions

The table below is an overview of common arguments for move instructions. For detailed information about the arguments, see the selected instruction in the RAPID Reference Manual.

<table>
<thead>
<tr>
<th>To set the</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>subsequent instructions to be executed at once.</td>
<td>Conc</td>
</tr>
<tr>
<td>destination target for the instruction target.</td>
<td>ToPoint</td>
</tr>
<tr>
<td>speed for the tool center point, the tool reorientation and external axes.</td>
<td>Speed</td>
</tr>
<tr>
<td>velocity of the TCP in mm/s directly in the instruction (it will be</td>
<td>V</td>
</tr>
<tr>
<td>substituted for the corresponding speed data).</td>
<td></td>
</tr>
<tr>
<td>total time in seconds during which the robot moves (it will be</td>
<td>T</td>
</tr>
<tr>
<td>substituted for the corresponding speed data).</td>
<td></td>
</tr>
<tr>
<td>size of the generated corner path.</td>
<td>Zone</td>
</tr>
<tr>
<td>position accuracy of the robot TCP directly in the instruction (the</td>
<td>Z</td>
</tr>
<tr>
<td>length of the path will be substituted for the corresponding zone</td>
<td></td>
</tr>
<tr>
<td>specified in the zone data).</td>
<td></td>
</tr>
<tr>
<td>tool used for the movement (the TCP of this tool will be positioned</td>
<td>Tool</td>
</tr>
<tr>
<td>at the destination target).</td>
<td></td>
</tr>
<tr>
<td>workobject to which the robot position in the instruction belongs.</td>
<td>Wobj</td>
</tr>
</tbody>
</table>
14.28 Modify Mechanism

The Modify Mechanism dialog box

See *The Modify Mechanism dialog box on page 313.*
14.29 Modify Tooldata

Modifying tooldata

1 In the Layout browser, select the tooldata you want to modify.
2 Click Modify Tooldata to bring up a dialog box.
3 In the Misc Data group:
   • Modify the Name of the tool.
   • Select if the tool is to be held by the robot in the Robot holds tool list.
4 In the Tool Frame group:
   • Modify the Position x, y, z of the tool.
   • Modify the Rotation rx, ry, rz of the tool.
5 In the Load Data group:
   • Enter a new Weight for the tool.
   • Modify the Center of gravity for the tool.
   • Modify the Inertia for the tool.
6 In the Sync Properties group:
   • In the Storage type list, select PERS or TASK PERS. Select TASK PERS if you intend to use the tooldata in MultiMove mode.
   • In the Module list, modify the module in which to declare the tooldata.
7 Click Apply.
14.30 Modify Workobject

Modifying a workobject

1. In the Layout browser, select the workobject you want to modify.
2. Click Modify Workobject to bring up a dialog box.
3. In the Misc Data group, modify the values for the workobject:
   • Enter a Name for the workobject.
   • In the Robot holds workobject list, select True or False. If you select True, the robot will move the workpiece instead of the tool.
   • In the Moved by mechanical unit list, select the mechanical unit with which the robot movements are coordinated. This setting is only valid when Programmed has been set to False.
   • In the Programmed list, select True or False. True means that the workobject will use a fixed coordinate system, and False that a movable coordinate system (that is, coordinated external axes) will be used.
4. In the User Frame group, do one of the following:
   • Modify the user frame by entering values for the Position x, y, z and the Rotation rx, ry, rz for the workobject. Click in one of these boxes, and then click the position in the graphics window to transfer the values.
   • Modify the user frame by using the Frame by points dialog box, see Frame from Three Points on page 212.
5. In the Object Frame group, do one of the following:
   • Modify the object frame by selecting values for Position x, y, z and Rotation rx, ry, rz for the workobject.
   • Modify the object frame by using the Frame by points dialog box.
6. In the Sync Properties group, modify the values for the workobject:
   • In the Storage type list, select PERS or TASK PERS. Select TASK PERS if you intend to use the workobject in MultiMove mode.
   • In the Module list, select the module in which to declare the workobject.
7. Click Apply.

Note

If you change the position of a workobject that is used in a program, you have to synchronize the affected paths to the virtual controller; otherwise, the program will not be updated.
14 Context menus

14.31 Move Along Path

14.31 Move Along Path

Prerequisites

At least one path must have been created in the station.
A virtual controller must be running for the robot to move along the path.

Moving along a path

1. In the Paths&Targets browser, select the path to move along.
2. Click Move along path. In the graphics window, the robot will move along the path.
14 Context menus
14.32 Move to Pose

14.32 Move to Pose

Prerequisites

At least one joint position must be defined.
Only one mechanism may be selected at a time.

Moving to a pose

1 In the Layout browser, select one mechanism to move.
2 Click Move to Pose and then click one of the available poses. In the graphics window, the mechanism will move to the pose.
14.33 Offset Position

Offset the position an item

1 Right-click the item you want to move.
2 Click Offset Position to bring up the Offset Position dialog box.
3 In the dialog box, select the reference coordinate system you want to use:

<table>
<thead>
<tr>
<th>If you want to move the item</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>relative to its own coordinate system</td>
<td>Local</td>
</tr>
<tr>
<td>relative to the coordinate system of its parent</td>
<td>Parent</td>
</tr>
<tr>
<td>relative to the coordinate system of the station</td>
<td>World</td>
</tr>
<tr>
<td>relative to a user-defined coordinate system</td>
<td>UCS</td>
</tr>
<tr>
<td>relative to a target reference frame</td>
<td>Target Reference Frame</td>
</tr>
<tr>
<td></td>
<td>This option is available only for targets.</td>
</tr>
</tbody>
</table>

4 In the Translation X, Y, Z boxes, either type the offset, or select it by first clicking in one of the value boxes and then clicking the point in the graphics window.
5 Specify the Rotation for the item.
6 Click Apply.
14.34 Place

Placing an item

1 Select the item you want to move.
2 Click Place and then click one of the commands to bring up a dialog box.

<table>
<thead>
<tr>
<th>If you want to move the item</th>
<th>Choose</th>
</tr>
</thead>
<tbody>
<tr>
<td>from one position to another without affecting the orientation of the object. Select the axes to be affected.</td>
<td>One Point</td>
</tr>
<tr>
<td>according to the relationship between a start and a finish line. The object will move to match the first point, then it will rotate to match the second point.</td>
<td>Two Points</td>
</tr>
<tr>
<td>according to the relationship between a start plane and a finish plane. The object will move to match the first point, then it will rotate to match the third point.</td>
<td>Three Points</td>
</tr>
<tr>
<td>from one position to a target or frame position and simultaneously change the orientation of the object according to the frame orientation. The position of the object changes according the orientation of the to-point coordinate system.</td>
<td>Frame</td>
</tr>
<tr>
<td>from one frame of reference to another</td>
<td>Two Frames</td>
</tr>
</tbody>
</table>

3 Set the reference coordinate system you want to use.
4 Click the points in the graphics window to transfer values to the from-point boxes to the to-point boxes. For detailed information, see the tables below.
5 Click Apply.

The Place Object by One Point dialog box

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Point - From</td>
<td>Click in one of these boxes, and then click the primary point in the graphics window to transfer the values to the Primary Point - From boxes.</td>
</tr>
<tr>
<td>Primary Point - To</td>
<td>Click in one of these boxes, and then click the primary point in the graphics window to transfer the values to the Primary Point - To boxes.</td>
</tr>
<tr>
<td>Translate along these axes</td>
<td>Select whether the translation is to be performed along the X, Y or Z axis, or several of the axes.</td>
</tr>
</tbody>
</table>

The Place Object by Two Points dialog box

<table>
<thead>
<tr>
<th>Reference</th>
<th>Select the reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
</table>

Continues on next page
### 14 Context menus

#### 14.34 Place

*Continued*

<table>
<thead>
<tr>
<th><strong>Primary Point - From</strong></th>
<th>Click in one of these boxes, and then click the primary point in the graphics window to transfer the values to the Primary Point - From boxes.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary Point - To</strong></td>
<td>Click in one of these boxes, and then click the primary point in the graphics window to transfer the values to the Primary Point - To boxes.</td>
</tr>
<tr>
<td><strong>Point on X-Axis - From</strong></td>
<td>Click in one of these boxes, and then click the point on the x axis in the graphics window to transfer the values to the Point on X-Axis - From boxes.</td>
</tr>
<tr>
<td><strong>Point on X-Axis - To</strong></td>
<td>Click in one of these boxes, and then click the point on the x axis in the graphics window to transfer the values to the Point on X-Axis - To boxes.</td>
</tr>
<tr>
<td><strong>Point on Y-Axis - From</strong></td>
<td>Click in one of these boxes, and then click the point on the y axis in the graphics window to transfer the values to the Point on Y-Axis - From boxes.</td>
</tr>
<tr>
<td><strong>Point on Y-Axis - To</strong></td>
<td>Click in one of these boxes, and then click the point on the y axis in the graphics window to transfer the values to the Point on Y-Axis - To boxes.</td>
</tr>
<tr>
<td><strong>Translate along these axes</strong></td>
<td>Select whether the translation is to be performed along the X, Y or Z axis, or several of the axes.</td>
</tr>
</tbody>
</table>

### The Place an Object by Three Points dialog box

<table>
<thead>
<tr>
<th><strong>Reference</strong></th>
<th>Select the reference coordinate system to which all positions or points will be related.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary Point - From</strong></td>
<td>Click in one of these boxes, and then click the primary point in the graphics window to transfer the values to the Primary Point - From boxes.</td>
</tr>
<tr>
<td><strong>Primary Point - To</strong></td>
<td>Click in one of these boxes, and then click the primary point in the graphics window to transfer the values to the Primary Point - To boxes.</td>
</tr>
<tr>
<td><strong>Point on X-Axis - From</strong></td>
<td>Click in one of these boxes, and then click the point on the x axis in the graphics window to transfer the values to the Point on X-Axis - From boxes.</td>
</tr>
<tr>
<td><strong>Point on X-Axis - To</strong></td>
<td>Click in one of these boxes, and then click the point on the x axis in the graphics window to transfer the values to the Point on X-Axis - To boxes.</td>
</tr>
<tr>
<td><strong>Point on Y-Axis - From</strong></td>
<td>Click in one of these boxes, and then click the point on the y axis in the graphics window to transfer the values to the Point on Y-Axis - From boxes.</td>
</tr>
<tr>
<td><strong>Point on Y-Axis - To</strong></td>
<td>Click in one of these boxes, and then click the point on the y axis in the graphics window to transfer the values to the Point on Y-Axis - To boxes.</td>
</tr>
<tr>
<td><strong>Translate along these axes</strong></td>
<td>Select whether the translation is to be performed along the X, Y or Z axis, or several of the axes.</td>
</tr>
</tbody>
</table>

### The Place Object with Frame dialog box

| **Select Frame** | Specify the name of the frame with which you want to place the object. |

### The Place by Two Frames dialog box

<table>
<thead>
<tr>
<th><strong>From</strong></th>
<th>Select the frame object (For example, Target, Workobject, Tooldata or Frame) from this dropdown list to set the From point of moving the object.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td>Select any of the frame object (For example, Target, Workobject, Tooldata or Frame) from this dropdown list to set the To point of moving the object.</td>
</tr>
</tbody>
</table>
14.35 Protected Smart Component

You can protect a Smart Component from being edited. To protect the smart component, right-click the smart component, and then click Protected. You can also optionally specify a password that will be required to unlock the component for edits.

For more information on protected smart components, see Protecting a Smart Component from edits in the section Smart Component on page 256.

Note

Protecting a Smart Component in this manner is a way of hiding complexity, and is not for providing security or securely protecting it.
14.36 Remove Unused Targets

Removing unused targets

1. In the Paths&Targets browser, select either the Controller node or the Task node from which you wish to remove the unused targets, and then click Remove Unused Targets.

2. To the question Are you sure you want to remove unused targets?, answer Yes. All targets that are not used by any move instructions are now removed.
14.37 Rename Targets

Renaming targets

1. In the Paths & Targets browser, select the targets to rename.
   To rename all targets in one or several paths, select the paths that contain the targets.
2. Click Rename targets to bring up a dialog box.
3. In the Target Prefix box, enter a text string to precede the target numbers.
4. Optionally, in the Increment box and the Start with box, change the numbering series for the target names.
5. Optionally, in the Target Suffix box, enter a text string to follow the target numbers.
6. Click Apply.
### 14.38 Reverse Path

#### The commands

<table>
<thead>
<tr>
<th>Simple</th>
<th>Here you reverse only the target sequence. The new path will keep the move instruction for each path segment and just reverse the programmed positions.</th>
</tr>
</thead>
</table>
| ![Path](xx050046) | - Move Target 40  
                        - Move Target 30  
                        - Move Target 29  
                        - Move Target 10  
                        - MoveAbsJ JavTarget_2 |
| Advanced     | Both target sequence and move instructions are reversed in a way that corresponds to recording the robot movements and playing the movie backwards. For example, if the robot used a linear motion to move from a target, it will use a linear motion to move to the target after the reversal. |
| ![Path](xx050047) | - Move Target 49  
                        - Move Target 30  
                        - Move Target 20  
                        - Move Target 19  
                        - MoveL JavTarget_19 |

Note that move instructions are not changed, just the targets. Even the MoveAbsJ instruction to the joint target is preserved, but placed last.

Note that the move instructions have changed together with the targets. For example, in the original path, a joint motion was used to reach target 20 and a linear motion to leave it. After the reversal there is a linear motion to the target and joint motion from it.

Also, note that the joint target has been converted into an ordinary target; otherwise, it would not be possible to program a linear motion to that position.
14.39 Rotate

Rotating an item

1  Select the item you want to rotate.
2  Click Rotate to bring up a dialog box.
3  Select the reference coordinate system you want to use:

<table>
<thead>
<tr>
<th>If you want to move the item</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>absolute in the coordinate system of the station</td>
<td>World</td>
</tr>
<tr>
<td>relative to the coordinate system of its parent</td>
<td>Parent</td>
</tr>
<tr>
<td>relative to its own coordinate system</td>
<td>Local</td>
</tr>
<tr>
<td>relative to the user-defined system</td>
<td>UCS</td>
</tr>
<tr>
<td>relative to an axis defined by two points</td>
<td>User defined axis</td>
</tr>
<tr>
<td>relative to a target reference frame</td>
<td>Target Reference Frame</td>
</tr>
<tr>
<td>Note that this option is available only for targets.</td>
<td></td>
</tr>
</tbody>
</table>

4  Specify the rotation of the item in the Rotate around x, y, z by first clicking in one of the boxes, and then click the center position in the graphics window to transfer the values.
5  If you have selected the coordinate system User defined axis, specify the Axis start point x, y, z and the Axis end point x, y, z.
6  Specify the Rotation of the item and the axis around which the rotation is to occur.
7  Click Apply.
1 In the Layout browser or the graphics window, select the paths to rotate.
2 Click Rotate path to bring up a dialog box.
3 In the Reference frame list, select the frame to rotate the paths around.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>World</td>
<td>rotate around the station’s world coordinate system</td>
</tr>
<tr>
<td>Baseframe</td>
<td>rotate around the robot’s baseframe</td>
</tr>
<tr>
<td>UCS</td>
<td>rotate around a frame or target that previously has been set to User Coordinate System.</td>
</tr>
<tr>
<td>Select Frame</td>
<td>rotate around an existing target or frame other than the listed ones. When using Select Frame, specify the frame to rotate around further down.</td>
</tr>
</tbody>
</table>

4 If Selected frame was selected in the Reference frame list, specify a frame or target in the text box by clicking in the box and then selecting the frame in the graphics window.
5 With the Rotation axis options, select the axis of the frame to rotate around.
6 In the Rotation angle box, enter the rotation.
7 Click Apply.
14.41 Set Local Origin

Setting the origin of the local coordinate system

1 If the object you want modify is a library component, first disconnect it from the library.
2 In the Layout browser or the graphics window, select the part to modify.
3 Click Set Local Origin to bring up a dialog box.
4 In the Set Local Origin dialog box, select the reference coordinate system you want to use:

<table>
<thead>
<tr>
<th>If you want to move</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>relative to the part’s current local coordinate system</td>
<td>Local</td>
</tr>
<tr>
<td>relative to the coordinate system of its parent</td>
<td>Parent</td>
</tr>
<tr>
<td>absolute in the coordinate system of the station</td>
<td>World</td>
</tr>
<tr>
<td>relative to a user-defined coordinate system</td>
<td>UCS</td>
</tr>
</tbody>
</table>

5 In the Position X, Y, Z boxes, either type the new position or, select it by first clicking in one of the value boxes and then clicking the point in the graphics window.
6 Type the Orientation.
7 Click Apply.
14.42 Set Normal to Surface

Setting the target orientation normal to a surface

1. In the Paths & Targets browser, select the target to modify.
2. Click Set Normal To Surface to bring up a dialog box.
3. On the Selection Level toolbar, set the selection level.
   - To align the target to a specific surface, set the selection level to surface.
   - To align the target to a specific point at the surface, set the selection level to part.
4. In the graphics window, click the reference surface. This will transfer the name of the part or surface to the Surface box.
5. In the Approach Direction, click the button for the axis to be used as the approach direction.
6. To set the distance between the surface and the target in the approach direction, specify an Offset value.
7. Click Apply.
14.43 Set Position

Positioning an item

1. Right-click the item you want to move.
2. Click Set Position to bring up the Set Position dialog box.
3. In the dialog box, select the reference coordinate system you want to use:

<table>
<thead>
<tr>
<th>If you want to move the item</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>relative to its own coordinate system</td>
<td>Local</td>
</tr>
<tr>
<td>relative to the coordinate system of its parent</td>
<td>Parent</td>
</tr>
<tr>
<td>absolute in the coordinate system of the station</td>
<td>World</td>
</tr>
<tr>
<td>relative to a user-defined coordinate system</td>
<td>UCS</td>
</tr>
<tr>
<td>relative to a target reference frame</td>
<td>Target Reference Frame</td>
</tr>
<tr>
<td></td>
<td>This option is available only for targets.</td>
</tr>
</tbody>
</table>

4. In the Position X, Y, Z boxes, either type the new position, or select it by first clicking in one of the value boxes and then clicking the point in the graphics window.
5. Specify the Orientation for the item.
6. Click Apply.
14 Context menus

14.44 Tool Compensation

14.44 Tool Compensation

Offsetting a path to compensate for tool radius

1. In the Paths&Targets browser or the graphics window, select the path.
2. Click Tool Compensation to bring up a dialog box.
3. In the Distance box, enter the size of the compensation (normally, the tool radius).
4. Using the Direction options, select whether the new path shall be on the left or the right side of the current path.
5. Click Apply.
14.45 Translate Path

Translating a path

1 In the Paths&Targets browser or the graphics window, select the paths to translate.

2 Click Translate path to bring up a dialog box.

3 In the Reference frame list, select the coordinate system to use as reference for moving the paths.

<table>
<thead>
<tr>
<th>Select</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>World</td>
<td>move relative to the origin of the world coordinate system</td>
</tr>
<tr>
<td>Base Frame</td>
<td>move relative to the origin of the robot’s baseframe</td>
</tr>
<tr>
<td>UCS</td>
<td>move relative to the origin of a frame or target that previously has been set to User Coordinate System.</td>
</tr>
<tr>
<td>Select Frame</td>
<td>move relative to the origin of an existing target or frame other than the listed ones. When using Select Frame, specify the frame to use further down.</td>
</tr>
<tr>
<td>Point to Point</td>
<td>move the path from one point to another without specifying any coordinate system.</td>
</tr>
</tbody>
</table>

4 If Select frame was selected in the Reference frame list, specify a frame or target in the text box by clicking in the box and then selecting the frame from the graphics window.

5 In the Translation vector box, specify the distance to move the path along the X, Y and Z axes of the reference frame.

   Translation vector is applicable only if a reference frame is used. If Point to Point is used as reference, specify the start and end points for the translation, instead. To do this, click in one of the boxes for the point to specify and then select the point in the graphics window, or type the coordinates of the point.

6 Click Apply.
14.46 View Robot at Target

Viewing a robot at a target

1 Click View Robot at Target.
2 Select a target, either in the Paths&Targets browser or in the graphics window.
3 The robot will be shown at each selected target whenever a target is selected. By stepping through the targets in the browser, it will be easy to see how the position of the robot changes.
4 To turn the function off, click the command again.
14.47 View Tool at Target

**Viewing a tool at a target**

1. Click View Tool at Target and select the tool you want to view at the target.
2. Select a target, either in the Paths & Targets browser or in the graphics window. You can also multiselect targets to show several copies of the tool. A copy of the tool will be shown at the selected target. By stepping through the targets in the browser, it is easy to see how the tool orientation changes.
3. To turn the function off, click the command and clear the check box.
This page is intentionally left blank
15 ScreenMaker tab

15.1 Introduction to ScreenMaker

15.1.1 Overview

What is ScreenMaker?
ScreenMaker is a tool in RobotStudio for developing custom screens. It is used to create customized FlexPendant GUIs without the need to learn Visual Studio development environment and .NET programming.

Why use ScreenMaker?
A customized operator interface on the factory floor is the key to a simple robotic system. A well-designed custom operator interface presents the right amount of information at the right time and in the right format to the user.

GUI concepts

A GUI makes it easier for people to work with industrial robots by presenting a visual front end to the internal workings of a robotic system. For FlexPendant GUI applications, the graphical interface consists of a number of screens, each occupying the user window area (the blue box in the figure above) of the FlexPendant touch screen. A FlexPendant screen is then composed of a number of smaller graphical components in a design layout. Typical controls (sometimes

Continues on next page
referred as widgets or graphic components) include buttons, menus, images, and text fields.

A user interacts with a GUI application by:

- Clicking a button
- Selecting from a menu
- Typing a text in a text box
- Scrolling

An action such as clicking a button is called an event. Whenever an action is performed, an event is sent to the GUI application. The exact content of an event is solely dependent on the graphic component itself. Different components trigger different types of events. The GUI application responds to the events in the order generated by the user. This is called event-driven programming, since the main flow of a GUI application is dictated by events rather than being sequential from start to finish. Due to the unpredictability of the user’s actions, one major task in developing a robust GUI application is to ensure that it works correctly no matter what the user does. Of course, a GUI application can, and actually does, ignore events that are irrelevant.

The event handler holds sets of actions to be executed after an event occurs. Similar to trap routines in the RAPID program, the event handler allows the implementation of application-specific logic, such as running a RAPID program, opening a gripper, processing logic or calculating.

In summary, from a developer’s point of view, a GUI consists of at least two parts:

- the view part: layout and configuration of controls
- the process part: event handlers that respond to events

Modern GUI development environments often provide a form designer, a (What You See Is What You Get) WYSIWYG tool to allow the user to select, position and configure the widgets. As for event handlers, typically the developer must use a special programming language recommended by the development environment.
Running Windows CE, the ABB FlexPendant has limited CPU power and memory compared to a PC. A custom GUI application must therefore be placed in the designated folders on the controller hard drive before being loaded. Once loaded, it can be found in the ABB menu as seen in the figure above. Clicking the menu item will launch the GUI application.

As the robot controller is the one actually controlling the robot and its peripheral equipment by executing a RAPID program, a GUI application needs to communicate with the RAPID program server in order to read and write RAPID variables and set or reset I/O signals.

It is essential for RAPID programmers to understand that there are two different levels controlling a work cell: an event-driven GUI application running on the FlexPendant, and a sequential RAPID program running in the controller. These reside on different CPUs and use different operating systems, so communication and coordination are important and must be carefully designed.
15.1.2 Development environment

Overview

This section presents an overview of the ScreenMaker development environment.

<table>
<thead>
<tr>
<th>Parts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Ribbon</td>
<td>Displays group of icons organized in a logical sequence of functions. See Ribbon on page 495.</td>
</tr>
<tr>
<td>2 Project explorer</td>
<td>Shows the active screen project and lists the screens that are defined in the project. For more information, see Managing ScreenMaker projects on page 504.</td>
</tr>
<tr>
<td>3 Design area</td>
<td>Layout to design the screen with the available controls. For more information, see Form designer on page 512.</td>
</tr>
<tr>
<td>4 Output window</td>
<td>Displays information about the events that occur during ScreenMaker development.</td>
</tr>
<tr>
<td>5 ToolBox / Properties</td>
<td>Displays a list of available controls. For more information. Contains the available properties and events of the selected control(s). The value of the properties can either be a fixed value or a link to an IRCS data or an Application Variable. For more information, see Properties window on page 498.</td>
</tr>
</tbody>
</table>

Continues on next page
Ribbon

The ScreenMaker tab contains groups of commands organized in a logical sequence of functions that facilitates the user in managing ScreenMaker projects. The tab consists of the following groups:

<table>
<thead>
<tr>
<th>Group</th>
<th>Functions used for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Managing a ScreenMaker project. See Managing ScreenMaker projects on page 504.</td>
</tr>
<tr>
<td>Add</td>
<td>Adding screen and application variables. See Managing screens on page 506 and Managing application variables on page 510.</td>
</tr>
<tr>
<td>Build</td>
<td>Building a project. See Building a project on page 508.</td>
</tr>
<tr>
<td>Controller</td>
<td>Connecting and deploying to the controller. See Connecting to controller on page 508 and Deploying to controller on page 509. Also for opening the Virtual FlexPendant.</td>
</tr>
<tr>
<td>Arrange</td>
<td>Re-sizing and positioning the controls on the design area. See Arrange on page 495.</td>
</tr>
<tr>
<td>Diagnosis</td>
<td>Detecting problems in the project and providing a diagnostic solution. See ScreenMaker Doctor on page 518.</td>
</tr>
<tr>
<td>Close</td>
<td>Closing a project.</td>
</tr>
</tbody>
</table>

Arrange

This toolbar displays icons for resizing and positioning controls on the design area. The icons are enabled once you select a control or group of controls on the design area.
ToolBox

ToolBox acts a container for holding all the available controls that can be placed on a screen.

The following table displays the GUI controls that can be dragged to the design area.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActionTrigger</td>
<td>Allows to run a list of actions when either a signal or rapid data changes</td>
</tr>
<tr>
<td>BarGraph</td>
<td>Represents an analog value in a bar</td>
</tr>
<tr>
<td>Button</td>
<td>Represents a control that can be clicked. Provides a simple way to trigger an event, and is commonly used to execute commands. It is labeled either with text or an image.</td>
</tr>
<tr>
<td>CheckBox</td>
<td>Allows multiple selections from a number of options. They are displayed as a square box with white space (for unselected) or as a tick mark (for selected).</td>
</tr>
</tbody>
</table>

Continues on next page
<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ComboBox</td>
<td>Represents a control that enables to select items from a list. Combination of a drop-down list and a textbox. It allows you to either type a value directly into the control or choose from the list of existing options.</td>
</tr>
<tr>
<td>CommandBar</td>
<td>Provides a menu system for a ScreenForm.</td>
</tr>
<tr>
<td>ConditionalTrigger</td>
<td>Allows to define conditions while defining action triggers. An action is triggered, if there is any change in value of the data bound.</td>
</tr>
<tr>
<td>ControllerModeStatus</td>
<td>Displays the mode of the Controller (Auto - Manual).</td>
</tr>
<tr>
<td>DataEditor</td>
<td>Represents a text box control that can be used to edit the data.</td>
</tr>
<tr>
<td>Graph</td>
<td>Represents a control that plots data with lines or bars.</td>
</tr>
<tr>
<td>GroupBox</td>
<td>Represents a Windows control that displays a frame around a group of controls with an optional caption. It is a container used to group a set of graphic components. It usually has a title at the top.</td>
</tr>
<tr>
<td>LED</td>
<td>Displays a two states value, like a Digital Signal.</td>
</tr>
<tr>
<td>ListBox</td>
<td>Represents a control to display a list of items. Allows the user to select one or more items from a list contained within a static, multiple line text box.</td>
</tr>
<tr>
<td>NumEditor</td>
<td>Represents a text box control that can be used to edit a number. When the user clicks it, a Numpad is opened.</td>
</tr>
<tr>
<td>NumericUpDown</td>
<td>Represents a spin box that displays numeric values.</td>
</tr>
<tr>
<td>Panel</td>
<td>Used to group collection of controls.</td>
</tr>
<tr>
<td>PictureBox</td>
<td>Represents a picture box control that displays images.</td>
</tr>
<tr>
<td>RadioButton</td>
<td>Allows to select only one of a predefined set of options.</td>
</tr>
<tr>
<td>RapidExecutionStatus</td>
<td>Displays the execution status of the Controller Rapid Domain (Running - Auto).</td>
</tr>
<tr>
<td>RunRoutineButton</td>
<td>Represents a Windows button control that calls a RapidRoutine when clicked.</td>
</tr>
<tr>
<td>Switch</td>
<td>Displays and lets change a two states value, like a Digital Output Signal.</td>
</tr>
<tr>
<td>TabControl</td>
<td>Manages a set of tab pages.</td>
</tr>
<tr>
<td>TpsLabel</td>
<td>Very commonly used widget that displays text, a label is usually static, that is, it has no interactivity. A label generally identifies a nearby text box or other graphic component.</td>
</tr>
<tr>
<td>VariantButton</td>
<td>Used to change the values of RAPID variables or Application variables.</td>
</tr>
</tbody>
</table>

**Note**

For more information on using these controls and their properties, see the section *Development environment on page 494* and the chapter *Using the FlexPendant SDK* of the Application manual - FlexPendant SDK.
Properties window

A control is characterized by its properties and events. Properties describe the appearance and behavior of the component, while events describe the ways in which a control notifies its internal state change to others. By changing the value of a property, the controls have a different look and feel, or exhibit different behavior.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1   Graphical component name panel</td>
<td>Displays the selected component, and lists the available components of the active design screen.</td>
</tr>
</tbody>
</table>
| 2   Properties window toolbar | 1 Organizes table panel in categories  
|                              | 2 Organizes table panel alphabetically  
|                              | 3 Displays Properties in table panel  
|                              | 4 Displays Events in table panel |
| 3   Table panel              | Displays all the properties or events in two-columns. The first column shows the property or event name, the second shows the value of the property or name of the event handler. |
| 4   Information panel        | Display information about a property or event. |
Editing the property value

You can edit the property value of a control from the Properties window in three ways:

1. By typing the numerics, strings and text. For example, Location, Size, Name etc.
2. By selecting the predefined values from the list. For example, BackColor, Font etc.
3. By entering the values in the dialog box. For example, Enabled, States, BaseValue etc.

Building a user interface

This section describes building the GUIs using the following controls from the ToolBox.

ActionTrigger

An action trigger initiates an event, such as making a hidden object visible when an action is performed using a control. It allows to run a list of actions when the property value changes. The property value can be bound to a signal, rapid data, or application variable.

ActionTrigger control can also be used to invoke the application from RAPID.

Use this procedure to add an ActionTrigger control:

1. Drag an ActionTrigger control from the ToolBox on to the design area.
2. You can modify the name, set the default value and configure data binding value for an ActionTrigger control.
   • To set the values of a property, see Properties window on page 498.
   • You can set the trigger event for an ActionTrigger to any of the event handler created either from a control or from an Events Manager option. To set up the events, see Setup Events on page 512.
   • To configure the data binding values, see Configuring data binding on page 515.
   • To set the application variables, see Managing application variables on page 510.

Note

An action is not triggered when the screen is launched for the first time, but is triggered when there is a difference in the bound value at any point of time. This functionality is supported only in RobotWare 5.12.02 or higher.

Example: Consider a signal being bound to the value property. The value of the signal changes at runtime on performing a specific action. The event handler configured for ActionTrigger control gets triggered based on this signal value change.

Continues on next page
TpsLabel

TpsLabel is a standard Windows label that displays a descriptive text.

Use this procedure to add a TpsLabel control:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Drag a <strong>TpsLabel</strong> control from the <strong>ToolBox</strong> on to the design area.</td>
</tr>
</tbody>
</table>
| 2    | You can set the values, setup events, configure data binding values and set the application values for a TpsLabel control.  
   • To set the values of a property, see **Properties window on page 498**.  
   • To set up the events, see **Setup Events on page 512**.  
   • To configure the data binding values, see **Configuring data binding on page 515**.  
   • To set the application variables, see **Managing application variables on page 510**. |
| 3    | You can set the option **Allow Multiple States** to true and change the property.  
   1 Click **Allow Multiple States**. The StatesEditor dialog box appears.  
   2 Click the check-box **Allow Multi-States**, select the properties to change from Properties For States and click OK. |

The controls **Button**, **PictureBox**, and **TpsLabel** support **AllowMultipleStates**. For more information on how to use AllowMultipleStates, see **Picture object and changing images due to I/O on page 533**.

Panel

Panel is used to group a collection of controls.

Use this procedure to add a Panel control:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Drag a <strong>Panel</strong> control from the <strong>ToolBox</strong> on to the design area.</td>
</tr>
<tr>
<td>2</td>
<td>You can add a group of controls to a panel.</td>
</tr>
</tbody>
</table>
| 3    | You can modify the name, set the default value and binding value for a Panel control.  
   • To set the values of a property, see **Properties window on page 498**.  
   • To set up the events, see **Setup Events on page 512**.  
   • To configure the data binding values, see **Configuring data binding on page 515**.  
   • To set the application variables, see **Managing application variables on page 510**. |

**Note**

Currently only **EventHandler**, **CancelableEventHandlers**, and **MouseEventArgs** are supported.

ControllerModeStatus

ControllerModeStatus displays the mode of the controller (Auto - Manual).

Use this procedure to add a ControllerModeStatus control:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Drag a <strong>ControllerModeStatus</strong> control from the <strong>ToolBox</strong> on to the design area.</td>
</tr>
</tbody>
</table>
### ActionStep

You can set the values, setup events, configure data binding values, and set the application variables for a ControllerModeStatus control.

- To set the values of a property, see Properties window on page 498.
- To set up the events, see Setup Events on page 512.
- To configure the data binding values, see Configuring data binding on page 515.
- To set the application variables, see Managing application variables on page 510.

### Step 2

You can select the image to be displayed when the controller is in Auto mode and in Manual mode.

- Click AutoImage in the Properties window and browse to select the image to be displayed in Auto mode.
- Click ManualImage in the Properties window and browse to select the image to be displayed in Manual mode.

### RapidExecutionStatus

RapidExecutionStatus displays the execution status of the Controller Rapid Domain (Running - Auto). This control is used

Use this procedure to add a RapidExecutionStatus control:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Drag a RapidExecutionStatus control from the ToolBox on to the design area.</td>
</tr>
</tbody>
</table>
| 2    | You can set the values, setup events, configure data binding values, and set the application values for a RapidExecutionStatus control.  
- To set the values of a property, see Properties window on page 498.  
- To set up the events, see Setup Events on page 512.  
- To configure the data binding values, see Configuring data binding on page 515.  
- To set the application variables, see Managing application variables on page 510. |
| 3    | You can select the image to be displayed when the Program is running and is stopped.  
- Click RunningImage in the Properties window and browse to select the image to be displayed when the Program is running.  
- Click StoppedImage in the Properties window and browse to select the image to be displayed when the Program is stopped. |

### RunRoutineButton

RunRoutineButton represents a Windows button that calls a RapidRoutine when clicked.

#### Note

To call a routine containing movements, you are not recommended to use the RunRoutine Button control. Instead use a normal button control to call a Trap routine. In the Trap routine, use instructions such as StopMove, StorePath, RestorePath and StartMove to control the movements of the robot.

Use this procedure to add a RunRoutineButton control:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Drag a RunRoutineButton control from the ToolBox on to the design area.</td>
</tr>
</tbody>
</table>

Continues on next page
15 ScreenMaker tab

15.1.2 Development environment

Continued

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 2 | Click the smart tag on the RunRoutineButton and select one of the following RunRoutineButtonTasks.  
  - Define Actions before calling Routine  
  - Select Routine to call  
  - Define Actions after calling Routine |
| 3 | Click Define Actions before calling Routine to define an action/event before calling the routine.  
  The Events Panel dialog box appears.  
  For more information on setting up events, see Setup Events on page 512. |
| 4 | Click Define Actions after calling Routine to define an action/event after calling the routine.  
  The Events Panel dialog box appears.  
  For more information on setting up events, see Setup Events on page 512. |
| 5 | Click Select Routine to call.  
  The Controller Object Binding dialog box appears. |
| 6 | In the Properties window, set the value for the following properties:  
  - RoutineToCall - Set the routine to be called. Indicates the RAPID Routine that will be called when this button is pressed.  
  - AllowInAuto - Set to True or False. Indicates if the routine could be called in the Auto mode.  
  - TextAlign - Set to MiddleLeft and MiddleCenter. Indicates the text alignment.  
  Note the following restrictions:  
  - You cannot bind RunRoutineButton to built-in Service routines.  
  - Only user defined procedures with no arguments can be bound.  
  - Set the PP to task before performing action through RunRoutineButton. |

CommandBar

CommandBar allows you to add menu items in a controlled and organized order. Use this procedure to add menu items to the CommandBar control:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1 | Drag a CommandBar control from the ToolBox on to the design area.  
  The CommandBar appear at the bottom of the screen. |
| 2 | Click the smart tag on the CommandBar and select Add/Remove Items.  
  The MenuItem Collection Editor window appears. |
| 3 | Click Add.  
  A new menu item is added and its properties are displayed which can be edited.  
  Note that while editing the menu item, ensure that the property Text is filled. If not, nothing appears on the CommandBar. |
| 4 | To remove the menu item, select the menu item and Click Remove. |
| 5 | Click Close to close the MenuItem Collection Editor window. |

To add an event to a menu item, for example menuItem1 on the command bar, use this procedure:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Go to the Properties window and select menuItem1 from the drop-down list.</td>
</tr>
<tr>
<td>2</td>
<td>Click Events icon and then double-click the Click event. This opens the Events Panel dialog for the Click event.</td>
</tr>
</tbody>
</table>

Continues on next page
### VariantButton

The VariantButton control is a simple button control with additional features and properties. Using this control, you can change the values of RAPID or Application variables.

Use this procedure to add the VariantButton control:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Drag a VariantButton control from the Toolbox on to the design area.</td>
</tr>
</tbody>
</table>
| 2    | You can perform the following VariantButton tasks from the SmartTag:  
      | • Define Actions before value change  
      | • Define Actions after value change |
| 3    | You can set the following VariantButton specific properties from the Properties window:  
      | • Select Increment or Decrement from Behavior drop down. The default behavior of VariantButton is Increment.  
      | • Select StepRate and set the rate at which the value must be varied.  
      | • Select DataType to which the value should be bound and set the value property of the selected datatype.  
      | Supports only the RAPID datatypes, Num and Dnum. For more information on data binding, see [Configuring data binding on page 515](#). |
| 4    | You can also perform the following common tasks from the Properties windows:  
      | • SetBackColor, ForeColor, Location, and Size of the control.  
      | • Select True or False from the Visible dropdown to hide or unhide the control.  
      | • Select True or False from the Enabled drop down to enable or disable the control. |

### ConditionalTrigger

The ConditionalTrigger button defines the condition while defining action triggers. An action will be triggered if there is a change in the value of the data bound.

Use this procedure to add the ConditionalTrigger control:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Drag a ConditionalTrigger control from the Toolbox on to the design area.</td>
</tr>
</tbody>
</table>
| 2    | You can set the following ConditionalTrigger properties from the Properties window:  
      | • Select the condition to execute from the Condition drop down. The following are the supported conditions AND, OR, XOR, NOT, and EQUAL.  
      | • Select True or False from the Enabled drop down to enable or disable the control.  
      | • Select LHS and RHS and bind the data value to Controller Object or Application Variable. For more information on data binding, see [Data binding on page 515](#). |
15 ScreenMaker tab

15.2 ScreenMaker projects

15.2.1 Managing ScreenMaker projects

Overview
This section describes how to manage projects in ScreenMaker. A complete cycle includes creating, saving, building, connecting, and deploying a ScreenMaker project.

You can manage a project (create, delete, load, or save) either from the ScreenMaker ribbon or the context menu.

Creating a new project

Use this procedure to create a new project:

1. Click New from the ScreenMaker ribbon or right-click Project context menu and select New Project.

   The New ScreenMaker Project dialog box appears.

   **Note**

   You can create a new project either from ScreenMaker installed templates or ScreenMaker custom templates.

2. To create a new project from the ScreenMaker installed templates,
   a. Click Simple Project.
   b. Enter a name and specify the location for the new project. By default, the new project is saved on C:\My Documents\RobotStudio\My ScreenMaker Projects.
   c. Click OK.
   d. A screen MainScreen(main) is added in the tree view.

3. To create a new project from the ScreenMaker custom templates,
   a. Click Basic, Standard, or Extended.
   b. Enter a name and specify the location for the new project. By default, the new project is saved on C:\My Documents\RobotStudio\My ScreenMaker Projects.
   c. Click OK.

   **Note**

   - If you select the template Basic, a project with two screens are created.
   - If you select the template Standard, a project with four screens are created.
   - If you select the template Extended, a project with six screens are created.
Loading a project or template

Use this procedure to load an existing project or an existing template:

1. Click **Open** from the ScreenMaker ribbon or right-click **Project** context menu and select **Open Project**.
   The Open Screen Project File dialog box appears.
2. Browse to the location of the project file or template file to be loaded and click **Open**.

**Note**

You can also load an existing project using a quick access method.
1. Click **Recent** from the ScreenMaker ribbon or right-click **Project** context menu and select **Recent Projects**.
2. Select the project file from the list of most recently opened projects.

Saving a project

To save a project or template, follow this step:

- Click **Save** from the ScreenMaker ribbon or right-click **Project** context menu and select **Save**.

To save the existing project or template with a new name, follow this step:

- Click **SaveAs** from the ScreenMaker ribbon or right-click **Project** context menu and select **SaveAs**.

**Note**

- Project files are saved with the extension *.smk*.
- Template files are saved with the extension *.smt*.

SaveAs FlexPendant Project

To save the ScreenMaker project as a FlexPendant project, in the project context menu, click **SaveAs FlexPendant Project**.

The project is saved with the extension *.csproj* which can be opened using Microsoft Visual Studio 2008.

Error for SaveAs FlexPendant Project

When a ScreenMaker project is saved as a FlexPendant project, an error message as follows, may be displayed if the controls were modified in Visual Studio.

Unable to find out the SDK version. Using code for 5.08

To solve this error:

1. Open the source code whose designer form needs to be modified. Consider that you have a screen named **Navigate**. Here, open the class definition of **Navigate**

```csharp
{
}
```

Continued on next page
2 Instead of `Navigate` inheriting from
`ABB.Robotics.ScreenMaker.Windows.Forms.ScreenForm`, use
`ABB.Robotics.Tps.Windows.Forms.TpsForm`, as follows.

```csharp
{}
```

This change will also enable the toolbox with FlexPendant specific GUI controls.

---

**Note**

There may be some errors in the output log window. When the form has been designed according to your needs, revert back to the previous state and rebuild the project. The state of the class definition should be as follows:

```csharp
public class Navigate :
    ABB.Robotics.ScreenMaker.Windows.Forms.ScreenForm
{}
```

---

**Closing a project**

To close a project, follow this step:
- Right-click `Project` context menu and select `Close Project`.

**Closing ScreenMaker**

To close ScreenMaker, follow this step:
- Click `Close ScreenMaker` from the ScreenMaker ribbon.

**Managing screens**

This section describes adding, copying, renaming, deleting, and editing a screen.

**Creating a screen**

1. On the `ScreenMaker` tab, in the `Add` group, click `Screen`.
   Alternatively, in the `ScreenMaker` browser, right-click the `Project` context, and then click `Add Screen`.
   The `New Screen` dialog box appears.
2. Enter the name of the new screen in `Name` text box.
3. Click `OK`

**Copying a screen**

You can copy an existing screen to create a similar or modified screen. To copy an existing screen:
1. In the `ScreenMaker` browser, right-click the screen to be copied.
2. Click `Copy Screen`.
   A copy of the screen appears and is listed in the browser. The copied screen is given a default name, you can rename it as required.

---

Continued
Renaming a screen

1. In the ScreenMaker browser, right-click the screen to be renamed.
2. Click Rename.
   The Rename of Screen dialog box appears.
3. Enter the new name in the text box and click OK.

Editing a screen

For information on editing a screen, see Editing a screen on page 512.

Changing the Main screen

You have the option to change the main screen.

1. In the ScreenMaker browser, right-click the screen to be changed.
2. Click Set as Main Screen.

Deleting a screen

1. In the ScreenMaker browser, right-click the screen to be deleted.
2. Click Delete.

Note
You can also delete screens directly from the controller. To do this, go to the /Home folder using an FTP client and delete the files TpsViewxxx.dll and TpsViewxxxx.gtpu.dll.

Modifying Project properties

Project properties define the properties of the ScreenMaker project, including how the GUI is loaded and displayed in the FlexPendant.

Use this procedure to modify the project properties:

1. Right-click Project context menu and select Properties.
   The Project Properties dialog box appears.
2. In the Display tab under Caption, enter the text in the Caption of the Application field to edit the caption.
   The updated caption appears in the ABB Menu on the right side.
3. In the Display tab under ABB Menu, select the following options,

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>application is visible to the left in the ABB Menu.</td>
</tr>
<tr>
<td>Right</td>
<td>application is visible to the right in the ABB Menu.</td>
</tr>
<tr>
<td>None</td>
<td>application is not visible at all in the ABB Menu.</td>
</tr>
</tbody>
</table>

Note
The applications that uses the option None cannot be run on RobotWare releases earlier than 5.11.01.

4. In the Display tab under ABB Menu, browse and select the ABB menu image.
5 In the Display tab under TaskBar, browse and select the TaskBar image.

Note

By default, the Use Default Image and Use Menu Image checkbox is enabled and the default image tpu-Operator32.gif is selected.

6 In the Display tab under Startup, select Automatic to load the screen automatically at the Startup.

Note

By default, the start up type is Manual.

7 In the Advanced tab under Run Settings, select Launch virtual FlexPendant after deploying checkbox.

The virtual FlexPendant will be launched after deploying the ScreenMaker project to the virtual controller.

Note

This feature is not applicable if connected to a real controller.

Connecting to controller

Use this procedure to connect to both real and virtual controllers:

1 Click Connect from the ScreenMaker ribbon or right-click Project context menu and select Connect.

The Select a Robot Controller dialog box appears.

Note

Click the Connect dropdown from the ScreenMaker ribbon to directly connect to the controller.

2 Click Refresh to find a list of all the available controllers.

Note

By default, the currently connected controller is highlighted and has a small icon before the row as an indicator.

3 Select the controller to be connected from the list and click Connect.

The connection status is displayed in the Project tree view.

To remove the connection with the controller, click Disconnect from the Project context menu.

Building a project

The result from building the ScreenMaker project is a set of files including DLL file and images. The ScreenMaker project can be compiled into binary format (.dll) that can be deployed on a FlexPendant.
15 ScreenMaker tab

15.2.1 Managing ScreenMaker projects

Use this procedure to build a project:

1. Click Build from the ScreenMaker ribbon or right-click Project context menu and select Build.

   The result is displayed in the output window.

Deploying to controller

Use this procedure to deploy a ScreenMaker project to a real controller or virtual controller:

1. Connect to the controller you want to deploy to. See Connecting to controller on page 508.

2. Click Deploy from the ScreenMaker ribbon or right-click Project context menu and select Deploy Screen to Controller.

   The Download dialog box appears displaying the progress of download. It disappears once the download is successful.

   The TpsViewxxxxxx.dll file is downloaded.

3. Restart the controller.

   **Note**
   - If a real controller is used, you can reboot the FlexPendant by moving its joystick three times to the right, once to the left, and once towards you.
   - If a virtual controller is used, you can reboot the FlexPendant by closing the virtual FlexPendant window.
15.2.2 Application variables

Overview

Application Variables are variables defined inside a ScreenMaker application. An application variable is similar to a RAPID variable. It supports the data types supported by RAPID, such as num, dnum, string, tooldata, wobjdata, and so on.

An application variable’s definition includes its name, data type and initial value. During the execution of the ScreenMaker application, an application variable has a persistent value. It can store values coming from controller data or can be used to write values to controller data. Therefore, it is like an intermediate persistent variable which is used during RAPID execution along with other RAPID variables.

Managing application variables

To create, delete, and rename an application variable, follow these steps:

1. On the ScreenMaker tab, in the Add group, click Application Variables. Alternatively, in the ScreenMaker browser, right-click the project, and then click Application Variables. The Project Application Variables dialog box appears.
2. Click Add and define the name, type and value of the new variable.
3. Select the variable, click Delete to delete a variable.
4. Select the variable, click Rename, enter the new name and click OK to rename a variable.
5. Click Close.

You can view the application variables related to a project listed in the Project Application Variables dialog box. To filter and view the variables according to their data types, use the Type list.

Note

For information on application variable data binding, see Data binding on page 515.
15.2.3 RAPID array

What is RAPID array

A RAPID array is a variable that contains more than one value. An index is used to indicate one of the values.

Sample RAPID array

Consider the following RAPID code.

VAR string part{3} := ["Shaft", "Pipe", "Cylinder"];  

Here, ‘part’ is a RAPID array which consists of three values. The index of the array in part ranges from 1 to 3.

The index of a RAPID array should not be negative and should start with 1.
15.2.4 Form designer

Overview
The Form designer is a tool to edit or design a screen. It allows you to design the screen with the required controls and the design area resembles a FlexPendant screen.

Editing a screen
To edit a screen, follow these steps:

1. Drag a control from the toolbox and drop it on the design area.
   The Properties window displays all the properties of the control.
2. Select the control and resize or reposition for configuration.

   **Note**
   You can either select a single control or multiple controls:
   - Single control: Left-click the control on the design area or select the control from the list in the Properties window.
   - Multiple controls: Left-click on the design area, drag the mouse and create a window selecting all the controls.

3. Click the smart tag on the upper right corner of the control to perform the basic tasks of configuration. See Configuring data binding on page 515.

   **Note**
   You can perform additional configuration by editing the attributes in the Properties window. See Development environment on page 494.

Setup Events
Event handler is a set of actions to be executed after an event occurs.
To set up an event, follow these steps:

1. Select the control for which the event handler is to be defined.
2. Open the Events Panel dialog box in any one of the following ways:
   - Double-click the control.
   - Right-click the control, select Events Manager, click Add enter the name, and click OK and close.
   - Click smart tag and select the task from the list.
   - In the Properties window, click Events icon and select the desired event from the list.

3. Click Add Action to add an action from a predefined list of actions.
   The following table lists the set of predefined actions:

<table>
<thead>
<tr>
<th>Screens</th>
<th>• Open Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Close Screen</td>
</tr>
</tbody>
</table>
Signals
- Set a Digital Signal
- Invert a Digital Signal
- Pulse a Digital Signal
- Read a Signal
- Write a Signal
- Reset a Digital Signal

RapidData
- Read a Rapid Data
- Write a Rapid Data

Application Variable
- Read and Write

Advanced
- Call another Action list
- Call .NET method
- Call Custom Action
- Call FP Standard View

4 Select the action from the left window and perform the following:
   - Click **Delete** to delete the action.
   - Click **Move Up** or **Move Down** to change the order of execution of actions.

5 Click **OK**

Deleting an event handler

To delete a user created event handler, do the following:

1 Right-click the control, select **Events Manager**. The **Events Manager** dialog box appears.

2 Select the event handler to be deleted from the list and click **Delete**.

Advanced options

Call another Action List

Existing event handlers from Events Manager can be reused by other controls while defining actions for event. You can call another event handler from an existing event handler.

In the following example, **listbox1_SelectedIndexChanged** event handler is called from **comboBox1_SelectionIndexChanged** event handler.

Select the **Show warning message before performing actions** check box to have a warning displayed before you can perform these actions.

Call .NET Method

You can import the dlls and add references to the Advanced tab of the Project Properties dialog box.

Once the references are defined, .NET methods appear in the Project Properties dialog box and can be included in the Actions list which will be executed on performing the desired action.

Double click the method and bind the return value to the application variable.

Continues on next page
Binding can be done only to the application variable. For more information, see Application variable data binding on page 517.

Note

ScreenMaker allows you to call static methods of the public classes defined in another DLL. This DLL is usually a class library or a control library. It has the following limitations and the user should be aware of them while using .Net DLLs.

- DLL’s references must be in the same directory in order to load the DLL.
- ScreenMaker provides access only to the static methods which contain basic data types such as string, int, double, boolean, object.

The following is a sample code snippet.

```csharp
namespace SMDotNetMethods
{
    public class Methods
    {
        /// <summary>
        /// Inverts a boolean value
        /// </summary>
        /// <param name="Value">input boolean value</param>
        /// <returns>inverted boolean value</returns>
        public static bool InvertBool(bool value)
        {
            return (value == false);
        }

        /// <summary>
        /// Increments a numerical value
        /// </summary>
        /// <param name="value">value to be incremented</param>
        /// <returns>incremented value</returns>
        public static double Increment(double value)
        {
            return (value + 1);
        }
    }
}
```

Call Custom Action

You can add an user control to the ScreenMaker toolbox and call a custom method for that control by defining it in the ScreenMaker.dll.config file.

Call Custom Action supports only the Graph control.

Call FP Standard View

Standard FlexPendant screens can be opened on any action performed on the control. The standard FlexPendant screens include Rapid Editor, Rapid Data, LogOff, Jogging, Backup and Restore.

For example, on button1_click, Rapid Editor view is opened.
15.2.5 Data binding

Overview

Data binding is the mechanism that links a GUI property with an external data source such that whenever the data source is updated the GUI property will be updated automatically and vice verse. Databinding has the following three aspects:

- A unidirectional connection means that an update of the data source is reflected by the GUI, or vice versa; a bidirectional connection means that updates to either are reflected by the other.
- A temporal connection can be suspended and resumed at any time.
- A convertible connection negotiates between the different data types or formats between the data source and the GUI property.

A screen has to be linked with data to be useful. There are two ways of linking the data with the GUI properties:

- Controller object data binding on page 516
- Application variable data binding on page 517

Configuring data binding

Data binding can be configured in the following two ways:

Using smart tag

Smart tags perform basic configuration tasks like binding default GUI property with controller data. The controls that either display or edit information normally have a value property to represent the information. Smart tag binds the value to the controller object.

- On the design area, select the control and click the smart tag. The tasks menu appears.

<table>
<thead>
<tr>
<th>Click...</th>
<th>to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bind Value to a Controller Object</td>
<td>bind data to a Controller Object. For more information, see Controller object data binding on page 516.</td>
</tr>
<tr>
<td>Bind Value to an Application Variable</td>
<td>binding data to a application variable. For more information, see Application variable data binding on page 517.</td>
</tr>
</tbody>
</table>

Using Binding menu

1. On the design area, select the control.
2. In the Properties window, locate the row from the table for binding the value.
3. Select the property and click the list to display the Binding menu.

<table>
<thead>
<tr>
<th>Click...</th>
<th>to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove actual binding</td>
<td>removes the existing data binding.</td>
</tr>
<tr>
<td>Bind to a Controller object</td>
<td>select available data in the controller for binding. For more information, see Controller object data binding on page 516.</td>
</tr>
</tbody>
</table>

Continues on next page
## 15 ScreenMaker tab

### 15.2.5 Data binding

**Continued**

<table>
<thead>
<tr>
<th>Click...</th>
<th>to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bind to an Application variable</td>
<td>select available data in project temporary data store for binding. For more information, see Application variable data binding on page 517.</td>
</tr>
</tbody>
</table>

**Configuring data binding for different controls**

Almost all the controls defined in the toolbox (except ComboBox and ListBox) have the following two options for binding values:

- Bind to a Controller Object
- Bind to an Application Variable

Binding to an array can be done with the following controls:

- DataEditor
- ComboBox
- ListBox

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataEditor</td>
<td>The default index value is 1. DataEditor is designed in such a way that the default value of the Rapid array starts with 1 and not 0.</td>
</tr>
</tbody>
</table>
| ComboBox and ListBox   | The default index value is -1. You can enter the appropriate index value but cannot bind to a controller object or an application variable. Note the following:  
  - You can limit the number of items to be displayed in the ComboBox and ListBox of an array.  
  - While using a ComboBox, a RAPID index starts with 1 (1 specifies the first element) and the ComboBox index starts with 0 (0 specifies the first index). |

For more information on RAPID array, see [RAPID array on page 511](#).

**Controller object data binding**

Controller object data binding lets you to select the data in the controller for binding. Use this procedure to set up a binding with controller objects:

1. Select **Bind to a Controller Object** either using smart tag or binding menu. The Controller Object Binding dialog box appears.
2. In the **Type of Object** group, select either **Rapid data** or **Signal data**.
3. In the **Shared** group, select **Built-in data only** to access shared Rapid data. When you select **Built-in data only**, the option **Signal data** and the text box Module are disabled.
4. If you select **Rapid data**, from the **Scope** group, select a task and module from the list. When you select **Signal data**, the **Scope** group is disabled.
5. In the **See** list, select the desired data.

*Continues on next page*
Note

ScreenMaker supports binding to only constant and persistent variables. The variables must not be declared LOCAL. TASK PERS is supported.

For example, the following binding is supported:

```
PERS num n1:=0;
TASK PERS num n2:=0;
CONST num n3:=0;
```

The following binding is not supported:

```
LOCAL PERS num n1:=0;
VAR num n1:=0
```

Application variable data binding

Application variables are used for data binding in the same way as controller data. See Controller object data binding on page 516.

Use this procedure to set up a binding with application variables:

1. Select Bind to an Application Variable either using smart tag or binding menu.
   
   The Application Variables Bind Form dialog box appears.

2. Select an application variable and the field to connect.

3. Click Setup Variables to manage the variables.

   The Project Application Variables dialog box appears. See Managing application variables on page 510.

4. Click OK.
15 ScreenMaker tab

15.2.6 ScreenMaker Doctor

Overview

ScreenMaker Doctor is a diagnostic solution to detect problems in the ScreenMaker project. It helps analyze the project and fix errors such as:

- Unused events
- Broken references, application variables, signals, modules, and Rapid data
- RunRoutine issue

Using ScreenMaker Doctor

Use this procedure to launch ScreenMaker Doctor, detect and report issues, and to view causes and solutions:

1. In the ScreenMaker ribbon, click ScreenMaker Doctor.
   The ScreenMaker Doctor Wizard opens.
2. Click Next.
   The wizard starts detecting issues and are reported as Completed Checks.
   The detected issues are categorized as:
   - Broken References
   - Unused Events
   - Broken ApplicationVariables
   - Broken Signals
   - Broken Modules
   - Broken RapidData
   - RunRoutine issue
   - Broken Routine
   - Other Dependencies
3. Click View Causes and Solutions to generate a report.
   The left hand side of the report displays issues under each category and the right hand side of the report displays the Probable Causes and Solutions for the issues.
   To check for issues again using the same instance, click Re-Detect Issues.

Note

In order to detect the signal data and RAPID, ScreenMaker project should be connected to the controller.

Errors fixed by ScreenMaker Doctor

The following sections show you how errors, which can be fixed by ScreenMaker Doctor, may manifest.

Unused Events

The following sequence of actions will result in creating unused events.

1. Create a ScreenMaker project.
2 Define events for the controls. See Setup Events on page 512.

3 Define the events Button1_Click and Button2_Click for the controls Button1 and Button2 respectively.

4 Delete the control Button1. The event Button1_Click will still exist. An unused event is created.

You can run ScreenMaker Doctor to detect and fix this error.

Broken Reference

The following sequence of actions will result in creating broken references.

1 Create a ScreenMaker project.

2 Define events for the controls. See Setup Events on page 512.

3 Define the events Button1_Click and Button2_Click for the controls Button1 and Button2 respectively.

4 Define action ScreenOpen - Screen2 for the event Button1_Click.

5 Delete or rename the screen. A broken reference is created.

You can run ScreenMaker Doctor to detect and fix this error.

Broken Application Variables

The following sequence of actions will result in creating broken application variables.

1 Create a ScreenMaker project.

2 Add an Application variable to the project.

3 Rename or delete the Application variable. No error is reported.

An error is reported during the run time due to the broken application variable.

You can run ScreenMaker Doctor to detect and fix this error.

Broken Rapid Data/Signals

If rapid data is bound but not found in the controller connected in the ScreenMaker project, then perform the following procedure:

1 Create a ScreenMaker project.

2 Connect to a controller.

3 Bind the properties of the controls with controller data.

4 Build the project and deploy it to the controller.

The application works.

5 Connect the ScreenMaker project to another controller and deploy the same project.

The application produces errors in the FlexPendant.

6 Run ScreenMaker Doctor. It detects that RapidData is not found in the controller, thereby suggesting to define the same.

Broken Modules

If modules are bound but not found in the controller connected in the ScreenMaker project, then perform the following procedure:

1 Create a ScreenMaker project.

2 Connect to a controller.

Continues on next page
3 Bind the properties of the controls with controller data.
4 Build the project and deploy to controller.
   The application works.
5 Connect the ScreenMaker project to another controller and deploy the same.
   The application produces errors in the FlexPendant.
6 Run ScreenMaker Doctor.
   It detects that the module in which the rapid data was defined is not found
   in the controller, thereby suggesting to define the same. ScreenMaker doctor
   also detects Hidden modules.

RunRoutine Issue

A check is made whether ScreenMaker.sys file is loaded on the controller or not.
An issue is detected if the system module is not loaded.
You can run ScreenMaker Doctor to detect and fix this error.
15.2.7 Screen navigation

Overview

Screen navigation in ScreenMaker follows a tree structure. Consider the following example,

- To open screen A1, you first have to open Screen A.
- To navigate from screen A1 to screen B1, you first have to close screen A1 and then Screen A and navigate from Main Screen through Screen B to screen B1.
- Similarly, to navigate from screen B1 to screen C1, you first have to close screen B1 and Screen B and then navigate from Main Screen through Screen C to screen C1.
This chapter is designed as a tutorial to take you through the steps involved in designing a FlexArc Operator Panel.

The FlexArc Operator Panel is a simple arc welding cell, where the robots can perform the following three different jobs.

<table>
<thead>
<tr>
<th>Job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Produce</td>
<td>Welding the part</td>
</tr>
<tr>
<td>Service</td>
<td>Service the welding gun</td>
</tr>
<tr>
<td>Bull’s Eye</td>
<td>Calibrate with bull’s eye</td>
</tr>
</tbody>
</table>

The FlexArc Operator Panel displays the following graphic elements:

- Controller Status (controller mode auto or manual and the RAPID execution status)
- Part Status (number of produced parts, the average cycle time per part, and a Reset button)
- Robot jobs (Produce, Service, and Bull’s Eye) and Robot locations (Robot at home position, service location, calibration location, and part location)
- Start and Stop buttons
15.3.2 Designing the FlexArc operator panel

Procedure

Use this procedure to design the FlexArc operator panel:

<table>
<thead>
<tr>
<th>Action</th>
<th>Info</th>
</tr>
</thead>
</table>
| 1 Create a system for the FlexArc operator panel. | Select the following options,  
• FlexPendant Interface  
• PC Interface  
For more information about creating a system, see Creating a system from layout on page 204. |
| 2 Load EIO.cfg and MainModule.mod files. | For more information on loading these files, see Loading a configuration file on page 363 and Loading a RAPID module on page 409.  
By default:  
• For Windows XP, the files can be found at C:\Documents and Settings\<username>\My Documents\RobotStudio\My ScreenMaker Projects\Tutorial  
• For Windows 7, the files can be found at C:\Users\<username>\Documents\RobotStudio\My ScreenMaker Projects\Tutorial |
| 3 The following signals are created after loading EIO.cfg file. |  
en1000000464 |
| 4 Create an empty station in RobotStudio with the system created in the previous step. | For more information about creating a station, see New on page 188. |
| 5 Launch ScreenMaker from RobotStudio. | For more information, see Launching ScreenMaker on page 354. |
## 15 ScreenMaker tab

### 15.3.2 Designing the FlexArc operator panel

Continued

<table>
<thead>
<tr>
<th>Action</th>
<th>Info</th>
</tr>
</thead>
</table>
| 6      | Create a new ScreenMaker project. For more information, see *Creating a new project on page 504*.  
  1. Enter the project name as *FlexArcGUI*, and save it in the default location, C:\Users\<username>\Documents\RobotStudio\My ScreenMaker Projects\Tutorial.  
  2. A new tab *MainScreen* is added to the Design Surface. |
| 7      | Configure the Project properties. To customize how the GUI should appear on the FlexPendant, modify the Project properties. For more information, see *Modifying Project properties on page 507*. |
| 8      | Connect to the controller. For more information, see *Connecting to controller on page 508*.  
The result appears in the output window. |
| 9      | Create application variables (temporary variables) and configure them with the following data  
en1000000360  
For more information, see *Managing application variables on page 510*. |
| 10     | Design the Main Screen. For more information, see *Designing the screen on page 526*. |
| 11     | Build and Deploy the project. For more information, see *Building and deploying the project on page 532*. |

**Continues on next page**
<table>
<thead>
<tr>
<th>Action</th>
<th>Info</th>
</tr>
</thead>
</table>
| 12     | Open virtual FlexPendant and test the GUI | • In RobotStudio, press Ctrl+F5 to launch the virtual FlexPendant.  
• Click FlexArc operator panel to launch the GUI.  
\* Note \*  
Ensure that you switch the controller to Auto mode and start the RAPID execution. |
15.3.3 Designing the screen

Introduction to designing the screen
A major effort in the GUI project development is designing screens. The Form designer in the ScreenMaker allows you to drag controls from the toolbox to the design surface. Using the Properties window, you can resize, position, label, color, and configure the controls.

Designing FlexArc Operator Panel screen
Use this procedure to design the FlexArc Operator Panel screen:

1. Drag a GroupBox control from the General category; place it on the design surface and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>14,45</td>
</tr>
<tr>
<td>Size</td>
<td>150,100</td>
</tr>
<tr>
<td>Title</td>
<td>Controller Status</td>
</tr>
<tr>
<td>BackColor</td>
<td>LightGray</td>
</tr>
</tbody>
</table>

2. Drag another GroupBox control from the General category; place it on the design surface and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>14,170</td>
</tr>
<tr>
<td>Size</td>
<td>150,204</td>
</tr>
<tr>
<td>Title</td>
<td>Part Status</td>
</tr>
<tr>
<td>BackColor</td>
<td>LightGray</td>
</tr>
</tbody>
</table>

3. Drag a ControllerModeStatus control from the Controller Data category; place it in the Controller Status groupbox created and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>19,40</td>
</tr>
<tr>
<td>Size</td>
<td>44,44</td>
</tr>
<tr>
<td>BackColor</td>
<td>LightGray</td>
</tr>
</tbody>
</table>

4. Drag a RapidExecutionStatus control from the ControllerData category; place it in the Controller Status groupbox created and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>80,40</td>
</tr>
<tr>
<td>Size</td>
<td>44,44</td>
</tr>
<tr>
<td>BackColor</td>
<td>LightGray</td>
</tr>
</tbody>
</table>
5 Drag a TpsLabel control from the General category; place it in the Part Status groupbox created and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>16,30</td>
</tr>
<tr>
<td>Size</td>
<td>131,20</td>
</tr>
<tr>
<td>Text</td>
<td>Parts Produced</td>
</tr>
<tr>
<td>BackColor</td>
<td>LightGray</td>
</tr>
<tr>
<td>Font</td>
<td>TpsFont10</td>
</tr>
</tbody>
</table>

6 Drag a NumEditor control from the ControllerData category; place it in the Parts Status groupbox created and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>16,56</td>
</tr>
<tr>
<td>Size</td>
<td>116,23</td>
</tr>
<tr>
<td>Value</td>
<td>Link to RAPID variable partsReady defined in the module MainModule.</td>
</tr>
</tbody>
</table>

7 Drag another TpsLabel control from the General category; place it in the Part Status groupbox created and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>16,89</td>
</tr>
<tr>
<td>Size</td>
<td>131,20</td>
</tr>
<tr>
<td>Text</td>
<td>Cycle time/part</td>
</tr>
<tr>
<td>BackColor</td>
<td>LightGray</td>
</tr>
<tr>
<td>Font</td>
<td>TpsFont10</td>
</tr>
</tbody>
</table>

8 Drag another NumEditor control from the General category; place it in the Part Status groupbox created and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>16,115</td>
</tr>
<tr>
<td>Size</td>
<td>116,23</td>
</tr>
<tr>
<td>Value</td>
<td>Link to RAPID variable cycleTime defined in the module MainModule.</td>
</tr>
</tbody>
</table>

9 Drag a Button control from the General category; place it in the Part Status group box created and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>33,154</td>
</tr>
<tr>
<td>Size</td>
<td>85,34</td>
</tr>
<tr>
<td>Text</td>
<td>Reset</td>
</tr>
</tbody>
</table>
Perform the following for the Reset button in the Part Status group:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Double-click the button Reset. The Events Panel dialog box appears which is used to define the actions for Events.</td>
</tr>
</tbody>
</table>
| 2    | In the Events Panel dialog box, click Add Action; point to Rapid Data and select Write a Rapid Data. The Action Parameters dialog box appears; assign Rapid data to the following value and click OK.  
  • T_ROB1.MainModule.partsReady to MyResetValue.Value  
  Similarly, assign Rapid data to the following value and click OK.  
  • T_ROB1.MainModule.cycleTime to MyResetValue.Value  
  Two actions of similar type are needed to perform the Reset action. One is to reset Rapid variable partsReady to 0, the other is to reset Rapid variable cycleTime to 0. |

10 Drag a PictureBox control from the General category; place it on the design surface and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>177,28</td>
</tr>
<tr>
<td>Size</td>
<td>284,359</td>
</tr>
<tr>
<td>SizeMode</td>
<td>StretchImage</td>
</tr>
<tr>
<td>Image</td>
<td>FlexArcCell.GIF</td>
</tr>
</tbody>
</table>

**Note**

You can find the graphic (.GIF) files at C:\MyDocuments\RobotStudio\My ScreenMaker Projects\Tutorial\Images.

11 Drag another PictureBox control from the General category; place it on the design surface and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>237,31</td>
</tr>
<tr>
<td>Size</td>
<td>48,48</td>
</tr>
<tr>
<td>SizeMode</td>
<td>StretchImage</td>
</tr>
<tr>
<td>Image</td>
<td>RobotAtHome.GIF</td>
</tr>
<tr>
<td>AllowMultipleStates</td>
<td>True</td>
</tr>
<tr>
<td>SelectedStateValue</td>
<td>DI_RobotAtHome</td>
</tr>
</tbody>
</table>
| States        | Link State[0] to RobotAtHome_gray.GIF  
  Link State[1] to RobotAtHome.GIF |

**Note**

Add AllowMultipleStates option to the PictureBox control. The objective is to have an image that changes when an I/O signal changes.

For more information on how to use AllowMultipleStates for PictureBox control, see Picture object and changing images due to I/O on page 533.
12 Drag a Button control from the General category; place it on the design surface and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>486,66</td>
</tr>
<tr>
<td>Size</td>
<td>116,105</td>
</tr>
<tr>
<td>Text</td>
<td>Start</td>
</tr>
<tr>
<td>Font</td>
<td>TpsFont20b</td>
</tr>
<tr>
<td>BackColor</td>
<td>LimeGreen</td>
</tr>
<tr>
<td>Enabled</td>
<td>Link to DI_RobotAtHome</td>
</tr>
</tbody>
</table>

Perform the following for the **Start** button:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Double-click the button <strong>Start</strong> or click the Smart tag and select Define Actions when clicked. The Events Panel dialog box appears which is used to define the actions for Events.</td>
</tr>
<tr>
<td>2</td>
<td>In the Events Panel dialog box, click Add Action; point to Rapid Data and select Write a Rapid Data. The Action Parameters dialog box appears.</td>
</tr>
</tbody>
</table>
| 3    | In the Action Parameters dialog box, assign Rapid data to the following value and click OK.  
  • T_ROB1.MainModule.JobProduce to JobProduce |

13 Drag a Button control from the General category; place it on the design surface and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>486,226</td>
</tr>
<tr>
<td>Size</td>
<td>116,105</td>
</tr>
<tr>
<td>Text</td>
<td>Stop</td>
</tr>
<tr>
<td>Font</td>
<td>TpsFont20b</td>
</tr>
<tr>
<td>BackColor</td>
<td>LimeGreen</td>
</tr>
<tr>
<td>Enabled</td>
<td>Link to DI_PRODUCE</td>
</tr>
</tbody>
</table>

Perform the following for the **Stop** button:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Double-click the button <strong>Stop</strong> or click the Smart tag and select Define Actions when clicked. The Events Panel dialog box appears which is used to define the actions for Events.</td>
</tr>
<tr>
<td>2</td>
<td>In the Events Panel dialog box, click Add Action; point to Rapid Data and select Write a Rapid Data. The Action Parameters dialog box appears.</td>
</tr>
</tbody>
</table>
| 3    | In the Action Parameters dialog box, assign Rapid data to the following value and click OK.  
  • T_ROB1.MainModule.JobIdle to JobIdle |

14 Drag a Button control from the General category; place it on the design surface and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>274,246</td>
</tr>
</tbody>
</table>
15 ScreenMaker tab

15.3.3 Designing the screen

Continued

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>111,47</td>
</tr>
<tr>
<td>Text</td>
<td>Bull’s Eye</td>
</tr>
<tr>
<td>Font</td>
<td>TpsFont14b</td>
</tr>
<tr>
<td>Enabled</td>
<td>Link to DI_RobotAtHome</td>
</tr>
<tr>
<td>AllowMultipleStates</td>
<td>True</td>
</tr>
<tr>
<td>SelectedStates</td>
<td>DI_RobotAtBull’sEye</td>
</tr>
<tr>
<td>States</td>
<td>Link State[0] to Red</td>
</tr>
<tr>
<td></td>
<td>Link State[1] to Green</td>
</tr>
</tbody>
</table>

Perform the following for the Bull’s Eye button:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Double-click the button Bull’s Eye or click the Smart tag and select Define Actions when clicked. The Events Panel dialog box appears which is used to define the actions for Events.</td>
</tr>
<tr>
<td>2</td>
<td>In the Events Panel dialog box, click Add Action; point to Rapid Data and select Write a Rapid Data. The Action Parameters dialog box appears.</td>
</tr>
<tr>
<td>3</td>
<td>In the Action Parameters dialog box, assign Rapid data to the following value and click OK.</td>
</tr>
<tr>
<td></td>
<td>• T_ROB1.MainModule.JobBulls to JobBulls</td>
</tr>
</tbody>
</table>

Drag a Button control from the General category; place it on the design surface and set the following values in the Properties window:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>274,324</td>
</tr>
<tr>
<td>Size</td>
<td>111,47</td>
</tr>
<tr>
<td>Text</td>
<td>Service</td>
</tr>
<tr>
<td>Font</td>
<td>TpsFont14b</td>
</tr>
<tr>
<td>Enabled</td>
<td>Link to DI_RobotAtHome</td>
</tr>
<tr>
<td>AllowMultipleStates</td>
<td>True</td>
</tr>
<tr>
<td>SelectedStates</td>
<td>DI_RobotAtService</td>
</tr>
<tr>
<td>States</td>
<td>Link State[0] to Red</td>
</tr>
<tr>
<td></td>
<td>Link State[1] to Green</td>
</tr>
</tbody>
</table>

Perform the following for the Service button:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Double-click the button Service or click the Smart tag and select Define Actions when clicked. The Events Panel dialog box appears which is used to define the actions for Events.</td>
</tr>
<tr>
<td>2</td>
<td>In the Events Panel dialog box, click Add Action; point to Rapid Data and select Write a Rapid Data. The Action Parameters dialog box appears.</td>
</tr>
</tbody>
</table>
3 In the Action Parameters dialog box, assign Rapid data to the following value and click OK.
   • T_ROB1.MainModule.JobService to JobService
15.3.4 Building and deploying the project

Procedure

1. From the ScreenMaker ribbon, click Build.
   For more information on building the project, see Building a project on page 508.

2. From the ScreenMaker ribbon, click Deploy.
   For more information on deploying the project, see Deploying to controller on page 509.

3. In RobotStudio, press Ctrl+F5 to launch the Virtual Flexpendant and click FlexArc Operator Panel to open the GUI.

   **Note**

   Ensure that you start the RAPID execution and switch the controller into Auto mode.
15.4 Frequently asked questions

How to deploy manually to a Virtual Controller

If for any reason you wish to manually by-pass the Deploy button in RobotStudio and the virtual controller, the following information describes what files are to be moved.

Actions

Location of output files

The files that contain the FlexPendant application from ScreenMaker are found (for example) in the bin directory under the My ScreenMaker Projects located in the My documents directory of the user.

For example, My Documents\My ScreenMaker Projects\SCM_Example\bin where SCM_Example is the example ScreenMaker project.

The files in the bin directory are to be copied to a location where the Virtual FlexPendant can read them during the start of the FlexPendant.

Location where the Virtual FlexPendant reads the files

The recommended location for manually copying the ScreenMaker output files is the location of the virtual controller system.

If the system is created manually from System Builder, it is located in the My Documents directory.

For example, My Documents\IRB4400_60_SCN_Example\HOME where IRB4400_60_SCN_Example is the example controller system.

If the system is created by a Pack-and-Go and then restored, it is located in the RobotStudio\Systems folder.

For example, MyDocuments\RobotStudio\Systems\IRB4400_60_SCN_Example\HOME where IRB4400_60_SCN_Example is the example controller system.

Copy files

Copy the files from the ScreenMaker output to the Home directory of the virtual controller system.

Restart the Virtual FlexPendant and the new application will be loaded.

Picture object and changing images due to I/O

The typical user objective is to have an image that changes when an I/O signal changes, this is common for a digital input to affect the state on the FlexPendant.

Actions

This is accomplished by adding an image and allowing the image to have multiple states.

Set AllowMultipleState to TRUE and set the Image state.

Create two states and add images for each state:

The Value property is extremely important. If binding to a digital input then there are two states for the input, 0 and 1. Set the Value property to the value of the
bound variable. 0 and 1 for digital input. It is also possible to bind to RAPID variables and have multiple states and values for the values in the RAPID variable. Set the SelectedStateValue property to bind to a controller object:

How to get radio buttons to show state when entering

The objective is to have two radio buttons that controls one digital output. When the screen is loaded, the buttons should show the current state of the output.

Actions

Create a group or a panel and place the two radio buttons on the group or panel. For button1, set the property default value to True and bind the property to the value of the controller digital output signal. For button2, do not do any changes. When the screen is loaded, the state of the two radio buttons is established correctly.
Index

3
3D view group, 248
   3D settings, 248
Markup, 252
Show/Hide, 248
View, 248

A
ABB library, 202
action instruction
   about, 27
Activate RobotStudio
   Automatic activation, 42
   Manual activation, 43
Add Controller, 348
add to path, 435
Adjust Robtargets, 417
alerts
   activate, 142
   align frame orientation, 436
   align target orientation, 437
Application grants, 391
Application Variables, 510
   create, delete, rename application variables, 510
attach to object, 438
Authenticate, 373
   Edit User Accounts, 373
   Login as a Different User, 373
   Log in as Default User, 373
   Log off, 373
   Log off all controllers, 373
   UAS Grant Viewer, 373
auto configuration, 439
AutoPath, 223

B
Backup, 357
   create backup, 357
Back up
   restore backup, 359
browser
   Layout, 49
   Modeling, 52
   Paths & Targets, 50

C
CAD file
   troubleshoot and optimize, 90
CAD formats
   convert, 89
check reachability, 441
collision
   detection, 137
   sets, 137
configuration
   robot axis, 34
configuration editor, 361
   instance editor, 362
configuration file, 180
configuration monitoring
   about, 35
Configure data binding, 515
   Using Binding menu, 515
   Using Smart tag, 515

controller system
   create, 156
controller world coordinate system, 30
cycle time
   measure, 143

D
data binding
   Controller object data binding, 516
Data Binding, 515
   Application variable data binding, 517
data declaration, 25
detach, 446
detected collision, 138
Development Environment, 494
device browser, 379

E
element
   select, 70
Ethernet, 150
event
   create, 140
events, 350

confJ
   about, 35
ConfL
   about, 35
Connecting a controller, 508
Controller grants, 389
   Backup and save, 389
   Calibration, 390
   Delete log, 390
   Edit RAPID code, 389
   Execute program, 389
   Full access, 389
   I/O write access, 389
   Manage UAS settings, 389
   Modify configuration, 389
   Modify controller properties, 390
   Modify current value, 389
   Program debug, 390
   Read access to controller disks, 390
   Safety Controller, 390
   Write access to controller disks, 390
controller menu, 180
Controller Shutdown, 394
controller status window, 58
   access, 59
   controller name, 58
   controller state, 58
   logged on as, 59
   operating mode, 58
   program execution state, 58
   system name, 58

Counter J
external axis
  program, 131
F
  File transfer, 374
    Controller explorer, 375
    PC explorer, 375
  FlexPendant Viewer, 376
  frame
    creating to workobject, 104
    creating by points, 104
  Frame
    create, 211
    create from three points, 212
  frames, 28
  function, 25
G
  geometry
    troubleshoot and optimize, 90
  Go Offline, 381
  Grants, about, 155
  Grants, give to groups, 387
  graphics window, 69
  Group, about, 154
  group, add, 386
  group, add user, 385
  group, remove, 387
  group, rename, 386
  Groups, give grants, 387
H
  handle events, 183
    date and time, 184
    event category, 184
    event code, 184
    event description, 184
    event log list, 183
    event title, 184
    event type, 183
  manage events, 185
  retrieve controller events, 185
  sequential number, 184
I
  I/O
    set, 141
  I/O system, 351
    I/O signals, 176
    input signals, 176
    output signals, 176
    simulated signals, 176
    virtual signals, 176
  import, 87
  import geometry, 210
  import library, 203
  instruction, 25
    about, 27
  Item
    select, 70
J
  jog
    mechanism, 105
    robot, 105
    several mechanisms, 105
    jog reorient, 246
  jointtarget
    creating, 106
K
  keyboard shortcuts, 72
    General commands, 72
L
  Layout browser, 49
  LED, 497
  library
    troubleshoot and optimize, 90
  Load Parameters, 363
  local coordinate system
    set, 96
  local origin
    set, 96
M
  Manage ScreenMaker project
    Close ScreenMaker, 506
    ScreenMaker Doctor, 14–15, 495, 518
  Manage ScreenMaker Project, 504
    Close project, 506
    Create project, 504
    Load project, 505
    Save project, 505
  Manage Screens, 506
    Copy screen, 506
    Create screen, 506
    Delete screen, 507
    Edit screen, 507
    Rename screen, 507
  Managing ScreenMaker Projects
    Build project, 508
  Markup, 252
  MediaPool, 24
  Mirror, 461
  Modeling browser, 52
  Modify project properties, 507
  module, 25
  move instruction
    about, 27
  Move instruction
    teach, 233
  MoveJ
    teach, 233
  MoveL
    teach, 233
  MultiMove
    programming workflow, 124
N
  near-miss detection, 138
  network settings, 151
    firewall settings, 151
    local network connection, 151
    remote network connection, 151
    service port connection, 151
O
  object
    select, 70
    set local origin, 96
    troubleshoot and optimize, 90
  Offline and Online browser, 53
  Online Monitor, 382
operator window, 60
  enabling operator window, 60
  show virtual operator window, 60
orientations, 111
  align target, 113
  copy and apply, 114
  target normal to surface, 112
  unordered, 111
output window, 57
  event types, 57
P
  pack, unpack, 146
  part
    set local origin, 96
Password, change for user, 385
path, 108
  about, 27
    compensating, 109
    creating, 108
    creating from curve, 108
    reversing, 108
    rotating, 109
    setting axis configuration, 108
    translating, 109
Paths & Targets browser, 50
Placing an item, 475
  Frame, 475
  One Point, 475
  Three Points, 475
  Two Frames, 475
  Two Points, 475
  positioner.program, 131
  procedure, 25
  process time
    measure, 143
program
  copy, 145
programming
  overview, 103
Program Pointer, 421
Properties, 378
  Device Browser, 379
  Renaming the controller, 378
  Save System Diagnostics, 380
  Set controller ID, 378
  Set date and time, 378
  View controller and system properties, 379
Properties Window
  Event Help panel, 498
  Graphical Component Name panel, 498
  Properties window toolbar, 498
  Table panel, 498
Property editor, 285

R
Rapid
  concepts, 25
  copy program, 145
Rapid Data Editor, 411
Rapid Editor, 402
Rapid instructions, 115
Rapid Profiler, 423
Rapid task, 414
Rapid Watch window, 425
reachability
  test, 122
Relation, 365
Release Write Access, 372
remote subnet, 152
Request Write Access, 371
Restore, 359
robot
  programming overview, 103
  Robot system button, 204
    adding an existing system, 205
    adding a template system, 205
    conveyor setup, 205
    create system from layout, 204
    remove objects from conveyor, 206
RobotWare, 23
  license key, 23
  RobotWare system, 23
  routine, 25
  Run mode, 416
    continuous, 416
    single, 416
S
  safety, 19
  safety configuration, 370
ScreenMaker
  Copy Screen, 506
  Screen navigation, 521
service port, 149
set task frame, 395
Signal Analyzer, 335
signals
  set, 141
  simulate
    alerts, 142
    create event, 140
    measure process time, 143
    set signals, 141
    TCP trace, 142
simulation, 135, 137
  simulation control, 330
Simulation watch, 286
  Break condition, 287
station
  build workflow, 75
  pan, 69
  rotate, 69
  zoom, 69
station world coordinate system, 28
Stopwatch, 334
  switch, 497
synchronization, 134
  station to VC, 134
  VC to station, 134
system
  create, 156
  create with positioner, 173
RobotWare, 23
  System Builder, 156, 360
    about virtual and real systems, 156
    building new system, 159
    copying system, 167
    create boot media, 170
    create system from backup, 168
    download a system to controller, 169
    modify controller system, 163
    viewing system properties, 158
System Configuration, 396
controller values, 396
stored station values, 397
used current station values, 397
system parameters, 177
editing parameters, 178
load parameters, 181
save system parameters, 180

T
target, 106
   about, 27
   creating, 106
   modifying, 106
   modifying with ModPos, 106
   removing unused, 107
   renaming, 106
   teaching, 106
Targets on Edge, 220
TCP, 28
TCP trace
   activate, 142
ToolBox
   ActionTrigger, 496
   BarGraph, 496
   CheckBox, 496
   CommandBar, 497
   ConditionalTrigger, 497
   ControllerModeStatus, 497
   DataEditor, 497
   Graph, 497
   GroupBox, 497
   ListBox, 497
   NumEditor, 497
   NumericUpDown, 497
   Panel, 497
   PictureBox, 497
   RapidExecutionStatus, 497
   RunRoutineButton, 497
   TabControl, 497
Tool Center Point coordinate system, 28
tooldata, 95
tools, 95
TpsLabel, 497
track
   program, 131
Transfer, 365
trap, 25

U
UAS Grant Viewer, 388
UCS, 33
unpack, 190
User, about, 154
User, add, 384
User, add to group, 385
User, change password, 385
User, change user name, 385
User, enable and disable, 385
User, remove, 385
User account, 383
   User tab, 383
user coordinate system, 33

V
VariantButton, 497
viewpoint, 250
   create, 250
   move to viewpoint, 250
viewpoint functions, 250
Virtual FlexPendant, 392
Virtual FlexPendant operator window, 60
VSTA, 39

W
workobject
   creating, 104
   modifying, 104
WorkObject, 33
workobjects, 104
world coordinate system, 28
Contact us

ABB AB
Discrete Automation and Motion
Robotics
S-721 68 VÄSTERÅS, Sweden
Telephone +46 (0) 21 344 400

ABB AS, Robotics
Discrete Automation and Motion
Box 265
N-4349 BRYNE, Norway
Telephone: +47 51489000

ABB Engineering (Shanghai) Ltd.
5 Lane 369, ChuangYe Road
KangQiao Town, PuDong District
SHANGHAI 201319, China
Telephone: +86 21 6105 6666

ABB Inc.
Discrete Automation and Motion
Robotics
1250 Brown Road
Auburn Hills, MI 48326
USA
Telephone: +1 248 391 9000

www.abb.com/robotics